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Introduction 

For New Artists Only 

DeluxePaint IV is an upgraded and enhanced version of 
Electronic Arts' premier color paint program for the Amiga, 
DeluxePaint III. Its improved and more versatile j^n^e of paint 
and animation features were designed to meet th$needs 
of amateur artists, while satisfying the rigorous r^’Sl^nents 
of graphics and video professionals. 

If you're new to computer graphics, you'll want to read the next 
section. For New Artists Only; before you move on to the rest 
of the introduction to DeluxePaint IV. If you're an experienced 
computer graphic artist, you might want to move directly to 
About the Manual, below. 

You are about to discover that DeluxePaint IV can help you cre¬ 
ate prototypes of your designs more quickly and easily than any 
traditional medium. You'll move from inspiration to execution in 
minutes instead of hours. We think that DeluxePaint IV's power 
and versatility can help you develop a new approach to graphic 
art. You'll soon find that DeluxePaint IV is ideal for creating 
graphic design comps, video and traditional animation, video 
titling, desktop presentations, and other desktop publishing 
applications. 

DeluxePaint IV lets you do things that would be difficult, if not 
impossible, using traditional methods. For example, you can eas¬ 
ily rotate a picture or flip it to create its mirror image. Shrink or 
expand an image as you wish, pick it up, and place it precisely. 
Or you can create a mathematically exact tonal ran^eipr^H^ 
colors just by specifying the beginning and endii^hafe4&dT 
the number of steps in between. " ^ 

You can also move images from one part of the pkh^ ^aYr 
other, or copy an image and paste it anywhere in your 
Create a forest of leaves just by drawing a single leaf and pasting 
it throughout your picture. And make global changes to the col¬ 
ors in your artwork with a few keystrokes. DeluxePaint will help 
you find more efficient ways to create traditional effects. 

You can save all your work on disk, so you don't have to create 
everything from scratch each time you work on a design. This 
means you can collect a library of images (called clip art) to use 
in future designs. Because you can save versions of your picture 
as you go, you can always return to an earlier state of a design 
and pick it up from there, if you like. Finally, because you can 
print as many originals of a picture as you need, or make un- 
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About This Manual 

Every User Should Read 

limited copies of your data disks with no degradation from one 
generation to the next, there need never be just one original of a 
picture to lose or spill coffee on. 

So, welcome to the world of computer-generated art. As you 
begin this great artistic adventure, we think you'll be impressed 
and delighted by DeluxePaint IV. 

When you need help or simply want more information about 
DeluxePaint IV, this manual is the best resource. But you don't 
have to memorize the manual to master the program. We've 
organized the information here so you can quickly learn how to 
use the program in a manner that best suits your style and ex¬ 
perience. 

The manual assumes that you know your way around your 
Amiga. If you just recently acquired your computer, familiarize 
yourself with Amiga terminology and techniques before using 
DeluxePaint IV. You do not have to become an Amiga expert. But, 
selecting, dragging, pointing, and clicking should not be a mystery 
to you; nor should menus, submenus, windows, and requesters 
sound strange. 

If any of these terms are unfamiliar, take a few minutes to browse 
through your Amiga User's guide, and make sure you read Hints 
and Reminders while using DeluxePaint, below, for some special 
tips. Knowledge of basic Amiga operations and features will help 
you learn to use DeluxePaint IV quickly and adeptly 

Before starting to work with DeluxePaint IV, there are three 
things that every user ought to do. 

□ Read What's New in DeluxePaint IV later in this introduction. 
It's especially designed for artists who are familiar with 
previous versions of DeluxePaint. DeluxePaint IV's exciting 
new features are briefly described there, and beginners will 
also find much useful information. 

□ Briefly review the Table of Contents to locate areas of special 
interest. Note that Chapters 4-7 assume familiarity with the 
more basic parts of the program. 

□ Carefully read Getting Started to be sure you have the all the 
proper equipment and software. If you have a hard drive, fol¬ 
low the numbered steps for installing DeluxePaint IV on it. 
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Beginning Computer 

Graphics Users 

Experienced Computer 

Graphics Users 

Those Who Don't 

Read Manuals 

After you've read What's New, reviewed the Table of Contents, 

and installed DeluxePaint IV, use the manual in whatever way 

suits you and your work. Follow our Guided Tour or strike off on 

your own. You can always consult Reference if you need help or 

want more information. Here are a few approaches you can take 

to learn DeluxePaint IV, depending on your knowledge of com¬ 

puter graphics programs. 

Work through Getting Started and the Guided Tour—in order 

and in detail. These chapters describe the fundamentals of the 

program and introduce some advanced techniques. YouTl start 

creating with DeluxePaint IV right away and learn about its 

more complex functions as you go along. After you've worked 

through the Guided Tour, move on to what interests you. We 

highly recommend Chapter 4, Painting Tutorials. Keep the 

manual close by so you can consult Reference to learn more 

about other program features when you're ready. 

If you're already familiar with DeluxePaint III, quickly scan 

What's New, for new information. YouTl find an introduction to 

some of the unique paint features of DeluxePaint IV there. Move 

on whenever you're ready. Use Chapters 4-8 and the Appen¬ 

dixes to learn more about powerful program features like color 

mixing, the LightTable, stencils, and animation. 

If you don't read manuals as a rule, we still hope that you'll 

read Getting Started. Keep this manual nearby, so you can 

consult it when you need to. 
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Hints and Reminders 

Using DeluxePaint IV 

Conventions of Several special elements in the manual's text are designed to 

the Manual make learning DeluxePaint IV easier 

^ Right-pointing triangles indicate action items or steps. They 
mark how-to sections that present something you should do 
to understand a program feature or function. 

□ Outline squares indicate a list of features, functions, or con¬ 
tents. They do not indicate action items. 

♦> A note preceded by this symbol indicates important addi¬ 
tional information, a warning, or a condition. Be sure to read 
every item that's labeled this way. 

boldface DeluxePaint IV's menu options and keystrokes appear in the 
text in simple boldface type. Every menu option is thor¬ 
oughly described in Chapter 8, Reference. 

special This special monospace typeface indicates characters that you 
should type. 

Enter Refers to the Enter key (sometimes called the Return key) on 
your keyboard. Enter is indicated on some keyboards by the 
J symbol. 

Backspace Refers to the Backspace key, indicated by the <- symbol on 
some keyboards. 

Control Refers to the Control key (Ctrl) on your keyboard. 

A Refers to the Amiga key(s) on the bottom row of your key¬ 
board. Some computers show these as Commodore key(s) 
C=. 

Keyboard 
Equivalents 

You can access many of DeluxePaint tools and functions 
directly from your keyboard. For example, typing the capital 
letter S activates the Show Page option, just as if you had 
chosen the option from the Picture menu. These keyboard 
commands ARE case sensitive, so when we show a command 
that requires a capital letter, like Q for Quit, make sure you 
hold down the Shift key as you type the letter. As you become 
more familiar with the program, you'll find that these key¬ 
board shortcuts can save you time. 
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Using the 
Mouse 

□ 

In this manual, we'll use the term click a few ways to 
describe some standard mouse actions: 

CLICK means press and quickly release the left mouse button. 

□ DOUBLH-CLICK means press and quickly release the left 
mouse button twice. 

r; RIGHT-CLICK means press and release the right mouse 
button. 

Dragging the Mouse 

Painting with the Mouse 

When you are asked to DRAG the mouse to perform some op¬ 
eration, we mean, hold down thep^^piouse button and move 
the mouse, unless otherwise indic^^S! 

The two mouse buttons let you switch between foreground and 
background colors while painting. 

Requesters 

Figure 1-1 
Painting with the Mouse 

Pressing the left mouse button paints with the current fore¬ 
ground color; pressints with the 
current backgroun<|^^Milher color using 
any of the painting^4^Jor in the palette 
selects it as your foj 
selects it as your b. 

Requesters display5! 
quire some input f 

sfilis 
licking a color 

"aya'oo'oP'ra'lfW^I 

|hey always re- 
you modify the 

d or save files. 

u ii 
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Requester window 

Action buttons 

Action Buttons 

Scroll Bars 

Load Picture 
Aqua r limBa ck&round. ha n 
DLDLabel.Han 
Do^&ieBack^round.lace 
Hall-of-Stars.LoRes 
Nev/Tut.Han 
Orig/aniBirds.Han 
Pa tternSet.LoRes 
Reference^^^L^s, 

Drawer 
Pattern 
File 

a 
It of Franes: 

Load Cancel 

Scroll arrow 

— Scroll bar 

y 
Scroll arrow 

Edit boxes 

figure 1-2 Load requester with too many files to shoiv in one window 

Action buttons activate operations or commands made in the 
requests*; or respond to a prompt. Clicking an action button 
usually closes the requester. If the requester has an OK button, 
clicking that button accepts any changes made to settings since 
the requester was opened. Cancel closes the requester without 
accepting any changes. 

The highlighted item in the requester is the one currently se¬ 
lected. Any action buttons you click will affect the item currently 
selected. 

Scroll bars are used to move (scroll) through a list of items that's 
too large to appear in one window of a requester. For example, 
there are too many filenames to fit in one window of Figure 2. 
You have to scroll the window to see the names of files that are 
not visible. There are three ways to scroll through a list. 

i Click the arrows on either end of the scroll bar. 

□ Drag the scroll box to either end of the scroll bar. 

Click the shaded area on either side of the scroll box. 
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Edit Boxes 

What's New in 
DeluxePaint IV? 

HAM 

Load Picture 
New Tut. Ha m 
OriganiBinds.Han 
PattennSet.LoRes 
Ref erencePalette.LoRes 
Seascape.LoRes 
StencilSet.LoRes 
Venus. LoRes 
MorldHap.LoRes_ 

Drawer [TITO MX Emra 
Pattern 

Disks | Assigns | Parent 1 

tt of Franes: 

Load | Cancel 1 

Figure 1-3 Load requester with the remaining files exposed 

Edit boxes let you enter file names or other information from the 
keyboard. Click in the edit to place the cursor, then type any 
printable characters. Press kfte backspace key (<-) to delete char¬ 
acters left of the cursor. Press Del to delete characters under the 
cursor. 

Review these brief descriptions if you see something on screen 
that's unfamiliar. When you're ready to paint, move on to 
Chapter 1, Getting Started. 

If you are familiar with DeluxePaint III, you'll quickly master 
the new features and enhanced functionality of DeluxePaint IV. 
You probably won't need to spend a lot of time working through 
this manual, but there are some special options here that you 
won't want to miss. This section briefly describes the major ad¬ 
ditions and improvements to the software and directs you to the 
areas where you'll find more information. For the straightfor¬ 
ward changes, the best place to find information quickly is in 
Chapter 8, Reference. 

These are the big changes in the software. 

The big news is DeluxePaint IV's support of HAM (Hold and 
Modify) screen format in either Lo-Res or Interlace mode. HAM 
gives you simultaneous access to all 4096 colors available on the 
Amiga. HAM's effects are most nottee&ble when you're color 
editing, and color mixing or spreading a range of colors, or 
defining gradients. 
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HAM has besn implemented in virtually all areas of the pro¬ 
gram, and features (like Translucency and Process) have 
been added to tetke advantage of the colors available in HAM. 
You can even animate in and easily manipulate HAM brushes 
and Anim8mshes» 

Figure 1-4 Choose Screen Format Requester 

□ Animation Control Panel. This on-screen panel's features pro¬ 
vide more fluid and interactive control of your animations. 

Figure 1-5 Animation Control Panel 

The Anim menu has new options for adding, copying, and 
deleting animation frames. And you can now save and load 
"moves" which you have described for your animations from 
the Move requester. 

LightTable in the Effect menu. Key-frame animations are 
now possible. This allows the animator to display additional 
frames under the current frame. Using the "key-frame" as a 
template, the animator can easily paint in-between frames for 
an animation. 

Metamorphosis in the Brush menu. Transforms two custom 
brushes into an AnimBrush over a designated number of 
frames. 

We've added a Color Mixer to the palette. You can use the 
Mixer to interactively mix colors together to create new 
colors. Use the PICK option to copy the new color to your 
palette. 
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Special Features 
and Functions 

Figure 1-6 Color Mixer 

More efficient control of colors ^%l®|^pafettes from the 
Color menu. You can Arrange the palette to suit a given 
project. You can also Load and Save palettes and color sets 
as independent files A palette doesn't have to be saved with 
a document to be accessible. 

We've added a number of general enhancements to the program. 

Ranges in the Color menu now allow you to choose colors 
from your entire color set, and use them to create virtually 
unlimited color cycling and gradient ranges. See Chapter 4, 
Painting Tutorials, for a tour of the new Range requester. 

Beautiful gradient fills. You have precise control of five 
different kinds of customized gradients from the Fill Type 
requester. Again, see Chapter 4, Painting Tutorials, for an 
introduction to the new gradient fills. 

Figure 1-7 Fill Type requester 

Antialias. When you antialias an image, you eliminate the 
"stair-step" effect that is apparent in bit-mapped images 
whose lines are not precisely vertical or horizontal. In 

Effect menu you can choose from three antialias levels, 

□ The Process and Translucency options from the Effect menu 
let you tint an image "on the fly." 
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□ There are two new styles of Color Cycling. You can now use 
colors that are not in your palette when you create a cycling 
range, or you can cycle a single color register through many 
colors. You'll find explanations and examples of Color 
Cycling in Chapter 4, Painting Tutorials. 

□ Stencil in the Effect menu now lets you create a stencil by 
"painting" an area to mask. With the Paint option you can 
use your current built-in or custom brush with any drawing 
tool to paint an area you want stenciled. 

In HAM you can adjust the extent of your stencil by setting a 
Tolerance level in the Make Stencil requester. 

□ DeluxePaint IV's Overscan options go beyond giving you a 
page that is the right size for an overscan image. It gives you 
the ability to paint on an Overscan screen! You'll love it if you 
do video work. Just select Std or Max from the Overscan edit 
box in the Choose Screen Format requester. You'll find addi¬ 
tional information in Reference and scattered through the 
manual in discussions of screen formats. 

“• " *.v 

Assorted Other Changes To t|j^;a4|antage of other capabilities we've provided some 
new options. This is a list of changes you should be aware 
of. If you want to know more, you'll find information about these 

in Reference. 

□ The Prefs menu contains a new option, named FastAdjust. 
This option is only available in HAM, where it is the default. 
With this option selected, your custom brushes move on the 
screen more quickly. See this option under the Prefs menu in 
Reference for more information. 

There is a new brush mode—Mix. The color of your brush 
interactively mixes with the colors already on the screen. 
This mode is particularly effective in HAM. 

You can now Load 256-color ILBM pictures into DeluxePaint 
IV. By default, these files load into 64 color mode, but you 
can also load them directly into HAM mode, where the colors 
of the original image are best preserved. 

□ Improved File requesters. Among other features, double¬ 
clicking in requesters to load, save, and delete files is now 
supported. See Load under the Picture menu in Reference 
for more information 
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This chapter briefly describes the contents of your DeluxePaint 
package and the computer hardware and software you will need 
to use the program. It also describes how to: 

u Organize your disks 

Install DeluxePaint on a hard drive 

Start DeluxePaint 

Open a file 

Quit the program 

Softivare Your DeluxePaint package contains three (3) floppy disks. 

The Program disk contains the DeluxePaint IV program. Color 
Text, Preferences, Install DPaint, and a Read Me file. 

The Artl disk contains pictures, brushes, example moves and 
color sets, and two color fonts that you can use in your own 
work. 

The Art2 disk contains more art, a few animation files and 
some AnimBrushes to give you ideas of what you can do 
with DeluxePaint IV's animation features, and the animation 
Player The Player program lets you play your animations 
outside of DeluxePamCIV (you'll find information about the 
Player in Appeti&foCh 

The ReadMe File Before you do anything else, read the ReadMe file on your Pro¬ 
gram disk. This file contains information about the program that 
was not available before the manual went to press. To read the 
ReadMe file: 

ReadMe 

► Double-click on the ReadMe icon. 

This opens a text window that, at a minimum, lists the title, ver¬ 
sion number, and copyright information about the program. If 
you need help using the ReadMe file, press h on the keyboard to 
see a screen of keyboard commands. To exit the ReadMe file; 

► Press q on the keyboard. 
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Hardware 

Organizing Your Disks 

Copying Your Disks 

To use DeluxePaint you need: 

L an Amiga computer with at least 1 megabyte of random ac¬ 
cess memory (RAM). Two megabytes of RAM (or more) are 
highly recommended; 

a monitor (analog RGB or Multisync Monitor recommended); 

at least one floppy disk drive. Two floppy drives or a hard 
drive are highly recommended; 

❖ If your Amiga has only one floppy drive, we recommend that 
you not double-click on file icons to start DeluxePaint and 
load a file. Instead, start DeluxePaint and then load the file by 
choosing Load from the appropriate menu. 

some initialized floppy disks, or a hard drive for saving your 
work. 

If you want to print the artwork you create, you'll need a printer 
capable of reproducing black and white or color graphics. Con¬ 
sult your Amiga Users Guide for information about connecting 
printers and other peripherals to your computer. 

We assume that you already know how to initialize and copy 
disks, create and rename drawers, and move files from one disk 
to another. If you are not familiar with all of these basic actions, 
we suggest you consult your Amiga Users Guide before going any 
further. 

If you don't have a hard disk, we strongly recommend that you 
make working copies of the DeluxePaint IV disks. This will help 
protect the originals from accidental damage, and you will be 
able to make new copies if necessary. Also, make sure you have 
one or more blank initialized disks handy for saving your work. 

To copy your disks, start your computer with a Workbench disk. 
Double-click the Shell or CLI icon. At the prompt, type the fol¬ 
lowing: 

DISKCOPY FROM DF0: TO DF1: 

This assumes you have two disk drives called DF0: and DF1:. 
Please see your Amiga user manual for information of copying 
disks using only one disk drive. 
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Installing on 
a HardDjsk 

^•^yKKSASS? 
^^A - SvOSWO *7'V£T»- 

If you use a hard probably want to install 
DeluxePaint on it. “f^ro^^&S^teps assume that yp^ started 
the computer with a standard Workbench that config¬ 
ured properly to support a hard disk. §||lll§ 

fmKKm 

Important! You'll need 400K of available disk space and 10K of available 
RAM to install DeluxePaint IV on your hard drive. 

The install program will install D^^^^int IV to a drawer of 
your choice, and lets you copy th£^f&f$fem fonts, which need to 
be installed in your system, in your FONTS: drawer. 

1. Create a drawer named DPaintIV on your hard disk. 

2. Insert the DeluxePaint Program disk into any disk drive. 

3. Double-click the Program disk icon to see the window, which 
displays the contents of the Program disk. 

4. Double-click the Install DPaint icon. This initiates the DPaint 
IV Installation Script. 

5. Type y (for yes) and press Return to continue the installation. 

You'll be prompted to enter the name of the directory in 
which you wish to install the program. 

6. Type the name of the partition of your hard drive, followed 
by a colon and the name of the DeluxePaint drawer you just 
created (DPaint IV). 

For example, if your hard disk is named dh0, and you 
wanted to install the program^,;^.df^J5fg|:you created in 
step 1, you would type: dh0: press Return. 

7. The Installation Script reportsjl^^i^^^ copied to your 
hard disk, and displays a mes^^^6^§^^om fonts. Type y 
to install the DeluxePaint font^i^^tfM^lri's FONTS: 
d i rectory. 

You'll receive the message "Installation complete!" 

Important! We recommend that you install the DeluxePaint fonts to your 
hard drive's FONTS: directory. If you choose not to follow 
this recommendation you must edit your sta^t-jjD |^quence 
for DeluxePaint to run. To edit your start-up^^^lice, 
follow the steps in the gray box below AFTE^^^kc\vc 
completed the 12 steps listed here for installih^m^rogram 
to your hard disk. 

8. If you plan to use color fonts, drag the Color Text icon to the 
DPaint IV drawer on your hard disk. 
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Editing a Startup 
Sequence 

Using a Floppy Drive 

Note: If you are using Amiga DOS 2.0, you do not need to 
run ColorText because it is already supported by your 
system. 

❖ Drag only the DeluxePaint Program and Color Text icons to 
the new drawer. Do not drag Install DPaint or Preferences onto 
your hard drive as they are not needed to run DeluxePaint. 

9. When the copy is complete, eject the Program disk and insert 
the DeluxePaint Artl disk. 

10. Double-click the Artl disk icon to view the contents of the 
disk. Click the Picture drawer to select it. Then press and 
hold down the Shift key and click the Brush drawer to select 
it. Repeat this procedure with the following drawers: Colors, 
Move, Karafonts, and Empty. Drag all the drawers to the 
DPaint IV drawer on your hard drive. 

11. When the copy is complete, eject the Artl disk and insert the 
Art2 disk. 

12. Select and drag the drawer icons into the DeluxePaint 
drawer as you did the Artl disk icons in step 8. 

You now have copies of the DeluxePaint Program and both Art 
disks on your hard disk. 

1. Start up the CL1 or Shell by double-clicking on the 
appropriate icon (probably in your System drawer). 

2. Follow the instructions in your Amiga User's Guide to enter 
and edit the start-up sequence. 

3. Type assign DPaintlV: hard drive namerdrawer 

name into your start-up sequence. 

For example, if you hard drive is named speedy and your 
drawer is named DPaintlV, you would type: 

assign DPaintlV: speedy:DpaintIV 

4. Exit the start-up sequence and return to the Workbench. 

^ Turn on your computer and monitor. (Amiga 1000 users, start 
by inserting the Kickstart disk [1.3 or later] in the internal 
drive.) When the request for the Workbench disk appears on 
the screen, insert your working copy of DeluxePaint. 

Double-click the DeluxePaint disk icon to open the disk 
window. 
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Starting y? ► Double-click the DPaint program icon to run the application. 

Deluxe Paint IV H7£ 
When you start DeluxePaint, the program presents a requester 
(a window that requires input from you) inviting you to 
select a screen format. Well be looking at some of these options 
later, but for now note the settings that are already highlighted 
in blue. These are the default settings, the ones the program auto¬ 
matically uses unless you specify otherwise. 

Figure 1.1 Choose Screen Format Requester 

If your computer has more than 1 MB of RAM, click OK to 
use the default settings. 

❖ If your computer has only 1 MB of RAM, we recommend that 
you click the Swap button and then click OK, so the program 
loads in Swap mode. 

You'll see the Workbench screen for a moment, then the Painting 
Screen appears. 

Title Bar/Menu Bar 

Painting area, 
or "page" 

Figure 1.2 Painting Screen 

Toolbox 

Color 
Indicator 

Palette 

The Painting Screen is your canvas or paper. It's where you'll 
create, color, edit, and manipulate your art. Animations you load 
from disk also appear here. 
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Loading a Picture 

The Toolbox contains the brushes, shape tools, and tool-modifi¬ 
ers youTI use to create and edit your artwork. You can select a 
tool by clicking on it. 

The Palette contains the colors representing a portion of your 
current color spectrum (sometimes called a color universe). This 
is where you select the color you want to paint with. 

Directly above the Palette is the Color Indicator. The two rect¬ 
angles display the colors you're currently using to paint. The in¬ 
ner rectangle shows the foreground color — the color your brush 
is currently using. The default foreground color is gray. You can 
choose a different foreground color by clicking on it. The outer 
rectangle shows the current background color — the color you are 
painting on or over. This color is black by default. You can choose 
a different background color by right-clicking on it. 

If this is your first time using DeluxePaint, we recommend you 
work through the next chapter, where you will learn how to use 
many of DeluxePaint's tools and techniques. 

Before we leave this chapter, let's load a picture so you can see 
how it's done. Let's load the one called Venus. 

❖ Venus is on the DeluxePaint Artl disk. If you don't have a 
hard drive (so that the files from the Art disk are not in the 
DPaintIV drawer on your hard drive), make sure your copy 
of the Art disk is in one of your floppy drives. 

^ Move your cursor to the top of the screen so that it is over the 
Title Bar. 

Whenever you move the cursor to the Title Bar, the cursor 
changes into a pointer. 

> Press and hold down the right mouse button. 

The Menu Bar replaces the Title Bar and you see a row of menus. 
In addition, you see one of the menus extending down into the 
painting area. 

As you move your pointer from left to right along the Menu Bar, 
one menu after another extends down, each one displaying its 
options. We'll be looking at each menu item in detail later, but 
for now we just need to use the first two options from the 
leftmost menu, the Picture menu. 

► Hold down the right mouse button, and drag the pointer all 
the way to the left on the Menu Bar to display the options in 
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Quitting DeluxePaint 

the Picture menu. Drag the pointer down to Load, and release 
the button. This displays the Load Picture requester. 

Load Picture 

t* of Fratie^i 

Aqua riunBa ck&round. han 
DLDLabel.Han 

lace 

Drawer 
Pattern 
File 

Disks 

Load Cancel | 

Figure 1.3 Load Picture requester 

Click <VOL> Artl: in the requester to look at the contents of 
the Art disk. 

ARTl: appears in the Drawer edit field, and the names of six 
directories appears in the window. 

^ Click <DIR> picture: in the requester. 

If necessary you could scroll through these file names by drag¬ 
ging the scroll box up and down. Or you could scroll through the 
names one at a time by clicking the up and down arrows. 

Click on the file named Venus.LoRes. 

Notice that when you click on the file name the name appears in 
the edit field beside File If you wanted, you could type the file 
name into the edit field, though it is usually easier to click it. 

Click Load. 

The disk drive spins for a few moments, and then the picture 
appears on the screen. 

To exit DeluxePaint, choose Quit from the Picture menu. If you 
have made changes to the Venus image since it was last saved, 
DeluxePaint will ask whether you want to save your current 
changes. If you wish to save your changes before quitting, click 
Yes. (You'll find instructions on saving documents in the next 
chapter.) To exit without saving changes to the image, click No. 
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Technical Support If you have questions about operating DeluxePaint, and you 
can't find the answers in this manual, our Technical Support de¬ 
partment can help. If your question is not urgent, please write to 
us at the following address: 

Electronic Arts Technical Support 
P.O. Box 7578 
San Mateo, CA 94403-7578 

Please be sure to include the following information with any corre¬ 
spondence: 

□ the version of PeluxePaint you are using (You'll find this in¬ 
formation in the About option of the Picture menu; 

the Amiga model you are using (500,1000, 2000, etc.); 

your Kickstart and Workbench version numbers; 

amount of random access memory (RAM) installed in your 
Amiga 

additional system configuration notes (for example, number 
of disk drives, type and make of monitor, printer, etc.) 

If you would like to speak to someone directly, call us at (415) 
572-2787 Monday through Friday between 8:30 am and 4:30 pm 
PST. Again, please be sure to have information about your ver¬ 
sion of DeluxePaint and your computer handy when you call. 
Tf&s information will help us help you more quickly. 

u live outside of the United States, you can contact one of 
our other offices. 

In the United Kingdom, contact: 
Electronic Arts Limited 
P. O. Box 835 
Slough SL3 8XU UK 
Phone -1-44 (753) 546465 

In Australia, contact: 
Electronic Arts Pty Ltd 
P. O. Box 539 
Ashmore City, QLD 4214 
Phone: 008-074-277 

What's Next? The next chapter, Guidedjtmr LJ); inS^Uc^ryou to many of the 
fundamental features t^rD^.xePaiqrtV. T^veilesigned the ex¬ 
ercises there to be is 
the first high-quality pmnfwe recomme$j§ 
that you go through aTQhem will give ydj|| 
a solid foundation &irbuttcU>n wTfei/you move on to ^' 
other parts of the prog^Trh^p^dei.KeJJgraphic artists should at 
least page through the Cuiit&hibti?. 
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Painting Screen 

The next two chapters take you on a tour of DeluxePaint IV's 
basic features. They serve as an introduction to the program's 
painting tools, and provide several advanced painting tech¬ 
niques using simple step-by-step instructions. 

If you are a relative newcomer to computer graphics, we rec¬ 
ommend that you work through these chapters from beginning 
to end. If you are an experienced computer artist, you might 
quickly review the material to become familiar with DeluxePaint 
IV's unique paint features. Once you are comfortable with the 
program, you can turn to Chapter 4, Painting Tutorials, to learn 
more about graphic techniques, or go off on your own if you 
wish. Use Chapter 8, Reference, to answer any questions that 
might come up. 

In this chapter you'll learn how to: 

Start a new DeluxePaint IV picture 

Select basic tools and paint with them 

Create, edit, and mo^eofe^cts 

Modify the scre^^^^f Shapes, and tools 

Create a custom 

Save your work 

❖ The step-by-step instructions in the Guided Tour, assume that 
you are using DeluxePaint on a floppy system. If you have 
installed all four DeluxePaint disks on your hard drive, you 
won't have to insert your copies of the mrious program disks when 
we request them. 

Start DeluxePaint IV. If you need a reminder of how to start 
the program, see Starting DeluxePaint IV in Chapter 1. 

Click Ok in the Choose Screen Format requester to use the 
program's default settings—Lo-Res, 32 Colors. 

After you have selected your screen format, the Painting Screen 

appears. 
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Title bar 

Painting area or 
"page" 

Title Bar 

Menus 

DeluxePaint Colon |C h|*Ol 

Figure 2.1 The Painting Screen 

Toolbox 

Color 
indicator 

Palette 

The area to the left of the Toolbox is called the page or painting 
area. The normal page size is the same as the screen size. 

❖ In the next chapter. Guided Tour (2), you'll learn how you can 
make the page larger than the screen. See Page Size. 

The Title Bar lists the name of the program and the current brush 
mode. 

PelMxePaint Colon_ _a is] 

Figure 2.2 Title Bar 

It also reports whether or not you are using certain program 
options. For example, if you choose to see the coordinates of the 
mouse, the current fill type, or angles of rotation, you can turn 
those features on, and see that they are active in the Title Bar. See 
User Feedback in the Title Bar in Reference for more detailed infor¬ 
mation. 

The menus in DeluxePaint work just like other Amiga menus. To 
select an option from a menu, point to the Title Bar and press the 
right mouse button to display the Menu Bar. 
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I Picture Brush Mode flnim Cofor Effect Pref» 

Figure 2.3 Menu Bar 

Drag the pointer toi^l|% name to open that menu. Pull the 
highlight down to dwW’rhe menu options and release the 
mouse button to select that option. 

You select the color you want to paint with from the palette. The 
number of colors in the palette depends on the screen format you 
are using. You'll learn more about screen formats and how they 
affect the number of colors available when you read the next 
chapter, or you can skip ahead and look in Reference under 
Screen Format in the Picture menu. 

Figure 2 A 
Color Indicator 
and Lo-Res Palette 

The Color Indicator looks like one rectangle sitting on top of an¬ 
other. The smaller rectangle shows the foreground color. This is 
the color your brus}] 
any time by clickin 

Move the pointej 

Notice that any cha 
the Color Indicator, $ 
by a gray border inji 

The larger rectangl 
are all the same co 
ground color. If you 

:e this color H 
Palette 

palette and tfitk. 

£ are reflected in 
is surrounded 

in the Palette, 
t's default back- 
ound color di- tnfwrti 

rectly onto the background, it would appear to have no effect, as 
if you were applying black paint to a black page. Painting with 
the background color is a way of erasing an image on the page. 
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UNDO [unI 
DO 

Pointing with the Mouse 

You can change the background color at any time by right-click¬ 
ing one of the other colors in the Palette. 

Move the pointer to one of the colors in the Palette and right- 
click. 

❖ Although the larger rectangle is now filled with the new 
background color, the painting area (page) is still the old 
background color. This is because DeluxePaint assumes that 
you want to maintain the old background color as a "wash" 
over the new background color. DeluxePaint will keep the old 
background color in place until you clear the painting area. 
Try it now. 

Click the Toolbox icon labeled CLR directly above the Palette. 
This clears the screen of the old background color and re¬ 
places it with the new one. 

Before going any further, let's look at UNDO, one of the most 
important tools in the Toolbox. Clicking UNDO will generally 
"undo" your last painting action. 

^ Click UNDO now to bring back the old background color. 
In V 1 l 

UNDO reverses your last action, provided there has not been an 
intervening mouse click. For example, if you were to click CLR 
twice, UNDO would not reverse the clear command. 

Now that you've seen how to choose colors from the Palette, let's 
use a brush to create our first freeform drawing. 

Select foreground and background colors from the palette. 
Choose contrasting colors, such as blue for the foreground 
and light gray for the background. 

Click CLR to cover your page with the new background color. 

Move the pointer over to the page, where it turns into a cross 
hair with a dot (the brush) in the center of it. 

► Hold down the left mouse button, and draw a small circle on 
the screen. Don't worry about quality for the moment. Fill in 
the circle with the foreground color. Release the mouse button 
to stop painting. 

► Now press the right mouse button and draw’ all over your 
filled-in circle. 

❖ The right mouse button has the effect of erasing your draw¬ 
ing, although w'hat you are really doing is painting over it 
with the background color. This is called erasing to iite bach* 
ground. 
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Reminder 

Picking Colors 
from the Screen 

Keyboard Eqivalents 

Follow this simple rule: use the left mouse button for painting 
with the foreground color, and the right button for painting with 
the background color. This parallels the rule we noted above for 
selecting colors from the Palette: select the foreground color by 
clicking with the left button and the background color by click¬ 
ing with the right button. 

So far you've been selecting your colors by clicking them in the 
Palette. DeluxePaint also lets you select colors directly from the 
screen. This is useful if you are working on fine details, or if you 
are working with many shades of the same basic color. For ex¬ 
ample, if you are painting a rose using eight different shades of 
red, it might be easier to pick the color you need directly from 
the screen rather than choosing it from the Palette. 

^ Click anywhere in the Color Indicator and move the pointer 
back to the screen. The pointer changes to an eye dropper 
cursor. Point to a color on the screen and click either the left 
or the right mouse button to select a new foreground or back¬ 
ground color respectively. 

An even easier way to select a color from the screen is to use a 
keyboard equivalent. Keyboard equivalents are shortcuts for doing 
something you would otherwise do with the mouse. In this case, 
it might be tiresome to click the Color Indicator every time you 
wanted the eye dropper to choose a color from the picture. The 
shortcut is to press the comma (,) key to get the eye dropper, and 
then click a color. By using the keyboard equivalent, you never 
have to move the cursor from your picture. 

Practice painting with the mouse for a while and try selecting 
colors from the screen. Remember, you can always click UNDO 
to reverse your last action, or CLR to clear the screen and start 
afresh. As soon as you're ready, move on to the next section, 
where we will be examining DeluxePaint's collection of brushes 
and tools. 
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Toolbox 

Dotted Freehand 

Straight Line 

Fill Tool 
Unfilled/Filled Rectangle 

Unfilled/Filled Ellipse 

Brush Selector 

Grid 

Magnify 

Undo 

Current Background Color — 

Continuous Freehand 

Curve 

Airbrush 

Unfilled/Filled Circle 

Unfilled/Filled Polygon 

Text 

Symmetry 

Zoom 

Clear 

~~ Current Foreground Color 

Figure 2.5 Toolbox 

Built-in Brushes So far you've been painting with the single pixel brush that's se¬ 
lected when ^you start the program. It is the default brush. Pixel is 
short for the smallest unit you can see 

on the screJ|®®;iif2#l 

The DeluxePaint 
round ones, four 
separate pixels. 

fiftjrajs ten built-in brushes: four 
two made up of a number of 

► To select a brush, move the pointer over the desired 
g^^hape and click. 

mm 
wkm 

treking a brush shape highlights it to indicate that it is the cur¬ 
rently selected brush. As you'll see below, this convention ap¬ 
plies to all the other tools in the Toolbox. 

❖ You can enlarge or reduce the size of the current brush with¬ 
out continually returning to the Toolbox. Press the equals (=) 
key to increase the size of the brush. Press the minus (-) key to 
reduce the size of the brush. 

Another way to size your built-in brush is to click on it in the 
Toolbox with the right mouse button. This gives you a SIZE 
cursor With the cursor on the page, hold down the left 
mouse button and drag the mouse to size the brush. When 
your release the mouse button, your brush is the new size. 

^ With your new brush selected, paint as before, using the left 
button to draw with the brush color and the right button to 
draw (or erase) with the background color. 
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In the next section we will be looking at the other drawing tools 
and seeing how they interact with the brushes. 

The Painting Tools The ten icons below the built-in brushes (in two columns of five) 
control the painting tools. Because any brush can operate with 
any given painting tool, you have a wide variety of combinations 
at your fingertips. 

It's a Rule To select a painting tool, click on it. 

We'll describe the tools in order, moving left to right and top to 
bottom: 

□ The Dotted Freehand tool allows fast freehand drawing. No mat¬ 
ter how fast you draw, this tool keeps up with you, making it 
ideal for sketching out a shape quickly before concentrating on 
the intricate details. Note, however, that the faster you go, the 
bigger the gaps in your drawing. Once you have roughed out a 
shape, you can refine your image using some of the other tools 
at your disposal. Try drawing w'ith it using some of the other 
brushes to get a feeling for how it works. 

HI The Continuous Freehand/Freehand Shape tool paints unbroken 
lines, but it doesn't keep up with you if you draw fast. It's better 
suited than the Dotted Freehand tool for slower, more precise 
drawing. 

Try the Continuous Freehand tool with different brushes and 
see how brush size affects speed. The smaller the brush, the 
better it is at keeping up with your painting strokes. 

Notice that the Continuous Freehand tool icon has a diagonal 
line running from its top right to its bottom left corner. This is 
because it is actually two tools in one — the top left one draws 
unbroken freehand lines, wrhile the one at bottom right creates 
freehand shapes filled with the current foreground or back¬ 
ground color. 

To create a filled shape: 

Click the lower right part of the Continuous Freehand tool 
and paint any shape. 

When you release the mouse button, the shape you painted is 
filled with either the foreground or background color, depending 
on which mouse button you pressed when you painted the 
shape. If you release the mouse button before you close the 
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shape, DeluxePaint closes the shape for you wi 
from your cursor position to where you began 

The Straight Line tool lets you draw straight lines of an 
and angle just by dragging the mouse. 

Select the Straight Line tool, and then move the cross hair to 
the point on the page where you want the line to begin. 

^ Nowr hold down the left mouse! >r the line at 
that point, and, drag the mouse to the.M|^%'here you want 
t he 1 i ne to end. ^ 

When you release the button, you have a straight line in your 
selected brush color and brush sise. You can alsq^p^traight 
lines w ith the background color by using the button. 

~-siFS£s:zj? 

The Curve tool draws a curved line between two points on the 
painting area. It works just like the Straight Line tool except that 
it requires an additional mouse click to complete the shape. 

► Select the Curve tool and move the cursor to the painting 
area. 

► At the spot where you want to begin the curve, press the 
mouse button to anchor the shaj|e/This is the first endpoint. 

► Drag the line to the point whe^^^want the curve|^||jp 
(the second endpoint), and rel^^^^ button. 

► Slowly move the cursor away from the endpoints. 

Figure 2.6 Painting Curves 

You'll notice that the line is still "active/' and forms an arc 
between the endpoints. The line will curve to follow the cross 
hair wherever you move it. 
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► When the curve is the shape you want, click to freeze it at 
that position. 

With a little practice, you'll be able to make curves of any shape 
and size, giving you much more flexibility than any collection of 
plastic templates with their limited selection of shapes 
Try joining a series of curves to make flowing shapes wi^v^f 
changes in curve direction. 

The Fill tool fills any enclosed shape with the current foreground 
or background color. 

Select the Continuous Freehand Shape tool. 

Draw an enclosed shape, a circle for example, with the largest 
round built-in brush. 

^ Select the Fill tool, and move the cursor (which now looks 
like a paint can) to the enclosed shape. Click to fill the shape. 

You can fill with the current foreground color by clicking the left 
button, or with the current background color by clicking the 
right button. 

❖ The Fill tool fills all the way to the boundaries of an enclosed 
shape. If the shape is not completely enclosed, the paint will 
leak out and fill the entire page. If this ever happens, you can 
stop the filling process by pressing the space bar. This aborts 
the current Fill command and returns the screen to its pre¬ 
command state. 

Figure 2.7 
The activation point 
on the Fill Tool 

The paint can spout, the so-called activation point, is the small 
(one pixel) gap at the base of the Fill cursor. You must put this 
part of the tool inside the enclosed shape before you click to fill 
With careful maneuvering, you can fill a space as small as one 
pixel, so long as the point coincides with that space. 

DeluxePaint has a full-featured airbrush with adjustable tips and 
nozzles. By using the Airbrush in combination with the different 
brushes, you can create a variety of effects, ranging from a fine 
one-pixel spray to a coarseUpfay made with the big brushes. In 
the following chapter we will see how to adjust the width of the 
spray, but for now let's try it as is. 
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► Select th^^pifer^sh and try painting with it using 
brushes. 

Try it with the three- and five-pixel brushes, and then try it with 
the big brushes. Note that, just like a regular airbrush, if you 
press down on the mouse button without moving the mouse, the 
paint continues to build up in one spot. 

II The Rectangle tool lets you draw squares or rectangles, either 
unfilled or filled with the current brush or background color. 
Like the Continuous Freehand tool, the Rectangle tool has a di¬ 
agonal line running from its top right to its bottom left corner. 
Let's try making a few rectangles. 

► Click the top left half of the icon. Move the pointer onto the 
painting area, where it changes into a large crosshair. 

► Hold down the left mouse button to anchor one of the corners 
of the rectangle, and drag the mouse away from the anchor 
point. 

You can drag the mouse down and to the right (in which case the 
first button press anchors the rectangle's top left corner), or in 
any other direction you wish. In any case, the rectangle is com¬ 
pleted as soon as you release the button. Note that it is unfilled 
and bordered by the current foreground color. You can also cre¬ 
ate an unfilled rectangle bordered by the background color by 
using the right mouse button. 

To create a filled rectangle, click ihe l.6wer right part of the 
Rectangle icon and repeat the procedure above. 

This time, the rectangles you create will be filled with either the 
foreground or the background color, depending on whether you 
pressed the left or right mouse button. 

Making Squares 

If you hold down the Shift key as you draw with the Rectangle 
tool, you can constrain the rectangle so that its height and width 
are equal. 

Because the Amiga's pixels are not perfectly square, "con¬ 
strained" rectangles will not appear square on the screen. You 
can compensate for this at the printing^^^ or by selecting 
Be Square from the Prefs menu. 
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* The Circle tool works like the Rectangle tool. Select the top left 
part of the icon to get an unfilled shape; select the bottom right to 
get a filled shape. Whether your circle is drawn in the fore¬ 
ground or background color depends on which mouse button 
you press down while you draw. 

Circles are painted from the center outward, so it's easy to put a 
circle around anything just by starting to paint from where you 
want the center of the circle. 

[^| The Ellipse tool works just like the Circle tool, except that the 
shape is still "active" after you release the mouse button. 

^ Select the Ellipse tool. Remember, top left for unfilled, and 
bottom right for filled shapes! 

^ Move the pointer to the painting area, and draw an ellipse by 
dragging the mouse. Release the button. 

Slowly move the mouse. Even though you have released the 
button, the ellipse continues to change shape as you move the 
mouse. 

► When your ellipse is the shape and size you want, press 
down the mouse button and hold it there. 

Now you can rotate your ellipse until it has just the right tilt. 

► Drag your cursor around the ellipse and watch your shape 
rotate. When it is in just the right position, release the mouse 
button. The menu bar displays the angle of rotation. 

Figure 2.8 Rotated Ellipse 
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When you complete your ellipse, the small cross hair changes 
into the large cross hair to let you know that DeluxePaint is 
ready for the next ellipse. 

Anything Can 
Be a Brush 

The Polygon tool lets you keep drawing straight lines until you 
have created a closed figure. Like the Rectangle, Circle, and El¬ 
lipse, the Polygon tool can create both filled and unfilled shapes 
Here's how it works. 

^ Select the Polygon tool. 

Move the cross hair into the painting area and click once to 
anchor the starting point of your polygon. 

^ Drag out a line, and click a second time to complete the first 
line, as if you were using the Straight Line tool. 

You'll notice that your cross hair is still connected to the first line 
by a second straight line. 

^ Click again to finish that line, and so on until you have cre¬ 
ated your shape. 

To complete the polygon: 

^ Move the cross hair to your starting point, and click. 

If you are creating a filled polygon, it will be filled with the 
current foreground color. If you right-click on the starting 
point, you'll fill with the current background color. 

Tip Because it can sometimes be a little tricky to end up on the exact 
pixel you started with, you can complete a filled polygon at any 
time by pressing the space bar. This automatically connects the 
last anchored point to the point of origin and fills it with the cur¬ 
rent foreground color. Pressing the space bar while drawing an 
unfilled polygon releases the cross hair from the line without 
completing the shape. 

Use the filled Polygon tool to$j 

The Brush Selector is a special to<d 
DeluxePaint's versatility. With thrill 
a brush — any piece of artwork or text you put on the; 

► Select the Brush Selector, and move the cursor over 

painting area. 

Your cursor is now a large cross hair that reaches to the edges of 
the screen. Let's make one of the filled stars you drew with the 
Polygon tool into a brush. 
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► Put the center of the cross hair to the upper left of the star. 
Drag the cursor to the lower right of the star, as if you were 
using the Rectangle tool to enclose the star in a box. Release 
the mouse button. 

When you release the mouse button, the cursor has a copy of the 
star attached to it. This star is your new brush! 

^ To stamp a star in a new location, simply click. There's no 
need to stop with one — go ahead and star-spangle the 
screen. 

❖ If any parts of your brush consist of the current background 
color, those parts will be transparent. In other words, when¬ 
ever you pick up a brush, it's as if you are picking up only the 
non-background colors; any background colors in the brush 
wilt regain invisible even after you change to a new back¬ 
ground color. This means that you can create brushes with in¬ 
tricate outlines without fear of picking up a rectangle of the 
surrounding background color. 

Let's try one more trick. 

Click the Brush Selector again and select a star from the 
painting area. But this time use the right mouse button to 
drag the cross hair over the star. 

Unlike the last exercise, which yielded two stars — one unmov¬ 
ing original, plus the one on your brush — this time you are 
picking up and moving just the one star. While the first feature 
lets you copy and move anything on the screen, the second lets 
you move images from one part of the screen to another, while 
leaving no trace behind. 

DeluxePaint's text editor lets you place text anywhere on the 
p^e^and the Brush Selector lets you pick it up and reposition it 

don't get it quite right the first time. 

■piWtfer text on the page: 

the Text tool. 

^ Move the cursor to the page. The pointer turns into the text 
cursor. 

* Click where you want to begin a line of text. 

^ Type on the keyboard. 

The text will automatically "wrap" around to the next line 
when it reaches the end of the line. 
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Changing Colors 

♦> You can delete text by pressing the backspace key, as long as 
you HAVE NOT clicked elsewhere on the screen. When you 
click elsewhere (the Toolbox for example), text becomes a bit¬ 
mapped image, and can no longer be edited as text. 

You can change the color of your text as often as you like by 
choosing a different foreground color from the Palette. 

a 

► Select a round color and type some more. 

To leave th^K^Sode, click on another tool, or press ESC. 

You'll learn how to use the Choose Font Requester to select 
different fonts, type sizes, and type styles in:th$ next chapter. 
Guided lour (2). See the section Modifyi}i$ l*jph. 

The Grid lets you apply paint on the page in accordance with an 
invisible grid and restricts your painting tools to the grid points. 

tf you need some room to work, click CLR. 

► Select the Grid, and then click the Dotted Freehand tool. Now 
^paint on the screen. 

W&h Grid and the Dotted Freehand tool selected, ypq c$p paijjt 
only on the points of the grid, making it easy 
with a polka-dot pattern (we'll see other methods 

design later). ‘‘‘W- vitf'toV, 
'11 ' ".Mill, 

'J | •Jb.’iMV.A, 1 
You'll learn how to adjust the spacing between ti$$ _ 
the next chapter. Guided Tour (2). See the section Mocfiji 

rm in 
> M .yj . 

\/mg loots. 

The Symmetry tool lets you paint symmetrically over the entire 
page at the same time. 

Click the Symmetry tool. [If the Grid is selected from the pre¬ 
vious exercise, turn it off]. Use the Dotted Freehand tool to 
paint whatever you like. 

Your brush now consists of a number of mirror images of itself. 
As you move the brush around, all the mirror images move as 
well, producing an effect much like that of a kaleidoscope. When 
you paint, you are laying down a number of identical mirror 
images about a fixed origin. With all tools except the Dotted and 
Continuous Freehand tools and the Airbrush tool, the mirror 
images are drawn after you release the mouse button. With the 
Dotted and Continuous Freehand tools and the Airbrush tool, 
all the images are drawn at the same time. 
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You'll learn how to customize the Symmetry settings in the next 
chapter. Guided Tour (2). See the section Modifying Tools. 

p You can magnify any section of your work, and view it alongside 
the standard-sized image. To magnify a section of your work: 

► Click the Magnify icon. When you move the cursor onto the 
page, it becomes a rectangular outline. 

► Move the outline to thqpajft of the injage you want to mag¬ 
nify, and click. 

Figure 2.9 Magnified image 

The part of the image included in the rectangle ijgjgggpears 
magnified on the right part of the screen. You tool to 
perform any function on either side of the screen' You'can scroll 
around your image using the four arrow keys; this moves the im¬ 
age around under the "magnifying glass " In addition, by point¬ 
ing your cursor anywhere #&jtfe;'jjinmagnified portion of the 
screen and pressing n, you^^^i^gnify that part of the picture. 

Once you have magnified a part of your picture, you can in¬ 
crease or decrease the amount of magnification by clicking the 
Zoom tool. 

Click the Zoom icon to increase the magnification. Right-click 
the icon to reduce the magnification. 

DeluxePaint's Magnify and Zoom tools let you carry out preci¬ 
sion work on your pictures by magnifying each pixel up to 400 
times its original size. 

To quit magnify mode, click the Magnify icon a second time. 
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Toolbox Summary This completes our brief review of DeluxePaint's versatile range 
of tools. You'll find additional and more detailed information 
about every tool scattered throughout the manual, and gathered 
in Reference. 

Before we continue our tour of DeluxePaint IV in the next chap¬ 
ter, Guided Tour (2), take a moment to learn how to save your 
artwork. 

Saving Your Work 

^ Press and hold down the right mouse button. This exposes 
the Menu Bar and extends the Picture menu. 

^ Select Save. 

The Save Picture requester appears. 

It's important to learn how to save the pictures (or "files") you 
create. We'll begin by saving whatever you drew in the preced¬ 
ing sections* 

^ Mavefee pointer up to the far left side of the Title Bar. 

Save Picture 
NewTut.Han 
Orisra ni Birds. Ha n 
PatternSet.LoRes 
Ref erencePalette.LoRes 
Seascape.LoRes 
StencilSet.LoRes 
Venus. LoRes 
MonldMap.LoRes_ 

n 
±1 

Drawer 
Pa ttern 
File lEB CilEBM s 

Disks | Assigns Parent 

Save Cancel 

Figure 2.10 Save 

Notice that this reqj^^ii^^^e Load Picture requester in 
almost every respecjy j£^ Save Picture requester to pro¬ 
vide DeluxePaint with the information it needs to save your files 
in its proper classification. The Drawer edit box tells DeluxePaint 
which drawer to save the file in. By using drawers to classify 
your pictures, you can keep related images together, in the same 
way you keep related papers together in one file folder. For ex¬ 
ample, the setting might be DF1: lo-res, which means that the 
drawer exists on a disk in your second disk drive ("DF1") and 
that the drawer is named "lo-res." 
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The File edit box is where you enter the name of your picture the 
first time you save it. 

If you want to save your current creation, this is your chance to 
do so. 

► Insert a blank, formatted disk in any drive, for example, DFl. 

► Click the Disks button. The name of the drive that contains 
the blank disk should appear in the window (<DEV> DFl:). 

► Click on the disk name in the window. In our example DFl: 
appears in the Drawer edit box. 

^ Click anywhere in the File edit box and type in a name for 
your new file. 

► Click Save. 

The disk drive will spin for a few moments; when the red light 
goes out, the file is saved. 

The next time you save this file (it's a good idea to save work in 
progress every 15 minutes or so, so that a power failure or other 
breakdown doesn't turn hours of work into a bitter memory), the 
Save Requester uses this same information, which means you 
won't need to type anything more unless you want to change the 
file name. You might want to do this to save it under another 
name, if you want to save each version as a separate file. In that 
case, you would click the File edit box as before, backspace over 
the old file name (or over those parts you wish to change) and 
type in the new name. Or you could just keep adding suffixes, 
such as 1, 2, 3, etc., to signify succeeding versions. 

You can specify drawer names in the same w'ay: click in the 
Drawer edit box, backspace over the old name, and type in the 
new' name. You can open any drawer already on the disk, but 
you cannot create one from the Save Requester. See your Amiga 
User Guide for information on creating new drawers. 

For more information on all the options available from the Load 
and Save requesters, see Reference. 

Right now you might want to taken break. When you're ready, move on 
to the next chapter, Guided Tour (2), where you'll learn how to modify 
tools and work with many other powerful features of DeluxePaint. 
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This chapter continues^ DeluxePaint's painting tools. 
It concentrates on t%;^f<^^Tt^ophisticated editing tools, 
describes tool modthe Anim menu, and intro¬ 
duces several painting techniques using simple 
instructions. 

•_ 

If you are a relative newcomer to computer j 
recommend that you work through this chapter^ 
to end. If you have some experience with computer grapFucs- 
software, you can probably become familiar with this material 
quickly You can use this chapter to learn how DeluxePaint 
handles features you have encountered in other programs. Feel 
free to skip around and read only those sections that interest you 
at the time. 

When you are comfortable with the program, turn to Chapter 4, 
Painting Tutorials, to learn how the program creates and 
handles color, or Chapter 5, Working with Perspective, to learn 
more about DeluxePaint's graphic power. If you go off on your 
own, use Chapter 8, Reference, to answer any questions that 
might come up. 

In this part of the Guided Tour you'll learn how to: 

Create and edit custom brushes 

□ Manipulate the variety of program screen formats 

Modify tool functionality and operation 

Mix and cycle colors from the Palette 

r: Use keyboard equivalents with the mouse button down. 

Use the various painting modes 

Control AnimBrushes and Animpainting 

To complete the examples in this section, you'll need your work¬ 
ing copies of the DeluxePaint Program, and both Art disks. If 
you want to save your work, you'll need an initialized disk with 
a fair amount of available space for saving large files. 

❖ The step-by-step instructions in the tour assume that you are 
using DeluxePaint on a floppy system. If you have installed 
all three DeluxePaint disks on your hard drive, you won't have 
to insert your copies of the DeluxePaint disks when we request 
them. 

^ Start DeluxePaint and use the default screen format settings. 
If you already have the program running, we recommend 
that you restart so that the tools and option settings are all 
set to their defaults. 
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Custom Brushes As we saw in Guided Tour(l), DeluxePaint's '"anything can be a 
brush" feature lets you select any image on the screen and define 
it as a brush. If you wish, you can keep a selection of brush im- ^ 
ages on the spare page (see Spare in the Picture menu) and md*$f 
them over to the main page by picking them up as brushes. Or i 
you can have one spare custom brush in RAM (see the Spare m 
option in the Brush menu). In addition, you can load and save:^:^^: 
brushes as though they were pictures. ^ ^ 

Here's a reminder of how to create a brush out of an on-screen 
image: 

► Select the Brush Selector. 

^ Move the cursor to the painting area. The cursor becomes a 
large crqsgi^ 

■V, 
► Drag th(|0|^|\air to form a rectangle around the image you 

want to When you release the mouse button, an ex¬ 
act copy of the image is attached to your cursor. 

Remember! When you drag the Brush Selector with the left buttoivJield 
down, DeluxePaint makes a duplicate of the image and attaches 
it to the cursor, while leaving the original image in place on the 
page. If you use the right mouse button to surround the image, 
the image itself becomes the brush, as if the original image had 
been lifted up off the page. This technique provides an ideal 
method for picking up objects and moving them around the page 
as you experiment with different compositions. See also Fixing 
the Background, below^ 

Paint with your new brush qf use ijjo cffeat£ fflled or unfilled 
shapes, just as you would with any of tfte built-in brushes. 

Creating a 
Rectangular Brush 

Creating a Brush with 
an Irregular Shape 

Though it's often convenient, youdorft^av? to create a rectan¬ 
gular brush. DeluxePaint k*jts yoijtyou corjakany image, so you 
can pick up shapes fr^hfl el "c^owde^lbackground, and make a 
brush in any shape you wi^h. £?o^ to corral an image: 

^ If the Brush Selectoiiicon is highlighted, click it again. If it is 
not selected, double-click it. 

The Brush Selector icon changes to a polygon shape to show 
that the polygon brush selector is active. 

► Click around the shape you wish to define, just as if you were 
making a polygon with the Polygon tool. 
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Transparent Color 

As soon as you complete the polygon, the complex shape 
becomes your new brush. 

❖ The left button-right button convention works here, too. 
Corralling the shape with the left button duplicates the shape, 
while corralling with the right button lifts the shape off the 
background. As with the Polygon tool, pressing the space bar 
completes the polygon for you, so you don't have to search 
for the starting pixel in order to complete it. 

When you pick up a custom brush, some parts of your brush 
may be transparent. There are two rules for determining which 
color is transparent: 

If AutoTransp in the Prefs menu is turned off (the default set¬ 
ting), or if any one corner of the brush is a different color 
from the others, the current background color is transparent. 

If AutoTransp is turned on and every corner of your brush is 
the same color, that color is transparent. 

Let's see how these two rules work in practice with a couple of 
brief examples. 

► To set up for our example, click black in your palette with the 
right mouse button to make it the background color, and click 
CLR to clear your screen. 

► Use the Dotted Freehand tool to scrawl randomly over the 
screen using several different colors. 

Figure 3.1 Figure in Progress 
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The Background 

Color Is Transparent 

The Corner Color 

Is Transparent 

Changing the 

Transparent Color 

Now you should have a black screen, because black is your 

background color, with several colors scrawled over it (see 

Figure 3.1). 

^ Click the Brush Selector icon, and move the cross hair to the 

painting area. 

^ Select a rectangular area that contains some black. 

When you release the mouse button, the black areas of your 

brush are transparent because black was the background color 

when you selected the brush. Move the brush around to confirm 

this: the painting shows through the areas where there used to be 

black. Any parts of the brush that consisted of background color 

when the brush was first created remain transparent, even after 

you change background colors. But if you want to change the 

transparent color, you can do that, too. We'll show you how in a 

moment. 

Now let's see what happens when you select an area with all 

corners the same color. 

^ Move the pointer to the far right of the Title Bar, and press the 

right mouse button. 

The Menu Bar appears and the Prefs menu extends down. 

^ Choose the AutoTransp option. Display the menu a second 

time to confirm that AutoTransp now has an check (a/) beside 

it. This means that it's turned on. 

^ Double-click the Brush Selector icon to activate the polygonal 

brush selector. 

^ Select an area of any shape. Make sure that you always click 

on the same color, but not on black (since this is the back¬ 

ground color and won't illustrate what we want to see). 

This creates a brush in which the color you clicked on is trans¬ 

parent because AutoTransp is turned on, and all corners of your 

brush are the same color. 

We used the polygonal Brush Selector for our example, but the 

AutoTransp option is especially useful for picking up a shape 

from any solid background without having to change the current 

background color. 

You can change which color in your brush is transparent by 

choosing a new background color and then choosing Brush> 
Change Transparency from the Color menu. Let's try a quick 

example. 
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A Brush Is a 
Little Picture 

^ Click the Brush Selector and select a rectangular area that 

contains some of the current background color so that your 

brush has some transparent areas. 

^ Choose a new background color by clicking on a color in the 

Palette with the right mouse button. 

Notice that simply changing the current background color does 

not change the transparent areas of your brush. You accomplish 

that with the next command. 

^ Choose Brush>Change Transparency from the Color menu. 

The transparent areas of your brush change from the areas of the 

original background color to the areas of the current background 

color. You can do this as many times as you like to change trans¬ 

parent areas. 

From the Brush menu you can treat brushes just like full pic¬ 

tures. You can Load and Save them just as you can other pic¬ 

tures. When you load a saved brush, it comes equipped with its 

own palette and ranges, the ones that were in effect when the 

brush was first saved. If the current picture is using a palette dif¬ 

ferent from that of the newly-loaded brush, you can change the 

current palette to the brush's palette by selecting Palette>Use 
Brush Palette from the Color menu. On the other hand, if you 

want to use the newly-loaded brush with the current palette, 

select Brush>Remap from the Color menu. 

Other options in the Brush and Color menus let you resize, 

reshape, and recolor brushes in various ways. 

Your DeluxePaint Art disk contains a number of saved brushes. 

Let's load one now just to see how it works: 

^ Insert the Art disk into any drive. Select Load from the Brush 

menu. Click <VOL> Art: in the Save Brush requester. 

^ Click <DIR> Brush. The Drawer edit box reads Art:Brush. 

^ Double-click Bobsled and the file will load automatically 

^ The Bobsled brush is attached to your cursor, but its colors 

are not correct. 

^ Choose Palette>Use Brush Palette from the Color menu. 

Select the Continuous Freehand tool and paint with the 

brush. 

47 Guided Tour (2) DeluxePaint IV 



Additional Features 

Handle 

Perspective 

Do you see why this brush is called Bobsled? Feel free to experi¬ 

ment with some of the saved brushes. Select Palette>Use Brush 
Palette whenever you load a brush to ensure that you are seeing 

it as it was when it was saved. 

❖ If you would like to see color cycling in action, load the brush 

called Fireworks. 

1. Select MultiCycle from the Prefs menu. 

2. Select Cycle from the Mode menu. 

3. Select Palette>Use Brush Palette and then press the Tab key 

before you start drawing with it. 

"Fireworks" comes complete with color cycling information, 

and is a spectacular example of the power of this feature. See 

Tutorial Tiuo: Working With Ranges in the next chapter for more 

demonstrations of color cycling. 

The following are some additional features relating to custom 

brushes. 

This feature, which is available from the Brush menu, allows you 

to specify where the cursor will sit in your custom brush. In the 

default setting the cursor sits at the center of the custom brush. 

When you select Handle>Corner, the brush handle moves to the 

lower right-hand corner of the brush. Each successive choice of 

the Corner option moves the handle to a different corner. 

Once you have selected Corner, the brush handle attaches itself 

to the ending corner when you enclose a brush. For example, if 

you pick up your brush by dragging downward from left to 

right, the brush handle will attach itself to the lower right-hand 

corner, whereas if you pick up the brush by dragging upward 

from right to left, the handle will attach itself to the top left-hand 

corner. 

The Handle feature is especially important in the perspective 

mode, because you can rotate a brush about its handle, whether 

the handle is at the center or on one of the corners. 

DeluxePaint's Perspective feature (in the Effect menu) lets you 

rotate a brush about any of the three axes of three-dimensional 

space to define a plane of operation, and then work within that 

plane to create perspective effects. Perspective is a big subject to 

cover, so we've provided an entire chapter to cover it. Chapter 5, 

Working with Perspective. If you are interested in 3D painting or 

in 3D animation, be sure to work through Chapters 6 and 7. 
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Fast FB 

DeluxePaint IV Screen 

Hiding the Toolbox 
and the Title Bar 

Pages 

With Fast FB selected (in the Prefs menu), lines, filled shapes, 

and unfilled shapes are drawn with a single pixel line instead of 

the full custom brush until you finish drawing, at which point 

your shape is repainted with the custom brush. Try painting an 

unfilled rectangle with a custom brush both ways to see how 

Fast FB works. 

Some of DeluxePaint's features affect the entire screen, while oth¬ 

ers, such as the tools and the brushes, affect the screen selec¬ 

tively. This section considers those features that have a screen¬ 

wide effect. 

DeluxePaint lets you paint on the entire screen, even under the 

Toolbox and the Title Bar. 

^ To remove these two items from the screen, press the F10 key 

(Make sure your cursor is not in the Menu Bar area, or the 

keyboard commands will have no effect.) This removes them 

both if they are both present. Press F10 a second time to bring 

them back. 

To hide just the Menu Bar (or to bring it back, if it's hidden), 

press F9. 

Note that you can still access the Menu Bar even while it's invis¬ 

ible. 

^ Move the cursor to the top of the screen (except the upper left 

corner) and press the right mouse button to display the Menu 

Bar. You can now select any menu item in the regular fashion. 

You can access the tools as well, even with the Toolbox hidden, 

through the keyboard equivalents. See Appendix B for a com¬ 

plete list of keyboard commands. 

DeluxePaint gives you two separate pages with which to work. 

You could use one of the pages for creating background images, 

and the other for creating foreground images. You could then 

move parts from one page to the other to complete your com¬ 

position. When you are working on a picture, the spare page is 

always the page you are not currently viewing. When you are 

working on an animation, the spare page is identified with the 

word Scratch in the Menu Bar; this page can be larger than the 

screen, even though your animation frames cannot. As we shall 
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Switching Pages 

Page Size 

see in a moment, the spare page is not entirely independent of 

the other page or animation frames. For one thing, they share a 

common Palette, almost as if they were the same picture. 

When you first open a new file or load a picture from disk, 

DeluxePaint opens one of the two pages. 

^ Load any image from the Picture drawer on your copy of the 

DeluxePaint Artl disk. 

^ To move from one page to the other, choose Spare>Swap 
from the Picture menu, or press j on the keyboard to "jump" 

to the other page. 

When you do, you will notice that the Palette from the first page 

follows you to the spare (second) page. This means that if you 

modify the Palette for one page and then switch to the other 

page, you end up modifying the second page's Palette as well. 

Note, however, that although the two pages share the same pal¬ 

ette, you can have a different background color on each page. Be¬ 

cause the background color is transparent, however, (see discus¬ 

sion under Custom Brushes, above) any part of a brush consisting 

of background color will remain transparent even if you move it 

to the spare page with a different background color. 

In addition, because the Toolbox is not really part of the page 

(but actually sits "above" it), whatever tools you had selected 

before you switched will still be selected after you switch pages. 

This way, you can retain the same tool settings, giving you conti¬ 

nuity as you work. Note that this continuity rule does not apply 

to the Fix Background and Stencil commands, which do not carry 

over from one page to the other. See the following section for 

information on fixing the background, and Tutorial Three: The 

World of Stencils in the next chapter for exercises involving the 

Fix Background and Stencil features. 

DeluxePaint lets you work on page sizes ranging from 320 pixels 

wide by 200 pixels high, to 1008 pixels by 1008 pixels, depending 

on memory availability. Note, however, that your page size can 

never be smaller than the current screen resolution. For ex¬ 

ample, if you are using HiRes 640x400 screen format, your page 

cannot be smaller than 640x400. In addition to the three preset 

page sizes (Standard; Full Page; Overscan), DeluxePaint lets you 

specify any height and width through the Set Page Size re¬ 

quester. To display this requester, choose Page Size from the 

Picture menu. 
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Scrolling the Page 

Screen Resolutions 

Set P< a 

Type in size: 
Pi- 

Width: liHJHI Height: 

On select one: 

I 320 x 200 

Full Pa£re J 320 x 340 

Overscan J 368 x 241 

Cancel | Ok 

Figure 3.2 Set Page Size requester 

If you are working on a page size larger than the screen, you can 
preview the entire page at any time by selecting the Show Pa 
command from the Picture menu. Your current work area wilLl, 
appear surrounded by a rectangle. You can move this rectang! 
to work on another area by holding down the left mouse butt 
dragging the rectangle, and releasing the mouse button when 
area you want to paint is enclosed. You can return to your cui*> 
rent page without moving the rectangle by pressing the space 
bar. 

If you are working on a page that is larger than the screen, you 
can also scroll the page with the arrow keys on the keyboard. 
Think of them as moving the screen rather than the picture; 
pressing the down arrow moves the screen down, so it looks like 
the page is moving up. To scroll the page in screen size incre¬ 
ments, hold down the Alt key and press the arrow keys. 

A more efficient way to scroll the page is to place your cursor 
over the area you want to move and press the n key. If the page 
can scroll that far, the area under your cursor will be centered in 
the screen. If the page isn't big enough to center the area, it will 
move as far as possible. 

DeluxePaint supports four different screen resolutions. You can 
switch from one to another even during a single work session, 
but be aware that changing formats in the middle of a job can re¬ 
sult in loss of information (such as your current brush, the spare 
page, the last requester used, etc ). It's important to save your work 
before changing screen formats. 

You should develop the habit of saving your work every 15 or 
20 minutes in any case, but it becomes especially important to 
do so if you are, e formats. 
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As we noted in Guided Tour (1), you're asked to select a screen 
format each time you start DeluxePaint, through the Choose 
Scte^S^^^j^ester. In addition, you can display the Choose 
Sfte^^^^^^pester at any time by selecting Screen Format 

Each screen format has its own limita- 
‘teaj^^^l^P^-equirements. 

jse Screen Fornat 

F ornat 

Hed-Res 640x200 

Co I or*s : 

Palette 

Color Mixer 

Figure 3.3 Choose Screer\ Forgvit requester 

This section introd^o^ovj r< 
learn about the colc^eqyA'fe 
in the next chapter 
ertce section (see PaJeMpi ih< 

pw Palette. You can 
; tlffiugh the tutorials 
at parts of the Refer- 

The Color Mixer lets [paj set of colors from 
ft\tniVw5V t>HOP&£olors. You can^l|^ors using either the 

Blue) or HSV (ration. Value) color 
THe/UJXhber of colors yo§^W-work with at any one 

4 ,tirr4{ Is. d$j^de$.on the screen format and number of colors you 
Format requester 

> ,K3^ip!w the.<^olor Mixer, choose Palette>Mixer On from 
or right-click the Color Indicator 
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Arranging C&M0T] 
in the Palette 

Creating Spreads 

Defining Ranges 

COPY EX .PREAD PICK DELETE 

Figure 3.4 Color Mixer 

■ M 1 \ | | 

□ 1 
REVERT 1 UNDO | OKI 

You can quickly modify the currently selected color on any of the 
three variables (RGB or HSV) by dragging the appropriate sliders 
left or right. 

EX (for "Exchange") and COPY let you swap or copy colors from 
one part of the Palette to another. 

EXJ To exchange the position of two colors: Click a 
and then click a second color. The two colors exic^fij^^i|0vbn 
the Palette. 

C0F>XJ To copy a color ovp^e^her: Click a color, click-;^^?^P^0^ a 
second color. This S<cp^iSthe first color into the 

These two functions make it easier to create the color spreads for 
your work. 

The Palette Requester lets you create color spreads to give you 
subtle shades of the same hue or equally spaced gradations 
across hues. 

spread ^ To create a spread of colors, click the first color for your 
spread, click SPREAD, and then click the last color for the 
spread. 

DeluxePaint looks at the first and last colors in the spread and at 
the number of steps in between, and then calculates the series of 
intervening shades. For example, if your first color is blue and 
your last color is yellow, DeluxePaint calculates the intervening 
shades and hues, to give you a series of blues, blue-greens, 
greens, yellow-greens, and yellows. Unlike traditional color 
mixing, if your modifications are not to your satisfaction, you 
can always reverse the last change by clicking UNDO, or you 
can cancel all the changes you made by clicking Revert. 

Good color ranges are important for effective Color Cycling, 
Gradient Fill, and some Painting Modes. Color Cycling and Gra¬ 
dient Fill are treated in the Tutorial Two: Working with Ranges in 
Chapter Four, and you'll find information about Painting Modes 
later in this chapter and in the Reference. Right now, well take 
just a quick look at where to define ranges. 
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Palette and 
Screen Formats 

You can define up to eight color ranges of 32 colors each and 
assign a cycling speed (RATE) to each range. 

^ Choose Ranges from the Color menu. The Range requester 
replaces the Palette at the bottom of the screen. 

Figure 3.5 Range requester 

The Range requester lets you put colors from your palette along 
a bar to define a range. This flexible way of defining ranges lets 
you place the colors in different orders from how they appear in 
the palette. Also, it is now easier to use the same color in more 
than one range. You'll learn how to use this requester in the next 
chapter. 

DeluxePaint contains a universe of 4096 colors. The maximum 
number of colors available in each format is listed below. The 
number of colors you can have at any time depends on available 
memory; if your page is large or you have a large brush, you 
may not be able to choose the maximum number of colors. 

Lo-Res 32 c|^^^standard LoRes (64 if your computer 
sup|pf||:j|||tra Halfbrite; 4096 in the special 
HA 

Med-Res 16 colors 

Interlace 32 colors in standard L<M?es (64 if your computer 
supports Extra HaiPorite; 4096 m the special 
HAM mode) 

Hi-Res 16 colors 

See the Reference for general information on the various screen 
formats. Appendix D, Amiga Display Modes, gives a technical 
explanation of the relationship between screen formats and the 

j^^>er of colors available. See also Appendix A, Memory 
%ement, for more information on memory usage. 
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Modifying Tools You've already learned that you can activate any tool by clicking 
its icon in the Toolbox. A tool remains active until you select an¬ 
other tool or, in some cases, deselect it by clicking the icon a sec¬ 
ond time. Examples of the latter kind of tool are the Grid and the 
Symmetry and Magnify tools, which are toggled on and off by 
each mouse click. 

Built-in Brushes 

Airbmsh 

In most cases, right-clicking a tool icon lets you modify some 
fundamental aspect of that tool. The following summarizes the 
effects of right-button mouse clicks on the tools in the Toolbox: 

You can change the size of any of the built-in brushes in the 
Toolbox. 

Right-click the brush. 

Move the cursor over to the painting area. The word SIZE is 
attached to the cursor. 

Hold down either mouse button and drag diagonally to 
adjust the size of the brush. 

You can adjust the Airbrush's nozzle by right-clicking the 
Airbrush icon. 

^ Right-click the Airbrush icon. 

Move the cursor over to the painting area. The word SIZE is 
attached to the cursor. 

► Hold down either mouse button and drag diagonally to ad¬ 
just the size of the solid circle, which represents the spray 
area. 

Straight Line, 
Curve, and 
Unfilled Shape 
Tools 

□□ A right-click on any of these tools brings up the Spacing re¬ 
quester. 

Spacing 

N Total | 

Every Nth dot 

Airbrush 

Continuous 

Cancel Ok 

Figure 3.6 Spacing requester 
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The Spacing requester lets you control the distance between 
"splats" in your lines. This lets you choose whether a line is 
continuous or dotted. If you want a dotted line, you can define 
the line in terms of the total number of dots (N Total) or by the 
number of pixels between dots (Every Nth dot). 

Choose Airbrush to use the Airbrush tool with any of the tools 
that uses the Spacing requester. This is especially useful for 
smooth airbrushed curves and circles. 

Figure 3.7 Circle drawn with different settings in the Spacing requester 

Right-clicking any of these icons brings up the Fill Type re¬ 
quester. 

Fill Type 

Brush | 

Perspective | 

Wrap 

Pattern 

Fron brush 

Range : <-» I t I Eg 

Line | Shap | Cir | Con | Hi 

Dither: 

Randon 

Cancel | Ok 
Figure 3.8 
Fill Type requester 

This requester lets you choose one of several fill types for your 
fills and filled shapes. Many features of the Fill Type Requester 
are covered in Tutorials Tiuo: Working with Ranges and in the 
Reference section. 
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Brush Selector 

Text Tool 

m 
mi 
n 
m 
#■ 

ED Right-clicking the Brush Selector restores the last custom brush. 
Thus, if you had created a custom brush (see Custom Brushes in 
this chapter for details) and then made some modifications, 
right-clicking the Selector would restore you to the pre¬ 
vious custom brush. Thfefeature is also useful if you create a 
custom brush and theft select a built-in brush. Right-clicking the 
Brush Selector restores the custom brush. 

Right-clicking the Text tool displays the Choose Font requester. 
You use this requester to choose fonts and styles for the Text tool 
to use. 

Choose Font 

sapphire 
swiss 
Tmes 

Zack 

Bold | Italic | Underline | 

Cancel Ok 

Figure 3. 9 Choose Font requester 

► To select a different type font, size, and/or style, display the 
Choose Font requester. 

► Click a font from the window. Choose from the available font 
sizes by clicking on the up and down arrows beside Size:. 
Click any of the Style buttons (Bold, Italic, Underline), to 
apply any font style you want. When you have everything 
you want, click Show to see the font, size and style you have 
chosen. If you like the results, click 

A special feature of the Choose Font requ^^^the ability to 
load fonts from a fonts directory on a different disk. In addition, 
your Art disk contains two special colored fonts. To use these 
multi-colored fonts you need to run the ColorText program 
(double-click the ColorText icon on the DeluxePaint IV Program 
disk) before you run DeluxePaint IV. Do that now, before loading 
the fonts from your Art disk. When ColorText is aggy^do the 
following: 

Display the Choose Font requester. Insert the DeluxePaint 
Art! disk in any drive. Click in the Drawer edit field, type 
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artl :karafonts, and press Return. (Jf you are using a one 
drive system, you'll be prompted to swap disks a couple of 
times. Just follow the prompts). 

In a moment, the fonts list from your Artl disk appears in the 
Choose Font requester. Let's use one of the fonts. 

^ Click the font named ChiselScript and click Ok. A message 
asks if you want to use the font's palette. Click Yes. Place your 
text cursor and type away! 

If you want to move your text once it's on the screen, use the 
Brush Selector to pick it up and move it around. If you are add¬ 
ing text to a picture, there are two good tips you should know: If 
you fix titeb^ck^tound before you type the text, you'll be able to 
move file texjt Witjhout messing up your picture Another way to 
do tKift to the Spare page to type your text and then 
pick it i).p fcrbsh to place on your picture. 

Grid and Symmetry Tools Right-clicks on these tool icons let you modify aspects of 
gridding and symmetry. 

You can also control the spacing between the points. 

ffl ► Click on the Grid icon to turn on the grid 

► Use the Dotted Freehand tool to paint in the painting area. 
’I he dots show you the current position of the grid. 

Right-click the Grid icon to bring up the Gridding requester. 
You can now set the spacing for both the X and the Y coordi¬ 
nates in the actual spacing in the calibration boxes. 
The spa^p^^ica lib rated in pixels. 

^ Click in me iC-spacing edit box, delete or backspace to remove 
the existing value, and then type in the new value — try 20. 
Do the same with the Y-spacing. Click OK. 

Figure 3.10 
Gridding requester 

the Dotted Freehand tool to see how 
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You can also recalibrate the griddlng by using a visual method. 

Display the Gridding requester. 

Click Adjust. 

^ You are returned to the page with a cursor that looks like a 
matrix. This matrix represents the current grid values in 
graphic form. To change the values, press and hold down the 
left mouse button, drag th£ mause ipxii the matrix is the de¬ 
sired size and sha£*4, tjH^n button. 

The new grid is bascai hi} tfrfe Yot|^ttJ&|£o reposition the 
points of the grid usm$| Adjr^t: £n$t*-the matrix 60 that its cells 
are in the desired pGj&iJ&ntettdfcl|cfc the|Mt^UUtSn. 

} -A ^ 1" T | ^ L '-| 

If you are in perspective mifde and tngivjt^iii^k the Grid icon, 
the appte&rs, rdsqiieMes lets you set a 
grid {?*$[ you choose other 

VjKirf***g| ujtth Perspective, 
or the description in Reference of the Perspective>Settings 
option in the Effect menu.) 

You can change the settings for the type of symmetry you use by 
right-clicking the Symmetry tool. This brings up the Symmetry 
Requester. 

SyMhetry 

Tile 

Cyclic | 

Order: 

Place | 

Cancel Ok 
Figure 3.11 
Symmetry requester 

You'll find a brief explanation of each of the options in the Sym¬ 
metry requester in Reference. For now, if you feel adventurous, 
try changing the settings and painting with different shapes. 
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Painting Modes The options in the Mode menu control the way your brush ap¬ 
plies paint to the page. In this section, we'll look at a few of the 
modes. Youil find information about all modes in Reference. 

To look at some of these modes, you'll need paint on the screen, 
so let's load a picture. 

^ Load the picture Venus from the Artl disk. 

First let's look at a couple of modes that change paint already on 
the page — these are Smear, Shade, Blend, and Smooth. 

^ Select the largest round built-in brush, the Dotted Freehand 
tool, and Color 0 (black). 

^ Choose Smear from the Mode menu, move the brush to 
Venus' left eye, hold down the left mouse button, and drag 
back and forth across her eye. 

Notice that instead of laying down black paint, your brush 
smears the paint already on the screen. Smear mixes the existing 
pixels rather than changing their colors. 

► Choose Smooth from the Mode menu, hold down the left 
mouse button and drag your brush along the edge of Venus' 
chin. 

Again, the brush uses colors other than black to paint with. 
Smooth reduces the contrast between two adjoining areas by 
painting intermediate shades along the boundary of the two 
areas. Smooth loo|pS|!s^p current palette and finds the colors 
closest to the ones tinder:!he brush. If the palette contains a wide 
selection of colors the ones under the brush, it will have 
more colors to choose from. In our case, there are many colors be 
tween the dark brown of the chin line and the yellows of Venus' 
face, so DeluxePaint does a good job of smoothing the edge (see 
Figure 3.12). 

Some of the painting modes change the way the color^^^pr 
brush are used. In particular Matte and Color determi^ft^fther 
a custom brush will paint with the colors in the brush, 
current foreground color. Let's see how that works. 

^ Click CLR to clear the screen. 

► Choose Load from the Brush menu and load the brush named 
MultiCycleMe from the Brush drawer of your Artl disk. 
Choose PalettoUse Brush Palette from the Color menu. 
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❖ When you load a custom brush, your painting mode is auto¬ 
matically changed to Matte. Matte paints with the colors in 
your custom brush. 

^ Drag the custom brush straight down your page to paint a 
broad stripe of several greenish blues and reds. 

► Click red in the Color Indicator. 

► Now choose Color from the Mode menu and drag the brush 
down again. 

This time your stripe is all one color (red), because Color uses 
the current foreground color and the shape of your custom brush 
to paint. 

Choose Cycle from the Mode menu and drag another stripe. 

Now your brush paints a stripe with bands of color running 
horizontally. Notice that the colors change in the order of the 
colors in your palette. Cycle uses the ranges in the Color Palette 
requester and cycles the colors as it paints. This is a good ex¬ 
ample of where ranges affect the way a painting mode works. 

Finally, choose MultiCycle from the Prefs menu. Select the 
Straight line tool and drag a line straight down from the top 
of the page. 

MultiCycle tells DeluxePaint to cycle each color in your brush 
individually when you use the Cycle mode. Since your brush is 
made up of many colors, they create a many colored pattern. 
Press the TAB key to see how psychedelic you can paint with 
colorcycling and MultiCycle. 

Figure 3.12 VENUS altered with Smear and Smooth brush modes 
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Extra-Halfbrite Mode Hbrite mode is a new feature in DeluxePaint. This painting mode 
is only available if you are using 64 colors. So, let's mange our 
screen format now. wmmm 

Choose Screen Format from the Pi 
click 64 colors and click Ok. 

|enu. In the requester. 

Now your palette should contain 64 colors. The first 32 colors die 
the same colors you had in Lo-Res format. The second 32 colors 
are halfbrite equivalents of the first 32. 

❖ Not all Amiga 1000's support Extra Halfbrite mode. If the 
second 32 colors in your palette are the same as the first 32 
colors, you do not have an Extra Halfbrite chip. Contact your 
Amiga dealer for information on how you can upgrade your 
computer if you want to use this mode. 

Let's take a look at how Hbrite paints. 

^ Choose Load from the Picture menu and load.ife^ 
named Hall of Stars from the Picture drawer 
disk. When the requester asks if you want to 
screen format, click NO. 

► Now select the largest built-in brush and the 
tool. Choose Hbrite from the Modes menu. Scrawl anywhere 
on the picture using the left mouse button. 

Notice that when you paint with the Left button in Hbrite mode, 
any colors that are the first 32 in your palette are changed to their 
halfbrite equivalent. This makes it look as though your picture is 
getting darker. Hbrite mode is a great way to add shadows to 
your pictures. 

^ Now scrawl over your picture again, but use the right mouse 
button. 

Any areas of your picture that are already in one of the first 32 
colors of your palette are unaffected by your paint, but areas that 
are painted with any of the 32 halfbrite colors become lighter. 

We've demonstrated only a few of the painting modes in this 
section. Be sure to take the time to review the description of the 
modes in Reference. Clever use of painting modes can save you 
time and help you create interesting effects. 

^ Before you move on to the next section, choose Color from 
the Mode menu. This is the default mode. 
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Keyboard Equivalents 

Looking Ahead 

Fixing the Background 

Most artists have found that De 1 ux|list of key¬ 
board equivalents helps them work fend efficiently. 
We are committed to making the keyboard commands an inte¬ 
gral and important feature of DeluxePaint. The most important 
thing to remember about our keyboard equivalents is that you 
can use most of them while the mouse button is down'.U This means 
that you can use multiple features simultaneously. 

A simple example of where using the keyboard equivalents 
comes in handy is the case of trying to pick up a brush very 
precisely. Here's what you might do: 

Click the Brush Selector. Move the cross hair to the area you 
want to magnify and press m to turn on magnification. Begin 
surrounding the area you want to pick up and, while the mouse 
button is down, press m again to turn off magnification. Move 
the cross hair to the other corner of the area you want to select 
and pre§$jpn^gain to magnify for precise selection. Finally, re¬ 
lease th43^iU$e button and you have your brush. 

This is just one example. There are more throughout the pro¬ 
gram. In particular, when you begin working with animation, 
you'll find that the keyboard equivalents let you do many things 
that otherwise would be impossible. If you ever need to use a 
menu option or other command while the mouse button is 
down, go ahead and try the keyboard equivalent; it usually 
works. 

You'll find a complete listing of keyboard equivalents at the back 
of this manual in Appendix B. You'll also find a summary of the 
keyboard equivalents on the reference card. 

Before you move on to the next chapter, or off on your own to 
explore DeluxePaint, we want to introduce you to & few' of the 
interesting and power^^js^bures of the program. You'll find 

r features throughout the manual. more information < 
V.Y.'v.. v'tf 

This section shows a very powerful feature you paint on 
your picture without fear of accidentally mefe&fr% li up. 

^ Load the picture Seascape from you copy of the Artl disk. 
If you are prompted by a screen message asking you if you 
want to change the screen format or the number of colors, 
click Yes. 
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Animpainting 

^ Choose Background>Fix from the Effect menu. 

What you have just done is remarkably simple, and yet remark¬ 

ably powerful. You have fixed the picture onto the background 

so that it cannot be removed. Try it. 

>> Click CLR and see what happens. That's right — nothing. 

The picture is fixed, which means you can draw over it any way 

you like. 

^ Select a thick brush and scrawl on the picture. Do it with the 

airbrush if you like. Then scrawl using the right mouse but¬ 

ton and see what happens. 

When you have the background fixed, painting with the right 

mouse button is truly erasing! Note that you can paint on the 

picture and then fix the background again to fix the new version. 

You can erase everything you painted since the last fix with a 

single click. And you can "unfix" the background as easily as 

you fixed it: just choose Background>Free from the Effect menu. 

This restores everything back to normal, so that clicking CLR 

clears the entire picture. 

WeTl look more closely at this feature in the next chapter when 

we look at custom brushes and the way they interact with the 

background. Meanwhile, feel free to experiment further with this 

feature. Art restorers should have it so easy! 

In particular, the combination of right-button brush selection and 

Fix Background lets you lift any complex shape off a fixed back¬ 

ground (provided the shape was applied after the background 

was fixed), without lifting up any of the background. Deluxe- 

Paint preserves in memory all those parts of a fixed background 

that are covered by unfixed shapes, which means that you can 

move the shapes around the page and uncover the previously 

hidden background. 

We realize that you may have just started painting on a computer 

for the first time. But we'll take a daring leap forward to show 

you animating on a computer. Right now we'll show you a spe¬ 

cial kind of painting on multiple frames. Just follow the steps 

carefully, and you'll see some wonderful results. 
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Animation Frames 

Animating with 
Animpainting 

► Choose AnimBrush>Load from the Anim menu. Insert the 
Art2 disk in any drive and click the Disks button so that 
<VOL> Art2 appears in the window. 

► Click <VOL> Art2. It appears in the Drawer edit box. 

► Click <DIR> AnimBrush in the window. 

Double-click the file named "Sweep.anbr". 

When the requester closes, you'll have an AnimBrush of a Karate 
black-belt attached to your cursor. An AnimBrush is special in 
that it is made up of many cels (short for cellophanes) that flip as 
you paint. 

► Choose Pa!ette>Use Brush Palette from the Color menu to 
see the brush in its own palette. 

Click the brush down once. 

Move the mouse, and click the brush down again. 

Notice that now your brush looks different. Each time you click 
the button the brush moves to the next cel. 

^ Paint freehand across the screen to see all of the cels of the 
AnimBrush. 

Above, we had you painting with an AnimBrush on a single 
screen. Now let's look at what happens if you paint one cel of the 
brush on each of several screens. This is one way to create anima¬ 
tions in DeluxePaint IV. 

Select dark blue as your background color and clear the 
screen. 

^ Choose Frames>Set # from the Anim menu. (The Set Frame 
Count requester appears.) Enter 20 in the Count field. (You do 
this by clicking at the right end of the field, backspacing over 
the existing number, and typing the new number.) Click OK. 

In a flash, you have 20 animation frames to paint on. Notice the 
numbers 1/ 20 on the left side of the Title Bar. This tells you that 
you are on frame 1 of 20 frames. Let's paint! 

Animpainting is simply the process of painting at the same time 
the animation frames flip. In most ways it is like regular paint¬ 
ing, since DeluxePaint flips the frames for you. 
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Summary 

Right-click on the Straight Line tool to display the Spacing 
Requester. Click the N Total button to highlight it. Click in 
the edit field next to N Total and set the number to 20. Click 
Okay to exit the requester with the new settings. 

Now your lines will paint exactly 20 stamps of the brush be¬ 
tween the start and end points of the line. Using the N Total 
option of the Spacing requester is an effective way to animate 
across a simple path, as you'll see in a moment. 

^ Press Shift-7 to set your AnimBrush back to its first cel. 

^ Select the Straight Line tool. Hold down the Alt key, and drag 
out a line from left to right across the screen. 

When you let go of your line and the Alt key you'll see 
DeluxePaint paint your AnimBrush on each frame of your 20 
animation frames. 

When DeluxePaint is finished painting, press 5 on the key¬ 
board. 

The Karate expert shows all of his best moves. Press 4 if you 
want to see your animation play continuously. If the animation 
moved too quickly, press the left arrow key repeatedly to slow 
down the play rate. Press the space bar to stop the animation. 

This chapter completes the Guided Tour of DeluxePaint IV. 
Chapter 4 presents some painting tutorials, which will help you 
learn how to get the most out of the way the program uses colors 
and palettes. Because DeluxePaint's color 
program's strongest and most versatile fe< 
ommend that you work through the exerc 
there. 

capacity 
itures| 

e of the 
phly rec- 

ises w^lj^pjdescribed 
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Tutorial One: 

Working with Colors 

Manipulating the Palette 

The Toolbox Palette 
(What You Can Paint with) 

The four tutorials in this chapter introduce some of the most 

powerful painting features of DeluxePaint IV. Though the tutor¬ 

ials have a common theme — effectively using the program's 

colors — each tutorial is independent from the others, so you 

can choose to complete only the exercises that interest you. 

This tutorial will walk you through how to use the DeluxePaint 

IV color requesters. 

Start DeluxePaint IV fresh, and at the Screen Format 

requester, choose Lo-Res 16 colors. 

Sixteen colors is far from the maximum number of colors you 

can work with, but it is a good place for us to begin explaining 

the color manipulation features of DeluxePaint IV. If you're fa¬ 

miliar with DeluxePaint III, you will see that the program has 

changed a bit to bring you more powerful color tools for work¬ 

ing in HAM mode. These tools can also be useful in other modes, 

as you'll soon see. 

In this section of the tutorial, we'll look at the ways you can ma¬ 

nipulate your palette. This will help you make best use of the 

colors available to you in non-HAM modes. 

You may remember from the Guided Tour that the number of 

colors you can paint with depends on the Screen Format you 

choose to work in. The important thing to remember in all modes 

except HAM is that all of the colors you can paint with appear in 

the palette area below the toolbox. If you are ever confused about 

which colors are available to you, look at the Palette below' the 

Toolbox to see your colors. 

Figure 4.1 
Color Indicator and Palette 

Of course, you can change these colors to create the ones best 

suited to the artwork you have in mind. The common way to 

change colors is to use the Palette Mixer. 
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The Palette Mixer Move the cursor over the Color Indicator and click with the 
right mouse button. 

Right-clicking on the Color Indicator displays the Palette Mixer. 
You can also display this requester by choosing Palette>Mixer 
from the Color menu, or by pressing p on your keyboard. Use 
the method that is most natural for you. 

■■■ 

COPY EX SPREAD 1 PICK 

=18 □ 
El DELETE 1 

Figure 4.2 The Palette Mixer 

Palettes vs. Color Sets 

One of the first things you'll notice about the Palette Mixer is 
that it contains more slots than there are colors in your Palette. 
In DeluxePaint IV you are able to mix and spread colors outside 
your palette as a way to "experiment" with colors before com¬ 
mitting to them in the picture. 

There are 32 color slots to a row, and 8 rows numbered 0 through 
7 for 256 color slots in the Mixer. We call this collection of slots 
the Color Set. The Palette is a smaller number of colors included 
in the Color Set. In the Palette Mixer, the Palette colors are ar¬ 
ranged in row' 0, and the top and left edge of each color is out¬ 
lined in white. The top and left edge of non-palette colors is 
outlined in light blue. When you are in a 16-color mode or HAM, 
you can use the left edge of the Mixing Area as an additional 
guide to where the first 16 palette colors end. 

When you first open the Palette Mixer, you have only palette col¬ 
ors and the rest of the slots are empty. Empty slots are indicated 
with a checked pattern. If you try to paint with one of these color 

slots, you'll see that the color is white by default. 

Change palette arrows to 
Palette colors see more of the Color Set 

r 1 
Palette number 

RGB/HSV button 

Palette action buttons 

4 ■ mmm i0M4*aM-MM*i-i***** im u u ]♦ + 

L J 
1 

REVERT 1 UNDO [OK 

Current foreground color Mixing Area 

Figure 4.3 The Palette Mixer 
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RBG/HSV Sliders 

First let's look at how you can change the colors that already 
exist in your palette. 

Click on the bright red in the Palette Mixer and paint on the 
screen. 

As you can see, you can still paint on your image when the 
Palette Mixer is displayed. 

^ Now, drag the sliders in the Palette Mixer to alter the red. 

Notice that the color on the screen changes as you change the 
color in your palette. The red in the Color Mixer is a Palette color, 
so the color you placed on the screen is tied directly to the color 
in the Palette. This is true of most Screen Format settings in 
DeluxePaint IV. HAM is the exception. In HAM it is possible to 
paint on the screen with colors that are not in your palette. We'll 
explore these two color models in a moment in Introduction to 
RGB and HSV Color Models. 

^ Click on the RGB button to change to HSV. Now use the HSV 
sliders to alter the color some more. 

DeluxePaint IV lets you set your color values using either the 
RGB (red, green, blue) or HSV (hue, saturation, value) models. 
You'll learn more about both of these color models in a moment. 

UNDO 

► Click UNDO in the Mixer to undo the change to the palette. 
You'll see both the color in your palette and the color on the 
screen restored to red. 

You can undo any change to a color in your palette so long as 
you don't click any other color before you click UNDO. Undo 
remembers and reverses only the most recent change. If you 
wanted to return to the palette and color set you had when you 
first opened the Palette Mixer, you would click REVERT. The 
UNDO button makes it possible to experiment with colors in 
your picture and return to the original easily if you don't like 
your experiment. 

Copy and Exchange 

You can rearrange the colors in your palette by using the COPY 
and EX(change) buttons. 
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^ With the red color selected, click COPY and click on the first 
empty slot to the right of your palette to copy the red there. 

^ Click the Yellow in your palette and copy it to the empty slot 
beside the new red. 

^ With the new yellow color selected, click EX and click on the 
new red to swap the positions of these colors. 

Copy and Exchange are straightforward ways to arrange colors 
in your palette. Perhaps the most important way you'll use them 
is to arrange your palette for creating spreads between colors. 

Spreading Colors 

Spreading colors is an effective way to get subtle shades of a 
color. Let's create a spread of colors from white to dark blue. 

^ Click on the white in your palette colors. Click SPREAD and 
click on the dark blue at the right end of your palette colors. 

Now you have a spread of colors from white to blue with the 
color settings for each of the slots mathematically calculated to 
give you the most evenly spread colors based on the number of 
slots between the white and the blue. Note that DeluxePaint uses 
the HSV model to build its spreads. This means that when you 
spread between blue and yellow, the colors in between will run 
through the greens in the color wheel. 

Many other functions in the program (including Ranges) use the 
RGB model to calculate spreads of color. It is important to under¬ 
stand the distinction between these two color models and how 
to use them to your advantage. If you aren't already familiar 
with these two color models, be sure to work through the section 
Introduction to the RGB and HSV Color Models below for an 
explanation of basic color theory. 

Color Set 

Now that there are no reds or yellows in your palette (though 
there is one of each in your Color Set), we want to illustrate an 
important concept. 

Special Note In any color mode other than HAM, if you try to paint with a color 

from the Color Set that is not in your palette, DeluxePaint paints with 

the color in your palette that most closely matches the Color Set color. 

Here's an example: 

► Click on the red in your color set and paint with it on the 
screen. 
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You should see that you are painting with the darker of the two 
grays in your palette, because this gray is the color in your pal¬ 
ette that is closest to red in the RGB color cube. (You'll learn 
more about the RGB color cube later in this section.) 

Click on the yellow in your color set and paint with it on the 
screen. 

You should see that you are painting with the lighter of the two 
grays in your palette. As we mentioned above, the best way to 
know which colors you can actually paint with when you are in 
any screen format other than HAM is to look at the palette un¬ 
derneath the Toolbox. 

The Mixing Area 

The mixing area lets you mix colors together the way an artist 
mixes paint. Like the extra color slots in the Color Set, the Mixing 
Area can contain any of the possible 4096 colors, but unless you 
are using [ IAM mode, you will be able to paint only with the 
colors you place in your palette. Let's mix a new color right now. 

^ Choose the third round built-in brush from the toolbox. 
Choose the red color from your Color Set and paint with it in 
the Mixing Area. Then choose the yellow and paint into the 
red. 

You'll see the two colors mix together to form oranges. As you 
mix, your brush spreads the mixed colors, but each time you 
click down, your brush starts over with yellow automatically so 
you can gradually add the yellow to the red. 

To move your new color into the Color Set you use the PICK 
button. 

Click on an empty slot in the Color Set. Click PICK. (Your 
pointer changes to an eyedropper.) Click on a color in the 
Mixing Area. 

The color you clicked on is added to the Color Set in the slot you 
chose. 

To clear the Mixing area to any color and start over, you copy a 
color to the color mixer. 

^ Click on white in the Mixing Palette. Click the COPY button. 
Click in the Mixing Area to clear it to white. 

73 Painting Tutorials DeluxePaint IV 



Loading and Saving 
Palettes and Color Sets 

Introduction to the RGB 

and HSV Color Models 

Arrange Palette Requester 

Although we moved a few colors in the palette using the Palette 
Mixer, the best place to accomplish this sort of operation is in the 
Arrange Palette requester. 

> Choose Palette>Arrange from the Color menu. 

This requester lets you see four rows of colors at a time, and you 
can quickly scroll through the other four rows with the up and 
down arrows. Each click on the arrows to the right of the color 
rows moves the rows up or down by one. The number in the up¬ 
per left corner of the requester is showing you the number of the 
row at the top of the list. When you are looking at the first four 
rows (rows 0 - 3), this number is 0, when you're looking at the 
last four rows (rows 4 - 7), the number is 4. If you hold down the 
Shift key when you click on the arrows, you move directly to the 
first or last four rows. 

COPY; EX SPREAD \ PICK | DELETE j REVERT | UNDO) OK I 

Figure 4.4 Arrange Palette requester 

The buttons in this requester work just like the ones in the Palette 
Mixer. The SPREAD option is especially useful in the Arrange 
Palette requester because it lets you easily spread over multiple 
rows in the set without having to scroll the rows. 

DeluxePaint IV also lets you load and save Palettes and Color 
Sets. If you continue on to the Ranges tutorial, you'll see an 
example of loading a Color Set. Otherwise we recommend that 
you look in the Reference for information on how to use these 
features. 

In this exercise, you'll be looking at the Reference Palette to learn 
how DeluxePaint mixes red, green, and blue to form other colors. 
You'll also see the relationship between the RGB and HSV (hue, 
saturation, value) color systems. 

► Choose Load from the Picture menu and load the picture 
named Reference Palette from the Picture drawer of your 
Artl disk. 

❖ If you see the message asking if you want to change screen 

format to that of the file, click Yes. 
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Figure 4.5 The Reference Palette picture 

The Reference Palette picture shows you a matrix of the colors in 
the color spectrum: Red, Orange, Yellow, Green, Blue, and Violet. 
These are the colors that are produced when you mix colored 
pigment. In effect, these are the colors a traditional painter would 
work with. This is not the spectrum produced when you mix 
colored light. That spectrum produces the colors Red, Yellow, 
Green, Cyan, Blue, and Magenta. 

* Choose Palette>Mixer On/Off to display the Palette Mixer. 
Click on the main screen to activate it. Press F10 to hide the 
Menu Bar and Toolbox. Place your cursor over the picture 
and press the down-arrow key on the keyboard until the 
ROYGBV letters in the picture are at the top edge of the 
screen. 

Now let's look at the RGB and HSV values of some of the colors 
in the Reference Palette. 

Click PICK in the Palette Mixer and then click the red square 
in the row labeled Pure Color. Look at the sliders in the 
Mixer. 

In RGB terms, your Mixer shows that a pure red is all red color 
with no green or blue. 

^ Click the RGB button to change to the HSV sliders. 

In HSV terms, pure red is hue 0 with full saturation and full 
value. Saturation is the relative amount of color to white, and 
value is the relative lightness*or darkness of a color. Value is 
often referred to as Luminosity. To see exactly what this means, 
let's change the sliders a bit. 
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Drag the saturation (S) slider all the way to the left to see 
what happens to the color. Drag the saturation slider back to 
the right. Now drag the value (V) slider all the way to the left. 

As you drag the saturation slider left, the red gets lighter until it 
is white. As you drag the value slider left, the red gets darker un¬ 
til it is black. Regardless of the hue or saturation, a value of zero 
always produces black. 

The meaning of the saturation and value sliders is exactly what 
the matrix in the Reference Palette shows. Notice that the colors 
in the Low Saturation row are all pale — they don't contain 
much color. The colors in the Low Value row are dark — they 
don't contain much luminosity. The colors in the Pure Color row 
contain full saturation and full value. 

Hue simply refers to the position of a color on the color spectrum 
or rainbow — Red, Yellow, Green, Cyan, Blue, or Magenta, and 
the various shades in between. Figure 4.6 shows the positions of 
colors on the Color Wheel. 

Figure 4.6 
The Color Wheel 

Let's look at another color in the Reference Palette. 

^ Click PICK and then click on the yellow square in the Pure 
Color row. 

^ Click the HSV button to switch back to RGB sliders. 

The RGB sliders show that yellow contains the maximum 
amount of red and green, but no blue. Yellow is said to be the 
"complement" of blue. Each of the primary colors has a comple- 
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merit. In the RGB color system, the relationship of the primary 
colors and their complements are best thought of as a cube in 
which each dimension is measured in one of the three primary 
colors, as shown in Figure 4.7. The complement of each primary 
color is positioned at the opposite corner of the cube. Thus, mov¬ 
ing downward on the edge of the cube to add red to green pro¬ 
duces yellow (R15, G15, BO) the complement of blue, which is 
positioned at the opposite corner from blue. If you look back at 
Figure 4.6 you'll see that in the HSV color system, the comple¬ 
ments are also directly across the circle from the primary color — 
yellow is directly across the wheel from blue. 

Figure 47 RGB color cube 

Notice that black is the absence of color (RO, GO, BO) and white is 
the maximum level of the three colors (R15, G15, B15). The line 
running diagonally through the center of the cube from black to 
white shows the positions of the grays, which are formed by 
combining equal amounts of red, green, and blue. Thus R8, G8, 
B8 would yield a medium gray. Let's try this in practice: 

► In the Mixer, drag each of the RGB sliders to 8. Once all three 
primary colors are at 8, you have medium gray. 

Click the RGB button to see the HSV slider. Look at the posi¬ 
tion of the value slider in your Color Palette; it is at the same 
level as the red, green, and blue sliders. (You can click quickly 
back and forth between the two slider systems to confirm 
this.) 

The mixing of grays is one area where the HSV system excels. 
Rather than moving all of the RGB sliders to the same position, 
you can simply drag the saturation slider all the way to the left 
and move the value slider to the level of gray you want. The 
position of the hue slider will have no effect, because there is no 
color (no saturation) in gray. 
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Tutorial Two: 
Working with Ranges 

^ Move the hue slider left and right and notice how the gray 
you produced doesn't change. Now move the value slider left 
and right and switch back and forth between the two color 
systems to see how the RGB sliders move along with the 
value slider, always staying in a perfect line. 

Can you change the color back to yellow? Remember, yellow is 
the complement of blue. 

^ Move the red (R) and green (G) sliders all the way to the right 
and move the blue(B) slider all the way to the left. 

Now that you know the basics, try mixing a few colors you like 
using either one of the two color mixing systems. Here's a trick 
you might also consider: mix a few palettes that you particularly 
like and save them using the PaIette>Save option in the Color 
menu. You can then automatically produce that palette by load¬ 
ing it from the Color menu. 

Before we leave the topic of color mixing, let us just summarize 
a few important points: 

Your Amiga and DeluxePaint mix colors using the RGB 
system, and this system is represented by the color cube. 

If you want to find any pure color, you can do so using the 
HSV system by moving the saturation and value sliders to the 
right and then scrolling the hue slider until you find the color 
you want. 

If you need to produce a gray, you can do so by setting all 
three of the RGB colors to the same level, or by setting the 
saturation slider to the left and adjusting the value slider to 
the gray level you want. 

Besides providing a sample spectrum for our color mixing tuto¬ 
rial, the Reference Palette is useful for adjusting your monitor. 
Reload the picture to restore it to its original colors and print out 
a copy on youtiCQlor printer. Then adjust your monitor until the 
colors on your screen look the same as those on the paper. 

In this section you'll learn how to build a Range for use in gradi¬ 
ent fills and color cycling. DeluxePaint IV has moved the range 
functions out of the Palette Mixer requester to make ranges more 
versatile in all color settings. First we'll show you how to work 
with ranges in 32 color mode, since this mode illustrates the basic 
concepts you need to master. The tutorial Painting in HAM will 

explain how Ranges work in HAM. So, before you begin: 
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Loading a Color Set Change your Screen Format to Lo-Res 320 x 200 with 32 
colors. 

Before you begin building a range, we'll have you load a Color 
Set that contains a pleasant spread of colors to paint the range 
with. 

^ Choose Color Set>Load from the Color menu. 

Figure 4.8 Load Color Set requester 

When the first Load Color Set requester appears, insert you 
Artl disk in the drive and load file Range.set from the Colors 
drawer. 

Once the Color Set is loaded, you are presented with a second 
Load Color Set requester that is similar to the Arrange Palette 
requester 

This requester allows you to choose which colors you want to 
load from the color set to add to your current color set. And you 
can choose to add colors to your current set, or you can over¬ 
write the colors in your color set with the new colors. We want to 
load all of the colors from this new' color set and overwrite the 
colors that are in our current color set. To do this: 

^ Click the Overw rite button. 

The Overwrite button loads colors into your current color set 
starting at color 0. After the Color Set is loaded, the Arrange Pal¬ 
ette requester is automatically displayed so that you can arrange 
the colors as you like. The Palette you'll see contains two spreads 
of color that paint smooth gradients even in the Low Resolution 
mode w'e are using now. These spreads of color were created by 
mixing the color at each end of the spreads in the Palette Mixer 
and then using the SPRHAD option to generate the colors be¬ 
tween. 
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Building the Range Choose Ranges from the Color menu to display the Range 
requester. 

Figure 4.9 Range Requester 

The Range Requester is DeluxePaint's new way of building 
ranges for use in painting gradients or cycling colors. You can 
build up to eight ranges for each document, and these ranges are 
saved with the file. When you start the program, it contains a de¬ 
fault set of colors in the first range. In our case, the default range 
contains the grays in the lower half of the palette. Well leave this 
range in place and build a new one. The slider in the upper left 
comer of the requester lets you choose the current range being 
used by the program. 

Click to the right of the slider to move to range 2. 

Range 2 should still be empty and ready for us to work with. To 
build a range, you place colors on the bar just as you saw them in 
the first range. If Range 2 is not empty' click the CLEAR button. 

^ Click on the last yellow in the requester. 

Your cursor becomes a rectangular bead, and the color indicator 
in the upper right corner of the requester shows that you are 
holding a yellow color. 

Move the cursor to the first mark on the range bar and click. 
(Your yellow color appears on the bar and your cursor reverts 
to an arrow.) Place the second yellow on the bar the same 
way. 

Tip You can speed up the process of placing colors on the bar by 
using the bracket keys [ ] to change the color of your color bead. 
We'll do it now: 

► Press the left bracket key [ to move to the next color in your 
palette. 

Your arrow cursor becomes a bead again and is holding the 
new color. 

^ Click the bead in place on the range bar. Repeat pressing the 
bracket key and clicking on the bar until you have all of the 
yellow through orange and red spread on the bar. 
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The Reverse Button 

Pattern and Random Dither 

♦> You don't need to put the colors right next to each other on 

the bar to build an effective range. And you don't need to put 

the colors in the same order that they appear in the palette. 

We're doing this only because this is the most convenient way 

to work with ranges in modes other than HAM. We'll show 

you some other variations on ranges when we look at gradi¬ 

ents in HAM and at Color Cycling later in this tutorial. 

^ Click the SHOW button to see the range painted as a gradi¬ 

ent. 

You'll see a gradient painted with your current range in both the 

requester and in a bar above the requester. The gradient inside 

the requester shows you the gradient using all of the colors avail¬ 

able for that gradient in the Amiga color universe of 4096 colors. 

If you are not working in HAM mode (and we're not) the second 

gradient appears above the requester to show you how the gra¬ 

dient will look using your current palette. Since our range was 

built from colors that exist in the palette, and we placed all of the 

colors on the range bar, our gradient looks spectacular. 

The REVERSE button beside your new gradient does exactly 

what its name implies, it reverses positions of your colors on the 

range bar. 

^ Click REVERSE once to see how it reverses the colors on the 

range bar and repaints the gradients. Click the button a sec¬ 

ond time to return the range to its original order. 

At the moment, the gradients you see for your range are painted 

using a regular pattern that produces an even transition between 

colors. If you want to exercise a little more control over your 

gradients or if you want to eliminate the smooth transitions 

altogether, you can do this with the Random button and Dither 

slider at the bottom of the Range requester. When you click the 

Random button, your gradients are painted using a Random 

dither that you control with the dither slider. 

^ Click the Random button at the bottom of the requester. 

A check mark appears in the middle of the Random button when 

it is selected. Notice that now your gradients are redrawn using a 

random dither. 

^ Drag the Dither slider all the way to the right to see how this 

affects your gradients. Drag the slider all the way to the left to 

see the gradient with no dither. 
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Gradient Fills 

The Fill Type Requester 

^ Click the Random button again to turn off random dither. 

Now that you've seen how most of the Range controls work, let's 
move on to painting with this range to see how it is used in gra¬ 
dient fills. 

As we mentioned above, one of the areas of DeluxePaint IV 
where ranges are used is in the painting of gradient fills. There 
are two general types of gradient fills to know about in 
DeluxePaint IV. The first type of gradient is the linear style that 
was supported by DeluxePaint III. The second is a "directional" 
gradient that lets you specify the angle of any linear gradient, 
and the central point for any radial style gradient. We'll show 
you how to draw one of each of these gradients. 

As mentioned in the Guided Tour, the Fill Type requester is 
where you choose what type of fill your filled shapes and the Fill 
tool will use. You display this requester by right-clicking on the 
Fill tool or any filled shape tool. 

Right-click on the Fill tool in the Toolbox to display the Fill 
Type requester. 

Figure 4.10 Fill Type requester 

The lower section of the Fill Type requester contains an assort¬ 
ment of options for filling with a range. You can choose which of 
your Ranges you want to fill with, and how the program should 
perform the fill. The requester also shows you a representation 
of your current range and lets you set the Random and Dither 
options just as you would in the Range requester. 
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The first three icons in the gradient area of the Fill requester are 
fills that were supported in DeluxePaint III. Let's paint with the 
first of these options to see what they are like. 

Click the <-> icon in the requester. 

► If you aren't already looking at Range 2 (yellow to red) in the 
requester, click in the Range box, delete the current number, 
type 2 and press Return to change to range 2. You'll see the 
range painted in the requester. Click OK. 

► Select the Filled Circle tool and draw a circle that is about two 
inches wide. 

In a moment DeluxePaint paints a circle that is filled horizontally 
with your gradient from left to right. The other two options in 
this row work essentially the same way They paint linear fills 
either horizontally or vertically. Try them out for yourself, or see 
Figure 4.13 for an illustration of these gradients. 

DeluxePaint IV introduces new gradients that allow you to 
define the direction of the gradient at any angle. There are two 
styles of gradients: linear gradients and radial gradients. 

Linear Gradients 

The two linear gradfeci tend SHAP(E). When you fill 
with these gr a d i en ti on a I" line to indicate the 
angle of your gradie^ ;p { ;'♦> 

► Select the Filled ► Select the Filled Press Shi ft -F to display the 
Fill Type Requester. Select the LINE option and click OK. 

Draw another filled circle that is about two inches wide. 

When you release the mouse button, your cursor changes to a 
cross-hair with a line connecting it to the center of the circle. We 
call this the "directional" line, and you use it to define the direc¬ 
tion of your gradient. Let's paint this linear gradient at an angle. 

^ Position the the cross-hair so that your line extends up and to 
the right at an angle of about 45 degrees (as in Figure 4.11) 
and click. 
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Figure 4.11 Positioning the directional line 

This new circle is painted with a gradient at 45 degrees. 

Radial Gradients 

The three radial gradients are CIR(CULAR)/ CON(TOURS), and 
HI(GHLIGHT). When you fill with these gradients, you use the 
directional line and cross-hair to indicate the point from which 
the gradient will radiate. 

Display the Fill Type requester. Select the C1R option and 
click OK. Draw another filled circle that is about two inches 
wide. 

When the directional line appears, place the line at a 45 de¬ 
gree angle, but this time make sure the cross-hair is mid-way 
between the center of the circle and its edge as in Figure 4.12. 
Click the mouse button. 

Figure 4.12 Positioning the directional line for a radial fill 

This time your circle is filled with a gradient that radiates out¬ 
ward from the point where you clicked. The gradient is painted 
with the first color of your range as the highlight color where 
you click. If you clicked outside the circle, the gradient would 
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still use the point where you clicked as the point from which the 
gradient would radiate, and the effect would be different. Give it 
a try if you like. 

Color Cycling Ranges 

Conventional Color 
Palette Cycling 

The figure below show's an example of each of the gradient fills 
available in DeluxePaint IV drawn using the yellow to red gradi¬ 
ent. If you like, experiment with the other gradient fill types and 
play around with the Random dither setting too. We also recom¬ 
mend that you try the radial gradients with different shapes to 
get a feel for which combination of fill and shape gives the best 
results. Of course ''best" is entirely a matter of personal taste. 

Figure 4.13 Example of the eight gradient fill types 

In the Gradient Fills section you learned how to use a range to 
fill shapes with a gradient. You can also use these same ranges 
and others to create color cycling animations. If you are familiar 
with DeluxePaint III, you probably already know about the sim¬ 
plest form of color cycling. This type uses ranges of consecutive 
colors just like the one we built for painting the gradients in the 
example above. DeluxePaint IV introduces two other types of 
color cycling that allow you to use colors that are not in your 
palette in a color cycling range. We'll w'alk you very quickly 
through each of the different versions of color cycling, and then 
have you look at some color cycling brushes that are included on 
your Artl disk. 

The simplest form of color cycling makes each of the colors in the 
cycling range move over to use the color in the next slot in the 
range. This type of color cycling requires that you use multiple 
colors from your palette to perform the color cycle. By cleverly 
combining colors, you can simulate animation with this kind of 
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color cycling. There are several examples of this type of color cy¬ 

cling on your Artl disk. Let's take a look at two of them now: 

The Running Man 

^ Choose Load from the Brush menu and load the Cycle2 brush 

from the Brush drawer on the Artl disk. 

Your Brush is now several images of a running stick figure. 

^ Choose Palette>Use Brush Palette from the Color menu to 

change your palette to the palette of the brush. 

^ Make Color 0 your background color and click CLR to clear 

your screen to black. 

^ Stamp down the brush and press the Tab key to start color 

cycling. 

Each position of the running man was drawn in a different color 

from Range 1. Because five of the six colors in this range are 

black, only one frame shows at a time, as the white color cycles 

into each position in the palette. The remaining five images are 

invisible against the black background. (Display the Color Mixer 

and change the black colors in this range to any non-black color 

to see all the frames.) 

The Spinning Wheel 

^ Load the brush Cyclel from your Artl disk; stamp down the 

brush and press Tab to turn on color cycling. 

This color wheel was drawn as a circle with lines radiating out 

from the center. The pie-shaped pieces were then filled with 

adjoining colors in Range 2 of the Range requester. Thus, as the 

colors in the wheel cycle, the wheel appears to spin. 

The brushes Birds, Snowball, StormNight, and Fireworks are 

other examples of this kind of color cycling animation. Load each 

of them, change to the brush palette and turn on color cycling to 

see how they work. 

Single Color Register Cycling DeluxePaint IV also allows you to cycle a single register through 

a range of colors. Rather than have you load an example to see 

this effect, we'll have you build one from scratch. 

Choose Palette>Default Palette from the Color menu. 

► Display the Ranges requester and move the slider to range 2. 

Click the Clear button beside the range to clear it. 
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* Click on the third color in the palette (bright red) and place it 
on the left side of the Range bar. Place the bright yellow in the 
middle of the range bar. Click the Show button to show your 
new range. 

Now you have a gradient that runs from red to yellow in the 
requester. (The gradient above the requester looks a bit less im¬ 
pressive because you don't have all of the in-between colors in 
your palette to make a smooth gradient.) At the moment, your 
range uses two color "registers," that is colors from your palette 
to build the range. You can tell that the colors on the Range Bar 
are colors from your palette because each of the color beads has 
a little dot beneath it. This little dot indicates that the colors are 
from the palette. The secret now is to change the yellow to a non¬ 
palette color. We do that by "picking" the RGB value we want 
from the gradient in the requester. 

^ Press the comma (,) key on the keyboard to get the eye-drop- 
per cursor. Move the cursor to the bright yellow area of the 
gradient in the requester and click to pick that bright yellow 
color. 

A new bead is now your cursor and the color indicator in the re¬ 
quester shows that the color is bright yellow. 

^ Click this new color bead directly over the yellow bead in 
your range. 

Notice that the new yellow bead on the Range Bar does not have 
a dot beneath it. This indicates that the color is not from the pal¬ 
ette, but instead is an RGB value that the program will use for 
gradients and color cycling. 

^ Press the comma key again, pick a bright red from the left 
side of the gradient and place it on the far right end of the 
Range Bar. 

Your Range Bar and gradient should now look like the one 
shown in Figure 4.14. 

Figure 4.14 Range Bar with red and yellow range 
using non-palette colors 
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Hybrid Cycles 

> Move the Rate slider in the requester three fourths of the way 

to the right and click OK to close the requester 

^ Choose the bright red in the palette and paint with it. Then 

press Tab to start the colors cycling. 

You should now see your bright red color cycle through orange 

and yellow and back to red repeatedly. Notice that the red color 

in your palette also cycles through orange and yellow, but that 

no other colors in the palette change. You are cycling the color on 

your screen but using only a single color register! 

As you might well imagine, this new form of color cycling is 

very useful for strobing effects of causing an area of your picture 

to fade in and out without giving up a lot of colors to do it. 

You can combine the conventional color cycling with RGB colors 

in the range to create moving images that also strobe. We've in¬ 

cluded a couple of these on the disk to give you the idea. Take a 

look at them now if you think that you'll be using color cycling 

in your pictures. These cycles are of special interest. 

^ Choose Load from the Brush menu and load the CycleCircle 

brush from the Brush drawer. 

^ Choose Palette>Use Brush Palette from the Color menu to 

change your palette to the palette of the brush. 

Your Brush is now a blue and white circle. 

^ Stamp down the brush and press the Tab key to start color 

cycling. 

Notice that although the original brush did not contain any yel¬ 

lows in it, as the wheel turns, yellow and gold colors strobe into 

the cycle. If you display the Range requester and examine Range 

1, you'll see a combination of palette colors (color beads with the 

dot beneath) and RGB colors (without the dot). The brushes 

Fountain and Lighthouse also use this range and demonstrate 

practical uses for this type of color cycling. 

Tip If you want to create your own cycling pictures that use this 

hybrid style of color cycling, create a conventional cycle range 

first and paint the picture so that it animates correctly when you 

cycle. Then add the RGB colors to the cycle range to incorporate 

the strobing effect. 
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Tutorial Three: 
Painting in HAM 

Before You Begin 

The HAM Palette 

Through the wonders of HAM mode, the Amiga computer lets 
you paint with 4096 colors simultaneously. In the right hands, 
this mode can yield wonderful results. If you are not already fa¬ 
miliar with painting in HAM from some other product, it will 
likely take you some time to get used to this mode. This section 
will walk you through a tour of HAM as it is implemented in 
DeluxePaint IV. If you plan to work in HAM at all, we strongly 
recommend that you work through this section. 

Start the program fresh and at the Screen Format requester, 
choose Lo-Res 320 x 200 and HAM. 

The first thing you'll notice when you start the program in HAM 
mode is that the Toolbox Palette now has arrows and a letter in 
the space below it. 

Figure 4.15 
-1 The Color Indicator 

and HAM palette 

The arrows let you scroll through the colors in your Color Set, 
and the letter tells you which of the groups of 16 colors you are 
currently looking at 

Click the right arrow below the palette several times to scroll 
forward through the Color Set (most of the colors are blank). 
Click the left arrow to scroll backward through the Color Set. 

You can move quickly to the beginning or end of the Palette by 
holding down the Shift key when you click the arrows. 

^ Hold down the Shift key and click the right arrow to move to 
the last group of colors. Shift-click the left arrow to to move to 
the first group of colors. 

The first group of colors in the Color Set (the "a" group) contains 
your actual Palette colors. The other colors are simply part of the 
Color Set, but unlike in other modes, you can actually paint with 
these extra colors. 
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HAM Ramping 

So what's the difference between a Palette color and a Color Set 
color in HAM? We're glad you asked... 

When you paint in HAM, any colors that are not in your Palette 
(group "a" of the colors below the Toolbox), are displayed on the 
screen by copying the color in the pixel to the left and modifying 
one of the RGB components of the color. (You'll find a technical 
explanation of how this is accomplished in Appendix D.) Because 
HAM mode can change only one of the color components at a 
time, it can take up to three pixels to reach the color you really 
want to paint with. This transition from one color to the next is 
called a "ramp." Let's take a look at an example. 

> Choose the largest square built-in brush and the Freehand 
tool. 

> Press p to display the Color Mixer. 

> In the Mixer, Copy color 0 (black) to color 15 (magenta). Now 
Click SPREAD and spread between the two blacks. This will 
change all of your palette colors black. 

> Click on one of the empty color slots in the row (remember: 
the default color of these slots is white), paint a square on the 
screen and press m to magnify it. 

You should see that your white square has a ramp on the left 
side. From black the color changes to green, then to yellow, and 
finally to white. The ramp required three pixels to reach white 
because the change from black to white requires a modification 
to each of the R, G, and B components of the color, and there are 
no intermediate colors. 

Figure 4.16 HAM Color Ramp from black to white 
without intermediary colors 
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If there were an intermediary color in the palette, the ramp might 
be accomplished in more or less than three pixels and result in 
a smoother transition from black to white. Let's look at an ex¬ 
ample: 

Choose Palette>Default Palette from the Color menu. 

Now you are back to the standard HAM palette. This palette 
contains some intermediate grays and an assortment of colors 
spaced throughout the color cube. 

^ Click on one of the empty color slots to choose a white that is 
not in the palette. Paint another square on the magnified 
screen. 

Notice that this time the ramp is four pixels across, but the colors 
used in the ramp are much closer to the target color of white, so 
the ramp is not as noticeable. DeluxePaint chose a color from the 
palette to start its ramp with. The color it chose is color 3, which 
has an RGB value of 13,13,13, very close to white. When 
DeluxePaint chooses a color from the palette to begin a ramp, it 
searches the palette from the left and chooses the first color that 
is acceptable. And to determine which color is closest, the pro¬ 
gram compares the colors in the palette with the color you are 
painting with. 

So far we've been showing you what happens to the HAM color 
that you are painting down and how DeluxePaint ramps to cre¬ 
ate that color. Keep in mind, however that if the color you are 
painting ON is a HAM color, the program will have to compute a 
ramp to create that color also, so you will see a ramp on the right 
side of your brush. When DeluxePaint creates this ramp, priority 
is given to the brush color when selecting a color from the palette 
to begin a ramp. 

❖ When you paint with a HAM color using single pixel brush, 
you are actually painting with the closest color that the pro¬ 
gram can ramp to in a single pixel. If you need to do detail 
work, you should put the colors for the fine details in the 
palette (the first 16 colors of the color set). 

The ccmstruetion m a useful palette is an important part of suc¬ 
cessful mmlmg inf3 AM. With a little experience, you'll find the 
palettfcfkat works best for you. 
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Combining Images 

HAM Fringing 

Fast Adjust 

Recompute 

If you plan to combine images in HAM by loading in custom 

brushes, it is best to create all of the separate images using the 

same palette. This is especially true if you are using HAM 

animbrushes to be combined with a HAM background. 

We included a HAM background (AquariumBackground) and 

two HAM animbrushes (AngelFish and BettaFish) on the Art2 

disk for you to experiment with. These images all use the same 

palette, so they combine fairly well. Load the background image 

and create frames to use the animbrushes against the back¬ 

ground. The brushes look especially good when stamped with 

Translucency set to 30 percent. 

When you load a 32 or 64 color brush into a HAM picture, the 

brush is automatically remapped to use the current picture's 

palette. So the brush will immediately look correct on the screen. 

The brush's palette is also loaded intact, so you can choose 

Palette>Use Brush Palette if you want to use the brush palette. 

Then load the brush again to remap to the brush palette. 

When you load a brush that is 16 colors or less into HAM, the 

brush is not remapped. You can choose to either use the brush 

palette or remap the brush. 

Remember that DeluxePaint IV loads and saves palettes and 

color sets. This should make it much easier and faster for you to 

combine palettes. 

Sometimes when you are moving a brush on the screen in HAM 

mode, you will see fringe on the right side of your brush. This 

happens when the colors in the picture are HAM colors, that is, 

not from the 16 color palette. DeluxePaint attempts to correct the 

fringing when you hold the brush still so that you can see how 

the image will actually look when you stamp down the brush. If 

you turn off the FastAdjust option in the Prefs menu (this option 

in ON by default), DeluxePaint will attempt to correct the fring¬ 

ing effect even when you are moving the brush. The advantage is 

that your brush will always look its best, but the brush will also 

move more slowly when you move it around on the screen. 

HAM Fringing will be especially noticeable when you load im¬ 

ages from some other programs that support HAM. If you load 

an image from another program and find that the fringing effect 

along the right side of your brush is severe, choose the Recom- 
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Changing a Picture's 

Colors in HAM 

pute option in the Color menu. This option remaps the picture to 

its own palette to eliminate the fringing. 

Many artists are accustomed to adjusting the colors in their 

image by changing the RGB values of the color in the palette and 

thus automatically changing all instances of the color in the 

picture. Since HAM colors are not tied to the palette, you cannot 

directly change them by changing the RGB values. You can, 

however, change the colors globally with the BG->FG option in 

the Color menu. Here's an example of how to do it: 

^ Choose Palette>Default Palette from the Color menu. 

❖ If it is not already displayed, press p to display the Color 

Mixer. 

^ Click on an empty color slot in the Mixer. 

If there are no empty slots, create some using the Delete but¬ 

ton in the Mixer/Make sure the empty slots you create are not 

one of the first 16 colors. 

► Change the RGB slider settings to 12,13, 0. 

This should produce a bright yellow color that is slightly dif¬ 

ferent from the yellow in the palette. Because it is not one of 

the first 16 colors, it is a HAM color. Paint on the screen with 

this new yellow. 

^ Click on another empty slot in the Mixer and change the RGB 

sliders to 15, 3, 4. This should produce a bright red color. 

^ With the right mouse button, click on the yellow color you 

created to make it your current background color. 

At this point the Color Indicator in the Color Mixer should show 

that your foreground color is bright red and your background 

color is bright yellow. You should also have some of the bright 

yellow background color painting in your picture. In the next 

step, we'll change the yellow color in your picture to the red 

color. 

^ Choose BG->FG from the Color menu. 

After a few moments, DeluxePaint repaints your picture with all 

of the yellow turned to red. 

The BG->FG option changes every instance in the picture of 

your current background color into the current foreground color. 

In our particular case this meant that every pixel in the picture 
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that had the RGB values 15, 3, 4 (yellow) changed to the fore¬ 
ground color (red). 

Color Processing 
Options 

Trans/ticeticy 

As you saw, it takes a moment for DeluxePaint to search through 
your image to change all of the pixel colors, but it performs this 
function much more rapidly that you ever could. 

To give you greater flexibility when working with HAM images 
in particular, DeluxePaint IV includes new effects for painting. 
The most notable of these are the Translucency and Process op 
tions in the Effect menu. We'd like to show you a couple of these 
very quickly just to give you an idea of why they are there and 
how to use them. 

Before you begin: 

^ Load the picture titled Retrospective from the Art! disk. 

The translucency option lets you combine a specified pen^ntage 
of the colors in your brush with the colors in the image. Thfetfe 
especially useful for overlaying one image on another. Let's try a 
quick example. 

^ Select the Brush Selector tool and pick up the eye image in the 
upper right portion of the picture as a brush. 

Press F10 to hide the Menu Bar and Toolbox. 

► Choose Translucency>On/Off from the Effect menu (or press 
Alt-t). 

► Press F9 to redisplay the Menu Bar. 

Notice that a T appears in the Menu Bar to tell you that Trans¬ 
lucency is on. 

Move the brush over the image of the earth viewed from 
space and stamp down the brush. 

You'll see DeluxePaint overlay 50% of the eye image over the 
earth image. You can also change the level of translucency by 
choosing Translucency>Settings from the Effect menu. Since 
Translucency is an Effect rather than a Mode, it will also change 
the way shapes are painted on the screen. And, you can combine 
the Translucency effect with any of the Process effects to exercise 
greater control over the strength of the process effect. 

Choose Translucency>On/Off from the Effect menu to turn 
Translucency off. 
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Process The Process options in the Effect menu let you paint with differ¬ 
ent combinations of the HSV levels of your brush. Tint paints 
with a combination of Hue and Saturation. Hue paints with only 
the hue of the brush, if you're painting with a solid color, this is a 
good way to convert a color image to a monochromatic image as 
we'll see in a moment. Value paints with only the value of your 
foreground color, and is a great way to add shadows or high¬ 
lights to an image, or even just to lighten the image overall. We'll 
take a quick look at the Hue option to give you an idea of how 
the Process options w'ork. 

► Choose Process>Hue from the Effect Menu to make it the 
current process option. Then Choose Process>On/Off to turn 
the Process option on. 

A P appears in the Menu Bar to tell you that one of the Process 
options is active. 

>> Press F10 to display the Toolbox. Choose the light pink as 
your current foreground color. Select the Filled Rectangle 
tool. 

^ Press F10 again to hide the Toolbox. Draw a filled rectangle 
over the eye image in the upper right corner of the picture. 

In a moment, the eye is painted over with pink and all of the 
colors in the image are shifted to pink. Using the Hue option 
does not affect the Saturation or Value of the colors in the image, 
so the resulting image is a monochromatic version of the eye. If 
you want to see the effect against the original, repeatedly press u 
to undo and redo the change. 

As we mentioned above, the Translucency and Process options 
can be combined. Try some combinations of options on other 
areas of the picture. For example, try the Tint option with Trans¬ 
lucency set to a high number to very lightly tint an area of the 
picture. 

This section covered only a small part of the world of HAM 
painting. We hope that the ideas we've presented here helped 
you better understand HAM mode and that you'll experiment 
freely with the new options designed for this mode. 
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Tutorial Four: 

The World of Stencils 

Before You Begin 

Distant Snowcaps 

In the following set of exercises you will learn how to create and 
use stencils within DeluxePaint IV. Although stencils are pri¬ 
marily used for producing quick, uniform lettering by amateur 
signwriters, they have uses that go far beyond that. Airbrush 
artists, for example, use stencils (which they call friskets) to cover 
certain areas of their work while they airbrush other areas. 

DeluxePaint makes it easy to create a stencil for any part of an 
image, without the need to redraw the image. All you do is 
specify the colors that make up the stencil, and DeluxePaint does 
the rest, eve^.ifjhe image is intricate. 

Here's how^§f^0s: when you make a stencil for a particular set 
of colors, ydtf f§0fcl(and thus protect) any parts of the picture that 
are made up of those colors. This means that when you have a 
stencil for a particular set of colors, you cannot paint over those 
colors until you turn the stencil off. It alsf^^^s that you can 
essentially paint a picture backwards, frc^^^^oreground to 
the background, because you can use steB^fef^mask^riv^ore-. 
ground objects from the colors you are using fordte p 

objects. 1 ' ‘ 

► Choose Screen Format from the Picture mens 
screen format to 320x200 with 32 colors. 

^ Choose Load from the Picture menu and loa<£ 
named StencilSet from the Picture drawer on| 

h { | , A t » i 

The left part of the Stencilset picture shows a di^tjpjt 
range behind a green field and under a colorful SKy. (IT you fol¬ 
lowed the preceding tutorial, you'll notice that both the sky and 
the field were created with a Gradient Fill, in a fraction of the 
time it would take using more traditional techniques.) Note that 
the mountain range is actually made up of three ranges, with the 
more distant ones painted in lighter shades than the nearer ones. 
In this exercise, we will put a snowcap on the most distant range 
without disturbing any other parts of the picture. This would be 
a tall order for any other graphic medium, but is surprisingly 
easy with DeluxePaint. Let's see how DeluxePaint does it: 

► Choose Stenci 
Make Stencil recj^J 
at the top of the^BgjSS? 
Make. 

to display the 
olor 8 (the one 
and then click 
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_Hake Stencil_1 

Clear 
Locked: 

Invert 

Cancel 

Hake m . | 
Figure 4.17 Make Stencil requester 

With four simple clicks you have created a stencil that locks ev¬ 
ery color in the picture except Color 8, the color of the most dis¬ 
tant mountain range. The first click cleared the picture of any 
stencils, the second selected the stencil color, the third click in¬ 
verted the stencil configuration (making everything except Color 
8 a stencil), and the fourth made the stencil. To let you know that 
you have a stencil active, an "S" appears on the Title Bar. 

Note that clicking Invert simply inverts the current stencil con¬ 
figuration, saving you the trouble of clicking all the colors except 
the one you want to paint on. This is useful if you want to paint 
on one or two selected colors to the exclusion of the rest; if you 
want to create a stencil to lock only one or a few colors, you don't 
need to use invert. 

The next step is to paint the snow on the distant mountain range: 

► Press p to display the Mixer Change Color 1 (the second 
color in the palette) from grey to white by dragging the RGB 
sliders all the way to 15. 

^ Select white as the foreground color, and then select the one- 
pixel brush and the Airbrush tool. Move the cursor over to 
the distant mountain range and spray a snowcap on it. 

Because every color except that of the most distant mountain 
range has been locked, you can spray without fear of splattering 
any adjoining colors. 

Note that although the white you are spraying on the mountain 
range is one of the locked colors, it is not itself locked while 
you are applying it. This means that you can paint over it with 
another color (such as the original color of the mountain, if you 
don't like the look of the snowcap) just as though it were un¬ 
locked. 
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Sunrise in the Rockies 

To lock a recently applied color, just select Stencil>Remake. You 
don't need to display the Stencil requester again, because the 
configuration is still as you want it. This also means that you can 
use the "Again" key (a) to update your stencil, if Remake was 
your last menu command. 

The Again rule is simple: press a whenever you want to repeat 
the immediately preceding menu command, to save you moving 
the mouse up to the Menu Bar and through menu and submenu 
options. If your last menu command produced a requester, then 
pressing a will produce that same requester, without the need for 
menu selections. 

In this exercise, we make the sun rise behind the mountains, so 
we need to lock every color except the sky Here's how: 

^ Display the Make Stencil requester. (Color 8 should be the 
only unlocked color in the requester.) Now click Color 8 to 
lock it, and then click Colors 0 (black) and 12 through 16 (the 
sky colors) to unlock them. (Color 12 is halfway down the 
second column, and Color 16 is at the top of the third col¬ 
umn.) Click Make. 

You have now locked every color in the landscape except the sky 
colors. Now let's make the sun rise: 

^ Choose Stencil>Off from the Effect menu to turn the stencil 
off. 

In DeluxePaint IV, your stencil affects picking up a brush — you 
can only pick up areas that are not in the stencil. Since the orange 
shades in the sun are part of the stencil, you turned off the stencil 
momentarily to pick up that area of the picture. 

^ Click the Brush Selector, move the large cross-hair over to the 
sun image (on the far right of the screen) and pick it up with 
the left mouse button. Move the brush over to the mountain 
range. 

^ Choose Stencil>On from the Effect menu to turn the stencil 
on. 

Did you see the sun move behind the mountains and then peek 
through? This is because every color — except the sky colors and 
the background— is locked, and so will not accommodate the 
sun brush. When you are satisfied with the placement of the sun, 
click to stamp an image of it there. 
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Cutting Some Z's 

Fixing the Background 

In this exercise we will explore further aspects of DeluxePaint's 

powerful stencil editor. In particular, you'll see how to turn sten¬ 

cil colors on and off from any part of your picture, not just from 

the Make Stencil requester. 

^ Display the Make Stencil requester and click Clear to clear the 

stencil. Now move the cursor outside the requester and click 

the large Z shape. Click Invert and then click Make to return 

to the painting screen. 

Did you notice that when you clicked the Z the Make Stencil 

requester responded by locking that color? This means that you 

can lock and unlock colors directly from your image just by click¬ 

ing them. Note that clicking with the left mouse button adds a 

color to the stencil and clicking with the right mouse button de¬ 

letes a color from the stencil. And to make it easy to find the col¬ 

ors you want to lock or unlock, you can move the Make Stencil 

requester to any part of the screen just by moving the cursor to 

the top of the requester, pressing the left mouse button, and 

dragging it to a new position. 

Now let's see what we can do with the stencil we just created: 

^ Press the ' (accent grave/tilde) key to turn off the stencil. 

Pressing N is the same as choosing Stencil>On/Off from the 

Effect menu. This is a very important keyboard equivalent for 

working with stencils. 

^ Click the Brush Selector and pick up the textured area to the 

right of the Z. 

^ Press ' to turn on the stencil. 

^ Move the cursor over to the Z and watch what happens. 

Did you see the textured brush appear behind the Z? Because all 

the colors except the Z are locked, it looks like you're viewing 

the textured brush through a Z-shaped window. Now, when you 

place the textured brush behind the Z and click, you will fill the 

Z with the textured pattern. 

By using a combination of stencils and fixing the background, 

you can define a stencil by area rather than color. This lets you 

confine a stencil to a particular area of the page, without forcing 

you to lock every instance of a particular color. Let's take a closer 

look: 
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► Pick up the small clump of pine trees from the right~h&ftd 
side of the page. From the Effect menu, choose 9 
Background>Fix. a 

You have just fixed the picture to the background (the "B" in the £ 
Title Bar tells you so), which means you can always return to that a 
picture by clicking CLR. Thus, you can stamp pine trees all over 
the landscape and then return to the original picture at any time. 9 
You can also fix the background successively, updating the pic- g* 
ture from the previous "fix." (As we saw earlier, you can use the 
"Again" key (a) to repeat the immediately preceding menu com- & 
mand.) a 

► For the purpose of this exercise, go ahead and stamp a few 
clumps of pine trees in front of the closest mountain range. 
Now let's turn that collection of pine trees into a stencil' ^ 

► From the Effect menu, select Background>Lock FC. 9 

This last action turned the foreground everything you 
added to the picture since fixing the background) into a stencil, 9 
but without affecting any other part of the picture that uses those ^ 
same colors. Try it and see* Move your pine-tree brush over to 
the pine forest and you'll see that yout brush goes behind the 0 
forest but in front of fcveryfchmg else. You can remove this stencil ^ 
either by turning the stencil off or making a stencil by locking 
colors. £ 

The color and area methods are mutually exclusive, so using one 
method automatically negates the other. And as is the case with 9 
regular stencils, clicking CLR does not clear the stenciled area — a 
it is protected until you turn it off, just like the fixed background. 

Painting a Stencil A more powerful way to define a stencil by area is to "paint" it. 
You can do this with DeluxePaint IV's Stencil>Paint option. 
Painting a stencil can be invaluable for protecting areas that are 
not easily defined by color. In the next few steps we'll show you 
how to "cookie-cut" an area of your image to create the first of 
the two logos in the StencilSet image. 

► At this point you should still be working with the StencilSet 
picture from the exercise above. If you still have Fixed Back 
ground active from the previous exercise, choose 
Background>Free from the Effect menu. 

^ Choose Stencil>Make from the Effect menu. Click Clear and 
Make in the requester to clear your stencil. 
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When you use Stencil Paint, you can either add to an existing 
color-based stencil or you can start from scratch. When you 
choose this option, DeluxePaint calculates the stencil based on 
the colors that are selected in the Make Stencil requester and 
then presents you with a screen that you can use to add or sub¬ 
tract areas from. So, to start from scratch, you need to clear the 
Make Stencil requester as we did above. 

In the next few steps, you'll pick up a brush to paint in the stencil 
with and turn on Stencil Paint to paint down your stencil. Then 
you'll reverse the stencil and pick up a new brush. 

Click the Brush Selector tool and pick up the red, yellow, and 
green logo as a custom brush. 

^ Choose Stencil>Paint from the Effect menu. 

In a moment, your image is dimmed and a lower-case "$" ap¬ 
pears in the Menu Bar to show that you are in Stencil Paint 
mode. 

Move your brush over to the mountain range so that the 
sunrise is in the lower part of the circle and click with the 
left mouse button. 

Painting with the left mouse button adds to the stencil (which 
you see as lighter colors) and painting with the right mouse but¬ 
ton subtracts from the stencil. By clicking down your brush, you 
created a stenciled area that is the shape of the brush. Now you'll 
exit Stencil Paint and reverse the stencil. 

Choose Stencil>Paint to turn off the mode and create your 
stencil. 

It's important to correctly turn off the Stencil Paint mode the 
same way you entered it. If you try to use other options while 
in Stencil Paint, DeluxePaint may turn off the mode for you, 
but there is no guarantee that in those instances it will save the 
changes to the stencil. If you think you'll be using this feature a 
lot, you should get used to the keyboard equivalent: Ctrl-s. 

► Choose Stencil>Reverse to reverse your stencil so that all 
areas except the logo-shaped area of the mountain range is 
protected. 

Choose the Brush Selector tool. Pick up the mountain range 
as a brush. And press the ' (accent grave) key to turn off the 
stencil. 
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Stencils in HAM 

Now you should be holding a brush like the first of the logos in 
the StencilSet. 

With a little creativity, you can combine Stencil Paint and the 
new gradient fills we showed you earlier in the chapter to create 
some stunning effects. 

When you're working in HAM, Stencil requester is a 
bit different from the one you see modes. This requester 
doesn't attempt to show you which dftfie 4096 possible colors 
you have locked. Instead, it gives you powerful ways to lock 
colors individually or based on a tolerance level. It then lets you 
view' the stencil as you would by choosing Slencil>Show. In the 
next pages we'll take a quick look at the features of the Make 
Stencil requester in HAM mode. 

❖ Due to the heavy computational and memory requirements 
of the Make Stencil option in HAM, this feature will be some¬ 
what slow on lower-end Amigos, ffyotirAiniga has no more 
than 1MB of RAM or 512K of Chip-SAKl, recommend that 
you use the Stencil>Paint feature to create pencils in HAM. 
However, if you are patient, you might want to work through 
this section; it might be just the tKiny for you. 

Before we begin: 

► Choose Screen Format from the File menu and change your 
screen format to Lo-Res 320x200 HAM. 

► If you don't already have the StencilSet picture loaded, load it 
now and choose NO to converting to the screen format of the 
file. 

► Choose Stencil>Make from the Effect menu. You'11 see a 
Make Stencil requester like the one in Figure 4.18. 

Make S tenci 1 

Clear Invert | Show Fine Tune| 

Make Tolerance: ZM Cancel 

figure 4.18 Make Stencil requester in HAM 

The Clear, Invert, Make and Cancel buttons in this requester per¬ 
form essentially the same function as they do in the Make Stencil 
requester in other modes. The important new concepts we want 
to show you are Show, Fine Tune, and Tolerance. 
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The tolerance setting lets you click on a single color in your 
picture and simultaneously lock (or unlock) all "similar" colors 
in the image. The Tolerance number determines how different 
a color can be and still be considered "similar" to the one you 
clicked on. A low Tolerance number requires that the colors be 
very similar, while a high Tolerance number locks colors that 
may be very different from the color you clicked. The range of 
Tolerance values runs from 0 to 48. At 0 tolerance, only colors 
that are identical to the cofet^c^click on will be affected. At 
48 tolerance, all colors wil^^i^cted. 

Tcchnical Note Tolerance is calculated in the RGB cube color space. Each incre¬ 
ment of tolerance represents a change of 1 on any of the RGB 
valuasoi fJhe color you clicked on. 

To tolerance works in a practical application, well use 
it to lock the green colors in the StencilSet image. When you first 
open the Make Stencil requester, Tolerance is set at 4. Well leave 
it at four as we choose our first color. 

Move the cursor down to the bottom of the green grass area 
of the sunset image and click once on the lightest green. 

Clicking on a color with the left mouse button tells DeluxePaint 
that you want to lock that color. Notice that the color appears in 
a box beside the Tolerance option, and a black "lock" bracket 
appears beside the color to show that you have locked it. You 
could click Make to exit the requester with your stencil, but in¬ 
stead, well use the Show button to confirm that we locked the 
colors we wanted. 

^ Click the SHOW button to show your stencil. 

After a moment of calculations, DeluxePaint will dim your im¬ 
age and show your stencil as lighter areas in the image just as if 
you had chosen Show from the Stencil submenu. Youll see that 
many more greens than the one you clicked on are stenciled. 
But not all greens are stenciled, because your tolerance was set 
to only 4. You'll also see that part of the green triangle from the 
Electronic Arts logo and the green of the trees is also stenciled. 

Now suppose that you actually wanted to select more greens 
than the ones that were stenciled in this first attempt. You can 
do this in two ways: either click on another green that is not 
stenciled to lock it and all colors similar to it; or increase the 
Tolerance setting. Let's try the latter method now: 
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^ Click in the Tolerance edit field and change the number to 8. 

Fine Tuning the Stencil 

^ Click SHOW once to turn off the option, and when the image 

has updated and the requester reappears, click Show again 

to recalculate your stencil with the new Tolerance setting and 

show it. 

Now you'll see that two thirds of the greens are selected in your 

image. 

❖ If you need to select a large area of your image quickly, high 

tolerance numbers can help you a lot. However, to get that 

help you sacrifice some control over which colors get sten¬ 

ciled. Of course, you can always go back and adjust the 

stencil with the Fine Tune option as you'll see below. 

Now that you've seen how to add to the stencil and use the Tol¬ 

erance setting, we'll take a quick look at fine tuning the stencil. 

We're going to use Fine Tune to subtract a color from your sten¬ 

cil, but you can also use Fine Tune to add colors to the stencil. 

^ Click the Fine Tune option to turn it on. 

^ Move the cursor over to the middle of the stenciled grass and 

click with the right mouse button to subtract a color. 

^ Click SHOW once to turn off the option. Click SHOW again 

to recalculate and show your stencil with the color removed. 

Fine Tune lets you add or subtract single colors from your locked 

set without having to change the Tolerance level. Fine Tune al¬ 

ways adds or subtracts only the color you click on, though you 

are certainly welcome to click on whatever colors you like. 
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T&& DeluxePaint's powerful Perspective mode. 
jjgfU paint in three dimensions, which can give your 

pkiu^&lfMf? fwlitig of depth. Perspective is a complex feature, so we 
you become familiar with the program before 

‘yCHi lWHixx#ink? ik& area. \Ne've tried to make this explanation as clear 
s&possible; hfti be tosvare that the steps we list assume that you under- 

:$tmd olhirprOgtUtnfea tures. 

Three-Dimensional 

Model 

When you paint in Perspective mode, you are working with a 
three-dimensional representation of the two-dimensional space 
that is available on your screen. To visualize this model it might 
help to dftkik of your computer screen as the front side of a box;. 

Figure 5.1 
The 3D Space and Screen 
Coordinate System 

Usually, when you paint, the mouse moves your brush in only 
two directions: horizontally and vertically. But when you move 
and rotate your brush in Perspective mode, you add a third di¬ 
rection to the motion: backward and forward. To move the brush 
into the distance or towards you, you'll move it on the Z axis of 
the coordinate system shown above. 

You'll learn more about the coordinate system later in this chap¬ 
ter. For now, just remember that in it's default settings, the screen 
coordinates operate as shown in Figure 5.1; the X axis runs hori¬ 
zontally across the screen, the Y axis runs vertically, and the Z 
axis runs backward into the screen. 

Rotating a ^ 
in 3D Spacif 

The key to working in Perspective is rotating the brush. In this 
brief section, we'll show you how to rotate your brush using the 
numeric keypad. Before you begin, you need a brush to rotate. 

^ Load the Dolphin brush from the Artldisk 
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If you are NOT in I1AM, choose Palette>Use Brush Palette 
from the Color menu. If you are in HAM, move to the next 

can enter Perspective mode, 

from the Effect menu, to enter the 

A small cross hair appears in the middle of the screen to indicate 
the Perspective Center (or line of view), and your brush is en¬ 
closed in a wire-frame with a large cross hair over it. In our ex¬ 
ample, you will also see three zeros on the right half of the Title 
Bar. These indicate the current rotation angles of the brush. The 
numbers are all zeros because we haven't rotated the brush yet. 

After wush, you 

i*i m 
► Cmr^jp^tive> I )o 

Figure 5.2 Screen in Perspective Mode 

The cross hair on your brush makes any brush rotations easier 
to see, and it will help you position the brush when it changes 
sizes. An important feature of the cross hair is that it indicates 
the X and Y axes of the brush. The Z axis of the brush runs per¬ 
pendicular to the other two axes, just like the screen's Z axis. 
Figure 5.3 shows the Brush axis system. 

Figure 5.3 
Brush cross hair 
and coordinate system 
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JVTfcrfttfate the brush, use the numer|fc;$^^W on the right side of 
y&m keyboard. Figure 5.4 shows ho^f-i^h of the keys rotates the 

❖ All numerical keystrokes in Perspective mode refer to the 
numeric keypad You'll use the keypad to rotate images. Some¬ 
times you'll use the Shift key in combination with the keypad 
to rotate an object a fixed number of degrees (more about this 
in Angle Step, below). 

-1’ +lw reset 

place center 

FillScreen 
Figure 5.4 
Brush rotations 
mapped to the keypad 

We'll try each of the rotations in the next few steps so you get a 
feel for moving in 3D. Well start off with the simplest rotation, 
that is, a rotation on the Z axis with the brush in its normal 0,0,0 
orientation. This is the simplest rotation, because no part of the 
brush moves off the plane of your computer screen. 

Hold down 2 on the keypad for about 5 seconds. 

The Dolphin disappears and the wire frame rotates clockwise on 
its center (the position of the pointer). Notice that the third num¬ 
ber along the right side of the Title Bar has increased as the rota¬ 
tion angles increased. Figure 5.5 illustrates rotation on the Z axis. 

^ Press 1 repeatedly until the numbers along the right side of 
the Title Bar show 0,0,0 as the brush rotation. 

When the brush is back to the 0, 0,0 position, the Dolphin reap¬ 
pears inside the frame. This is a handy visual cue that the brush 
is at it's original orientation. Later, when you begin moving the 
brush in three-dimensional space, you'll see that the same rule 
applies to movement — if the brush is back on it's original plane 
it reappears inside the frame. 
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❖ Displaying the brush is dependent on memory availability; 
your brush may not appear even when in its original orien¬ 
tation if it is large or memory availability is low. 

Figure 5.5 Brush Rotation on Z Axis 

Rotating on the other axes works just like rotating on Z, but 
when you rotate on the other axes, the brush moves off the plane 
of the screen and into the third dimension. Let's see how this 
works by rotating on X. 

^ Move {don't drag) the brush to the lower left corner of the 
screen. Hold down 7 on the keypad. 

When the brush frame has rotated to about -45°, release the 
7 key, and click to paint the brush. 

As you rotate the brush on the X axis, it appears as though the 
top half of the brush is turning into the screen and the bottom 
half is turning outward. As a result, your painted brush is set at 
an angle to the screen as shown in Figure 5.6. 

Figure 5.6 
Brush Rotation 
on the X Axis 
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Resetting the Brush Rotation 

The Angle Step 

Rotation around the Handle 

► To return your brush to its original orientation, press 0. 

The last step introduced an important keystroke. Any time you 
need to reset the brush to its original orientation of 0,0,0, press 0 
on the keypadr get lost in the world of 3D, you can always 
get back to the l^toing with this simple keystroke. 

To rotate on the you use 4 and 5 on the keypad. This time 
we'll use the Shift key to rotate by a larger increment, automati¬ 
cally. 

Move your brush to the lower right corner of the screen. 1 lold 
down the Shift key and press 4 on the keypad. Your brush 
instantly rotates -90° on the Y axis. Click to paint the brush. 

Press 0 on the keypad to return the brush to its original ori¬ 
entation. 

When you use the Shift key with one of the keypad keys, the 
brush rotates by the Angle Step. The default Angle Step is 90#, 
but you can change it to any angle you like in the Perspective 
requester. 

Choose Perspective>Settings from the Effect menu to display 
this requester, or right-click on the Grid tool while you are in 
Perspective mode. 

Perspective 

Grid: mi 
FroM brush 

Angle Step: 

Type: Screen Brush 

Display: An&le Pos 

Cancel Ok 

Figure 5.7 
Perspective 
requester 

When using perspective, 90 degrees is the most common angle, 
so leave it there for now. 

Click Ok to return to the painting screen 

When you rotate a brush in Perspective, the rotation always 
occurs around the brush handle. In the preceding examples, the 
brush was held by the center (the default position), so the rota¬ 
tions always occurred around the center Ok the brush. Let's look 
at the difference between rotation around the center and rotation 
around the corner of the brush. 
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Screen Verses Brush 
Coordinates 

Information 

Click CUR to clear the screen. Position the brush 
middle of the screen. Hold down the Shift key and 
on the keypad to rotate 90°on the Z axis. Press Shi ft-2 
three more times to set the brush back to 0,0,0. 

You've seen this rotation before, but we had you repeat it to 
compare this with rotation around the corner of the brush. 

^ Keep the brush in the same location. Press Alt-x on the 
keyboard. 

This moves the brush so that it is held by the lower right corner. 
Note the position of the arrow cursor. You can also do this by 
choosing Handle>Comer from the Brush menu. 

Press Shift-2 to rotate the brush around the new handle 
position. 

Figure 5.8 illustrates the difference between rotation around the 
center and rotation about the corner. 

Figure 5.8 Rotating a brush with the handle at the 
center and at the corner of the brush 

So far in our discussion of brush rotations, we've always rotated 
the brush on one of the two possible coordinate systems. If you 
look back to Figure 5.7, you'll see that below Angle Step in the 
Perspective requester there is an item labeled Type with two but¬ 
tons: Screen and Brush. We've been rotating in the Screen coordi¬ 
nate system. In the next few steps, we'll demonstrate the differ¬ 
ence between the two rotation systems. 

□ If you are familiar with rotation systems, you'll recognize that 
this Screen coordinate system is based on Euler angles. 
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Before beginning this brief example, make sure your screen is 

clear. When it is: 

► Choose HancUe>Center from the Brush menu; and press 0 to 

reset your brush to it's original orientation. 

To make this example clearer, it will help if the Angle Step is set 

to something other than 90°. In the next step we'll have you 

change it to 45°. 

Choose Perspective>Settings from the Effect menu (or right- 

click the Grid icon), to display the Perspective requester. 

^ Click in the right side of the Angle Step edit field, backspace 

to erase the 90 setting and type 4 5. Click Ok to close the re¬ 

quester and use the new setting. 

Now let's try a rotation in the screen coordinate system: 

Position your brush in the lower left comer of the screen. 

Press Shi ft-2 to rotate 45° on the Z axis. Now press Shif t- 

7 to rotate -45 on the X axis. 

Click to paint the brush down. 

Notice that when you rotated the brush on the X axis, the 

Screen's axis was used. The brush's X axis was tilted sideways, 

but the brush still rotated backward into the screen. Also notice 

that the rotation angles appear in the Title Bar. 

Figure 5.9 Rotating the brush 45c on Z and X in Screen coordinates 

Now we'll change the setting to Brush angles and do the same 

rotation to see the difference. 

^ Right-click the Grid tool to display the Perspective requester. 

Click the button labeled Brush and click Ok. 

^ Press 0 to reset your brush to its original orientation. 
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b Position the brush in the lower right corner of the screen. 
Press Shi f t -2 to rotate 45" on the Z axis. Now' press 
Shi ft-7 to rotate-45* on the X axis. 

b- Click to paint the brush down. 

In the Brush coordinates system, rotations always take place 
about the brush axes, regardless of the current orientation of the 
brush. In this example, the X axis was positioned diagonally after 
you rotated 45° on the Z axis; as a result, the brush rotated on 
the diagonal axis instead of rotating straight backward into the 
screen. 

at the angles shown in the Ti 
rotated. The Title Bar always 

•gcreen coordinate system. 
[ish rotation by switching to 
'ts indicated in the Title Bar. 

Figure 5.10 
Rotating the brush 45* on Z 
and X in Brush coordinates 

DeluxePaint offers both Screen and Brush coordinate systems for 
rotation, because each of the systems has unique merits: 

The Screen coordinates often consistent with the no¬ 
tion of the three screen coc^^lf^ defining the 3D space. More 
importantly, the Screen coordinates system is reproducible: you 
can jot down the rotation numbers in the Menu Bar and repro¬ 
duce the same brush orientation simply to the same 
angles. The results of multiple rotations ai|l||^ame no matter 
what order you rotate in. ' '■■ 

The Brush coordinates system is usually easier to visualize if 
you are rotating at angles other than 90°. So you can usually 
produce the desired brush orientation without much difficulty. 
Unfortunately, the cumulative effect of separate rotations on the 
brush axes are not reproducible unless you make the exact same 
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Moving in 3D Space 

Moving on the Z axis 

rotations in the exact same order. You'll notice that the angles 

given in the Menu Bar when you rotate using the Brush coordi¬ 

nates are actually the angles for the Screen coordinates system; 

this is so you will be able to reproduce your brush rotation, 

though you will have to use Screen angles to do it. 

Now that you've seen how to rotate your brush in three dimen¬ 

sions, the next section will show you the ins and outs of moving 

a brush around in all three dimensions. 

Before you begin this section clear the screen. 

^ Choose Perspective>Reset from the Effect menu to reset all 

perspective settings, including Angle Type, to their defaults. 

^ Load the brush named Blockbrush from the Artl disk. 

Choose Palette>Use Brush Palette from the Color menu. 

^ Make sure you are in Perspective mode. 

When your brush is in its original orientation (0, 0, 0), moving 

your mouse moves your brush along the X and Y axes. Try it 

right now: 

^ Move your mouse forward and watch how your brush moves 

up on the screen. Move your mouse backward and your 

brush moves down on the screen. Likewise, moving the 

mouse left or right moves the brush left or right. 

Because your mouse can move in only two dimensions (the third 

direction would require you to lift it off the desk), it can move 

your brush in only two directions. You can move your brush in 

the third dimension by using the keyboard. One method is to 

move the brush straight back along the Z axis only: 

^ Position your brush in the lower left corner of the screen, 

hold down the Shift key and press the quote key (") several 

times. 

Each time you press Shift-", the brush moves backward along the 

Z axis. It appears as though the brush is getting smaller, but in 

fact it is moving away from the front of the screen. To move the 

brush forward along the Z axis, you use the colon key(:). 

^ Hold down the Shift key and press the colon key (:) once. 
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3D Coordinates 

Laying Down the 
Brush to Move in 3D 

Notice that the " and : keys move the brush toward and away 

from the cross hair in the middle of the screen. This cross hair de¬ 

fines the Perspective Center, which is best thought of as the point 

of view. No matter where you place the brush on the screen, if 

you move the brush using the quote key, the brush will move 

into the distance and toward the Perspective Center. 

When you use Perspective, you'll often want to move your brush 

backwards and left and right along a plane. The effect is of a 

brush moving across the floor. DeluxePaint lets you do this by 

holding down the Ctrl key while in Perspective. 

^ Press 0 to reset your brush to its original orientation. 

^ Position the brush near the bottom of the screen, hold down 

the Ctrl key and move your mouse forward and backward. 

With the Ctrl key held down, the brush moves away along the Z 

axis when you move the mouse forward. In this way, you can 

easily move in the X and Z axes instead of the usual X and Y 

axes. 

DeluxePaint IV lets you see the position of your brush in three 

dimensional space when you are in Perspective mode. This is 

useful if you need to align your brush precisely. 

^ Press the \ key and look at what happens to the angles in the 

right side of the Title Bar. Now hold down the Ctrl key and 

move the mouse forward and backward. 

Pressing the \ key toggles the Display option in the Perspective 

requester between Angle and Pos (position) (see Figure 5.7). 

^ Press the \ key again to return to displaying angles in the 

Title Bar. 

Another way to move into the distance is to lay the brush down 

and then move it on its own Y axis. Rotating the brush 90° on its 

X axis makes the brush's Y axis act like the screen's Z axis. Figure 

5.11 shows what happens to the different axes during perspective 

rotation. 
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Perspective Plane 

Brush's original Y axis 

Figure 5.11 Brush coordinate system before and after rotation 

Let's try it once to see how it works. 

Press 0 to reset the brush to its original orientation and 
position the brush in the lower left corner of the screen. 

^ Press Shift-7 to flop the brush down into the screen. 
Now move the mouse around. 

You will quickly discover that moving the mouse forward and 
backward moves the brush into the screen and back out instead 
of up and down. This is because the mouse moves the brush on 
the plane defined by the brush's X and Y coordinates. 

► Move the brush to any new position and press Shi ft - 8 to 
turn it back up on end. Paint the brush down. 

Use the combination of Shift-7 and Shift-8 several times until 
you are comfortable with how these keys help you move in 
the third dimension. 

You might have noticed that when you flopped the brush down 
by rotating on it's X axis, the brush moved on a plane below the 
Perspective Center. Remember that when the brush is in its ori¬ 
ginal 0,0,0 orientation, it moves on a plane that is roughly the 
equivalent of the computer screen. When you rotate the brush, 
you change the orientation of the plane. The plane can be at al¬ 
most any angle to Perspective Center. The easiest way to see this 
is to fill the perspective plane you've defined. 
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The Perspective Horizon 

^ Press 0 to reset 
cursor is at the 

► Press Shi ft-7 

* Choose 
watch as 
tern of your 

so that your 

menu and 
with a pat- 

The results of this last step should look something like Figure 
5.12. 

Figure 5.12 Perspective plane painted using Perspective^ illScreen 

As we said, you can set your perspective plane at almost any 
angle to the Perspective Center. In the next step, we'll draw a 
plane to the right of center with the brush rotated sideways. This 
will create a "wall" on the right. 

► Press 0 to reset your brush to it's original orientation. Place 
the brush in the lower right corner of the screen. 

► Press Shi ft-4 to turn the brush into the screen. 

► Choose PerspectivoFillScreen from the Effect menu. 

Practice creating different planes. For example, position the 
brush above perspective center to create a "ceiling" from your 
brush. 

The position of perspective center plays an important role in de¬ 
termining the angle of the plane to the viewer. It also determines 
the horizon point. The horizon point is the farthest edge of the 
plane when you rotate a brush to 90°. To demonstrate how this 
works, we'll load a picture that has a horizon, and fill the plane 
out to the horizon. 
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The Angle of the Platte 

► Load the picture Seascape from the Art l disk and choose 
Palette>Default Palette from the Color menu. 

You might remember this picture .tom th$Qtf£ed Tour. In the 
picture, the ocean stretches to a flat hotizen on the right side. 
We'll set ou|?J^[|pective Center ii\ horizon and 
then fill a p|^^^|ve plane. 

^ Choose &^iktive>Center ft^i^'Bffertmenu. Your cur¬ 
sor changes to a large cross hair. 

Position the cross hair so that it is half way across the screen 
and so the horizontal line of the cross hair lines up with ex¬ 
actly the horizon in the picture. Click to place the perspective 
center. 

► Now, load your Blockbrush brush, and enter Perspective 
mode. 

► Press Shift-7 to rotate your brush -90*. 

► Choose Perspective>FillScreen from the Effect menu to fill 
the perspective plane. 

When you are finished, your screen should look like Figure 5.13. 
Notice that the horizon of your perspective plane exactly 
matches the horizon of the original picture. 

Figure 5.13 Seascape with a perspective plane added 

In the example above, the perspective plane matches the horizon 
because you rotated the brush by 90*. If you had rotated by more 
than 90* the plane would not reach the horizon, as though the 
plane sloped downward. If you had rotated by less than 90°, the 
plane would extend above the horizon, as though it sloped up¬ 
ward like a mountain. It is difficult to see the differences unless 
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you have an existing horizon to compare the plane with. Without 
an existing horizon, the sloping of the plane will appear to be 
only a difference in the distance between the position of the 
brush and the perspective center when the brush was rotated. 

When you create a perspective plane, the position and angle of 
the plane are determined by three things: 

the position of the Perspective Center; 

the position of the brush handle (cursor) when you rotate the 
brush; 

□ and the degree of rotation. 

In our examples above, we rotated the brush in 90* increments so 
the plane was always either parallel to our point of view or at a 
right angle. If you want to create a sloping surface, you do so by 
rotating the brush to an angle less than 90°. Here's a quick ex¬ 
ample. 

^ Choose PerspectivoReset from the Effect menu. 

Position your brush so that the cursor is at the very bottom of 
the screen. Hold down 7 on the keypad until the brush has 
rotated -60° on the X axis. 

^ Move the mouse forward and backward to see how the brush 
moves on this new plane. 

You'll notice that the vanishing point of the brush is above the 
horizon in your picture, this is because the plane is not parallel to 
the point of view. It is as though you were looking at a gradual 
incline. 

Putting Things in 
Perspective 

We've covered the fundamentals of perspective. Now it's time to 
put what you've learned into practice. In this exercise, we'll cre¬ 
ate a perspective landscape and build a three dimensional arch 
as shown in Figure 5.14. In the process, you'll learn some of the 
tricks about using perspective that you can understand only 
when you see them in context. 

120 Chapter 5 DeluxePaint IV 

$
 #

 



Creating the Plane 

Figure 5.14 Seascape with Arch 

The first step of our tutorial is to create a perspective plane. You 
don't need to create a plane every time you use perspective. 
We're doing it here, so you can readily see the "depth" of your 
picture. 

^ Load the Block brush from the Artl disk. 

Notice that this brush is held by the lower right corner. If you ex¬ 
pect to use a brush in Perspective, it is best to save the brush with 
the handle in the lower right corner for two reasons: 

1. Rotations always occur around the handle, so holding the 
brush in the corner helps make the rotations consistent and 
useful. 

2. If you establish a Perspective grid, you can make all of your 
brushes conform to that grid if their handles are in the same 
corner. 

Choose Coords (short for Coordinates) from the Prefs menu. 

Press the Enter key to enter Perspective mode. 

Position the cursor at 196, 25 and press G, which turns on the 
grid and uses 196, 25 as one of the grid points. 

❖ If you turn on Coordinates and take note of the cursor posi¬ 
tion before you rotate your brush, you'll be able to recreate 
the perspective plane exactly. 

Press Shi ft-7 to rotate the brush -90° on X. 

121 Working with Perspective DeluxePaint tV 



Building the Arch 

Notice that at this point you don't have angles in your Title Bar. 

You can turn off Coordinates if you want to see the angles, but 

you don't need them for this exercise, since all of our movements 

are on 90° and based on sight, not numbers. 

Choose Perspective>FillScreen from the Effect menu. 

Load the RedBlock brush. 

At this point you are no longer in Perspective mode, but the Grid 

is still on. 

Press the Enter key to enter Perspective mode. 

Your brush is automatically laid down on the perspective plane 

in the same orientation you left it in last (that is, rotated -90* on 

the X axis). This is an important point to remember, because it 

means that you can easily bring in new brushes at the right 

perspective simply by loading them with the perspective plane 

defined by the previous brush. 

❖ You'll notice that the grid has been adjusted to your new 

brush size. It is not necessarily true that your new brush will 

line up correctly with the grid point you used to define the 

plane (196, 25), because the brush handle is tied to the closest 

grid point when you enter perspective, and there is a three- 

in-four chance that it will be tied to one of the other corners. 

If you want the brush to line up with the grid point you 

specified when you created the grid, press 0 to reset the 

brush to 0, 0, 0 orientation, align the handle with the grid 

point, and rotate the brush again. 

If you don't want your perspective grid automatically sized to 

new brushes, turn off the AutoGrid option in the Prefs menu. 

► Press G to turn off the Grid so you can move the brush freely 

on the plane. 

► Position the brush so that the Y axis of the brush is aligned 

with the Perspective Center and the bottom of the brush is 

aligned with the edge of the second full row of tile on the 

floor. (The coordinates will show this point as 175, 46.) 

► Press G to turn on the grid and use your new handle position 

as one of the grid points. 

► Press Shi ft-8 to rotate the brush up on the Xaxis. Move the 

brush two grid points to the left and stamp it down. Paint the 
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brush three times above the current brush position so you 
create the face of a column. 

► Paint the brush four times to the right to form the top of the 
arch and the top of the right column. Then paint the brush 
three times down to form the right column. 

At this point you have a two dimensional arch on a three dimen¬ 
sional plane. Our next task is to give the arch a third dimension. 

► Move the brush so that it is directly on the bottom block of 
the left column of your arch. Press Shi ft-4 to rotate the 
brush 90" on the y axis. Paint the batsh where it is and twice 
above to form the left side of the column. 

Move the mouse a bit to the right to move the brush back 
along its x axis and paint another set of blocks so your col¬ 
umn is one block wide at the face and two blocks deep as 
shown in Figure 5.14. 

Press Shi ft-5 to rotate the brush back on its Y axis so that it 
is facing you head on. If the brush is not the same size as the 
facing blocks of your arch, hold down the Ctrl key and move 
the mouse forward or backward to bring it closer or move it 
back. 

❖ Remember, the Ctrl key temporarily fixes the Y axis of your 
brush so that you can move it on it's Z axis. As you become 
adept at painting in Perspective, you'll find yourself using 
this key often. 

^ Position the brush to the left of the bottom block of the right 
column. Press Al t-x to change the brush handle to the other 
side of the brush. 

Your brush jumps so that it is over the bottom block of the right 
column, but the brush is now held by the lower left corner. Re 
member that Alt-x, Alt-y, and Alt-s reposition your brush handle. 
These keyboard equivalents are especially useful while working 
in Perspective, since you usually don't want to move your 
mouse to choose from a menu. 

^ Press Shift-5 to rotate the brush 90°on the Y axis. Paint the 
brush w here it is and twice above to form the left side of the 
column. Paint another column just behind this first one so 
your column is one block wide at the face and tw'O blocks 
deep. 

Press Shi ft-4 to rotate the brush back on the Y axis. If the 
brush is not the same size as the facing blocks of your arch, 
hold down the Ctrl key and move the mouse forward or 
backward to bring it closer or move it back. 
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Inserting the 
Seascape Picture 

Move the brush up so that it is over the block in the upper 
left corner of the arch. Press Shi f t -7 to rotate the brush -90° 
on the X axis. Move the brush to the right and stamp it once 
below each of the three blocks that form the top of the arch. 
Paint another row just behind this first row so the top of your 
arch is one block high and two blocks deep. 

Now your arch is complete and should look just like the arch in 
Figure 5.14. 

To give your perspective painting a bit more color, and a land¬ 
scape for the background, we'll load the Seascape picture and 
add it behind the arch. 

Choose Spare>Swap from the Picture menu to display the 
spare page 

Load the Seascape picture from the Picture drawer on your 
Artl disk. Choose Palette>L)efault Palette from the Color 
menu. 

► Jump back to your main page (press j or choose Spare>Swap 
from the Picture menu). 

► Choose Spare>Merge in back from the Picture menu. 

In a flash, your arch has a nice seascape backdrop. 

This exercise gave you a quick example of perspective, but you 
can do a lot more. For an excellent example of perspective at 
work, load the picture Hall-of-Stars on your Artl disk. 
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Before You Begin 

The Basic Model 

This chapter introduces you to DeluxePainl IV's animation features. 
It begins by explaining the basic model for animation and then covers 
each of the different ways to create animations with the program. We 
recommend that you work through this chapter in one sitting. It will 
take you approximately 45 minutes to complete. 

If you've been experimenting with DeluxePaint for a while be¬ 
fore starting this chapter, it would be a good idea to quit the 
program and restart. If you start the program fresh, there is less 
chance that the results you get from following our instructions 
will be different from what we describe. 

When the Choose Screen Format requester appears, click Ok 
to use the default settings (Lo-Res, 320x200, and 32 colors). 

❖ If your computer has only 1 MB of RAM, we recommend that 
you load the program in Swap mode. 

The basic idea behind animation in DeluxePaint is that instead of 
having a single page to paint on, you have multiple pages that 
you can paint on and flip through. By creating images that differ 
slightly from page to page and then playing them back in rapid 
succession, you create the illusion of motion. 

Figure 6.1 The Basic Model 

This section shows you how to: 

create frames for your animation 

paint on individual frames in the animation 

paint while the frames are flipping—this is called 
Animpainting™. 

□ use the Animation Control Panel 
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Creating Frames 

Painting One 
Frame at a Time 

The first step in building an animation is to create the frames to 
paint on. 

^ Choose Frames>Set # from the Anim menu. The Set Frame 
Count requester appears. 

Figure 6.2 
The Set Frame Count requester 

► Click in the Count edit box, change the frame count to 10 and 
click Ok. 

You now have 10 frames to paint on. Notice the numbers 1/10 at 
the left side of the Title Bar. This means you are positioned on the 
first frame of a 10 frame animation. 

The most basic way to create an animation is to paint on each 
successive frame individually. 

^ Select the largest round built in brush and paint a dot in the 
upper left area of your screen. 

The dot you just placed is on frame 1. The trick of animation in 
DeluxePaint is to paint a slightly different picture on successive 
frames. So you need to move to the next frame. 

^ Choose Control>Next from the Anim menu to move to frame 
2. (Notice the Title Bar shows 2/10.) Click another dot to the 
right of where your first dot was. 

Now you have a dot on frame 1 and a dot on frame 2. To create a 
series of dots that move across the screen, you just repeat the last 
step. You'll notice that changing frames from the menu is a little 
cumbersome, and it forces you to move the mouse from the 
painting area. It's much more efficient to move through the ani¬ 
mation frames by using the keyboard equivalents (listed in the 
menu beside the options). Follow the numbered steps below and 
we'll use keyboard equivalents to complete and play our little 
animation. 

1. Position your brush just to the right of the dot you painted on 
frame 2. 

2. Press 2 on the keyboard once, then click to paint a new dot. 
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Animation 
Control Panel 

Frame Slider 

3. Repeat step 2, painting each dot to the right of the previous 
one, until your first dot appears again in the left side of the 
screen. (The Title Bar will show 1/10 as your frame position.) 

You've just created a brief animation. Now let's play it. 

4. Choose Control>Play from the Anim menu (or press 4 at the 
top of the keyboard). You should see your dot moving from 
left to right across the screen. 

m•••••••••••« 
Figure 6.3 A simple dot animation 

5. To stop the animation, press the space bar. 

Selecting animation options from the Anim menu or using key¬ 
board equivalents for those commands are only two of the ways 
DeluxePaint has for controlling your animations. Those two 
methods are handy, but perhaps the most efficient way to control 
your animation is through the Animation Control Panel. 

^ Select Control>Panel On from the Anim menu. 

pi 
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Figure 6. 4 Anim Control Panel 

The Animation Control Panel appears at the bottom of the 
screen. It's useful to have it visible while you work on your ani¬ 
mation sequence. If you want to remove it while you're animat¬ 
ing, choose Control>Panel Off from the Anim menu. 

The Control Panel presents Frame slider and scroll arrows, and 
fifteen control buttons for working through and playing with 
your animation. 

The Frame slider helps you keep track of where you are in your 
animation sequence, when you've hidden the Title Bar. Even 
when the Title Bar is showing you can move to a specific frame 
by dragging the slider or by clicking on it. One click moves the 
animation one frame. Clicking on the scroll arrows will take you 
to the first (left-arrow) or last (right-arrow) frame. 
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Atiim Control Buttons 

Play Backward 
Continuously 

Play your animation sequence in a continuous Icc^fooni' 
frame to first frame. Press the space bar or click 

Play Backivard Once _u Click to play through your animation sequence cgre Hmey 
the last frame to frame 1. Animation ends on the -Jfraapg;: 

Previous Frame 

m 

Click to move backward one frame. Steps from the current frame 
to the previous frame in the animation sequence. If the current 
frame is the first frame in the sequence, the position is set to the 
last frame. 

Next Frame JLl Click to move forward one frame. Steps the current frame to the 
next frame in the animation sequence. If the current frame is the 
last frame in the sequence, the position is set to the first frame. 

Play Forward Once _LJ Click to play through your animation sequence one time, from 
Frame 1 to the last frame. Animation ends on the last frame. 

Play Fonvard 
Continuously 

daj Play your animation sequence in a continuous loop, from first 
frame to last frame. Press the space bar or click to stop play. 

Play Ping-Pong JU Plays your animation sequence continuously as above, but plays 
the sequence forward then backward then forward and so on. 
Press the space bar or click to stop play. 

Add a Frame U Adds a frame after the current frame, and copies the contents of 
the current frame to it. 

Delete a Frame m Deletes the current frame and makes the following frame the 
current frame (unless you're already at the last frame). 

You can't UNDO a delete command, so DeluxePaint asks you to 
confirm that you really want to delete a frame. 

Go To Frame Takes you to the frame specified in the Go To Frame requester. 
Holding down the Ctrl key when clicking this icon brings up the 
Go To Frame requester. 

_£J ❖ The LightTable and the four associated icons on the right side 
of the Control Panel will be described later in this chapter. 
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Painting with 
Animation 

You saw above that one way to create an animation in Deluxe- 
Paint is to paint on a series of frames individually. For creating 
animations that involve simple movement of an object, Deluxe- 
Paint provides a much easier method called animpainting. 
Essentially, the frames flip automatically while you paint. 

Click CLR in the Toolbox. The Clear requester appears. 

Clean 

Current Fnane | 

Range | : to 

All Fnanes | 

Figure 6.5 Clear requester 

When you click CLR with multiple frames, DeluxePaint gives 
you the option of clearing only the current frame, a range of 
frames in your animation, or all frames 

► Click All Frames in the requester. 

In a moment all of your frames are cleared and you are auto¬ 
matically set back at frame 1. Now let's do some animpainting. 

^ Select the large round brush, and the Dotted Freehand tool. 

^ Hold down the Alt key, and paint by holding down the left 
mouse button and dragging across the screen from left to 
right. 

As you paint, the frames flip automatically, so you place only 
r^t^^kiot on each frame of your animation. Notice that the frame 
tl^ip^ter in the Title Bar changes to show what frame you are on. 

reach the last frame, you loop back to frame 1, where 
you'^^ur first dot again. 

The is your animpainting key. If you hold down the Alt 
key at the time you press the mouse button down, the animation 
frames will flip with each stamp of the brush so that you stamp 
only once on each frame. Remember that you only need to hold 
down the Alt key as you press the mouse button down. Then 
you can release Alt to press other keys if you need to. 

After you have painted for a few seconds, stop and choose 
Control>Play from the Anim menu or press 4 on the key¬ 
board. 
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You can also use the Animation Control Panel to activate any 
of the commands that are called for in this chapter. 

Press the space bar or click to stop the animation. 

Now you know these basic elements of animation: 

l j How' to create frames. 

I low to move through the frames one by one and paint. 

How to animpaint. 

Animpainting is especially powerful if you have an animated 
brush to paint with; we'll show you how to create and use 
one later in this chapter Right now' we want to show' you 
more ways to move objects on the screen. 

Automatic Animation 
Using the Move 

Requester 

The Move requester lets you automatically move and rotate a 
brush over a number of animation frames. More importantly, 
you can move and rotate the brush in all three dimensions. In 
essence, you are painting using Perspective, but DeluxePaint 
makes all of the calculations for the individual frames. 

This section will take you through a detailed explanation of each 
feature of the Move requester and give examples for most of the 
features. 

► To begin, click CLR and clear All Frames from the previous 
animation sequence. 

► Choose Frames>Set # from the Anim menu. Change the 
frame count to 20, and click OK. 

Press Shi ft-1 to move to frame 1. 

► Load the brush DPaintTitle from the Brush drawer of the Artl 
disk. 

► Choose Palette>Use Brush Palette from the Color menu. 

These instructions assume that your memory method 
(Method in the Anim menu) is set to Compressed—the de¬ 
fault setting. Amigas with one megabyte of RAM can create 
only 9 to 10 frames using the Expanded method. You'll find 
a brief description of the two memory methods in Reference. 
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Simple Moves in 

Three Dimensions 

The Move requester does exactly what its name implies—it 
moves your brush on the screen. There are many impressive 
animations you can create with only the Move requester and a 
brush like our DPaint IV brush, but to create those impressive 
animations, you need to know how each feature of the Move re¬ 
quester works. This brief section explains the most basic Moves. 

^ Stamp your brush in the center of the screen. 

^ Choose Move from the Anim menu. The Move requester 
appears. 

Move 

_J Brash 

✓I Brush 

✓] Cyclic 

Ease-Out: 

Ease-In: 

Count: 

Direction: 
Move Record 

a»i«i 
Preview 1 Trails! Fill Draw 

Cancel Load Save Exit 

Figure 6.6 The Move requester 

The first row in the Move requester lists the three axes (X, Y, and 
Z) in the three dimensional space of your screen. If you are famil¬ 
iar with Perspective you know that these axes run left and right, 
up and down, and in and out from the screen respectively. Figure 
6.7 shows the orientation of the three axes to the screen. 

Figure 6.7 
The three axes 

Directly below the X, Y, Z letters there are edit boxes for entering 
Distance (Dist:) numbers. You enter numbers here to tell Deluxe- 
Paint how far to move your brush in any direction or combina¬ 
tion of directions. (If your brush is moving only on the X and Y 
axes, the numbers are equal to pixels, but once you move along 
the Z axis, the units are either smaller or larger than pixels.) Let's 
look at a simple example: 

133 Animation Basics Deluxe Paint IV 



Simple Rotation 

Click in the Dist edit box below X and set the number to 200. 

Make sure that the Count edit box (in the middle of the re¬ 
quester) shows 20 as the current setting. If the number is not 
20, click in the edit box and change the number. 

Click Preview to see a preview of the movement of your 
brush. 

You will see your brush enclosed in a wire frame move to the 
right across the screen. If you want your brush to move to the 
left, you enter a negative number for the X Distance. Try it. 

^ Set the X Dist edit box to -200. Click Preview. 

This time your brush moves to the left across the screen. A sim¬ 
ilar rule applies to the other two axes: Y Distance moves your 
brush upward if the number is positive and downward if the 
number is negative. Z Distance moves your brush out to the 
distance (away from you) if the number is positive or inward to 
the screen (coming toward you) if the number is negative. 

You can use any combination of the three Dist edit boxes to move 
your brush anywhere in three dimensional space. Try it if you 
like. Set a number for each of the three boxes and click Preview 
to see where the brush would move. 

In addition to moving the brush along an axis or several axes in 
combination, the Move requester lets you rotate the brush 
around one or more axes. You rotate the brush by entering num¬ 
bers in the Angle edit boxes. 

In the Move requester, click Clear, which clears all data from 
the Distance and Angle edit boxes. 

► Click in the Z Angle edit box and enter 360 as the angle of 
rotation. (This tells DeluxePaint that you want to rotate the 
brush 3604 on the Z axis.) Click Preview. 

You'll see a wire frame representation of your brush rotate clock 
wise on the screen. Just as negative numbers change the direction 
of movement when using Distance moves, negative numbers 
change the direction of rotation when you use Angle moves. 

^ Change the Z Angle setting to -360° and click Preview. 

The wire frame rotates counter-clockwise. 
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Brush Check Boxes 

The Go Back Command 

Successive Moves 
without Go Back 

At this point you may be wondering about those two options 
labeled Brush beside the Distance and Angle edit boxes. The 
short answer is that these options determine whether your brush 
moves and rotates based on the screen axes or based on the 
brush axes. The default setting is for the brush to move along the 
screen axes and to rotate around the brush axes. under¬ 
stand this feature, you'll need to be familiar with 
tive, described in Chapter Five, works. We'll expl^iifeBrush 
check boxes in more detail later in this chapter. For now, just 
leave them as they are. 

The Go Back button has a similar function to the Clear button, 
only it affects the location of the brush rather than the settings in 
the Move requester. When you use the Move requester to move 
your brush in three dimensional space, DeluxePaint remembers 
the ending position of the brush when the move is complete. If 
you want to do a second move from the original brush position, 
click Go Back to reset the brush location. 

We'll show you the results of two different move paths, one 
without using Go Back and one using Go Back. In this example 
you'll also actually draw and play the animation instead of sim¬ 
ply previewing it. 

► Click Cancel in the Move requester Click CLR and clear all 
frames. 

Position the brush at the bottom of the screen, and paint it 
down. 

Choose Move from the Anim menu to display the Move 
requester. 

^ Click Clear to clear the edit boxes and then set the Y Distance 
to 200 and the Z Distance to 400. 

^ Click Draw. 

You just created the first part of the brush's movement. Now 
we'll create the second part to continue from where the brush 
ended. 

^ Instead of choosing Move again, this time press M to display 
the Move requester. M is the keyboard equivalent of choosing 
Move from the Anim menu. 

Set the X Distance to 800, leave the Y distance at 200, and set 
the Z distance to 0. Click Draw. 
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^ Choose Control>Play from the Anim menu and watch your 
animation. Press space bar when you've seen it enough. 

Successive Moves 
with Go Back 

In the animation you created, your brush moves into the distance 
and upward and then shoots off the screen diagonally to the 
right. Because you didn't use the Go Back button, the second part 
of the brush's movement follows directly from the end of the first 
part. 
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Figure 6. 8 Results of two successive moves without Go Back 

In the next set of steps, you'll use the same settings as the first 
example, but you'll also click the Go Back button before drawing 
the second part of the brush movement. 

^ Click CLR and clear all frames. Position the brush at the bot¬ 
tom of the screen, and paint it down. 

^ Press M to display the Move requester. Set the X Distance to 0, 
the Y Distance to 200, and the Z Distance to 400. Click Draw. 

^ Press M again. Set the X Distance to 800,leave the Y distance 
at 200, and set the Z distance to 0. Click the Go Back button. 
Click Draw. 

When DeluxePaint is finished drawing the animation, choose 
Control>Play from the Anim menu and watch your anima¬ 
tion. 

This time you see your animation shows a title splitting into two, 
with one title moving into the distance and upward and the 
other moving diagonally off the screen to the right. 
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Cyclic and Non- 
Cyclic Moves 

Cyclic Animation 
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Figure 6. 9 Results of two successive moves with Go Back 

You use the Cyclic button to tell DeluxePaint which of two kinds 
of animation you want: 

an animation that will loop back on itself (cycle) or chain 
from the current move to another move of a similar type; or 

an animation that is linear and will end at the last frame you 
requested in the Move requester. 

DeluxePaint draws your move differently depending on whether 
or not the Cyclic button is selected. In this section weil give you 
a very quick example of the difference between the two moves. 

For purposes of this exercise, the number of frames in your ani¬ 
mation should be 20. 

^ Load any brush that contains features to help you tell 
whether or not the brush has been rotated. (The DPaintTitle 
brush will do very well.) 

Click CLR and clear all frames. Stamp the brush in the upper 
half of the screen. 

Display the Move requester. Click Clear in the requester. Set 
the Z Angle to 360. 

► Click the Cyclic button so a V appears in the box. Click Draw. 

When DeluxePaint is finished drawing your animation, notice 
that you are on frame 1 of your animation. DeluxePaint moved 
you to the frame past the ending frame of your Count. 

Press Shift-2 to go to the last frame of the animation. 
(20/20 appears in Title Bar.) 
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Non-Cyclic Animation 

,arC44 

Figure 6.10 First and last fratnes of a cyclic 3600 rotat^^zf 

Notice that on the last frame of your animation, the brush is not 
rotated 360*, even though you asked for a 360 rotation in the 
Move requester. This is because Cyclic tells DeluxePaint to create 
a "cyclical" animation—one that completes the move on the 
same frame where it began. With this animation, you can play 
continuously without a seam. 

Press A and watch the animation for a moment. Press the 
space bar to stop the animation. 

If DeluxePaint had painted the brush fully rotated on the last 
frame, you would have the same image on frames 1 and 20, and 
the animation would hiccup when you played it continuously. 
Let's draw the same thing with Cyclic turned off to see how that 
works. 

► Press Shift-1 to frame 1 of your animation. Paint 
your brush in th£ towns' half of the screen. 

Display the Move requester. Click Cyclic to turn it off (re¬ 
move the V), and click Draw. 

Even as the new move is being drawn you can see that the new 
rotation is in larger steps than the first one. When the draw is 
complete, you will be left at frame 20, where you can see that the 
new move completed the 360* rotation on frame 20, unlike the 
Cyclic move ivhich left you on frame 1. 

► Press A and watch the animation. Press the space bar to stop 
the animation. 

\ First 1 

DPAZNT4 
- 
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Figure 6.11 First and$&^t$? ties of cyclic (above) and 
non-cyclic 360° rotations 
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You should be able to see that the rotation at the top of the screen 
is smooth, but the rotation at the bottom of the screen hiccups 
noticeably. 

You might ask yourself at this point why anyone would want 
Cyclic turned off. The answer is simple: you might want to rotate 
exactly 90e by a particular frame or you might want to move an 
object from point A to exactly point B. Generally, if you are creat¬ 
ing an animation sequence that runs for less than the full number 
of frames you have allocated for your animation, you don't want 
Cyclic turned on. For a clear example of why you would want 
Cyclic turned off, follow the next set of steps. 

► Clear all frames of your animation. Press Shift-2 to move 
to the last frame. 

^ Select the Unfilled Circle tool and the single-pixel brush and 
draw a small circle on the right side of the screen. 

Choose Coordinates from the Prefs menu to turn on Coor¬ 
dinates. 

Select the Dotted Freehand tool and the largest round built-in 
brush. Position the brush in the middle of your unfilled circle 
and note what the Coordinates show as the location of the 
brush. 

^ Move the brush 200 pixels to the left of that position, press 
Shift-1 to move to frame 1 and stamp down your brush. 

Tip When you need to move your brush in a straight line horizon¬ 
tally or vertically as you did in the step above, hold down the 
Shift key. This constrains your cursor to horizontal or vertical 
movement, depending on which direction you move in first. 

^ Display the Move requester, click Clear, set the X Distance to 
200, make sure Cyclic is selected, and click Draw. 

When DeluxePaint finishes drawing the animation, notice that 
you are left on frame 1. Now look at frame 20 (press Shift-2). 

You'll see that even though the distance from where you 
stamped your brush to the center of the circle was exactly 200 
pixels and the move you requested was 200, the dot did not 
reach the center of the circle. If you want to move your brush to 
a specific location by your ending frame, turn Cyclic off. 

Figure 6.12 shows the results of the steps above with Cyclic 
selected and not selected. 
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Figure 6.12 Example of linear move with and without Cyclic selected 

Although you can't see it, DeluxePaint has positioned the brush 
in the center of the circle on frame 1. If you want to prove this. 
Go to frame 20, display the Move requester, click Clear, change 
the Count to 1 and click Draw. 

When you complete a move with Cyclic selected, DeluxePaint 
automatically advances you to the frame beyond the end of your 
Count and the brush position DeluxePaint remembers is the 
position you specified in the Move requester. 

The Ease Out and Ease In edit boxes let you specify a number of 
frames over which the brush can accelerate or decelerate in your 
animation. The primary advantage of these features is that you 
can make the brush movement smooth at its beginning and end¬ 
ing points. Also, some effects require a gradual acceleration and 
deceleration to be realistic. For example, a bouncing ball should 
accelerate on the way down. The bouncing ball is a good ex¬ 
ample of how this feature wrorks, so let's try it. In the process 
we'll also use the Come To option under Direction: Move in the 
Move requester. 

► Clear all of your frames. Draw a filled circle about the size of 
a nickel. 

► Press b to select and activate the Brush Selector tool. 

^ Use the right mouse button to pick up the "nickel" as a brush. 

► Move to frame 20 and stamp the brush down near the bottom 
of the screen. 

Moves with Ease 

-M 
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More on the Move 
Requester 

Direction 

Assembling the Pieces 

► Display the Move requester; click Clear; enter -170 for your Y 
Distance move. Change the Ease Out edit box to 10. Select the 
Come To option. Make sure the Count is set to 20. Click 
Draw. 

After the animation is drawn, choose Control>Ping-pong 
from the Anim menu to play the animation forward and 
backward. What you should see is a bouncing ball. 

Let's take a moment to review what you just did. When you 
entered -170 for your Y move, you told DeluxePaint that you 
wanted the brush to move dow nward 170 pixels. When you 
entered 10 in the Ease Out edit box, you told DeluxePaint that 
the brush should gradually increase its speed over the first 10 
frames and then move at the same speed for the last ten. Finally, 

B by clicking the Come To option, you told DeluxePaint that the 
brush movement should end in the position and on the frame 
where you clicked. We'll find a detailed explanation of this 
option in the next example. 

What remains in the Move requester is fairly straightforward. 
For now, we'll summarize what each of the buttons does. You'll 
find additional explanations and more examples of the features 
below, in the following chapter, and in Reference. 

The Direction options control the direction of the move and the 
direction of the recording. 

The Go From button is the default setting for movement. With 
this option selected, the settings in the Move requester are used 
to paint motion away from the point where you stamped your 
brush. For example, an X Distance of 200 moves to the right from 
where you stamped your brush, over the number of frames set in 
the Count edit box. 

With the Come To option selected, the settings in the Move re¬ 
quester are used to paint motion toward the point where you 
stamped your brush. For example, an X Distance of 200 moves to 
the right to where you stamped your brush. This option is most 
useful when it's easier to specify the position where you want 
the move to end than it is to specify the beginning. Remember 
that you want to stamp the brush on the frame you want your 
animated move to end on. Here's a practical example. 

Suppose you want pieces of a picture to fly onto the screen and 
assemble neatly on the last frame. If the pieces are coming from 
off screen, it's difficult to position the brush there for the begin- 
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ning of the move! And you don't want to calculate backwards 
from the ending position to figure out just where the starting po¬ 
sition should be anyway. The answer is to go to the last frame, 
paint down your brush, and tell DeluxePaint to paint the brush 
moving toward this point. That's what the Come To option is all 
about. Let's do it. 

Clear all frames. 

^ Choose Frames>Set # from the Anim menu and set the num¬ 
ber of frames to 20. 

^ Press Shift-2 to go to the last frame of the animation. 

Remember, when you use the Come To option, you always paint 
the brush down on the frame where you want the move to end. 

Choose Load from the Brush menu. Load the file named 
piel.brush from the Artl disk. Choose Palette>Use Brush 
Palette from the Color menu. 

Paint the brush down in approximately the middle of the 
screen. 

Display the Move requester, and click Clear. 

^ Set the X distance to -200. Set the Y distance to -150. Set the Z 
angle to 180. Click the Come To option. 

Ease out should be set to 0. Set Ease In to 5, and click Draw. 

^ Play the anim that you have so far. If you wish to adjust the 
speed at which the anim plays, choose Control>Set Rate 
from the Anim menu 

You'll see the piece of pie chart fly in from off the screen. Notice 
how the Ease In setting of 5 frames smoothed the landing of the 
pie. If you continue with the other two pieces to construct the full 
pie chart, you'll see that this Ease In element is very important to 
the look of the animation. 

If you get the point of this exercise and don't want to complete 
the flying:pfe chart, you can continue on. Otherwise, (or if you 
want £& continue for fun) there are two more pieces of pie chart 
to load. Load each one and stamp it in place (with the black 
edges of the slices overlapping) and set any move you want that 
will send the slices flying onto the screen. 

This is a great opportunity to experiment with the Move re¬ 
quester settings; no matter what numbers you enter, the pie will 
come to the proper end point on frame 20. 
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Figure 6.13 Flying pie chart using Come To and Ease In 

Record 

Load 

» | I I | « | The Record options let you specify the direction in which 
DeluxePaint paints the frames of your move. 

Forward is the default and paints the frames by flipping for¬ 
ward. 

ED In Place causes DeluxePaint to paint all of the move on the cur¬ 
rent frame. 

Backward paints the frames by flipping backward — this option 
is useful with Trails. 

Trails and Fill are best explained by vivid example, you'll find 
two examples of each in the next chapter. 

Displays the Load Move requester. From here you can load Move 
settings that you entered and saved with the Save Move re¬ 
quester. When you load a move, you are loading only the set¬ 
tings for the Move requester. You still need to stamp your brush 
in the correct position and on the correct frame to duplicate the 
move you had in mind. If you aren't absolutely sure of the set¬ 
ting you want to load, try using the feature this way: stamp your 
brush in the center of the screen; load the move settings you 
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Save 

Animated Brushes 

Creating an AnimBrush 

think you want; click Preview to see the move as it would look if 
it started from the middle of the screen. This will give you a 
good idea of what the move looks like when it is actually drawn, 
and it will also help you determine where your brush should be 
stamped to produce the best move for these settings. The re¬ 
quester works just like the Load Picture requester. 

Displays the Save Move requester. DeluxePaint lets you save the 
settings (though not the images) of any move you set up in the 
Move requester. You can load a saved settings and use them as a 
kind of template to automatically describe the movement of an¬ 
other object. The requester works just like the Save Picture re¬ 
quester. 

So far we've shown you how to create 4n~imiiri3tion by painting 
on a series of frames. DeluxePaint aisqJeftryou select an area of 
animation as a brush and paint with it. The result is that the 
brush changes while you paint, and, depending on whether or 
not the frame changes, you create either animation or interesting 
effects. 

In Guided Tour (2), we showed you how to load and use one of 
the AnimBrushes included on the Art2 disk. In this section, we'll 
show you how to create a simple AnimBrush of your own and 
paint with it. 

To begin, let's create a simple animation that we can easily pick 
up as a brush. 

► Choose Palette>Default Palette from the Color menu. 

► Clear all of your animation frames. Paint a circle about the 
size of a quarter and filled with a gradient. Pick your sphere 
up as a brush. 

^ Paint your brush down and rotate it 360° over twenty frames. 
To do this: 

► Display the Move requester. Click Clear to set all of the op¬ 
tions to their defaults. Set the Z Angle to 360 and select Brush 
angle. Select Cyclic and make sure the Count is 20. 

► Make sure Ease In and Ease Out are set to 0. 

^ Click Draw. 
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Picking Up an 
AnimBrush 

m 

Painting ivith the 
AnimBrush 

AnimBrush Settings 

Your brush will rotate in place to create an animation that looks a 
little like a spinning planet. 

^ When DeluxePaint is finished painting the animation, step to 
frame 1 and choose AnimBrush>Pick Up from the Anim 
menu. 

A large cross-hair like the one you use to pick up standard 
brushes appears, but it is special in that it picks up from a series 
of frames. 

^ Pick up the sphere animation as a brush as you normally 
would using the left mouse button. 

In the Pick up AnimBrush requester that appears, 20 should 
appear in the Number of Cels edit box. If it does, click Ok. 

After you click Ok, you will see each of the frames flip as the 
area is picked up. When it's done, you have your AnimBrush. 
Another way to pick up an AnimBrush is to select the Brush 
Selector and hold down the Alt key as you pick up an area of 
your animation. 

To prove that you have an animated brush, paint with it a 
little. 

You'll see that the brush spins as you paint. This is one way to 
use an animated brush. But better yet, try animpainting: 

► Click CLR and clear all frames. Hold down the Alt key. Posi¬ 
tion the brush in the lower left corner of the screen and paint 
from left to right across the screen. 

The frames flip as you paint, so you only place one cel of the 
AnimBrush on each frame of your animation. When you play the 
animation back, you'll see a ball roll from left to right across the 
screen. 

When you begin to combine AnimBrushes into large animations, 
you'll find that occasionally you want to change the rate at 
which an AnimBrush transforms. You might even want to 
change the direction in which an AnimBrush plays. For example, 
you might want the gradient ball you created above to turn in 
the opposite direction. You can do this with the AnimBrush 
Settings requester. 
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y Choose AnimBrush>Settings from the Anim menu. 

Direction 

Duration 

AninBnush Settings 

Nunber of cels: 20 

Duration: 

Current: 

Direction: O 

Cancel | 

Figure 6.14 AniniBrush Settings 

Click the (backward) direction button and click Ok 

Now your gradient circle will rotate in the opposite direction 
when you paint with it. 

The other direction setting is called Ping Pong. This setting 
causes the brush to alternate between forward and backward 
p!ay. 

The Duration box in the AnimBrush Settings requester let's you 
specify how many stamps of the brush the AnimBrush uses to 
complete its cycle. If the Duration number is larger than the 
number of cels, the brush seems to move more slowly. If the 
Duration number is smaller than the number of cels, the brush 
seems to move more quickly. Let's try painting normally with a 
brush and then paint with the Duration set higher 

Choose AnimBrush>Load from the A^l^^enu. Load the 
file named Sweep from the Anim Bruat wer on the 
Art2 disk. Choose Palette>Use Brush from the Color 
menu. 

Display the AnimBrush Settings requester and set the Direc¬ 
tion to play forward. (Notice that this animated brush has 10 
cels.) Click Ok. 

Position the karate figure on the left side of the screen. Hold 
down the Alt key and click the mouse button repeatedly 
without moving the mouse to paint one cel of the animbrush 
on each of the 20 frames of your animation. 

You now have an animation of a karate character performing a 
sweep kick twice. You'll notice that the sweep kick is fairly rapid. 
Next we'll paint the same animbrush with a longer duration to 
slow down the motion of the character. 
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Metamorphous 
AnimBrushes 

The Chicken and the Egg 

► Choose AnimBrush>Settings from the Anim menu. Set the 
Duration box to 20. Set the Current box to 1 to put the brush 
at its first cel. Click Ok. 

Now position the karate figure on the right side of the screen. 
Hold down the Alt key and paint one cel of the AnimBrush on 
each of the 20 frames. 

When you've finished painting your AnimBrush on the 20 
frames, press the 4 key at the top of the keyboard to play the 
animation. 

Compare the speed of the two characters. If you step through the 
frames of your animation one at a time, you'll see that the man 
on the right takes two frames before changing position, while the 
man on the left moves on every frame. You can also use Duration 
to speed up an animbrush by setting the duration number lower 
than the number of cels in the brush. In that case, cels of the 
brush would be skipped as you painted with the brush. 

❖ If you increase the duration of an AnimBrush, it is best to set 
a duration that is a multiple of the number of cels in your 
brush. For example, an AnimBrush that has 10 frames will 
generally look best if you set the duration to 10, 20, 30, etc. 

Another way to create AnimBrushes is to transform the image 
and shape of one custom brush into those of a second custom 
brush. This special feature, called metamorphosis, can create 
some stunning effects. We'll show you a couple of very simple 
examples just to give you the idea. The first example metamor¬ 
phoses between very different brushes. The second example 
metamorphoses between two transformed versions of the same 
brush. In both examples, you'll use the Sparc options in the 
Brush menu to work with two custom brushes at the same time. 

In this example, you'll load two different custom brushes (a 
chicken, and an egg) and create an AnimBrush that metamor¬ 
phoses between the two. 

^ Clear all frames of your animation. 

^ If the Animation Control Panel is NOT on your screen, press 
Alt-A to display it. 

Choose Load from the Brush menu, and load the file named 
egg.brush from the Brush drawer on Artl. Choose 
Palette>Use Brush Palette from the Color menu. 
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Choose Spare>Brush->Spare from the Brush menu. 

The Brush->Spare option copies your custom brush to the spare 
custom brush buffer. Now that you have the first brush in the 
spare buffer, you can load a second brush without losing the first 
one. 

^ Choose Load from the Brush menu, and load the file named 
"chicken" from the Brush drawer on Artl. 

Now you have two custom brushes that you can swap back and 
forth between by choosing Spare>Brush<->Spare from the Brush 
menu. Try it if you like. Make sure that the chicken is your cur¬ 
rent brush before you proceed. 

^ Now choose Spare>Metamorph from the Brush menu. (The 
Make Animbrush requester appears.) 

Enter 11 in the edit box as the number of cels in your new 
brush, and click Ok. 

It will take a couple of minutes for DeluxePaint to metamorphose 
your two custom brushes into one AnimBrush. 

► Go to AnimBrush Settings, click on the ping pong direction 
button, and click Ok. 

The Ping Pong option automatically plays your AnimBrush to 
the end and back again repeatedly without doubling the first or 
last cel of the brush. This means that the brush is effectively 
twice as long minus 2 cels. (In this case, we had you create an 11 
cel brush so that the Ping Pong version would play over exactly 
20 frames.) You'll find the Ping Pong option very useful for con¬ 
verting linear brushes into cyclical ones without having to create 
the extra frames. 

^ Hold down the Alt key, and click the brush repeatedly to 
paint the brush over 20 frames. Press 4 to play the anim, 
or click the Play Continuously icon on the Control Panel. 

You'll see an egg metamorphose into a chicken and back into 
an egg over and over until you press the space bar to stop the 
animation. 
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The LightTable 

Simple 'Tweening 

S>i The LightTable lets you see a few frames of animation overlayed 
on each other like clear sheets of cellophane to help you position 
brushes or paint the in-between frames of a character animation. 
The LightTable can also dim the frames that are behind (or after) 
your current frame so that you can more easily see which frame 
you are working on. (This dimming effect is available in all 
modes except HAM.) 

Traditional animators work by painting the key positions or 
poses of a character and then paint the ''in-between'' frames to 
create the smooth transition between poses. The LightTable is 
ideal for creating animation with this traditional approach. In 
the next few pages, we'll introduce you to the basics of using 
the LightTable through an exploration of the techniques used 
to create the Doggie's_Inferno animation on your Art2 disk. 

We'll start out with a simple example of painting a smiling face. 
To begin, we need a clean frame to work with. 

Delete all frames. Choose Palette>Default Palette from the 
Color menu. 

If the Animation Control Panel is not on your screen, press 
Alt-a to display it. 

❖ The most obvious place to access the LightTable feature is 
from the Anim Control Panel, and this is the method we'll 
use in this example. However, if you prefer, you can also 
access this feature and its options from the Effects menu, or 
from the keyboard. Check Appendix B for keyboard equiva¬ 
lents. 

Click the + button on the Anim Control Panel to add a frame. 

^ Choose AnimBrush>Load from the Anim menu and load the 
brush Smile from the AnimBrush drawer of your Art2 disk. 

This AnimBrush has only two cels, one frame shows a simple 
unexpressive face, the other shows a smiling face. We'll stamp 
these down on our two frames and then look at how the 
LightTable helps us create the in-between frames. 

^ Drag the Frame Slider in the Anim Control Panel to the left to 
move to frame 1. Stamp the first cel of the Smile brush on 
frame 1. 

Drag the Frame Slider to frame 2. 
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At this point, LightTable can already help us out. We'll use it to 
align the second cel of the AnimBrush over the first. 

^ Click the LightTable icon to turn it on. 

You automatically see Frame 1 behind your current frame. Be¬ 
cause you are working on an animation, DeluxePaint assumes 
that you will want to see the previous frame when you turn on 
the LightTable. Notice that the image on the previous frame is 
dimmed to help you see the difference between the current frame 
and the frames you are viewing behind. 

^ Position your AnimBrush directly over the image on frame 1 
and stamp down the second cel (which should be a smiling 
face). 

Now you have two frames, each containing one extreme of your 
future animation. The trick now is to draw the frames in between 
these two. The easy way to do this is to copy the first frame and 
modify it incrementally until you reach the state of the ending 
frame. Here are some steps: 

► Drag the Frame Slider back to frame 1. Click the + icon in the 
Anim Control Panel to add another frame. 

At this point you are on frame 2 looking at a copy of the infor¬ 
mation on frame 1 (the straight face). Since the goal is to make 
changes that will animate the face into the smile on the following 
frame, it would be helpful to see that frame while you make 
changes. 

^ Click the N (for next) button in the Anim Control Panel to 
show the next frame in the LightTable. 

Now you can see your goal, so it will be easy to draw a face that 
shows a transition between what you have now (in the bright 
colors) and what you have on your last frame. 

^ Use the second round built-in brush and the Curve tool to 
draw eyebrows that curve a little higher and a lower lip that 
curves a little lower. Then use the Dotted Freehand tool to 
erase the original eyebrows. 

► View your changes by clicking the loop forward icon in the 
Anim Control Panel. If the animation is too rapid, press the 
left arrow key several times to slow down playback. Press the 
spacebar to stop playback and use the Frame Slider to move 
back to frame 2 if you aren't there already. 
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Evolution of an 
Animation 

The Background 

The Outline 

^ Continue to make changes and view them. When the changes 
look good to you. Go to frame 2 (the frame you were just edit¬ 
ing), and click the + button again to add another frame to edit 
between frame 2 and the final frame. 

Do you get the idea? You can keep making small changes and 
adding in-between frames until the transition to the full smile is 
perfectly smooth. You might even try evolving the simple face 
into a more full featured one with ears, hair, a chin, etc. 

[f you like your animation, save it before moving on to the 
next section. 

In this section we'll look at how a traditional animation evolves 
in DeluxePaint IV. 

Turn off the LightTable and delete all of your animation 
frames. 

Choose Load from the Picture menu and load the picture 
DoggieBackground.lace from the Picture2 drawer on your 
Art2 disk. When the message appears asking whether or not 
you want to change format to that of the file, click Yes. 

The picture you see is a simple background image of a lawn and 
tree. This image forms the background for a completed 
Doggie'sjnferno animation. Before animators begin to draw an 
animation, they create a background image against which the 
animated characters will move. The background image can be as 
complex as a city scene or as simple as a.straight line to indicate 
the ground level for the characters to walk on. Whatever its level 
of complexity, the background helps keep all of the pieces work¬ 
ing in harmony. 

In the next brief section, we'll load a wire-frame animation over 
the background image. But before we do, we need to change the 
screen format of this image. 

^ Choose Change Screen Format from the Picture menu. In the 
Screen Format requester, click Lo-Res 320x200, and Screen for 
the page size. Click OK. When the message appears to ask if 
you want the image stretched to fit the page, click Yes. 

This will change the picture to Lo-Res format and resize it to fit 
the screen. 

Now we'll take a look at the first step of creating an animation 
over a background. 

151 Animation Basics DeluxePamf IV 



^ Choose Spare>Swap from the picture menu to put the back¬ 

ground picture on the spare page, 

^ Load the anim DoggieOutline from the Anim drawer on your 

Art2 disk. When the message appears to ask if you want to 

change the number of colors to that of the file, click No, 

❖ You just performed an important operation; you loaded an 

8-color wire-frame animation into 16-color mode. Deluxe- 

Paint lets you load animations into screen formats that use 

more colors and thus makes it possible for you to create the 

initial animation outline in just a few colors and load it into a 

format with more colors later on when you want to paint the 

frames. 

DoggieOutline is a few frames of a simple wireframe animation. 

(The original outline animation was created in Interlace mode, 

but we converted it to LoRes so that you wouldn't see the 

flicker.) The Doggie'slnferno animation (which we'll load in a 

moment) was created by an animator who uses the traditional 

method of first drawing the outline version of the animation and 

then filling it with solid colors or patterns to create a finished 

piece. Traditional animators call the outline version of an anima¬ 

tion the "pencil test.'' 

^ Turn on the LightTable to view the animation frames 

overlayed on one another. 

^ Click the S button in the Anim Control Panel to view the 

Spare page behind the animation. 

See how useful it is to view the background image through your 

animation frames? With the background visible, the animator can 

easily align the animated characters without having to worry 

about accidentally ruining the background image. Even if you 

aren't working on an animation, you might find it useful to view 

a background image while you paint. If you turn off the Dim op¬ 

tion (from the LightTable submenu of the Effects menu) you can 

view the background in its original colors and thus treat your 

animation frame as a transparent page. 

^ Choose different combinations of settings (2, P, N, and S) in 

the LightTable area of the Anim Control Panel. Move the 

Frame Slider back and forth to view the different animation 

frames and background combined with the various settings. 

Merging in the Background One of the powerful features of the LightTable is its ability to let 

you merge your viewed frames. We'll try it right now by merg¬ 

ing the background image into the image on one of the frames. 
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The Painted Animation 

► Make sure LightTable is on, but turn off all of the LightTable 
options other than S (for Spare). 

You should see your current frame against the background on 
the Spare page with no other frames visible. 

► Choose LightTable>Merge from the Effects menu. 

In a moment, your background is merged with your wireframe 
animation. Notice that the LightTable is automatically turned off 
after a merge operation. This is done so you will see the frame in 
its actual state and not be confused by LightTable effects. One 
caution is in order: you can't Undo a merge, so you should be 
very careful that the image as you see it in the LightTable is 
correct before you merge it. 

Another way to merge the background image with the frames is 
to use the Spare>Merge in Back option in the Picture menu. This 
option lets you merge to the current frame, to a range of frames, 
or to all frames in a single operation. This is generally the last 
step an animator takes in the creation of a finished traditional 
piece. If you have enough memory in your Amiga, you can try it 
yourself after you view the painted animation frames in the next 
section. 

Before we leave this section, we'd like you to load the 
Doggie's Jnferno animation and, if possible, merge it with its 
background. We've included two sets of instructions: one set for 
those with less than 2MB of RAVI, and one set for those with 
2MB or more. 

If you have less than 2MB of RAM: 

* Choose Load from the Anim menu and load the 
Doggie's_Inferno animation from the Anim drawer of the 
Art2 disk. When it has finished loading, press 4 on the key¬ 
board to play the animation. 

Be sure to read the Tip below! If you don't have a lot of RAM, it 
is an especially useful tip. 

If you have 2MB or more of RAM: 

Choose Frames>Delete Frames from the Anim menu. In the 
requester, click Delete All. 

^ Choose Load from the Picture menu and load the 
DoggieBackground picture from the Picture2 drawer of the 
Art2 disk. 
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Brush Axes vs. 
Screen Axes 

Movement Along 
the Brush Axes 

Choose Spare>Sfyjtygjiye the background image to the 
spare page. '' 

** 11 *. i’ 

Choose Load from the Anim menu and load the 
Doggie'sjnferno animation from the Anim drawer of the 
Art2 disk. When the message asks if you want to change the 
number of colors to that of the file, click No. 

you have both the background and the full-length painted 
•i'-fy^ion of the animation loaded, you can merge the two together 
^P?|bild the final animation. 

Choose Spare>Merge in Back from the Picture menu. When 
the Merge requester appears, click All Frames to merge the 
background image behind all of the animation frames. When 
the process is finished, press 4 on the keyboard to view the 
finished animation. 

Tip If you are going to be recording your animations to video tape 
and you don't have a lot of RAM in your Amiga, it might be best 
not to merge a background into your animation. Instead, you can 
create a painted background and use a GenLock device to com¬ 
bine the video signal of the Amiga with the signal of a camera 
focused on the painted background as you record the two to a 
videotape. 

Now that we've covered pretty much everything else, it's time 
tacover the sticky issue of brush vs. screen axes. We've tried to 
jgftftke the example very clear, but if you feel you need further 
h*%>, review Chapter 5, Working with Perspective. We should 
also mentionyou will not often need to change the default 
settings for these? Options. 

So far in our examples, we've been moving the brush along the 
screen axes. When your brush is in a standard orientation (0, 0, 
0), movement on the brush axes is the same as movement on the 
screen axes. If you rotate your brush using Perspective, the brush 
axes may no longer correspond to the screen axes, and move¬ 
ment on the brush axes will be different. In this example we'll 
use the Load Move requester to set some of our movements. 

Choose Screen Format from the Picture menu and change 
your format to Lo-Res 320 x 200 with 32 colors. 

Choose Frames>Set # from the Anim menu and set the 
number of frames to 20. 
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► Choose Load from the Brush menu and load the brush called 
DPaintTitle brush from the Brush drawer on your Artl disk. 

Choose Palette>Use Brush Palette from the Color menu. 

^ Click CLR to clear your screen to black. 

You should now have a clear page and and the DPaintTitle brush 
ready to work with. 

► Choose Perspective>Do from the Effect menu to enter Per¬ 
spective mode. 

► Move the brush down near the bottom of the screen and press 
Shift-7 to flop the brush over on its back. 

^ Click to paint down the brush. 

To flop the brush over on its back, you rotated it *90° on the X 
axis (see the Title Bar) and shifted the brush axes so that they no 
longer correspond to the screen axes. Figure 6.15 illustrates the 
change in the brush axes. 

Figure 5 Tm change in a brush's axes upon rotation 

Now Move requester to move the brush along the 
Y axis, you wittgfii different results depending on whether or 
not you have Seized the Brush button. 

Display the Move requester, and click Load. 

When the Load Move requester appears, load the file called 
Animbasicsl.Move from the Move drawer of Artl. 

^ Click Preview from the Move requester. 
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Rotation on the 
Brush's Axis 

The wire frame model of your brush moves upwards, just as you 

would expect when moving along the screen axis. 

^ Click the Brush button beside the Distance edit boxes. A 

check mark (V) appears in the box. Now click Preview and 

watch the direction the brush moves. 

This time the brush moved into the distance along the Y axis of 

the brush. As Figure 6.15 above shows, the brush's Y axis is the 

same as the screen's Z axis when you rotate backwards -90°on X 

as we did. 

You may have already guessed what will happen when we rotate 

the brush on it's own axes rather than on the screen axes, but this 

is sometimes difficult to visualize, so we'll give an example. 

Click Cancel to close the Move requester 

^ Click CLR and click All Frames in the requester to clear all 

frames. 

^ Choose Perspective>Reset from the Effect menu to reset all of 

the Perspective settings. 

At this point you once again have your brush in the original ori¬ 

entation and are in Perspective mode. Now we'll rotate the brush 

on the Z axis, so that the X and Y axes of the brush no longer 

match the X and Y axes of the screen. 

^ Hold down 2 on the keypad until the brush has rotated 45° 

on the Z axis. You'll see the degrees of rotation in the right 

side of the Title Bar. 

^ Paint down the brush in the middle of the screen. 

^ Press M to display the Move requester. 

^ Click Clear in the requester. 

Click Load. When the Load Move requester appears, load the 

file called Animbasics2.Move from the Move drawer of Artl. 

^ Make sure the Brush button beside the Angle edit boxes 

doesn't have a V on it. 

^ Click Preview. 

With the settings above, you'll see the brush tumble toward the 

screen on the X axis. Remember that the brush is rotating on the 

screen's X axis. Now let's look at a rotation on the brush's X axis. 
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► In the Move requester, click the Brush button beside the 
Angle edit boxes; click Preview. 

This time the brush spins around its own X axis instead of tum¬ 
bling toward the screen. The idea is the same for all rotations, 
though it isn't always easy to predict what a complex set of rota¬ 
tions will look like. You'll probably find that most of your moves 
can be accomplished with rotation around only one axis at a 
time. And once you get used to rotations on the brush axes, we 
think you'll use these most often, so brush rotations are the 
default setting. 

Tip If this last exercise was less informative than you had hoped, you 
should probably review the chapter on Perspective. There you 
will find more examples that might help you better understand 
the difference between screen and brush angles. 

Now that you've seen some of DeluxePaint's animation features, you 
might like to play around a little. Load the animations from Art2 disk 
and play them. There are several AnimBrushes on the disk that you 
can combine with the Ocean Background.picture to form an aquarium 
scene. When you feel you're ready to see some more of DeluxePaint's 
animation features, move on to the next chapter. It shows you hoiv 
to create some interesting animation effects by combining different 
features of the program. 
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Effects 

Before You Begin 

Quick Effects 

Receding or 
Approaching Shapes 

This chapter introduces several interesting animation effects and a host 
of animation tips. We strongly recommend that you work through this 
chapter and complete the Amazing Bouncing Ball section, which serves 
as a good test of your knozvledge of DeluxePaint. 

In the following sections you'll create some interesting animation 
effects. Many of these effects are not obvious, so it is worth your 
time to follow closely and work along. 

NOTE: As you begin each section that uses the Move requester, 
reset the requester to its default settings. Our instructions will 
tell you only which settings you need to change out of the de¬ 
faults when you first open the requester. Figure 7.1 shows the 
Move requester in its default settings; use this as a guide if you 
need to check your own settings. 

Figure 7.1 Move Requester showing default settings 

Make sure you are in Lo-Res mode with 32 colors. Set your 
number of frames to 40. Make sure you are using the Com¬ 
pressed memory method. 

These two effects are good examples of how multiple features of 
DeluxePaint combine to make simple animations easy to create. 

This technique creates the effect of a shape moving off into the 
distance. Notice that this involves using a keyboard command 
while you paint with the mouse button down. 
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Figure 7.2 A receding circle 

Right-click the largest round brush and stretch the brush to 
be about the size of a nickel. 

Select the Dotted Freehand tool 

^ Position the brush near the upper left corner of the screen. 

Hold down the Alt key and begin animpainting in a curve 
downward toward the lower right area of the screen. As you 
paint, release the Alt key and press the - (minus) key repeat¬ 
edly to shrink the brush as it moves. 

When you play back the animation, the gradual shrinking of the 
brush makes it look as though it is receding into the distance. 
Play the animation backwards, or create a new one using the = 
(equals or plus) key to enlarge the brush, and the brush will ap¬ 
pear to approach from the distance. This example used a built-in 
brush, but you can do the same thing with a custom brush. 

Dissolve The Edge>Trim command in the Brush menu makes it easy to 
have an object dissolve into nothing. You stamp the brush, trim 
some away, step to the next frame, and stamp again. The real 
trick is to use the keyboard to do all of your frame changes, 
trimming, and brush stamps. 

^ Select black as your background color and clear all of your 
frames. 
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* Load the DPaintTitle brush from your Artl disk. Choose 
PaletloUse Brush Palette from the Color menu. Stamp the 
brush in the middle of frame 1 

Expanding Circles 

^ Display the Move requester. Click Clear to set all of the 
Distance and Angle edit fields to 0. 

► Set the Count to 1. Make sure that all of the other options are 
set to their defaults. Click Draw. 

■p>- Press 0 to trim the brush. Press M to display the Move re¬ 
quester and click Draw. Repeat this step until the brush has 
completely disappeared. (It will take about 9 frames.) 

Ifeihg the Move requester to stamp your brush saves you from 
having to carefully position the brush on each frame. You can 
also accomplish this by positioning the brush once and then 
using the keyboard equivalent Amiga-Left Alt to click the left 
mouse button. (We recommend that you press the Amiga key 
first and then press the Alt key quickly once for a single stamp, 
because pressing the keys in the opposite order 
animpainting over many frames.) 4 . : 

- '-v%: 

Since you didn't use all 40 of your frames, we'll i;" >* 
Control>Set Range option in the Anim menu V 
frames you painted. V 

► Choose Control>Set Range. In the Set Play 
set the From field to 1 and the To fiel^ip 
Click Ok. *< 

f v * « • • A ♦ ♦ ♦ ♦ • « ♦ » 
>/•* 

Now press 4 to play your t 
brush dissolve repeatedly until you press space bar or click to 
stop the animation. (If the animation is moving too quickly, 
press the left arrow key repeatedly to slow it down.) 

Before you leave this example, choose Control>Set Range 
again and click the All Frames button. 

This example shows you how to create the effect of a circle 
expanding outward like a "sonar blip." You use two Deluxe- 
Paint features to help you align the circles and make them grow 
uniformly: Grid and the 2 key (the Next Frame keyboard equi¬ 
valent). 
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Trails 

p 

• o O 
o :oo 
Figure 7.3 Expanding Circles 

Clear all frames of your Animation and go to frame 1. Turn on £ 
the Grid with X and Y spacing of 8. ^ 

Select the second-largest round built-in brush and paint a dot 
in the center of the screen. ™ 

^ Choose the Unfilled Circle tool. ® 

^ Start from the dot in the center of the screen and drag out a 
circle that is just one grid point wider than the dot, but don't 
release the mouse button. Press the 2 key to move to the next 
frame. Now release the mouse button. 

At this point you have a dot on frame 1 and a small circle on 
frame 2. 

Continue to follow the last step above to paint larger and 
larger circles on successive frames until your circle reaches 
the sides of the screen. 

When you play your animation, you'll see one circle expanding 
outward. If you're adventurous, try picking up your entire ani¬ 
mation as an AnimBrush and animpainting it onto your existing 
animation by starting it on frame 5. This will give you an anima¬ 
tion of two circles expanding outward. 

This example demonstrates the use of Trails. You'll find this op¬ 
tion in the Move requester makes it easy to create impressive title 
effects. 

Turn the Grid off, and clear all frames. 

► Load the brush DPaintTitle from the Art disk. Choose 
Palette>Use Brush Palette from the Color menu. 
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► Press Shift-2 to go to the LAST frame. You should be on 
frame 40. 

► Stamp the brush,4t:f|^|^f^;;of the screen. Display the 
Move requester, tCksas:Sfet the Z Distance to -1500. 
Select the Come fo QphYm fervour Move Direction. 

The Come To opHoi*.f^|& that the position of the 
brush is where you ^ttf'mi^liiifrriation to end—you want the 
animation to "come to" the brush position and frame. 

► Set Count to 40, and click Preview. 

There is a slight delay, and then the preview plays, starting 
at the distant position [Z=1500] and coming closer. 

Instead of clicking Draw, click Trails, and let it record. 

By clicking Trails, you tell DeluxePaint to carry the cumulative 
effect of each frame forward as it draws. The result is that the 
brush leaves a trail as it moves through three-dimensional space 
in your animation. 

Press 5 on the main keyboard for a single play of the ani¬ 
mation. 

The Slinky is a modified version of the standard Trails title. 
You've probably seen this effect on many television sports 
shows. A special feature of this effect is that it uses the Stencil in 
combination with the Move requester. This combination can be 
very powerful when used properly. When a stencil is used with 
the Move requester, DeluxePaint remakes the stencil for each 
frame as it renders the move. 

Load the DPaint. brush if you don't already have it. Clear all 
frames. 

> Step to the middle frame of your total. For example, if you 
have 40 frames as we suggested, move to frame 20 by choos¬ 
ing Control>Go to from the Anim menu. Stamp the brush 
down near the bottom of the screen. 

Display the Move requester. Click Clear. Make sure that both 
Brush buttons are unchecked. 

> Set the Z Distance to -1000. Set the Count to 20. Select the 
Come To option. Click Trails. 

As in the Trails effect above, DeluxePaint paints your title with 
the cumulative image carried forward to each successive frame. 
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Curving Titles 

^ Step to frame 40. 

Now you need to create a stencil so you can "paint behind." 

^ Choose Stencil>Make from the Effect menu. In the Make 

stencil requester, click the background color (black), click 

Invert, and click Make to lock all colors but the background. 

^ Display the Move requester. Leave all of the other settings the 

same, but select the backwards Record Direction. Click Trails. 

Because you reversed the Record direction, DeluxePaint begins 

this move by painting on frame 40. It then steps one frame back¬ 

wards and paints the cumulative effect of frame 40 and the new 

brush position on frame 39. This is where the Stencil comes into 

play. Because the colors in the title are stenciled, the second 

brush stamp appears to be painted "behind" the single image 

that was stamped on frame 40. Though, in fact, it was painted 

over the single image. 

The resulting animation should have your brush moving from 

the distance, leaving Trails, until it gets to the nearest position, 

at which point the Trails start erasing from the back forward. 

^ Before you move on to the next effect, choose Stencil>Free 
from the Effect menu. 

This example shows you how to create the effect of a title moving 

across the screen on a curved path using the curve tool instead of 

the Move requester. 

^ Clear all frames. 

^ Load the DPaintTitle. brush from your Artl disk. Choose 

Palette>Use Brush Palette from the Color menu. 

^ Go to the last frame (frame 40) and stamp the brush near the 

bottom of the screen. Click Undo. 

T/p Clicking UNDO immediately after stamping the brush helps 

ensure that your results are what you expect. This is particularly 

important if you are using a Brush Mode in your move, because 

DeluxePaint paints on the screen you stamped on when it paints 

the move, and stamping twice on the same screen will give a 

different result from a single stamp. 

^ Display the Move requester, and click Clear. 

^ Set the Z distance to -1200. Select the Come To option. Set 

Count to 40, and click Draw. 
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Tumbling 3D Objects 

DeluxePaint paints the brush moving toward the screen from the 
distance. 

► Pick up the animated title as an AnimBrush. (Be sure you are 
on frame 1 when you pick up the brush, and that you enclose 
the entire area over which the brush moved.) 

^ Press Alt-x to place the brush handle in the lower right 
corner of the brush so you will be able to click it off-screen. 

► Clear all frames. 

Right-click the Curve tool to display the Spacing requester. 
Click the N Total button and set the total to 40. Click Ok. 

The Spacing requester lets you tell DeluxePaint exactly how 
many brush stamps you want to use to paint your curves, lines, 
and unfilled shapes. By setting the Spacing to N Total of 40, 
you'll get 40 stamps of the brush. Since you have 40 frames, 
when you use the brush to animpaint, you'll get one stamp of 
the brush on each frame. 

^ Press Shi ft-7 to go to the first cel of the AnimBrush. 

^ Position the brush at the left side of the screen and midway 
between the top and bottom 

Hold down the Alt key and the left mouse button and drag 
down to the lower right corner of the screen. (You'll see your 
title drawn along the path of your curve.) 

^ Release the mouse button and define the shape of the curve 
while still holding down the Alt key. When the curve is a 
shape you like, click to begin animpainting. 

When DeluxePaint is finished painting your curve, press 5 to 
play the animation once. You'll see the brush move into view 
and curve it's way down to the lower right corner of the screen. 

Like the Curving Title effect above, this effect also uses the curve 
tool to move an AnimBrush along a curved path. However, in 
this effect, you use an object that looks three-dimensional, and 
you tumble it at the same time you move it toward the screen. 
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Figure 7.4 Object tumbling into the screen along a curved 

Clear all frames. , 
i { ■ j i | ‘t , 

Load the brush named Gradien*|£^p$ If^Frtij^e Brush drawer 
on your Art disk. Choose Palet^^^|l^l^ft Palette from the 
Color menu. Go to the last ani^^^’f^it^frame 40). Stamp 
the brush ill the center of the sa;i&h, t?^do. 

Display the Move requester. Set. to -1200 and 
the Z Angle"to 720. Select the Click Draw. 

DeluxePaint paints your cube rotating^fl* and moving toward 
you from the distance. Now you need to pick up this tumbling 
object as a brush. You must pick up the entire animated area, be¬ 
ginning at frame 1 where you see only a tiny object. Here's how: 

^ Click the Brush Selector. 

Go to frame 40, where the object is largest. 

From this frame you can easily see how large an area you need 
to select to enclose the entire animated area of the gradient cube. 

► Hold down the Alt key and enclose the object with your 
cross-hair, but don't release the mouse button. (You can 
release the Alt key.) 

^ Press 2 to step forward to frame 1. Release the mouse button. 

► Click Ok in the Pick AnimBrush requester. 

► 

► 

► 
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Now you have your AnimBrush of the object tumbling and mov¬ 
ing toward you. In the next steps, you'll use the Curve tool and 
the Spacing requester to give it a trajectory across the screen. 

► Clear all frames. 

ft- Right-click on the Curve tool. Set the Spacing requester to N 
Total 40. 

^ Place the brush handle in the lower right corner of the brush 
so you will be able to click it off-screen. 

^ Press Shi f t-7 to go to the first cel of the AnimBrush. 

Select the Curve tool if it is not selected. 

ft- Position the brush at the left side of the screen and midway 
between the top and bottom. 

^ Hold down the Alt key and the left mouse button and drag 
down to the lower right corner of the screen. 

Release the mouse button and define the third point of the 
curve while still holding down the Alt key. When the curve 
is a shape you like, click to begin animpainting. 

Notice that even though the cube has only two true dimensions, 
the combination of the three-sided view and the tumble make it 
appear as though the brush is three-dimensional. 

Planetary Orbits— 

Brush Handles 
This example shows you how to create an animation that simu¬ 
lates the orbit of a planet. This demonstrates the importance of 
brush handles—when you rotate a brush, the rotation always 
takes place around the brush handle. 
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Figure 7.5 Orbiting planets using brush handle 
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► Paint a circle about the size of a quarter g£k§ filled with a gra¬ 
dient. Pick the circle up as a brush. 

^ Clear all frames. 

^ Stamp a copy of the brush in the middle of the screen. 

^ Display the Move requester and click Draw to draw 40 
frames of your brush. 

^ If you are holding the brush by its corner, first choose 
Handle>Center from the Brush menu. Now choose 
Handle>Place from the Brush menu. 

Your brush now has a cross-hair running through the center of it. 

^ Position the brush about an inch and a half above the circle 
you painted in the middle of the screen. Hold down the left 
mouse button, drag straight down to the center of the ball 
you painted, and release the mouse button. 

Figure 7.6 Placing the brush handle 

Now your brush is offset from the cursor by about two inches. 
We'H us&this brush to create an orbiting planet. 

► Point ai‘ the center of the stamped circle with the cursor and 
dk'k. (This stamps your circle brush above the circle in the 
middle of the screen.) 

► Display the Move requester. Set the Z Angle to 360. Click 
Draw. 

Play the animation back and you'll see that your planet orbits 
around the central circle! 
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Using the brush handle effectively becomes a little more compli¬ 
cated when you rotate over more than one axis, but you might 
want to spend a little time trying different settings to see the 
effects you can create. 

Scrolling Background This section shows you how to create a scrolling background 
from a single picture. All you need to create this effect is a picture 
with left and right edges that meet to form a seamless image. 

Width of original picture 

Division of picture into frames 

Figure 17 Scrolling background 

* Choose Frames>Set # from the Anim menu and set your 
number of frames to 32. 

► Clear all frames. 

^ Load the picture named DinoBackdrop from the Picture 
drawer on your Art! Disk. 

In the next step, you remove the gradient from the ground in the 
picture to reduce the amount of memory required for the anima¬ 
tion. Since you are working in the Compressed memory model, 
each pixel of your animation that changes from one frame to the 
next uses memory. By removing the gradient, you reduce the 
number of pixels thatch&frge, and thus the amount of memory 
required. Still, this scrolling background will use a lot of memory 
Jf you are using a 1 megabyte system, you will probably not be 
able to add any additional animation to the background. 

Change your background color to the primary orange color of 
the ground in your picture. You can use the Pick eye dropper 
to do this quickly. 
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Filled Plane Effects 

^ Select the Brush Selector tool and pick up the ground using 

the right mouse button. This will remove the gradient and 

leave the primary orange color behind. 

^ Click the Brush Selector again and pick up the entire picture 

as a brush. Click CLR and clear all frames to the orange back¬ 

ground. 

^ Stamp the picture back down as it was before. Display the 

Move requester. Set the X Distance to -320. Set Count to 32. 

Click Draw. 

^ When DeluxePaint is finished drawing your move, press Alt- 

x twice to hold your brush by the lower left corner. Position 

the cursor in the very bottom right corner of the screen. (This 

aligns the left edge of your brush with the right edge of your 

picture on frame 1.) Stamp the brush in place. Display the 

Move requester and click Draw. 

DeluxePaint paints a second version of the DinoBackdrop pic¬ 

ture to complete the 32 frame scrolling background. Play your 

scrolling background to see how it looks. 

This example showed you how to create a scrolling background 

that simulates a camera panning from left to right, but you can 

create one that moves in any direction by following the same ba¬ 

sic steps. You can also use a picture that is larger than an anima¬ 

tion frame to create your scrolling background. To do this, you 

create a large Spare page and load or paint your large picture. 

Then you pick up the pieces of the picture in frame-size chunks 

and put them together just as we did above, except that after you 

put together two pieces, you go to the Scratch page for the next 

chunk of picture and position at the first blank frame (in our case 

the first blank frame would be frame 33 if we had additional 

frames) and do the same move as before. 

The following effects use the Fill option in the Move requester 

to create filled planes that move. In the first example, the plane 

moves toward you so that it seems as though you are traveling, 

in the second example, the filled plane rolls as though you are 

doing a roll in an airplane. 

^ Set the number of frames to 20. 

^ Create a simple filled circle brush to use for your filled 

planes. (If you are on a 1 megabyte Amiga, don't add any 

gradient or other detail, because these filled plane moves 

require a lot of memory even with a simple brush.) 
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Tie 

Moving Ground 

Rolling Horizon 

For the Moving Ground example, it helps if your brush height is 
a multiple of the number of frames you have. This will produce 
smoother results. in the Prefs menu when you 
draw the brush and if Op to confirm that it is the dimensions 
you want.) ' 

► Enter Perspective, 

► Position the brush near the bottom right corner of the screen 
and press Shift- 7 to rotate the brush -90‘. Stamp down the 
brush. Click Undo. 

Right-click the Grid tool and note the number listed for the Y 
Grid value in the Perspective r^gij^ter. Click OK. 

Display the Move requester. Se||^^Distance to the same 
number as the Y Grid value onf|g5Nll^ the number negative. 
Click the Brush button beside the Distance boxes so that you 
move along the brush's coordinates. Make sure the Count is 
set to 20. Click Fi^. 

DeluxePaint will your 20 frames. When it 
is finished, the anini^|^:^SI;^^v a plane of circles moving 
toward you. £ v .>: .V;: 7 

► Clear all frames. Choose Perspective>Reset from the Effect 
menu. 

figure 7.8 Rolling Horizon 
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Spinning Effects 

Amazing Bouncing Ball 

Press Enter on the keypad twice (this takes you out and then 
back into Perspective). 

Position your brush near the bottom of the screen. Rotate the 
brush to -90° on the X-axis. Stamp down the brush. Click 
Undo. 

Display the Move requester. Click Clear. Set the X Distance to 
-640 and the Y Angle to 360. Make sure both Brush buttons 
are selected. Click Fill. 

Again, DeluxePaint takes a while to paint your 20 frames. When 
it is finished, the animation will show the filled plane of circles 
rotating 360" around the perspective center. 

Here are two terrific spinning effects. In the process of creating 
these effects, you'll need to use a range of DeluxePaint features. 
At this point we assume you are familiar with all of the features, 
and our instructions are, at times, general. These exercises are a 
good way to test your knowledge of the program; if you get 
stuck, you should look up how to perform the task we describe 

A bouncing ball sounds complicated, doesn't it? With traditional 
media, it would indeed be tedious, but with DeluxePaint, you 
can master the effect in no time at all. 

L i—^ TV "\ / 
Figure 7.9 Amazing Bouncing Ball 

To produce the spinning effect we want for the bouncing ball, 
you would ordinarily need to do several things: 

Create a range of colors to cycle 
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Create a checkerboard pattern and wrap the pattern onto a 
circle to make it appear spherical. 

0 iSreate a ball-shaped brush and rotate it so the ball spins on 
angle. 

These steps ^ ^ necessary for this exercise, however, because 
we have cre^^^^all for you to use. 

I* Ltf&d the^rush named Ball.Brush from the Artl disk. Choose 
F»k$te>U»e Skish Palette from the Color menu. 

§*• Ssfthe nutft^rDf frames to 10 and clear all frames. 
i i 

tog2ve''the bail some bounce. 

Co to Framed* 

Stamp dow/V&fc brush so the bottom edge is near the bottom 
oHfte screen. 1 
♦ r * 

► Display the Move requester, ai^^^Clear. 

► Set the Y distance to about 75. In to 10. Set the Count 
to 10. Select Go From. Click Pr^lwf" 

The brush should move upward until it almost reaches the 
top of the screen. If it goes too far or not far enough, 
the Y Distance setting and try Preview again. 

Click Draw. 

Now that you've given the ball some bounce, you pick it up as 
an AnimBrush and send it bouncing off into the distance by 
using the Move requester. 

^ Pick up the animated ball as an AnimBrush. Choose 
AnimBrush>Settings from the Anim menu. Click the Ping 
Pong icon. Click Ok. 

^ Clear all frames. Set the number of frames to 40 and Go to 
Frame 1 of the animation. 

^ Move the brush handle to the lower right corner of the brush. 

+ Go to cel 7 of the AnimBrush. Place the cursor in the lower 
left corner of frame 1 (so the brush is off the screen) and 
stamp down the brush. 

^ Display the Move requester, and click Clear. Set the X 
Distance to 850 and the Z Distance to 500. Set the Count to 
40. Set Ease In to 0. Click Draw. 

^ Turn on Color Cycling and play the animation. 
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You'll see a remarkably realistic animation of a spinning, bounc¬ 
ing ball. If you are adventurous, try creating a plane for the ball 
to bounce on. You'll need to adjust the plane's position to match 
the bottom of the ball where it bounces. Then you create the 
plane on the Spare page and merge it behind the animation. 
When you choose tb£ Spare>Merge in back option, DeluxePaint 
asks if you want to merge behind all of your frames. This feature 
makes it easy to build tip animations from several elements. 

Creating the Spinning Ball 

Here are the steps for creating the spinning ball. First you need to 
create a range of colors to cycle. These will ultimately produce a 
spinning effect. . -—, 

► Display the Color Mixer and create a spread ^vit?cal 
reds and eight identical whites. 

Choose Ranges from the Color menu to < 
requester. Select an empty range or clear the^rli i^gfe^d 
define these colors as a range by setting the eight whites and 
eight reds next to each other along the Range bar. Set the Rate 
for color cycling to the maximum. Check Random and slide 
the Dither slider all the way to the left to turn dither com¬ 
pletely off. (Make sure that your reds and whites aren't in 
any other ranges.) 

Rate Slider Dither Slider 

■■ Jllli JU1IUJL ]±+| 
; -L'. i T UNDO OK 

Random 
Button 

Figure 7.10 Range requester 

Now you create a checkerboard pattern and wrap the pattern 
onto a circle to make it appear spherical. 

► Display the Fill Type requester. Select the red and white range 
you created. Select the first gradient fill option for a plain 
horizontal fill. 

► Select the Filled Rectangle tool. Turn on Coordinates. Select 
black as your background color and clear the screen. Paint a 
rectangle that is 44 pixels wide and 22 pixels high. 
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Figure 7.11 The two color rectangle and the checkerboard 

You should now have a rectangle that is white on one side and 
red on the other. 

^ Pick up your rectangle as a brush and create a red and white 
checkerboard pattern. Then pick up exactly a 5 square by 5 
square section of the checkerboard as a brush. 

Clear the screen. Display the Fill Type requester. Select Brush 
Wrap fill. 

Turn on BeSquare in the Prefs menu (so your circle will be 
truly a circle). Paint a filled Circle that is approximately 3 
inches across. 

There it is. Press the Tab key to see the ball cycle. You'll find 
more information about color cycling and color ranges in Tuto¬ 
rial Two of Chapter 4, Painting Tutorials. 

The Spinning Globe This example shows you how to create a spinning globe from the 
WorldMap picture on your Artl disk To accomplish this effect, 
you create a scrolling background, pick up a section of the back¬ 
ground as an AnimBrush, and use it to animfill a circle using the 
Wrap fill type. 

❖ If you are working on a 1MB Amiga, we recommend that you 
start this example from a fresh start of the program in Swap 
mode (chosen from the initial Screen Format requester). This 
fresh start will ensure that you have no memory fragmenta¬ 
tion and Swap mode will give you the most memory to work 
with. This example is very memory intensive and may not 
work on some 1MB configurations. 
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► Set the number of frames to 10. 

,j£.;£5o to frame 1 and load the picture WorldMap from the Artl 
■?.••• disk into the frame. 

Pick up the entire map image as a brush. You should use the 
blue background as a reference for what area to pick up. 

^ Choose Replace from the Mode menu to put your custom 
brush in Replace mode. 

You don't want any of the areas of your brush to be transparent; 
Replace mode replaces any colors of your image that would have 
been transparent in Matte mode. (If you're not familiar with 
the brush modes, we recommend that you review them in the 
Reference.) 

► Clear all frames and press F10 to hide the Toolbox and Title 
Bar. 

Place the brush handle in the lower right corner of the brush 
and stamp the image down in the center of the screen by 
placing the cursor in the lower right corner of the screen. 

► Display the Move requester and set the X distance to 320 (the 
width of the image). Set the Count to 10; turn on Cyclic, and 
make sure the direction is Go From. Click Draw. 

When the move is completed, you'll have a map that scrolls off 
the screen to the right. Now what you need is a second image 
that scrolls into the space the first image leaves behind. 

► Go to frame 1. Move the cursor to the lower left corner of the 
screen and stamp the brush down off screen. 
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► Display the Move requester, and click Draw. 

At this point you'll see DeluxePaint draw the second map image 
scrolling into place alongside the first. When the draw operation 
is finished, you should have a scrolling map. 

^ Press the 4 key to confirm that you have a scrolling map 
without any glitches. If it's moving too fast for you, slow it 
down using the left arrow key. 

Now you need to pick up half the scrolling image as an 
AnimBrush. 

► Go to frame 1. 

► Press b on the keyboard to get the Brush Selector tool and 
pick up a very small brush (1 pixel square) from anywhere on 
the screen. 

The step above was included for the sole purpose of getting your 
screen size map brush out of memory. By selecting the smaller 
brush,, you released the large brush from memory. If you are on a 
1MB system, and you didn't perform the last step,yoia probably 
will get an out of memory message on the next 

^ Choose Animbrush>Pick Up from the Anim menu. Select the 
left half of the image. If you have Coordinates turned on, half 
the map is exactly 160. Enter 10 in the requester to pick up 
the left half of your animation as an AnimBrush. Again, use 
the blue background as a reference for picking up the Anim¬ 
Brush. 

Now you have an AnimBrush of a scrolling map. The trick is to 
convert that to a ball shape. 

^ Clear all frames. 

Choose BeSquare from the Prefs menu. 

Draw a solid color filled circle in the middle of frame 1. 
(Make the circle about 3 inches across.) 

Choose Frames>Copy frames from the Anim menu and se¬ 
lect the All Frames button. This will copy frame 1 to all of the 
animation frames. 

Right-click on the Fill tool to display the Fill Type requester. 
Choose Brush as your fill type, and click OK. 

^ Choose Animbrush>Use from the Anim menu. Press 
Shi ft-7 to position your AnimBrush on its first cel. 
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Select the Fill tool. Hold down the Alt key and click on the 
center of your solid colored circle. 

DeluxePaint will automatically "animfill" to wrap the map im¬ 
age into each of your circles. When it's finished, play the anim to 
see your spinning globe. All that's left now’ is to pick it up as an 
AnimBrush and move it through three dimensions. We'll leave 
that part up to you. Or if you like, try creating spinning balls 
with other images, like faces or interesting patterns. Once you've 
mastered this feature, you'll find it hard to resist. 

This brief section lists some tips for using DeluxePaint's anima¬ 
tion features. This is not a complete list of tips, so be sure you at 
least scan the rest of the manual if you are not inclined to read 
everything. 

❖ You can use Fixed Background to see the current frame as 
you modify it for the next frame. This is very' useful for free¬ 
hand animations. Here's how it w'orks: 

Create some animation framesa figure on frame 1. 
Choose Background>Fix fromi&Bifect menu. Choose a dif¬ 
ferent color to paint a modified version of the first figure. 
Press 2 to step to frame 2. Choose Background Free to stamp 
the modified figure on frame 2. You can repeat this process to 
paint the next modification, and so on. 

❖ If you want your brush to grow (move toward the screen) in 
your animation, but you need to stamp it in the small size for 
proper positioning, you will get nicer results if you paint the 
brush large and then use the ' or Ctrl key in Perspective to 
shrink it before you paint it down for the move. This way the 
brush moves toward its original large size as it is drawn by 
the Move requester and the large size will not suffer from 
"jaggies." 

❖ Because Ease Out and Ease In in the Move requester always 
affect both the Distance and Angle motions, a falling, tum¬ 
bling object won't look right — the tumble appears to accel¬ 
erate along with the fall. Here's a work around: Use Move to 
make a tumbling object without Ease Out or Ease In. Pick the 
object up as an AnimBrush. Now use Move to make this 
AnimBrush fall with Ease-Out for acceleration. The tumble 
stays at a constant rate, but the fall accelerates! 
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Similarly, Move can't Ease-Out one Distance parameter and 
not the other That means it can't make a cannonball fly at a 
constant X speed but a decelerating Y speed (to form a pa¬ 
rabola). You can overcome this by creating the animation in 
steps as in the Amazing Bouncing Ball effect: Use Move to 
paint a ball falling with Ease In. Pick up the falling ball as an 
AnimBrush. Use Move (or the Straight Line tool with N Total 
spacing) to paint the falling ball moving across the screen at a 
constant rate. 

❖ If you want an object to completely disappear when it flies off 
to infinity, here's a trick: Set the X rotation to 90° so that the 
brush turns "edge on" as it approaches infinity. This way no 
more than a single pixel line will remain of your brush. 

❖ When you paint your brush down to begin a move, select 
Undo immediately after you stamp the brush. This guaran 
tees that the brush appears correctly on the current frame 
when the move is painted. Painting down your brush before 
a move is how you tell DeluxePaint where to start the move 
from. You don't need to leave the paint in place, since Deluxe- 
Paint paints that frame again as the first frame of the move. 

❖ You can't stamp the brush behind you, but you can Move it 
there. If you want an object to start from behind the viewer 
and drop into the screen with a perfect, unbroken motion, 
do this: Start from the center position and use the Move 
requester set to a Count of 1 to move the brush out to the 
position you want (for example, -1000 from the front of the 
screen). Now clear the screen or reload the background for 
the animation. Use the Move requester to move the brush 
forward enough Z distance to go from behind you past the 
center position and off into the distance. 

❖ If you have a series of pictures that use the same screen for¬ 
mat and palette, you can use DeluxePaint IV to give a slide 
show. Just load each picture into a frame (see Load in the 
Picture menu for loading multiple pictures) and set a slow' 
frame rate or flip the frames manually with the 2 and 1 keys. 

❖ You can calculate the Distance numbers for the Move re¬ 
quester by positioning the brush at each end of the move in 
Perspective and subtracting the beginning position coordi¬ 
nates from the ending position coordinates. Use the \ key to 
toggle between angle and position coordinates. 
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Spacing Tips When you animpaint with the shape tools, use the Spacing re¬ 

quester to control the number of brush stamps used to draw the 

shape. In effect, this setting determines how many frames you 

will paint over. 

Instant Marquees: Set the Spacing requester to N Total and the 

number of frames you have, and animpaint unfilled shapes 

using a built-in brush. Using the Spacing set to N Total for anim- 

painting is especially good with the Circle tool, which otherwise 

paints a non-cyclical pattern. Also try setting Spacing to Every 

Nth Dot, especially with the unfilled Polygon tool. 
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DeluxePaint IV's Reference chapter contains all the information 
you'll need to master the program, arranged in a way that's easy 
to use. The Tools section covers the Toolbox, explaining how to 
select, modify and use the tools to draw basic shapes or other¬ 
wise manipulate your image by color, size, shape or orientation. 
The Menus section covers all the options available in the pull¬ 
down menus. The menus are described individually, moving left 
to right across the Menu Bar, and down through each option. 

Some entries in Reference cross-reference other parts of the 
manual or other sections of Reference. We recommend that you 
look at the cited section for more information about any cross- 
referenced entry. 

Tools 
When you start DeluxePaint IV, the Toolbox appears on the right 
side of the screen. It contains built-in brushes, tools, the Color 
Indicator, and the Palette. 

❖ Select a tool by clicking its icon in the Toolbox. 

You can hide the Toolbox to expose more of the painting area by 
pressing F10 (this hides the Toolbox and the Menu bar). You can 
then press F9 to display the Menu Bar without the Toolbox. Press 
FI0 to display the Toolbox again. 

❖ Be sure the cursor is not at the top of the screen when you 
press F10. 

Built-in Brushes 

Continuous Freehand 

Curve 

Airbrush 

Unfilled/Filled Circle 

Unfilled/FilJed Polygon 

Text 

Symmetry 

Zoom 

Clear 
— Current Foreground Color 
— Current Background Color 

Figure 8.1 The Toolbox 

Dotted Freehand 

Straight Line 

Fill Tool 

Unfilled/Filled Rectangle 

Unfilled/Filled Ellipse 

Brush Selector 

Grid 

Magnify 

Undo Last Painting Action 
Color Indicator 
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Built-in Brushes 

Dotted Freehand 

The following tool descriptions include any keyboard equiva¬ 
lents that are available. And to help you learn these, we have 
suggested a mnemonic for each one. You'll find these especially 
useful if you want to hide the Toolbox as explained above. You 
can also find all keyboard equivalents in Appendix B. 

B 
■ ■■■ 

Right-clicking a brush invokes the resize brush option. When 
you move the brush to the screen, your cursor will have the 
word SIZE hanging from it. To increase or decrease the size of 
the brush, drag the mouse. 

You can also change the size of the current brush dynamically, 
even while you're painting. Press the plus (+) key to increase the 
size of your baish (no need to press the Shift key). Press the 
minus (-) key to decrease its size. The icon in the Toolbox reflects 
any changes you make. 

❖ The smallest a resized built-in brush can be is 1 x 1 pixel. The 
largest it can be is 100 x 100 pixels. 

There are ten built-in brushes you can paint with in the Toolbox. 
To select any built-in brush, click on it. 

Keyboard Equivalent: s—mnemonic—sketch 

Lets you paint freehand with the current built-in (or custom) 
brush. Hold down the left mouse button to paint with the fore¬ 
ground color, or the right mouse button to paint with the back¬ 
ground color. The tool paints in a series of "splats" or "stamps" 
of the current brush shape. 

The spacing between each stamp depends on how fast you move 
the mouse—the faster you move the mouse, the greater the spac¬ 
ing between stamps. If you move the mouse slowly, there is no 
space between splats. 

Holding down the Shift key while painting constrains the tool to 
move either horizontally or vertically, depending on the direction 
you move the cursor immediately after pressing Shift. 
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Continuous 
Freehand/ Filled 

Freehand Shape 

Reybo 
D—Fill etl dr 

livalent: d—mnemonic—draw, 
aw 

£2fick in thart^jjer left corner of the icon to select the Continuous 
Freehand tool. Click in the lower right corner to select the Filled 
Fp*(Phand Shape tool. ^1 

The Continuous Freehand tool paints the brush in a continuous 
line as you drag the mouse. This tool works like the Dotted Free¬ 
hand tool, except that it never "splats." 

% ) Holding down the Shift key while painting with the Continuous 
Freehand tool constrains the tool to move either horizontally or 
vertically, depending on the direction you move the cursor im¬ 
mediately after pressing Shift. 

Use the Filled Freehand Shape tool to draw filled freehand 
shapes. When you release the mouse button, your shape is filled 
using the current setting of the Fill Type requester. (If you release 
the mouse button before you reach the starting point for your 
filled shape, DeluxePaint completes the shape by drawing a 
straight line from the current mouse position to the starting point 
of the shape.) 

Holding down i as you click on the Filled Freehand Shape tool 
causes the tool to paint shapes that are filled and then outlined 
with the current brush using the settings of the Spacing re¬ 
quester. If you use a custom brush as your current brush, it is 
possible to paint shapes that are filled with one color and out¬ 
lined with another. The outline is painted by tracing the shape 
with the current brush. Note that the shape is traced by the brush 
handle; if the handle is offset from the brush, the outline will be 
offset from your filled shape. 

Figure 82 Two outlined shapes using a custom brush—one with the 
handle centered and one with the handle offset from the brush 
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Straight Line Tool 

ED 

0 

Right-clicking on the Filled Freehand Shape tool displays the Fill 
Type requester. From here you can set the fill type for all filled 
shapes. See Fill Tool for an explanation of the options in this re¬ 
quester. 

Keyboard Equivalent: v—mnemonic—vector. 
V—Spacing requester 

Paints a straight line in any direction. The width of the line is 
determined by the current built-in (or custom) brush. To paint a 
line: 

^ Select the Straight Line tool, and position the cursor where 
you want the line to begin. 

^ Use the left mouse button to paint with the foreground color, 
or the right mouse button to paint with the background color. 

^ Drag in any direction to create a line. 

Holding down the Shift key while painting a straight line con¬ 
strains the line to be either horizontal or vertical, depending on 
the direction you move the cursor immediately after pressing 
Shift. 

Holding down the Ctrl key as you paint a straight line, causes the 
line to leave "traces" as you paint. 

Figure S3 Traces drawn with Straight Line tool 

Right-clicking the Straight Line tool displays the Spacing re¬ 
quester. The Spacing requester lets you specify the space between 
the paint "splats" deposited by the brush. Click to choose any of 
the four options in the requester. 
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N Total 

Every Nth dot 

Airbrush 

Continuous 

Figure 8.4 
The Spacing requester 

Defines the total number of "splats" that will occur along the 
line. You can define the number of ''splats" by clicking the edit 
box, backspacing or deleting over the existing value, and typing 
in the new value. This setting is especially useful for ensuring 
that when animpainting over a series of frames you get exactly 
the number of brush stamps you need. 

Spacing 

N Total 

Every Nth dot 

Airbrush 

Continuous 

Cancel Ok 

Spacing sets the number of pixels between each "splat" of the 
brush. This lets you space your brush splats accurately. 

Paints using the Airbrush tool along the path defined by any tool 
affected by the Spacing requester The number to the right of the 
button sets the number of airbrush sprays to be applied at each 
pixel along the path. This creates a fuzzy line or shape. You can 
use this feature w'ith the painting modes from the Modes menu 
to create interesting effects. For example, using Smear with the 
Airbrush spacing can create interesting textured effects on a 
colored background. 

Figure 8.5 Circle painted using Airbrush spacing and the Color 
painting mode 

This spacing paints an unbroken path with no space between 
pixels. Continuous is the default setting. 
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Curve Tool □ Keyboard Equivalent: q—mnemonic—qurve 

Use the Curve tool to draw an arc between two points. The 
width of the line is determined by the current built-in (or cus¬ 
tom) brush. The Curve works like the Straight Line tool, except 
that the line remains attached to your cursor, so you can specify 
the third point in the arc. 

Select the Curve tool, and position the cursor where you want 
the curve to begin. 

Drag to where you want the curve to end, and release the 
mouse button. 

& Move the mouse in any direction to form the arc shape you 
&'ant, and click. 

$ 1 Hiding down the Shift key while painting with the Curve tool, 
LLt^^rains the tool to move either horizontally or vertically as 

, you paint the initial line, depending on the direction you move 
the cursor immediately after pressing Shift. This is useful if you 
want the ends of your curve to line up horizontally or vertically. 

Holding down the Ctrl key as you paint a curve, causes the curve 
to leave "traces" as you paint. 

Right-clicking the Curve tool displays the Spacing requester (see 
Straight Line Tool, above, for an explanation of the options in this 
requester). 

Fill Tool )ij&| Keyboard Equivalent: f—mnemonic—fill. 
F-HFill Type requester 

Use the Fill tool to fill an enclosed area using the current settings 
in the Fill Type requester. To use the tool: 

► Move the paint can cursor over the enclosed area you want to 
fill, so that the tip of the spout is within the area. 

*> The spout is the one pixel opening at the bottom of the 
"splash." 

► Click to fill the enclosed area. 
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Spout 

Solid 

Figure 8.6 
The "spout" of the fill cursor 

O Holding down i when you click with the Fill cursor, fills outward 
to the background color. In other words, the fill spreads outward 
until it reaches areas of the current background color. 

Holding down the Alt key when you click with the Fill cursor, 
animfills the shape. This means that the frames of your anima¬ 
tion will flip, and the fill tool will fill outward on each frame 
from the point where you clicked. This option works with all of 
the Fill Types except the gradient fills that use the gradient direc¬ 
tion line to define the gradient. 

Right-clicking the Fill tool displays the Fill Type requester. The 
options in the requester are explained in the following para¬ 
graphs. When you return to the painting screen after choosing a 
fill type, the current gradient (or pattern, if Pattern or Perspective 
is selected) and its orientation are shown in the Color Fill box in 
the Title Bar (see User Feedback in Title Bar, later in this chapter). 

Figure 8.7 
The Fill Ti/pe requester 

Fills with the current color. If you paint or fill your shape using 
the left button, the shape is filled with the foreground color. If 
you paint or fill your shape using the right mouse button, it is 
filled with the background color. This is the default mode. 

Brush Fills with one image of the current custom brush and sizes it to 
fit the filled area. See Figure 8.8. 
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Wrap 

Perspective 

HBrite 

Pattern 

Range 

Fills with one image of the current custom brush and adjusts it to 
the horizontal and vertical shape of the filled area. This gives the 
illusion of wrapping the brush around a 3D solid. The effect is 
most pronounced if you use it to fill a shape that is very different 
from the shape of the custom brush. See Figure 8.8. 

DefuxePaint Matte_□_UMP 

Figure 8.8 Brush and Wrap fills 

Fills with a pattern of the current brush in the current perspec¬ 
tive setting (see Perspective under the Effect menu). 

Fills using the Hbrite painting mode. In effect, this is a special 
form of tinting that only works if you are working in Halfbrite 
mode (see HBrite in the Mode menu, below). When you are not 
in Halfbrite mode, this option does not appear in the requester. 
Drawing with the right mouse button over Halfbrite areas re¬ 
verts them to their full color counterparts. 

Fills with a pattern made from a brush. To use this option, you 
must first click the From Brush button to create a pattern of the 
current brush. This pattern remains the current fill pattern until 
you click From Brush again to create a new pattern from your 
new custom brush. 

Fills an enclosed object with a spread of colors (a gradient, see 
Gradients, below) from the selected range. Type in the number of 
the range you want to use. Click to select one of the fill options, 
which specify the direction and type of the gradient fill. You can 
only use one fill option at a time. 
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Gradients 

o 
[2 

O 

Horizontal paints the gradient horizontally. 

Vertical paints the gradient vertically with an even distribution. 

Horizontal Line paints the gradient one line at a time and ad¬ 
justs the gradient on each line so that it follows the contours of 
the shape being filled. 

Figure 8.9 Vertical, Horizontal, and Horizontal Line gradient fills 

DeluxePaint supports two types of gradients: Linear and Radial. 
A Linear gradient fills an object in one direction (in a line), and 
can either take the object's shape into account, or ignore it. A 
Radial gradient fills an object in all directions (radially) from 
the point where you click, until it reaches the boundaries of the 
object. Like Linear gradients, a Radial gradient can either take 
the object's shape into account, or ignore it. 

Linear Gradients 

The linear gradients are Line and Shap(ed). When you fill an 
object with either of these options, a gradient directional line 
stretches from the center of the object to the cursor. Use this line 
to tell DeluxePaint the direction in which to fill the shape with 
the gradient. For example, if you move the directional line to the 
top of your shape and click, DeluxePaint fills your shape with 
the selected gradient from top to bottom. The first color in the 
gradient (in the far left position in the range) appears at the 
bottom of the shape. 

Line | Line fills the object with a uniform linear gradient, ignoring the 
shape of the object. 
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DeluxePaint Matte_g 

Figure 8.10 Filling the same shape using different gradient directions 

Shaped fills the object with a linear gradient, taking the shape 
of the object into account, so gradient lines tend to follow the 
object's contours. 

DeluxePaint Haft# 

Figure 8.11 Shaped Gradient 
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Radial Gradients 

The radial gradients are Cir(cular), Candours), and (Hi)light. 
When you select any of them and click on a shape, a gradient di¬ 
rectional line stretches from the center of the object you filled to 
the cursor. Move the cursor, which is attached to the directional 
line, to the spot where you want the gradient to begin and click. 
DeluxePaint will fill your shape radially outward from the point 
where you clicked. Radial gradients are especially useful for 
drawing shadows and other consistent three dimensional light¬ 
ing effects. 
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Random 

Dither 

Cir | Circular fills the object with a circular (shaped) gradient radi¬ 
ating outward from the point where you click. Like the Straight 
linear fill, above, Circular does not take the shape of the object 
into account. 

Con | Contours fills the object with the gradient taking the shape of the 
object into account. This creates a contour effect, reminiscent of 
topographical maps. 

Hi | Highlight is similar to Contours, but optimized to create a high¬ 
light effect. Like Contours, the object is filled with its shape taken 
into account. See Figure. 8.12 for a comparison between the two 
methods. 

Figure 8.12 Gradient fill, showing the difference between 
Contours and Highlight 

When you click the Random action button, a V appears. With 
Random turned on, the border between any two colors in the 
gradient are randomly mixed (see Dither, below). Click the ac¬ 
tion button a second time to turn off Random. 

DeluxePaint draws patterned gradients by dithering, which re¬ 
duces the contrast between adjacent colors (without changing 
the colors themselves). When Random is checked, you can adjust 
the degree of color mixing in the gradient fill. Drag the Dither 
slider left or right to decrease or increase the amount of dither. 
Setting the slider all the way to the left gives almost no mixing 
between shades. Moving the slider to the right increases the 
amount of mixing at the color boundaries 
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Airbrush Tool 

Unfilled/Filled 
Rectangle 

Simulates the action of an airbrush by spraying with the current 
brush. 

Select the Airbrush tool. Position the cross-hair on the page 
and drag to paint. 

Holding down the Shift key while painting with the Airbrush 
tool, constrains the tool to move either horizontally or vertically, 
depending on the direction you move the cursor immediately 
after pressing Shift. 

Right-clicking on the Airbrush tool lets you size its nozzle. After 
right-clicking the tool, move the cursor onto the page and drag 
the mouse until the nozzle is the size you wrant, then release the 
mouse button. 

Keyboard Equivalent: r—unfilled. 
R—filled; mnemonic— rectangle 

Use the Rectangle tool to paint a rectangle shape using any 
brush. The upper left half of the tool paints a rectangle outline 
using the size of the current brush and the current settings of the 
Spacing requester. The lower right half of the tool paints a filled 
rectangle using the current settings of the Fill Type requester. 

^ Select the Rectangle took and position the cursor on the page 
where you want the rectangle to begin. 

Drag the cursor diagonally to form a rectangle. When the 
rectangle is the size you want, release the mouse button. 

Holding down the Shift key while painting with the Rectangle 
tool, constrains the rectangle to be the same number of pixels 
wide and high. You'll notice that ttefhfepe is not necesarily a 
square. This is because the pixels Amiga display are not 
square. To paint a square, turn on Be Square option in the 
Prefs menu. When Be Square is on, DeluxePaint IV adjusts the 
height and width of your square so that it appears square rather 
than being square in terms of pixel count. 

©Holding down the Ctrl key as you paint a rectangle, causes the 
rectangle to leave "traces" as you paint. 

Holding down i as you click on the Filled Rectangle tool causes 
the tool to paint shapes that are filled and then outlined with the 
current brush using the settings of the Spacing requester. (See 
Freehand Shape Tool for more information.) 
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Right-clicking on the Unfilled Rectangle tool displays the Spac¬ 
ing requester. Use this requester to set the spacing between 
"splats" in the sides of your rectangle. (See Straight Line Tool, 
above.) 

Right-clicking on the Filled Rectangle tool displays the Fill Type 
requester. Use this requester to set the type of fill you want in 
your rectangle. See Fill Tool for an explanation of the options in 
this requester. 

Keyboard Equivalent: c—unfilled. 
C—filled; mnemonic—circle 

Use the Circle tool to paint circles using any brush. The upper 
left half of the tool paints a circle outline using the current brush 
and the current settings of the Spacing requester. The lower right 
half of the tool paints a filled circle using the current settings of 
the Fill Type Requester. 

Select the Circle tool, and position the cursor on the page 
where you want the center of the circle. 

> Drag the cursor in any direction to form the circle. When the 
circle is the size you want, release the mouse button. 

The circles that DeluxePaint IV paints may not appear perfectly 
circular. Circles are painted to be the same number of pixels high 
as they are wide. The circles do not appear perfectly circular be¬ 
cause the pixels of the Amiga display are not square. If you want 
your circles to appear circular, turn on the Be Square option in 
the Prefs menu (see Prefs Menu, below). 

Holding down the Ctrl key as you paint a circle, causes the circle 
to leave "traces" as you paint. 

Holding down i as you click on the Filled Circle tool causes the 
tool to paint shapes that are filled and then outlined w'ith the 
current brush using the settings of the Spacing requester. (See 
Freehand Shape Tool for more information). 

Right-clicking on the Unfilled Circle tool displays the Spacing 
requester. Use this requester to set the spacing between "splats" 
in the sides of your circle. (See Straight Line Tool, above.) 

Right-clicking on the Filled Circle tool displays the Fill Type re¬ 
quester. Use this requester to set the type of fill you want in your 
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circle. See Fill Tool for an explanation of the options in this re¬ 
quester. 

Unfilled/Filled 
Ellipse 

Keyboard Equivalent: e—unfilled. 
E—filled; mnemonic—ellipse 

Use the Ellipse tool to paint an ellipse. The width and shape of 
the line is determined by the current brush. The upper left half of 
the tool paints an ellipse outline using the current settings of the 
Spacing requester. The lower right half of the tool paints a filled 
ellipse using the current setting of the Fill Type requester. 

^ Select the Ellipse tool. Position the cursor where you want 
the center of the ellipse to be and click. 

^ Move the cursor in any direction to form the shape you want. 

Drag the mouse in a circular motion to rotate the ellipse The 
degree of rotation is shown in the menu bar 

► When the ellipse is positioned in the orientation you want, 
release the mouse button. 

Holding down the OH key as you paint an ellipse, causes the 
ellipse to leave ''traces" as you paint. 

Holding down f as you click on the Filled Ellipse tool causes the 
tool to paint shapes that are filled and then outlined with the 
current brush using the settings of the Spacing requester. (See 
Freehand Shape Tool for more information.) 

Right-clicking on the Unfilled Ellipse tool displays the Spacing 
requester. Use this requester to set the spacing between "splats" 
in the sides of your ellipse. (See Straight Line Tool, above.) 

Right-clicking on the Filled Ellipse tool displays the Fill Type 
requester. Use this requester to set the type of fill you want in 
your ellipse. See Fill Tool for an explanation of the options in this 
requester. 

Unfilled/Filled f^l Use the Polygon tool to paint a polygon shape using any brush. 
Polygon The upper left half of the tool paints a polygon outline using the 

current settings of the Spacing requester. The lower right half of 
the tool paints a filled polygon using the current settings of the 
Fill Type requester. 
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► tool and position the cursor where you 
corners of the polygon. 

»> Click and then move the mouse in any direction to pull out a 
side of the polygon. 

► Click to tack down each corner of the polygon. Clicking on 
the Polygon's point of origin completes it. 

•> You can complete a polygon without having 
point of origin by pressing the space bar. This 
completes the polygon by connecting your 
the origin. However, if you're using the Unf 
tool, pressing the space bar will not complete 
You'll need to connect the last corner with the pbfht oF'drigin 
yourself. 

Holding down the Ctrl key paint a polygon, causes the 
polygon sides to leave "tra^r* ^ you paint. 

Holding down / as you click on the Filled Polygon loo! causes 
the tool to paint shapes that are filled and then outfitted7 with the 
current brush using the settings of the Spacing requester, (See 
Freehand Shape Tool for more information.) 

Right-clicking on th^®j^|led Polygon tool displays the Spacing 
requester. Use this ^i^ler to set the spacing between "splats" 
in the sides of yourSpg^^n. (See Straight Line Tool, above). 

Right-clicking on the Filled Polygon tool displays the Fill Type 
requester Use this requester to set the type of fill you want in 
your polygon. See Fill Tool tor an explanation of the options in 
this requester. 

Keyboard Equivalent: b—new brush. 
B—previous brush; mnemonic—brush 

Use the Brush Selector to create a custom brush from any image 
on the page, or to recall your most recent custom brush. 

To select a rectangular brush: 

Select the Brush Selector, and move the cursor to the page, 
where it becomes a large cross-hair 

^ Drag diagonally to enclose the area you want to use as a 
brush. Release the mouse button to select it. 
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To select a polygonal brush: 

[gg ► Double-click the Brush Selector to select it. The Brush Selector 
icon now looks like the Polygon tool. 

You can now surround the area you want to pick up as a 
brush as though you were drawing with the Polygon tool. 
As with the Polygon took pressing the space bar completes 
the brush selection automatically. 

❖ Using the left mouse button to pick up a brush simply copies 
the selected area as a brush. Using the right button to select 
the brush cuts the selected area from the page to make the 
brush, and replaces the area with the current background 
color. 

When you pick up a brush, any colors that match the current 
background color are transparent. If you have AutoTransp 

turned on in the Prefs menu, this additional rule applies: if all 
corners of the brush are of the same color, that color becomes 
transparent, regardless of whether it is the background color. 
(See AutoTransp in the Prefs menu). 

You can retrieve your most recent custom brush or AnimBrush 
by right-clicking the Brush Selector or pressing B. 

Ni Holding down the Shift key while selecting a brush with the 
rectangular Brush Selector will constrain the brush to be a 
square. This means that it will be the same number of pixels high 
as it is wide. Because the pixels of the Amiga display are not 
square, your brush may not appear square. If you want the brush 
to appear square, turn on Be Square in the Prefs menu before 
you select the brush. 

Text [jjjj Keyboard Equivalent: t—mnemonic—text. T—text requester 

Use the Text tool to add text to your picture. 

► Select the Text tool, and move the cursor to the page. 

Click to place the text cursor. Type on the keyboard to enter 
text in the current foreground color. 

The text will automatically wrap around the right edge of the 
page and restart below the original cursor position. If your page 
size is larger than the screen, the page scrolls as you type off the 
edge of the screen. The text tool does not automatically word¬ 
wrap like a word processor. 
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You can use the Backspace key to erase text, and the Return key 
to begin a new line. To exit text mode, press ESC or click a paint¬ 
ing tool. 

❖ You cannot backspace over typed characters if the screen 
scrolls. 

Right-clicking the Text Tool displays the Choose Font requester. 
Use this requester to choose fonts, sizes, and styles for your text. 

Figure 8. 23 The Choose Font requester 

The scrolling font list displays the fonts that are available in the 
current font directory. To choose a font, click on its name. By 
default this directory is specified as FONTS:. 

By clicking in the Drawer edit box, typing a new disk directory 
path name and hitting Return, you can specify a new disk drawer 
for fonts. This makes it much easier to access fonts from directo¬ 
ries other than FONTS. For example, to use the fonts on the Art 
disk, you would type Art 1 :Karafonts in the Drawer edit box 
and press Return. 

Choose a size for the font by clicking on the up and down arrows 
next to the size edit box. The scrolling list of sizes is restricted to 
the currently available sizes for the font that you have chosen. 

Choose a style for the font by clicking on the Bold, Italic, and Un¬ 
derline action buttons. You can use these styles in any combina¬ 
tion. Clicking an active (highlighted) button turns it off. The two 
fonts included on the Art2 disk have only one size available for 
each. 
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Fo*vt Tips 

Clicking the Show button loads the currently selected font from 
disk and displays a sample of the current font in the show win¬ 
dow of the requester. 

Some fonts are CAPS only fonts, so if you are typing and all you 
see is an outline, turn on the Caps Lock key and try again. 

To Load and Assign Fonts from other Disks or Directories: 

1. Make sure that you know the correct disk name or storage 
device name and/or the full path name of the fonts location. 
For example, say you have some video fonts stored on a disk 
called EXTRAFONTS in a drawer called FORVIDEO, then in 
the Drawer field of the Choose Font Requester you would 
typo EXTRAFONTS: FORVIDEO and press the Return key. 
Similarly, if the fonts were stored on a hard drive partition 
called dhO in a subdrawer called FONTS1 under a drawer 
called PAINT, then you would type dhO: PAINT/F0NTS1 in 
the Choose Font requester. 

2. If you have a hard drive and keep your fonts j 
ers or in drawers a couple of levels deep, youlp! 
add assigns to your startup-sequence so that 
your font collection quickly in the Font reque 
suit your Amiga owners manual or Amiga DOS manual on 
how to edit your startup sequence before you experiment 
with this. Following is an example of an assign you can use 
to access the two ColorFonts included on the ART1 disk. 
The assign to access the fonts would be: 

ASSIGN KARA: dhO:DpaintIV/Karafonts 

After this Assign has been executed, rather than having to 
type in dhO:DpaintIV/Kara fonts in the drawer field, you will 
need to type only the system will automatically 
take you to the KarafousF subdirectory. This example as¬ 
sumes you have instiled Karafonts drawer from your 
ARTl disk into yo**.rDjT^fe^.%drawer on your hard drive. 

This example can be, for other font drawers as 
w«ti-fe^ikS?AD & SAVE requesters throughout the pro- 
g^jRvS^%^L«an also be quite useful for saving and loading 

AnimBrushes, and Animations to long patlV i • 
n^m • 

- — . 7- - “•* - 

3. Pfease note that not all font sets have complete attributes, 
some fonts may not be able to be Italicized or Underlined; 
most fonts should be able to be set to Bold. 
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4. DeluxePaint IV is compatible with most Standard Amiga 
Fonts, and can also load ColorFonts of up to 16 colors. Your 
Amiga dealer, local Amiga Users Group, or Amiga magazines 
are good sources for obtaining Public Domain fonts or for 
Purchasing additional commercial fonts like the KaraFonts 
included with DeluxePaint IV. 

Grid a Keyboard Equivalents: g—grid on/off; Shift-g—grid on and use 
brush handle location as a grid point; mnemonic— grid 

The Grid constrains some of the painting tools so that they paint 
only on the coordinates of a grid. If you press G to turn the grid 
on while using a brush, the grid will use the current brush 
handle position as one of its grid points. 

The tools affected by the grid are: 

Dotted Freehand 
Straight Line 
Rectangle 
Circle 
Ellipse 
Brush Selector 
Text 

Right-clicking the Grid icon displays the Gridding requester. Use 
this requester to adjust tht K and y spacing of the grid. 

Gridding 

X-spacing: 

Y—spacing: 

Adjust 

Cancel I Ok 
Figure 814 
The Gridding requester 

You can specify the grid values in pixels by deleting or backs¬ 
pacing over the existing values and typing in the new ones. 
Alternatively, you can click Adjust, which lets you visually place 
and adjust the grid cursor on the work area. The upper left cor¬ 
ner of the adjustable grid is anchored as you drag the lower right 
corner. Release the mouse button to complete the adjustment. 

Right-clicking the Grid tool while you are in Perspective mode 
displays the Perspective Settings requester. See Perspective 
Settings under thelEffect rnenu . 
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Symmetnj 

Point Symmetry 

Place 

Tile Symmetry 

Keyboard Equivalent: / 

The Symmetry tool helps you paint symmetrical patterns around 
a central point or based on a tiling scheme. Symmetry works 
with all tools except Text and Brush Selector. 

Right-clicking the Symmetry tool displays the Symmetry re- 
quester.,jij«4lyi;s..requester to choose between the two symmetry 
modc^:v,pomtand.T!le) and to set parameters for each of the 

mod^&^TT^^pS^ 

Mieeor 

Cancel Ok 

Uidth: 

Height: 

Cancel Ok 

Figure 8.15 The Symmetry requester in both Point and Tile settings 

Works around a central symmetry point in either Mirror (mirror 
image duplication of each point) or Cyclic (direct duplication at 
each symmetry point). In Point Symmetry you can select the 
number of symmetry points by using the Order edit box. You can 
also set the location of the symmetry center by clicking Place and 
then the point on the screen where you want the center of 
symmetry to be. 

Lets you position the central point of your symmetrical pattern. 
To reposition the central point, click Place, move the large cross¬ 
hair to the new location, and click. Subsequent symmetrical 
drawing will be centered on the new location. 

Creates "tile" patterns. You can set the horizontal and vertical di¬ 
mensions (in pixels) of the tile in the width and height edit boxes 
(Tile Symmetry requester only). Tile is useful in creating fill pat¬ 
terns; once you've created your symmetrical pattern, set the Grid 
to the same spacing as the tiles to pick up exactly one tile as a 
brush. Tile lets you create an entire pattern just by drawing one 
of its elements, and is an ideal tool for textile designers. 
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• • 

Magnify 

Zoom 

♦> Because Tile Symmetry gives immediate feedback as you 
draw, it replaces the picture beneath each of the tiles in the 
symmetry. This will effectively destroy any picture that was 
on the screen before you turned on Tile Symmetry. 

If you want to use Tile Symmetry to paint over an existing 
picture, choose Background>Fix from the Effect menu before 
you turn on Tile Symmetry. This will protect your existing 
picture from any inadvertent alteration. 

Keyboard Equivalent: m—mnemonic—magnify 

The Magnify tool divides the screen into two parts and displays 
the right-hand side in magnification. This tool is especially use¬ 
ful for detail work. When you are in Magnify mode, you can use 
any other tool on either side of the screen. 

^ Select the Magnify tool. Position the Magnify box over the 
part of the image you want to enlarge and click with either 
button. 

This divides the screen into two parts, with the right part mag¬ 
nified. You can scroll the magnification window using the arrow 
keys or the n key, which centers the area under the cursor. 

To change the magnification scale click the Zoom icon (beside the 
Magnify tool). Clicking Zoom enlarges the magnified area; right- 
clicking shrinks it. 

❖ You can set the Zoom level before you magnify an area. 
Changing the Zoom setting will change the size of the rect¬ 
angle attached to your cursor when you are in the process of 
magnifying an area. 

The Magnify tool is especially useful for detailed work. You can 
use any other tool on either side of the screen in Magnify mode. 

Keyboard Equivalent: > enlarge; < shrink 

Changes the scale in Magnify Mode (see Magnify Tool, above). 
Click the Zoom tool to enlarge the image; right-click to shrink the 
image. 
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Undo Keyboard Equivalent: u—mnemonic—undo 

Reverses the lastest painting action (including UNDO) as long as 
there has not been an intervening mouse click or a refresh of the 
screen such as that caused by pressing F9 or F10 to hide or show 
the menu and toolbox. 

CLR Keyboard Equivalent: K—mnemonic—Klear 

Clears (erases) the screen to the current background color. If you 
have multiple frames, an Options requester appears for you to 
indicate which frames you want to clear. 

Color Indicator Indicates the current foreground and background colors. 

0 
0 

Figupe fji3$ Th&C&tor indicator 

Clicking thpCofor Indicator (or pressing the comma from the 
keyh^ai^^fi^t^'the eye dropper cursor. This lets you select a 

pir background color by clicking a color on¬ 
screen. Click the on-screeto select a new foreground color, 
or right click to select a ncW;&^|ground color. 

Right-clicking the Color Indicator displays the Mixer. Use the 
Mixer to arrange, modify, and mix colors for your palette. 
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Palette 

lluMMd ■■■1M I.J I 

COPY j EX SPREAD PICK IOELETE 

Figure 8.17 Color Mixer 

DeluxePaint IV lets you modify colors with either the RGB or the 
HSV color mixing systems. See Palette under the Color Menu, 
below for a detailed description of the Mixer 

Clicking a color in the palette selects that color. Click to select a 
new foreground color and right-click to select a new background 
color. 

You can scroll through the colors in the palette to select a fore¬ 
ground color by pressing the [ and ] keys on the keyboard. Shift-[ 
and Shift-] to scroll through and select a background color. 

4b ►! In HAM mode an indicator appears below the palette to show 
which area of the Color Set you are viewing. Click the arrows to 
move forward or backward. Shift-click to move to the beginning 
or end. 

To change the colors in your palette, use the Palette and/or Color 
Set options from the Color menu. 
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Menus 
DeluxePaint menus work just like standard Amiga menus. 

Point to the Title Bar and press the right mouse button to 
display the Menu Bar. 

Point to a menu name to open that menu. 

Drag the pointer down to one of the menu options, and 
release the mouse button to select that option. 

Some menu options have submenus indicated by a right pointing 
triangle ( ►) to the right of the option. You can drag the highlight 
down to the option to display the submenu, then drag the high¬ 
light to the right and down again to select an option from the 
submenu. 

When we reference a submenu option in this manual, we use the 
following convention: "Choose menu option>submenu option 
from the X menu." So, for example, "choose SparoSwap from 
the Picture menu," means display the Picture menu and high¬ 
light Spare. This exposes the Spare submenu. From the submenu 
highlight Swap and release the mouse button to activate your 
command. 

In many cases, you can select a menu item by using its keyboard 
equivalent. A table of keyboard equivalents is included as 
Appendix B at the back of this manual. Before you use a key¬ 
board equivalent, make sure the cursor is not pointing at the 
Title Bar, or your keystroke will have no effect. 

❖ One keyboard equivalent deserves special mention: a, the 
"Again" key invokes your last menu command, whatever it 
may have been. 

The menus are discussed below in the order they are displayed, 
reading from left to right, across the Menu Bar. 

Picture 

Menu 

union 
Load.. oi 1 
Save.. PHS 
Delete.. PHD 
Print.. KJP 
Flip ► 
Spare ► 
Pac/e Size.. 
Show Pd«L» S 
Screen Fornat.. 
About.. 
Quit Q 

The Picture menu lets you save, load, and print ^ctures, as 
well as allowing you to make various global cha^|^)fe> the color 
palette, screen resolution, and page format. 
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Load ... Keyboard Equivalent: Right-Amiga-1 
Displays the Load Picture requester. 

Figure 8.18 Load Picture requester 

Clicking the Disks action button displays the currently loaded 
disks, devices (for example DFH: or DFO:, DF1:), and volumes 
(DPaint IV, RAM DISK:, etc.). Clicking the Parent action button 
moves you into the parent directory in which the current 
subdirectory resides. This may or may not be the root directory. 
If you click a drawer [subdirectory! name you will see all the 
files in that subdirectory. 

If you swap disks while this requester is displayed, DeluxePaint 
reads the new disk's directory but does not display it until you 
click the Disks button. 

If there are more items in the directory than there is room in the 
window, you can scroll through the window by clicking the up 
and down arrow keys, or by dragging the scroll box up and 
down. 

Note that devices, volumes and directories are shown in the 
requester in blue type, while files are shown in black type. Also, 
devices, volumes and directories are denoted with the prefixes 
DEV, VOL, and DIR respectively. 

Pattern Edit Field This is a new field in the Load, Save, and Delete Requesters. 
When used with the proper pattern matching parameh^ it Jets 
you selectively view the files you want. You may have&olk*?d 
that there are two types of 3 character extension patternsihaL 
were used for files in the Picture drawer of the Artl disk, 
Filename.LoRes, and Filename.Ham. For example, if you only 
wanted to look at t|a<^lite^s^-iihat end with .LoRes, you would 
type #?.LoRes. Your would show you only the files 
that end in .LoRes, -ppa&i ca 1 example of how this could 
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ASSIGNS Action Button 

be used is for the loading of a sequence of pictures as an anima¬ 
tion. If your sequence of Pictures were numbered sequentially or 
alphabetically, and started with the word Space and ended with 
a .ham extension then you could type Space#?.ham in the Pattern 
edit field and only those files would be viewable. Select the first 
file, set the # of frames (see below for a more complete explana¬ 
tion of the # of frames edit box) click on load, and your anima¬ 
tion will be put together automatically for you. 

The recognized pattern parameters for this edit field are: 

? Matches single characters. 

#<pattern> Matches occurrences of <pattern> 

Examples: 

#? shows all files 

#?A#? shows all files whose name contains the letter A. 

AN#? shows all files that begin with the letters AN. 

AN#?.??? shows all files that begin with the letters AN and 
end with a period followed by a 3 character 
extension. 

#?.ANIM shows all files that end w'ith a .ANIM extension. 

The ASSIGNS button, when clicked, shows you the current 
assigns for your system. They are denoted as <ASN> in the file 
window', and are blue in color in all but 2 color modes. This func¬ 
tion is beneficial to users with large storage devices, such as hard 
disks, removable media, etc. You can create assigns to go directly 
into deep levels of subdirectories. For example, if you are work¬ 
ing on a job for XYZ company and your image files are 5 drawer 
levels down from your workbench, it will get cumbersome click¬ 
ing through subdirectory after subdirectory to get down to the 
images drawer. By placing an assign command in the startup- 
sequence of your boot drive, you can avoid this. Please consult 
your Amiga owner's manual or an Amiga DOS manual for more 
information regarding editing your startup sequence. The assign 
command for the example given above might look like this: 

ASSIGN Images: dhO:Graphics/Paint/Jobs/XYZ-CO/ 

Images 

Now from w'ithin the program rather than clicking down the 5 
levels of drawers you could click the Assigns button and then 
click on <ASN> Images: and you are taken directly to the 
subdirectory Images. 
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Loading a File Click the file you want to load, and the|y^|||he Load button to 
load the selected file, Or, if you prefer, simply double¬ 
click on the filename to had ihs fite* with all their 
attributes: palettes, asKl perspective information. Click 
Cancel if you don't warn- to lo&d a file, 

• ♦ » i 

When you load a picture the landed picture replaces any exist¬ 
ing picture. If you have nuiltiple frames, the loaded picture 

:;riJ^laces the current frame. 
v J||! ^ 
' : TOe # of Frames edit box near the bottom of the requester lets 

you load multiple pictures at one time, as frames of an anima¬ 
tion. The pictures must all be in the same format. If you already 
have animation frames, those frames are discarded and 
DeluxePaint creates new frames as you load. 

❖ If you want to add pictures to your animation without dis¬ 
carding it, you must load the pictures one at a time. 

DeluxePaint loads the pictures starting with the picture you se¬ 
lected in the requester and continuing alphabetically down the 
listing to load the number of frames you requested. If any of the 
files in the list is an animation, DeluxePaint loads the first frame 
of that animation as an animation frame in the new animation. 
The newly assembled animation uses the palette of the first pic¬ 
ture loaded. 

Tip If you plan to load a series of pictures with different palettes, 
build an image that contains a common palette of the most im¬ 
portant colors to be preserved in the pictures this 
image as the first in the series to set the palette 
pictures will be remapped. Once the animatiod^^'-^^^iU, 
you can delete the first picture. 

Save ... Keyboard Equivalent: Right-Amiga-s 
Displays the Save Picture requester. This requester works liketfife 
Load Picture requester, except that it saves the file to disk rather 
than loading it. 

To save a picture from the requester, click on the disk name you 
want to save to. Click on the subdirectory you want to save your 
picture in. (Both the disk drive and directory you selected appear 
in the Drawer edit box, for example DF0:Art). Click in the File 
edit box and type a name for your picture. Finally, click Save to 
save the file. 
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You can save in a particular subdirectory by clicking in the 
Drawer edit box and typing in the subdirectory name, or by 
clicking the subdirectory name directly from the file names 
displayed in the window. 

When you type in either the Drawer or File edit boxes, you can 
erase the existing type by clicking at the end of the existing name 
and backspacing, or by clicking at the beginning of the name and 
Deleting. You can move over the text without deleting it by using 
the arrow keys. 

You can save a picture under an existing file name by clicking 
that file name in the file listing, or you can enter a new file name 
(up to 29 characters long) by clicking the File edit box and typing 
the name. Whenever you save a picture under an existing name, 
DeluxePaint displays a requester for you to confirm that you 
want to overwrite the e^tfeig file. 

Pictures are saved arrd-Ytrfoaded with all their attributes, such as 
palettes, stencils and perspective information. 

Save Picture 
NewTut.Han 
Or i^ra niBirds. Ha n 
Pa IternSet.LoRes 
ReferencePalette.LoRes 
Seascape.LoRes 
StencilSet.LoRes 
Venus. LoRes 
NorldHap.LoRes_ 

Drawer 
Pattern 
File grrarjZKrgiir): 

Disks_| Assigns | Parent 

Save Cancel 

Figure 8.19 Save Picture requester 

If you have multiple frames when you display the Save Picture 
requester, the bottom portion of the requester will contain 
Frames edit boxes for you to specify which frames of your ani¬ 
mation you want to save. You enter a file name and specify a 
drawer just as you would when saving a single picture. When 
you click Save, the frames are saved as separate pictures with a 
number added to the end of the file name. For example, if you 
enter 5 to 10 as the frames you want to save, the frames are saved 
as Filename005 through Filename 010. 

The Pattern edit box and Assigns action button work just as they 
do in the Load Picture requester (see Load, above). 
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Delete... Keyboard Equivalent: Right-Amiga-d 
Displays the Delete File requester, vvhich delete a file 
from the disk without leaving the prografe^is is especially 
useful if you find that your data disk is full and you need to 
delete a file before you can save your work. The Delete File re¬ 
quester wrorks just like the Load and Save requesters described 
above. You can enter a file name by clicking that name in the 
requester window, or by typing the name directly into the File 
edit box. 

❖ You can use this option to delete any kind of file on the disk, 
not just pictures. Thus, you can delete brushes, animations, 
etc. 

Print ... Keyboard Equivalent: Right-Amiga-p 
Displays the Print Picture requester. Before you start to print a 
picture, make sure you have selected the correct printer driver 
from Preferences, and that your printer is connected and turned 
on. See your Amiga Users Guide for information on Printer 
Preferences. 

Figure 8.21 Print Picture requester 
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The Print Picture requester provides the following options: 

Aspect: Specifies the orientation of the picture on the paper, 

either Normal, the default, or Sideways. Click the Up-arrow 

button for Normal or the Right-arrow button for Sideways. 

Image: Specifies whether the printout will be a positive or nega¬ 

tive image. Click the Plus button for positive or the Minus button 

for negative. 

Shade: Specifies whether the printout will be in color, in shades 

of gray, or in black and white. Make sure the setting is appropri¬ 

ate for your printer. If you are using a single-color ribbon, click B 

& W. If you want to translate your image's colors into shades of 

gray, use the Gray setting. To print in full color, click Color. 

❖ For your picture to print out correctly in the B&W or Gray 

settings, your palette should contain black, white, and a 

number of grays. 

Placement: Specifies whether the picture should be printed 

against the left margin of the page or centered on the page. 

%/Dots: Controls the size of the printout by specifying the % 

width and % height of the printout paper. The Dots option lets 

you specify the size of the printout in terms of the actual printer 

pixels. 

If the % option is active then the following parameters can be 

specified: 

% Wide and % High: These let you change the aspect ratio (the 

ratio of height to width) of the picture by setting the percentages 

for each. The default values are 100% Wide and 0% High. 0% is 

a special case and tells the printer to maintain the same aspect ra¬ 

tio as the screen version of the picture. To change the aspect ratio, 

leave the % Wide at 100 and enter a new % High value. 

You can use this feature to compensate for elongated squares and 

circles that result when you change screen formats. If you just 

want to shrink the picture while maintaining the same aspect ra¬ 

tio, change the % Wide value and leave the % High value at 0. To 

change either value, click the appropriate gadget, Backspace or 

Delete over the existing value, and type in the new one. 

If the Dots option is active you can set only the printout width 

and height in dots. 
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Flip > 

Spare ► 

Swap 

Line Feeds: Specifies the number of line feeds you want to insert 
after a picture is printed. This way you can easily print two pic¬ 
tures on the same page with a specified amount of space in be¬ 
tween the pictures. 

Copies: Specifies how many copies of the picture you want 
printed. 

Form Feed: Lets you set whether or not you want the printer to 
move to the next sheet of paper before printing each image. This 
lets you easily print a single picture per sheet of paper. 

Cancel if don't want to print and don't want to save any new set¬ 
tings. Click Exit if you don't want to print, but want to save your 
settings to print later. Click Print to print the current picture, or 
once you start printing, you can stop at any time by pressing the 
Stop button that appears while printing is in progress. 

❖ If you wish to Abort a print request before it is complete. 
Take your printer off-line before you click the Abort button. 

Flip lets you flip a picture about its X or Y axis. If you have mul¬ 
tiple frames, you can flip one frame, a range of frames, or all 
frames of your animation. The submenu offers two ways to flip 
an image, horizontally or vertically. 

Horiz 

Flips the current picture about the horizontal or X axis. 

Vert 

Flips the current picture about the vertical or Y axis. 

The Spare option presents a submenu with options for manipu¬ 
lating DeluxePaint's spare page. 

Keyboard Equivalent: j 
Conceals the current page and displays a second or "spare" 
page. This means you have two pages to wrork on. The concealed 
page is always the spare page. 

When you first select the spare page, it is the standard screen 
size. If you wish to use a larger page size on the spare page, 
you'll need to make the appropriate selection from the Page Size 
option (see below). Note, however, that you can increase the size 
of a page only if you have sufficient memory available. Note also 
that a spare page uses up memory, even if there is nothing on it. 
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Copy to Spore 

Merge in Front 

Merge in Back 

Delete This Page 

Page Size ... 

Keyboard Equivalent: Ctrl-j 
Copies the picture on the current page to the spare page so you 
can experiment with your picture on the spare page without fear 
of losing anything. If you do not have sufficient memory for a 
spare page, save the image to disk if you wish to experiment 
with it. If you copy to the spare from a page that is larger than 
the spare, only the visible portion of the page is copied. If you 
copy to a spare which is larger than the screen, a copy is made to 
the spare at the location in the spare that was visible when you 
last viewed it 

Merges the spare page in front of the current page. When the 
spare page is brought forward, all pixels matching its current 
background color will appear transparent, allowing images on 
the current page to show through. You must be viewing the page 
you want to merge to when you choose this option. 

Merges the spare page in back of the current page. When the 
spare page is put behind the current one, all pixels which match 
the current page's background color will appear transparent, al¬ 
lowing images on the spare page to show through. You must be 
viewing the page you want to merge to when you choose this 
option. 

If you no longer wish to have memory allocated for a second 
"spare" page, use this option to delete the current page (the one 
currently showing on the screen) and to deallocate the memory 
set aside for it. Be sure you have saved a copy of the picture you 
are deleting if you think you may need it later. When you select 
Delete this Page, DeluxePaint asks you to confirm the deletion, 
and then switches you to the other page. 

Displays the Page Size requester. Select the page size (in pixels) 
you wish to work on. Standard is the normal Amiga display size 
for the selected resolution. 

Set Page Size 

Type in size: 

Width: Heisrht: mBmm 

Or select one: 

| 320 x 200 

Full Pasre J 320 x 340 

Overscan J 368 x 241 

Cancel Ok 

Figure 8. 22 Set Page Size requester 
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Show Page 

Screen Format... 

Full Page gives you a full printed page image (8 1/2 by 11 
inches) on most printers. Overscan presents a full-screen display, 
which lets you create pictures that fill the entire screen. This is 
particularly useful if you wish to videotape your images. In or¬ 
der to paint on the edges of a full video screen, you need to scroll 
the image around using the cursor keys or the n key unless you 
set the screen format to Overscan (see Screen Format, below). Al¬ 
ternatively, you can view the entire screen by selecting Show 
Page, below. 

Clicking one of the three settings automatically sets the height 
and width in the corresponding edit boxes. You can also type in 
any other size you wish by clicking the appropriate edit field, 
Backspacing or Deleting over the existing value, and typing in 
the new size. Although DeluxePaint will recognize page sizes up 
to 1008 x 1024, you would need to reduce the number of colors in 
your palette to create a picture this large. 

Keyboard Equivalent: S 
Hides the Toolbox and Title Bar, and displays the entire docu¬ 
ment, if necessary in a reduced format. For example, in 640 x 400 
page size in Lo-Res, it shows only every other pixel. If the page is 
oversized (larger than the screen), you can move the rectangle to 
view a different area of the screen by holding down the left 
mouse button; dragging the rectangle to the area you want to 
view; and releasing the mouse button. You are returned to the 
current page with the area of the rectangle in view. Pressing any 
key returns you to the current page without repositioning the 
view. 

For more exact positioning of the rectangle, you can move it with 
the arrow keys. The arrow keys move the rectangle one unit at a 
time. (A unit is the page size dimension divided by the screen 
size. So with 320x200 screen format with 640x400 page, the rect¬ 
angle moves 2 pixels at a time.) Holding down the Alt key and 
pressing the arrow keys moves the rectangle in screen size incre¬ 
ments. 

Displays the Screen Format requester. If you select a number of 
colors that will exceed your available memory, DeluxePaint will 
retain the format you have selected but use fewer colors. Be sure 
to save a copy of your current screen before changing screen for¬ 
mats, because once you have reduced the number of colors, the 
original color information is lost. In addition, note that changing 
formats eliminates most items from memory, including the Font 
Directory. 
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Choose Screen Fornat 

F ornat: Co 1 or s: 

Bi Lo-Res 320x200 1 2 1 16 | 

Med-Res 640x200 | 

Interlace 320x400 | 8 | 64 | 

Hi-Res 640x400 | HAM | 

Overscan: frjgj Std| Maxi PAL 

Paffe Size: Screen| Keep sane 

Cance1| Ok 

Figure 8.23 Choose Screen Format requester 

Lo-Res: This is the default setting, giving you a pixel array of 320 
x 200. Lo-Res allows up to 32 colors on the screen. 

DeluxePaint IV also supports a special 64 color mode called Ex¬ 
tra-Hal fbrite. The 64 color Extra-Halfbrite is special in that the 
first 32 colors in the palette are alterable, whereas the last 32 col¬ 
ors iti8®c^dpi|^re half intensities of the first 32 and are not di¬ 
rect user. 

r. ■' — '-m. 

❖ computers support Extra Halfbrite. The 
nd out whether or not your computer sup- 

mode is to try it. Choose Lo Res and 64 
colors in the Choose Screen Format requester and look at 
the palette (make sure the pointer is not in the Menu Bar or 
Toolbox). If the last 32 colors are the same as the first 32, your 
computer does NOT support Extra Halfbrite. 

Med-Res: Uses a pixel array of 640 x 200. Pixels in Med-Res for¬ 
mat are tall and narrow compared to the other screen formats. 
This means that if you switch between Lo-Res and Med-Res, ob¬ 
jects will become flattened or elongated because of the different 
pixel shape used by each format. You can compensate for this by 
using the Double Horiz and Double Vert options from the Brush 
menu (see below). Med-Res supports up to 16 colors. 

Interlace: Uses interlace techniques to double the number of 
horizontal lines. The Interlace pixel is wider than it is tall, so 
moving from Lo-Res or Med-Res to Interlace will flatten images, 
while moving in the other direction will elongate them. Like Lo- 
Res, Interlace format allows up to 64 colors on the screen. 

<• Interlace mode produces a flicker on some computer screens. 
It can be avoided by using a high-persistence monitor. 
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Hi-Res; Us€s a pixel array of 640 x 400. Because Hi-Res also in¬ 
terlaces the horizontal lines, it is subject to the same flicker as the 
Interlace format Pixel shape in Hi-Res format is the same as that 
of Lo-Res. Hi-Res format allows up to 16 colors on the screen. See 
Appendix A for more information on memory requirements. 

Colors The maximum number of colors you can use depends on your 
screen format. A format can use any number less than maximum, 
so, for example. Interlace, which supports up to 64 colors on the 
screen, also supports 2, 4,8,16, and 32 colors. 

HAM The Hold and Modify display mode (HAM) uses only 16 color 
registers, but manages to display all 4,096 colors on the screen at 
the same time. A HAM color is formed by taking the RGB value 
of the preceding pixel on the screen, and substituting a new 
value for one of the RGB components. 
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Figure 8.24 Hold and Modify Pixel Color Selection 

Because 11 AM colors are based on color values of the preceding 
pixel and only one color value can be changed at a time, it may 
take three pixels to reach the color you really wanted. In Figure 
8.25 it takes three pixels to change black (RO, GO, BO) to white 
(R15, G15, B15). Note that this example assumes there are no 
intermediate colors in the normal color registers. This gradual 
change from one color to the next is sometimes referred to as 
"ramping" the color, and appears on the screen to the left of 
HAM pixels. If you need fine details in your picture, you will 
want to use a color from one of the sixteen color registers, be¬ 
cause those colors do not require ramping. 
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Black (0,0, 0) Green (0.15, 0) Yellow (15,15, 0) White (15, 15, 15) 

Figure 8.25 HAM Color Ramping 

When you paint with a brush over an area made up of HAM 
pixels, you may see streaks of color running to the right from the 
edge of the brush. This is a temporary effect called "fringing." 
When you paint the brush onto the picture, DeluxePaint corrects 
the fringing, but you may see the "ramping" effect where the 
program recreates the HAM color to the right of your brush. 

\is ►[ In HAM mode there is a selector button displayed under the 
palette on screen. Click on the arrows to move through the 16 
sets (A through P) of 16 colors available in your 256-color set. 
The "a" group is your palette or base register colors; the other 
colors in the set are HAM colors. 

Overscan 

Std puts the screen into standard overscan mode allowing you to 
view and edit your image in the border area around the normal 
viewable screen area. Notice that the dimensions of all four 
screen formats get larger. If the Toolbox or Title Bar are showing 
when you choose overscan, mode, the screen is shifted down and 
to the left to make sure you car see the controls. 

At Max setting the viewing area gets even larger. The new verti¬ 
cal and horizontal dimensions of the screen appear beside the 
screen formats. 

If you need to adjust the position of your screen, you can do so 
by holding down Ctrl and using the cursor keys. This saves you 
the trouble of exiting the program to adjust your screen through 
Preferences. 

NTSC and PAL Monitors 

The NTSC broadcast protocol is most common for the United 
States. The PAL protocol is most common in the United Kingdom 
and Europe. Click your monitor type. 

The Page Size option lets you choose whether to retain the same 
page size or change your current screen to the new screen size. 
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About... 

Example #1: Screen — If you start in 320 x 200 screen format and 
move to 640 x 400 format, your image will fill only one quarter of 
the screen. If you go from 640 x 400 to 320 x 200, you will only re¬ 
tain the upper left quarter of your image. 

Example #2: Keep Same — If you start in 640 x 400 format and 
move to 320 x 200 format, you will retain the entire image but 
you will need to scroll the screen to see all of it. 

When you first boot DeluxePaint you are presented with a 
slightly different version of the Screen Format requester. 

Choose Screen Foma t 

Fornat: Colors: 

320x200 1 2 16 

Med-Res 640x200 | _ 4 | fn 
In ter 1 ace 320x400 | 81 _64 | 

Hi-Res 640x400 | HAM | 

Overscan: StJ Hax| [JEE3 PAL 

Proarah Loading: Swap | Load All 

Ok | 

Figure 8.26 Choose Screen Format requester at program start up 

The basic difference is that you need to specify how the program 
is loaded. Clicking on the Load All button loads the entire 
DeluxePaint program into memory, while clicking on the Swap 
button causes parts of the DeluxePaint program to load into 
memory as they are needed leaving more memory available for 
image data. Owners of 1MB Amigas are advised to start up the 
program in Swap mode, particularly if they intend to create ani¬ 
mations. 

The program's About requester shows the program version 
number, the authors' names, the copyright notice, and informa¬ 
tion about the amount of available memory and the size of your 
animation or AnimBrush. 

About Deluxe Paint IV 

Version 4.0 
Created by Daniel Silva, 
Lee Taran, and Steve Shaw 

<c> 1985-1991 Electronic Arts 

Menory Chip Fast 
Available: 672448 3193888 
Max Block: 647432 3191760 

Anin Size: 0 
AninBrush Size: 0 

Ok 
Figure 8.27 
The About box 
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Quit Keyboard Equivalent: Q 
Exits DeluxePaint. 

Brush Menu 

—I Displays the Load Brush requester. This is identical in function to 
the Load Picture requester, except that you are loading brushes 

B rather than pictures. When you load a brush that has a palette 
* different from that of the current picture, the picture palette 
» remains in place. Nonetheless, the brush palette information is 
► loaded along with the brush; you can change to the brush's 
► palette at any time by choosing Palette>Use Brush Palette from 
► the Color menu. If you wish to revert to the previous palette, use 

Pa.lqtte>Restore Palette option. 

Sfll>e ... pj^^^plays the Save Brush requester. This requester is identical in 
mri£tion to the Save Picture requester (see Save in the Picture 
menu,above). Brushes are saved with their palettes, which in¬ 
cludes color cycling information. 

Restore Keyboard Equivalent: B 
Restores as the current brush the custom brush yftii 
after you've used an AnimBrush, a built-in brush, or^k^i^d^itr 
custom brush with an option from the Brush menu. 'not 
reverse the effect of all brush manipulations in theBm^h 
Generally the options that cannot be reversed 
be reversed by choosing the option again. For example. Restore 
does not reverse the Flip>Horiz option, but choosing Flip>Horiz 
again (with no intervening commands) returns your brush to its 
previous state. 

•> It's a good idea to save your custom brush, or stamp it down 
on the spare page if you want to do a lot of experimenting. 
This way you'll have your original brush to go back to. 

Spore ► The Spare option's submenu has options for manipulating 
DeluxePaint's spare brush. 

Bru$h->Spare Keyboard Equivalent: Alt-n 
Moves the current brush to the spare brush position (which is 
hidden). If your current brush is an AnimBrush, the current cel 
of the brush is copied to the spare brush position. 

Brii$h<->Spare Keyboard Equivalent: Alt-b 
Swaps the current brush and the spare brush positions. 
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Metamorph ... Keyboard Equivalent: Alt-m 
Lets you create a special AnimBrush that metamorphoses be¬ 
tween the shape and colors of the current brush and the shape 
and colors of the spare brush. To use this option, you must first 
have a custom brush and a "spare" custom brush. 

When you choose Metamorph, the Make AnimBrush requester 
appears. Enter the number of cels you want in the AnimBrush. 
Enter a number and click Ok. DeluxePaint creates the 
AnimBrush automatically. 

For best results, your custom brush and spare brush should be 
picked up with the same dimensions. This does not mean that 
the brush images must be the same size; but the area that you 
surrounded to pick up the brush images should be the same size. 

The resulting first and last cels of the AnimBrush generally do 
not contain exactly the same images as your original custom 
brush and spare brush. Usually you will see some change in the 
colors of the first or last frames. 

❖ You should not attempt to metamorph brushes that are wider 
than around 250 pixels. Morphs of this large size may yield 
unpredictable results. Under no circumstances should you 
attempt to morph a custom brush that is larger than the 
screen. 

See the metamorphosis exercise in Chapter 7, Animation Effects, 
for more information. 

Size ► 

Stretch 

The Size option lets you resize the current brush. The submenu 
presents the following options. 

Keyboard Equivalent: Z 
Lets you freely stretch the current custom brush in any direction 
to any size. To stretch the brush, drag it to the desired size. Select 
Restore from the Brush menu to negate the effect of the stretch. 

Holding down the Shift key constrains the stretch operation so 
that your brush maintains the same aspect ratio (relative width 
and height) 

❖ Stretching a brush uses a lot of memory; if you try to stretch a 
brush to a size bigger than the available memory can accom¬ 
modate, the brush will snap back to its original size. 
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Halve 

Double 

Double Horiz 

Double Vert 

Fl ip ► 

Horiz 

Vert 

Edge l 

Outline 

Keyboard Equivalent: h 
Reduces the size of your brush by 50% in vertical and horizontal 
dimensions. For instance, a 20 X 20 brush is resized to 10 X 10. 

Keyboard Equivalent: H 
Doubles the size of your brush in both dimensions, for a quadru¬ 
pling of the total area. For instance, a 20 X 20 brush is resized to 

dimension. This 
you created in 
Format under 

the Picture menu). 

Keyboard Equivalent: Y 
Doubles the size of your brush in the vertical dimension. This 
option is useful for reproportioning images that you created in 
Med-Res and then moved to Lo-Res (see Screen Format under 
the Picture menu). 

❖ Doubling the size of a brush may require more memory than 
you have available. In that case, the resized brush may ap¬ 
pear only as an outline. 

40 X 40. 

Keyboard Equivalent: X 
Doubles the size of your brush in 
option is useful for reproportionin^,f^^ 
Lo-Res and then moved to Med-F 1 1 

Lets you flip a brush about its X or Y axis. When you Flip an 
AnimBrush, all frames of the animated brush will flip. 

Keyboard Equivalent: x 
Flips the current custom brush about the horizontal or X axis. 

Keyboard Equivalent: y 
Flips the current custom brush about the vertical or Y axis. 

Modifies a one pixel boundary around the current brush. 

Keyboard Equivalent: o 
Adds a one pixel boundary around the current custom brush us¬ 
ing the current foreground color. This is ideal for outlining text. 
To increase the thickness of the outline, one pixel at a time, select 
Outline repeatedly. 

❖ Outlining in HAM mode with a HAM color may supply dif¬ 
ferent results. The boundary color you get may be different 
from the foreground color if one pixel is not sufficient to 
"ramp" to the HAM color. 
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Trim Keyboard Equivalent: O 
Deletes a one pixel boundary around the current brush. You can 
trim repeatedly. 

Rotate ► Rotate the current custom brush in any of three ways. 

90 Degrees Keyboard Equivalent: z 
Rotates the current brush clockwise 90 degrees. 

Any Angle Lets you rotate the current brush any number of degrees. 

^ Choose Rotate>Any Angle from the Brush menu. Hold the 
left button down and drag the rectangular outlineabout its 
bottom left corner. Release the button at the dasirfcd orienta¬ 
tion. 

If you select this option more than once, your brush reverts to its 
original orientation before you rotate it again. 

Shear Gives you coff0^%d distortion of the current brush. The top part 
of the brush^^l^ored, and you can drag the bottom of the 
brush in eitk^'^iction. 

Bend ► Use this option to bend a brush horizontally or vertically. 

Horiz Lets you bend the current brush in a horizontal direction. 

fr* Choose 8end>Horiz from the Brush menu. Drag the brush 
outline left: or right until it is the desired shape. Release the 
mouse button. 

The vertical position of the cursor to the brush determines where 
the brush bends, 

Vert Lets you bend the current brush in a vertical direction. 

► Choose Bend>Vertical from the Brush menu. Drag the brush 
outline up or down until it is the desired shape. Release the 
mouse button. 

The horizontal position of the cursor to the brush determines 
where the brush bends. 
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Handle ► Lets you specify whether the cursor holds a custom brush by its 

center (the default), by one of its four corners, or by an offset po¬ 

sition, which you can define. Use the keyboard equivalents to ad¬ 

just your brush handle when you need to move your cursor 

without moving the brush. You can move the brush handle with 

the mouse button down this way. 

Center Keyboard Equivalent: Alt-s 

Positions the arrow cursor, which represents the handle, at the 

center of the brush. This is the default position. 

Corner Keyboard Equivalent: Alt-x and Alt-y 

Positions the arrow cursor, which represents the handle, at one 

of the four corners of the brush. If you have a custom brush cur¬ 

rently held at the center, selecting Corner moves the arrow cursor 

to the lower right corner of the brush. Use Alt-x to toggle be¬ 

tween the lower corners. Use Alt-y to move the handle to the 

top of the brush and toggle between the upper corners. 

The location of the arrow cursor the next time you pick up a 

brush depends on the direction you drag the mouse when you 

pick up the brush. If you drag down and to the right, the cursor 

will remain at the lower right. If you drag up and to the left, the 

cursor will move to the top left. The same principle applies if you 

drag down and to the left or up and to the right. In other words, 

the corner you drag to is the one to which the arrow cursor will 

attach. 

Corner is particularly useful in Perspective mode (see the Effect 

menu, below). 

Place Keyboard Equivalent: Alt-z 

Lets you position the brush handle at any position relative to the 

brush. To place the handle, pick up your brush. Choose Handle> 
Place. Drag in any direction to offset the cursor from the brush. 

When you release the mouse button, the cursor will hold the 

brush as you specified. 
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Mode 
Menu 

Matte 

Color 

Replc 

Smear 

Shade 

Node 

Half* F3 
y Color 

Replc. F3j 
Snear R f 
Shade { 
Blond j 
Cycle F7 j 
SnooHt fB 
Mix 
HBnlr 1 

The Mode menu contains different brush modes. These modes 
determine which color(s) in your brush are used when you paint. 
Most of the modes have keyboard equivalents, using the funtion 
keys (P-keys) on the top row of your keyboard. 

4> With the exception of Shade, none of the modes affect the 
color used when you paint with the right mouse button. 
Except in Shade mode, the right mouse button paints using 
the current background color in Color mode. 

Keyboard Equivalent: FI 
Uses a custom brush in its original form. Those areas of the 
brush, which match the background color that was in effect 
when the brush was first created, are transparent. Matte is the 
default mode when you create a custom brush using the Brush 
Selector. 

Keyboard Equivalent: F2 
Uses the shape of the brush and fills it with the current fore¬ 
ground color. Those areas of the brush, which match the back¬ 
ground color that was in effect when the brush was first created, 
are transparent. 

Keyboard Equivalent: F3 

Uses the custom brush in its original form (i.e.. Matte, see 
above), except that no colors are transparent. 

Keyboard Equivalent: F4 

Smears any colors on the page when you drag a brush over 
them. This is like smearing a wet watercolor with your fingers, 
so the bigger the brush, the more pronounced the effect. Smear 
uses only the colors under the brush, and does not add any new 
colors. Current brush color is irrelevant. 

Keyboard Equivalent: F5 
Shade helps you create subtle shading effects on those colors in 
your picture that are in a cycle range. Like Smear, Shade ignores 
the current brush color but uses its shape. By dragging the brush 
over those colors in vour picture that are in the currently selected 
cycle range, you can paint over each color with the next color in 
the range. You can paint with the next-higher color by using the 
left mouse button, and the next-lower color by using the right 
mouse button. 
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Blend 

Cycle 

Smooth 

Mix 

HBR1TE 

"Higher" and "lower'" are relative to the color under the brush at 
the time. Shade has no effect on colors outside the current range. 
You select a range from the Range requester, the Fill Type re¬ 
quester, or by using the keyboard equivalent (Alt-[ and Alt-]) to 
step through the ranges. 

Keyboard Equivalent: F6 

l.ike Smear, Blend affects the colors under the brush by running 
them together. Unlike Smear, however. Blend uses additional 
shades by averaging the blended colors, whereas Smear uses 
only the colors under the brush. Thus, when you Blend two 
shades by painting over them, you are selecting a third shade 
from the palette, the closest one the program can find to the 
average of the two original shades. 

KeyboapA Equivalent: F7 

Uses the current brush shape and cycles through all the colors 
in the currently selected range as you draw. A range is selected 
if one of its members is selected. If a color is a member of two 
ranges, selecting it selects the first of those two ranges. If your 
current brush color is not within a cycle range, it paints with that 
color only. Use MultiCycle (in the Prefs menu) to achieve the 
same effect with a multicolored brusb^here each color in the 
brush cycles through its range ind^jp&id^ntly of the others. 

Keyboard Equivalent: F8 
Softens hard lines and reduces the contrast between adjoining 
areas. DeluxePaint finds colors in the palette between the two 
bordering colors and paints the boundary in intermediate 
shades. Smooth looks at the current palette and finds the colors 
closest to the ones under the brush. Thus if the palette contains 
a wide selection of colors dose to the ones under the brush (e.g., 
the selection of grays in fhedefault palette), it will have more 
colors to draw from to create its weighted averages. Smooth is 
useful for creating airbrush effects and for eliminating jagged 
edges. 

The color of your brush mixes interactively with the colors al¬ 
ready on the screen (in your image). This is particularly effective 
in HAM. 

This mode is only available if your computer supports it, and if 
you have selected 64 Colors from the Screen Format option in the 
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Picture menu.. When you are in HBrite mode, painting with the 
left mouse button darkens colors on your painting to their half- 
brite equivalent; painting with the right button lightens colors 
that are halfbrite. This mode is especially useful in pictures with 
shadow and highlight effects. 

The Amiga supports only 32 color registers directly, but Halfbrite 
uses a trick to double the number of colors available on the 
screen. The first 32 registers are standard color registers; the 
second 32 are halfbrite equivalents of the original 32. Pixels that 
use halfbrite colors point to one of the standard color registers 
and indicate that the color should be displayed at half its normal 
intensity. This means that the second 32 pixels are not indepen¬ 
dent of the first 32; you can change the color values only in the 
first 32 registers, and the change is automatically reflected in the 
halfbrite equivalent. 

❖ Not all Amiga computers support Halfbrite. If HBrite is 
grayed out in the Mode menu, you can't select it. 

Attim Menu 

AnimBrush ► 

.rjimi 
AninBnush ► 
Load.. 
Save.. 
Move.. M 
Franes ► 
Control ► 
Mefhod ► 

AnimBrush is a special type of brush that has more than one cel 
associated with it. 

Displays the Load AnimBrush requester. This requester is iden¬ 
tical in function to the Load Picture requester described under 
Load in the Picture menu, except that you are loading an 
AnimBrush. 

When you load an AnimBrush that has a palette different from 
that of the current picture, the picture's palette remains in place. 
Nonetheless, the brush palette information is loaded along with 
the brush; you can change to the brush's palette at any time by 
choosing Palette>Use Brush Palette from the Color menu. 

Save ... Displays the Save AnimBrush requester. This requester is identi¬ 
cal in function to the Save Brush requester described in the Save 
option of the Brush menu 

Pick up ... y^l Selecting Pick up is similar to selecting the Brush Selector (rect- 0 
angular mode) from the Toolbox. However, when you pick up ^ 
an AnimBrush, you pick up all the "cels" that make up the 
animated sequence in the AnimBrush. ^ 

❖ Cels are to an animated brush what frames are to an ani- ® 
mat ion. Q 
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SaiUtfgs... 

When you paint with an AmroBrush, the brush cycles through its 
frames automatically as you paint The brush will continuously 
cycle on the current animation frame unless you hold down the 
Alt key when you press the mouse button down, in which case 
the brush will paint each of its cels separately into each of the 
animation sequence frames. 

Choosing Pick up displays the Pick up AnimBrush requester. To 
pick up the whole animation, click Ok; drag the cross hair to se¬ 
lect the entire "animated" area. When you release the mouse but¬ 
ton, DeluxePaint attaches an animated brush to your cursor. You 
can use an AnimBrush with any painting tool, just as you would 
use a custom brush. 

❖ If you want to make an AnimBrush from only a few frames 
of your animation, you only need to pick up those frames. 
Move to the first frame in your intended AnimBrush, and 
choose AnimBrush>Pick up. Type in the number of cels that 
will compose your AnimBrush in the Pick up AnimBrush re¬ 
quester. Click Ok. 

For example, let's say you have an animation of 15 frames. 
And that you want to make an animated brush out of what 
appears on frames 6 through 10. You would move to frame 
6, type 5 in the Pick up AnimBrush requester, and click Ok. 
Frames 6 through 10 make up cels 1 through 5 of your new 
AnimBrush. 

Note, however, that you cannot pick up an AnimBrush of 
ot^i^ frame. 

OHoldh^&i&vn the Alt key while picking up a brush with the 
Brush Selector is the same as choosing AnimBrush>Pick up. The 
Pick up AnimBrush requester appears. Type in the number of 
cels that will compose your AnimBrush and click Ok. 

After you have picked up an animated brush. Settings displays 
the AnimBrush Settings requester. Use this requester to control 
the AnimBrush. 

AninBrMtsh Setting 
Nunber of 

Duration: 

Current: 

Direction: 

Cancel I 

cels: 

Figure 8.28 
Settings requester 
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Number of cels 

Shows you how many cels of animation are in your AnimBrush. 

Duration 

Lets you set the number of frames it takes the AnimBrush to 
move completely through its cels. You can also think of this as 
the rate at which the AnimBrush transforms. For example, if 
your brush has 10 cels and you set duration to 20, your brush 
will stamp each of its cels twice before flipping to the next cel. 

Current 

Lets you type in the value for the brush cel you want to start 
with. This is very i^feLifyou want to continue painting from a 
particular cel of yafet 

When the requester is not: displayed, you can step backward and 
forward though the cels of your AnimBrush by pressing 7 or 8 on 
the keyboard (not the keypad). Shift-7 steps to the first cel, and 
Shift-8 steps you to the last cel. 

Direction 

These three icons give you the choice of flipping forward, flip¬ 
ping backward, or ping-ponging through the cels of your 
AnimBrush as you paint. 

Use Makes the last AnimBrush you ''picked up" the current brush. 
This lets you pickup an AnimBrush, then pickup a regular brush, 
and then return to your AnimBrush. You can also restore your 
AnimBrush by right-clicking the Brush Selector. This toggles be¬ 
tween a standard custom brush and an AnimBrush. 

Free Releases the memory used by the current AnimBrush. 

❖ You cannot retrieve the brush once you free it! Any time you 
think you are low on memory, but before you throw away 
brushes or frames, press Ctrl-a. This displays information 
about available memory in the menu bar. 

Load ... Displays the Load Anim requester. This requester works like the 
Load Picture requester (see Load under the Picture menu). When 
you load an animation, it replaces the one currently in memory. 
When you append an animation, the appended animation is 
added to the end of your current animation. 

It is also possible to load individual pictures into the frames of 
your animation using the Load Picture requester. To do so, go to 
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Save... 

Move... 

the frame you wish to load a picture into, display the Load Pic¬ 
ture requester and select the picture you wish to load. Your ani¬ 
mation will take on the palette of the picture loaded. If you want 
to restore your animation's palette, choose PaIette>Restore Pal¬ 
ette from the Color menu. If you want to remap the picture just 
loaded to the Animations original palette, choose Remap from 
the colors menu and select current frame from the requester that 
appears. See Load in the Picture menu for more information. 

Displays the Save Anim requester, which works like the Save 
Picture requester described under Save in the Picture menu. The 
one difference is that the Frames edit boxes in the Save Anim 
req|p^|3et you save a section of your animation as an animation 
rat^^^HP as a series of pictures as in the Save Picture requester. 

Keyboard Equivalent: M 
Displays the Move requester. Use this requester to define a path 
along which your brush is painted in 3D, either $ Single 
frame, or while stepping through an animation $eqt^?J\ce 

To use the Move Requester: 

► Stamp your brush on the screen at the starting position you 
want. 

Choose Move from the Anim menu. 

► Enter the Distance and Angle settings you want. 

► Set the Count edit field to the number of frames over which 
you want to animate the brush. 

► Select the Direction of your Move and Record. 

► Select any other settings that apply to your animation. 

^ Click Draw to paint the animation with the settings you 
specified. 

Move 

_| Brush 
✓J Brush 

✓I Cyclic 

Ease-Out: 
Ease-In: 

Count: 

Direction: 
Move 

Preview Fill Draw 

Cancel Load | Save | Exit 

Figure 8.29 The Move requester 
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Dist: The Dist edit boxes let you specify the total distance in 
pixels that the brush will move along the X, Y, and Z axes in your 
animation. 

You can set the brush to move along the brush axes (V) or the 
screen axes (no \/) by clicking the Brush action button to the right 
of the Dist edit boxes. 

Angle: The Angle edit boxes let you specify the total angle, in 
degrees, that the brush will be rotated about the X, Y, and Z axes. 

You can set the brush to rotate around the brush axes (V) or the 
screen axes (no V) by clicking the Brush action button to the 
right of the Angle edit boxes. Brush axes are active by default, 
which means the rotation is always based on the brush coordi¬ 
nate system. 

❖ The brush coordinate system will change during the course 
of a Move if you are rotating on more than one axis. 

If the Brush action button is unchecked, any angle rotation takes 
place along the current axes of the screen coordinate system. The 
''screen" rotation system is an Euler (pronounced oiler) system, 
and the order of rotation is always X, Y, and Z. When you rotate 
on more than one angle, or when the brush has been rotated pre¬ 
viously, the rotations produced by the screen angle system are 
not always around the axes that are used for the Distance moves 
along the screen axes. Generally it's better to think of the screen 
angle rotations as "non-brush" rather than screen. 

❖ All rotations occur around the brush handle. If you want 
your brush to appear as though it is orbiting around a point 
away from the brush, you would want to offset the handle 
from the brush. 

Click these action buttons to toggle a V on and off. The 
selects whether the Dist and Angle movements are rela¬ 

tive to the brush's coordinate system (v=on) or relative to the 
screen coordinate system (no >/=off). 

Clear: Click to zero out all of the Move and Angle numbers. 

Go Back: Click to restore the brush's starting position (for the 
next movement) to the last place you manually clicked it down. 

Cyclic: Click this button to turn it on (V), if you are creating an 
animation that is cyclic (that is, one that starts and ends at the 
same position). 
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For example, if you have 10 frames, and you want a brush to ro¬ 

tate 360 degrees over the 10 frames to make it look as though it is 

spinning when you play the animation, you would turn Cyclic 

on. DeluxePaint IV would calculate the rotation to end on the 

11th frame (which in this case would be the 1st frame). The result 

is that the brush is not rotated to a full 360 degrees on Frame 10. 

Instead, the brush reaches 360 degrees on Frame 1. DeluxePaint 

doesn't paint the brush on the last frame, since it's position 

would normally be the same as your original frame, but it does 

move forward to that frame and positions the brush in the event 

that you want to click it down. 

Ease-Out: Set the number of frames over which you want the 

brush motion to gradually accelerate. 

Ease-In: Set the number of frames over which you want the 

brush motion to gradually decelerate. 

Count: Set the number of times the brush is painted to complete 

the total movement and rotation as specified by the dist and 

angle edit boxes. 

Direction: The Direction action buttons control the direction of 

your move and the order in which the frames of the animation 

are painted. 

Move lets you choose to have a move drawn in one of two ways. 

Go From starts the movement of the brush from the point where 

you stamped your brush (indicated by the large dot) and paints 

forward. 

Come To starts the animation at an earlier frame and moves the 

brush forward to the point where you stamped your brush. 

Record lets you choose the order in which the frames of the 

brush move are painted. These buttons are available only if you 

have more than one animation frame (see Figure 6.6). 

Forward paints the move by stepping forward from the point 

where you stamped your brush. This is the default setting and 

the one you will use most often. 

In Place paints all of the move on the current frame. 

Backward paints the move in reverse order by advancing to the 

last frame and painting backwards. This option is useful when 

you are using Trails. 
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Frames ^ 

Set #... 

Preview: Click to view (in "wire-frame" mode) the move you 
have set up. When the preview is complete, the Move requester 
returns. To interrupt the preview, and return to the Move re¬ 
quester, hit the space bar. 

Trails: This button is 
animation frame allc| 

?le only if you have more than one 
Zlicking Trails is like clicking on the 

Draw button except ||||||^ frame you get the sum total of all of 

thed#M 
"trail 

Fill: 

the rotilrrent brush. 

oint. The net effect is that of leaving 
las it moves. 

r, except that when you click it, the move 
Ki to draw a filled perspective plane based on 

Draw: Executes the move that you have specified, causing the 
brush to be drawn into animation sequence. 

Cancel: Restores any settings that have been changed and exits 
this requester. 

Exit: Exits the requester and keeps all of the settings that you 
have entered. 

Presents a submenu of options for manipulating the frames in 
your animation. 

Displays the Set Frame Count requester. DeluxePaint will try to 
allocate as many frames as are requested. If there 
memory to allocate the requested number of frarr^^J^||t^^^t 
will allocate as many as memory will allow #■ 

You can use this requester to add or delete fra 
tion. For example, you could add several frames 
of your animation by stepping to the frame you want to add 
frames after, and changing the number of frames to the current 
count plus the number of frames you want to add. 

Similarly, you could delete several frames from any point in your 
animation by stepping to the first frat^^ou wantt&dfffete and 
changing the number of frames to iheiflffpBit cotfff Iftl&is the 
number of frames you want to delete. Fot example, Wyou have 
100 frames and you want to delet|frarnes 41 to 50, step to frame 
41 and set the number of frames l$P90. 

J_ J 
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Add Frames .. 

Copy Frames.. 

Delete Frames .. 

Control 

Panel On/Off 

Set Frane Count 

Count: P 

Cancel j Ok Figure 8.30 
Set Frame Count requester 

Displays a requester that lets you add any number of frames af¬ 
ter the current frame. DeluxePaint copies the contents of the cur¬ 
rent frame to the added frames, and makes the last new frame 
the current one. 

Keyboard Equivalent: Click on the + icon in the Animation Con 
trol Panel. Ait-= will automatically add a single frame to the ani¬ 
mation. 

Displays a requester that lets you copy the current frame to a 
range of frames or to all the frames in your animation sequence. 
Use the Insert Before Frame edit box to place the copied range of 
frames in your animation. 

Figure 8.31 Copy frames requester 

Displays a requester that lets you delete the current frame, a 
range of frames or all frames in your animation sequence. If you 
delete the current frame, DeluxePaint makes the following frame 
the current frame unless you are already at the last frame. 

— | Keyboard Equivalent: Click on the - icon in the Animation 
Control Panel. 

Control displays a submenu of options for moving around in 
your animation frames and for playing the animation. 

Keyboard Equivalent: Alt-a 
Displays the DeluxePaint Animation Control Panel. It contains 
a Frame Counter scroll bar and 15 control buttons for working 
through and playing your animations. Click an option on the 
Panel to select it. 
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Set Rate... 

Set Range... 

❖ The options represented by the control buttons can also be se¬ 
lected from the Anim and Effect menus, which is where these 
features are described in detail. It is convenient to have them 
all in the Control Panel, so you don't have to access a menu, 
or use the keyboard while you're working on your animation. 

First Frame 

Loop Backwards Previous Play Once Play Ping- Delete l%hF Previous Spare 
Continuously Frame Forward Pong Frame Tbbte Page 

Figure 8. 32 Animation Control Prnef 

Frame Counter 

The number of the current frame and the total number of frames 
in your animation appear in the left corner of the Title Bar. You 
can move to a specific frame by dragging the Frame Counter 
scroll bar, clicking on either side of the scroll box, or by clicking 
the Next Frame or Previous Frame icons in the Control Panel. 
Any movement you make is reflected in the numbers on the Title 
Bar. 

Displays the Set frames per second requester. The default setting 
is 30 frames per second (fps). The speed range is between 1 and 
60 fps, though results of settings over 30 fps are unpredictable. 
You can set the frames-per-second rate by entering a number in 
the edit field and clicking Ok. 

Displays the Set Play Range requester. Use this requester to in¬ 
struct DeluxePaint to play any range of frames, or all frames in 
your animation. 

•> The From number in your range must be smaller than the to 
number for the range to play correctly. 

The range setting is used by the Play Once and Ping Pong op¬ 
tions in the Control submenu, but the Play option is not affected. 

This option is especially useful if you are editing a small section 
of a large animation. You can edit the frames and play only the 
frames you are editing to see your changes. 

m . c . Go To Previous 
Play once Loop Forward GoTo Command , 

backwards Continuously ■ Last Frame 
I Next i Add | Two 

Frame Frame I Frames Next 
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Previous 

Next 

Go to... 

Piny 

Play once 

Ping-pong 

Method ^ 

Keyboard i^uivatenl: 1 
Steps the current frame to the previous frame in the animation 
sequence. If the current frame is the first frame, the position is set 
to the last fraiste 

a 

JKe^oandlBqiwalent: 2 
Steps the current: frame to the next frame in the animation se¬ 
quence. If the current frame is thej^frj|me, the position is set to 
the first frame. 

Keyboard Equivalent: 3 
Displays the Go to Frame requester. This requester lets you posi¬ 
tion the current frame to any of the available animation frames. 
You can also display this requester by Ctrl-clicking the Go to icon 
on the Animation Control Panel. 

0
 

0
 

V
 FraMe 

number: tiBH 

Cancel Ok Figure 833 
The Go to Frame requester 

Repeat last Go to Kei/board Equivalent: Shift-3 

Clicking on this icon brings you to the frame number set in the 
Go To requester. You can display this requester either by choos¬ 
ing Control>Go to from the Anim menu, or by Ctrl-clicking on 
this icon. 

Keyboard Equivalent: 4 
Plays the animation at the speed set in the Set Rate requester. The 
animation sequence will continue cycling until you press the 
space bar. (You can reverse the direction of playback by pressing r 
on the keyboard while the animation is playing.) 

► J i^^board Equivalent: 5 
• the animation sequence once through from Frame 1 to the 

last frame. 

Keyboard Equivalent: 6 
Plays the animation sequence continuously as in Play above, but 
plays the sequence forward then backward then forward then 
backward and so on. Click or press the space bar to stop the ani¬ 
mation. 

The Method menu contains two submenu options which can be 
used to specify the "memory model" of the animation sequence 
frames. The memory model refers only to the animation in 
RAM, not to the disk file. When you load an animation, it is 
loaded into your current memory model. 
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Compressed 

Expanded 

Color 
Menu 

Ranges ... 

The Compressed Method, while a little more complex than the 
Expanded Method, offers the advantage of permitting many 
more animation frames in memory at one time. The compressed 
memory model only needs enough memory to store the differ¬ 
ences between frames. While this model allows for more frames, 
it has a couple of disadvantages: it is slower than the expanded 
method while animpainting, loading and saving are slower, and 
memory tends to fragment, making it easy to run out of memory. 

The Expanded Method represents the simplest of the two 
memory models where all of the roetnory each animation 
frame is allocated. If you are in low sesolmfon mode, 320 x 200, 
and you have 10 animation frames, then you would need enough 
memory to hold 10 complete 320 x 200 images. Two advantages 
of this method are that the frame flipping for animpainting is 
very smooth, and you will not run out of memory to add an 
element to your animation within the allocated frames. 

If you set this option and then request animation frames, 
DeluxePaint automatically inserts the maximum number of 
available frames in the Set Fame Count requester so that you 
don't have to guess how many frames you can create. 

Color 

Ranges.. 
Cycle TAB 
Palette ► 
Color Set ► 
BG -> rG 
BG <-> FG 
Renap 
ItiKiOhpiite 
Brush ► 

Keyboard Equivalent: Ctrl-r 
Displays the Range requester, which you can use to define cus¬ 
tomized color ranges for the color cycling, gradient fill, and 
Shade features of DeluxePaint. 

Color Beads Selected Color 

Palette 
Number 

Cycle Speed Gradient Band 

Figure 834 Range Requester 

The requester lets you specify the colors in a range (maximum of 
32 colors), and how the colors are mixed. You can define eight 
ranges for each picture. 
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To define a range: 

The RANGE slider indicates the number of the current range. 
By default this is range 1. You can see the range of colors dis¬ 
played on the range bar. Click to the right of the slider or 
drag the slider to the right to access an empty range bar. 

All range-based features depend on the Range number set in 
this requester. Once you've created ranges to work with, you 
can step forward and backward through them without enter¬ 
ing the requester by pressing Alt-] and Alt-[. 

► To select a color for the range, move the arrow cursor to the 
row of colors in the requester and click one. 

When you click a color, it appears in the sample square. The ar¬ 
row cursor becomes the color bead cursor. If you don't want to 
use the color you chose, click another with the color bead cursor. 
When the color you want is in the sample square: 

► Move the bead cursor to the range bar. Position the cursor 
wterey&u want the selected color to fall in the range, and 
click. The color appears in the range. 

Jfie position of colors in the range control the cycle direction 
for each range, and also sets the direction of the range when 
it is used as & gradient. The start color is the color furthest left 
on tke mngtf has* Any color cycling begins with this color. 

Equivalent: Alt-r 

Wv&r&e the direction of the color range, and therefore the 
direction of cycling and gradient by clicking the REVERSE action 
button. 

► Select another color and position it on the bar. Repeat this 
step until all the colors you want are on the bar. To reposition 
a color on the bar, click it, move the bead cursor to another 
position, and click again. 

CLEflR 1 To eliminate a color from the bar, click it, move the bead cursor 
off the bar, and click again. The arrow cursor returns. 

To eliminate all colors from the range, click the CLEAR action 
button. 

Each color you place on the bar appears in the range sample. The 
gradient between colors, that is the transition of shades from one 
color to the next, is calculated automatically. You can place origi¬ 
nal colors far apart to create subtle blending of colors, or close to¬ 
gether to create more abrupt transitions between original shades. 
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Rate 

Random 

Dither 

In modes other than HAM. DeluxePaint can use only colors cur¬ 
rently in the palette to make these transitions. If the transitional 
shades are not: in the palette, colors may appear as discrete or un¬ 
evenly mixed bands in the range. You can overcome this limita¬ 
tion by adding the transitional shades to the palette. 

Copying Tip •> It is possible to copy a range to the next range set in the re¬ 
quester. To do this: Move to a defined range you want to 
copy; drag the Range slider to the range number you want to 
copy to; click Undo. (It's important to click Undo with no in¬ 
tervening clicks after you display the range number you want 
to copy to.) 

SHOM i Click see the results of your color selections and place¬ 
ment. beneath the bar shows the gradual transition 
frorrix^k^ as it would appear if you had access to all 

universe (as you do in HAM mode). 
ROTin Ham mode, a band above the Range re¬ 

quester shows ftie gradient as it will appear using the available 
colors in the palette of your current mode. 

The Rate slider lets you control the speed of color cycling for 
each range. Drag the slider to the right for faster cycling. While 
dragging the slider you can monitor the color cycling on the 
page, even if Color Cycling is turned off. The number to the right 
of the slider indicates the current speed setting. This number is 
intended to help you set different ranges to the same speed. The 
number does not indicate the relative speed of the cycling since 
the increments from 0 to 63 are not equal. 

When you click the Random action button, a \l appears. When 
Random is on, the border between any two colors in the gradient 
is randomly mixed (rather than mixed by pattern), dep^^^on 
how you have set the Dither slider. Click the action bu$@s£J& • 
turn off Random. " ^ 

Dither is onty active when Random is selected. Dithering reduces 
the contrast between adjacent colors (without changing the col¬ 
ors themselves). Drag the Dither slider to the right to increase 
the amount of dither. Setting the slider all the way to the left 
gives almost no random mixing between shades. Moving the 
slider to the right increases the amount of mixing at the color 
boundaries. 

❖ If you are not in HAM mode, and you have placed colors on 
the gradient bar with empty notches between the colors, you 
may not see the dither effect you expect. When you leave 
notches between colors on the bar, DeluxePaint calculates the 
spread of colors that would fill the notches and then looks in 
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Cycle 

Palette ^ 

Mixer On!Off 

the palette for the closest matching colors to fill in the range. 
In many cases, the closest color will be one of the colors al¬ 
ready on the bar. A dither between two identical colors will 
look like no dither at all. 

other than HAM, it is advisable to always place all 
tl^_^^|r.s you want in your gradient on the bar with no 

latches between them. This way you will get exactly 
the colors you expect, and the dither will appear as you 
would expect it to. 

If you are working in HAM mode, you won't see the dither effect 
in the gradient sample painted in this requester. To see the gradi¬ 
ent with dither effects, go to the Fill Type requester. 

REOERJJ This returns the Range requester to the condition it was in before 
you displayed the requester. 

UNDO | You can reverse the last change you made in the palette by click¬ 
ing UNDO. 

You can reverse the last change you made in the Range requester 
by clicking UNDO. 

Keyboard Equivalent: Tab 
Toggles color cycling on/off. Color cycling uses the color ranges 
you define in the Range requester. (See Range, above.) If a color 
is not included in any range, it does not cycle. See Animation with 
Color Cycling in Tutorial One of Chapter 4, Painting Tutorials. 

Keyboard Equivalent: p 
Displays/removes the Color Mixer. You can also display this 
Mixer by right-clicking the Color Indicator (between the Palette 
and the Toolbox). 

❖ There is a subtle but important difference between removing 
the Color Mixer by choosing the menu option and by clicking 
OK. When you choose the menu option or press "p", the 
Color Mixer is hidden behind the current screen and the data 
in the Mixing Area remains intact when you redisplay the re¬ 
quester. Clicking OK in the accepts all changes in the Color 
Mixer and clears the Mixing Area. 
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Compatibility Notl 

The j& the master color control panel. From here you 
can ffgjj&By colors, create spreads, and copy or exchange 
colors 

m 
M-j-J i i»+l 

^0 
10 

COPY | EX | SPREAD | PICK 1 DELETE | REVERT 1 UNDO I OK l| 

Selected Color Mixing Area 

Figure 8.35 The Color Mixer requester 

The Color Mixer and the Arrange Palette requester described 
below let you work with a 256 color Color Set, regardless of the 
number of colors you are actually using in your current screen 
format. If you are in a mode other than HAM, you can paint 
only with the colors that are in the Palette. The Palette colors are 
arranged in the first slots of row 0. You can identify them by the 
white highlight on the top and left edge of each color. The other 
Color Set colors have a light blue highlight on the top and left 
edge. Occasionally you will see us refer to your Palette colors as 
your '"base register" colors. 

❖ In Extra Halfbrite mode (64 color mode) you cannot modify 
the colors in row 1. These are the halfbrite colors, and always 
take the halfbright value of the corresponding Palette colors 
in row 0. If you attempt to copy to, exhange with, delete, or 
spread the halfbrite colors, nothing will happen. 

In HAM mode, you can paint with any color in the 4096 color 
universe. The Color Set is merely a holding spot for extra 
colors beyond your "base register" colors. 

<• We have found that several other painting and viewing 
programs incorrectly assume that the palette will contain no 
more than the maximum number of colors in the pictures dis¬ 
play mode. These programs will not correctly load a picture 
saved with a Color Set. At this time, for maximum compat¬ 
ibility, any pictures you are distributing should be saved with 
no colors in the Color Set beyond the Palette colors. You can 
delete the colors in your Color Set with the Delete button in 
just a few steps. We hope that in the near future these other 
programs will correctly ignore the extra colors in the Color 
Set if they are not able to use them. 

Modifying Colors 

DeluxePaint IV lets you modify colors with either the RGB or the 
11SV color mixing systems. Click the RGB (or HSV) action button 
to expose the other. Let's say you want to modify an individual 
color to use in the foreground. I lere's how to do it. 
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p Click the color you want to modify either in the requester's 
row of colors or wherever the color appears on the page. The 
selected color is displayed in the sample-color box. 

❖ You can use the up and down arrows at the right end of the 
palette to expose the next row of 32 colors. You can also Shift- 
click on the arrows to scroll directly to the first or last row of 
colors. 

^ Move the box(es) inside the slider(s) to modify the selected 
color, by varying the proportions of Red, Green, and Blue 
(RGB). To move a box, click on either side of it (inside the 
slider) or drag the box left or right. 

RGB color mixing is the default setting. The HSV method is sim¬ 
ply an alternative method; it yields identical results. HSV breaks 
each color down into its Hue, Sati^&pfk anc* Value. 

Hue refers to the color's posit^;p|0ie color spectrum. As 
you move the box along the HifeMI&r (starting from the 
left), your current color changes to a shade of the following 
colors—Red, Orange, Yellow, Green, Blue, Purple, and Red. 

Saturation refers to the strength of the particular hue and the 
extent to which the strength is "diluted" by some proportion 
of white. If your current color has a Saturation setting of zero, 
your color is necessarily white. 

Value refers to the amount of light a color reflects off a surface 
(and therefore, the absence or presence of black). A color with 
a high Value setting has little or no black, whereas colors with 
low Value settings contain more blackJNk* matter what set¬ 
tings you've entered for Hue and Satu^t|p!^ a Value setting 
of zero produces pure black. ^ 'r'' 

In the requester, the RGB system uses a 16-point scale (0-15) for 
color values, while the HSV method uses two different types of 
measurement. Hue is is referred to in degrees of the Color Wheel 
(0—360°) and Saturation and Value are measured in percentages 
(0-100%). 

(See Tutorial One in Cfegter 4, Painting Tutorials, for an explana¬ 
tion of color xmxitig in RGB or HSV.) 

COPY I Use the COPY button to copy a color from your picture or the 
pa let ftp. 

► S^ect fhe cohr you want to copy . 

► Click COPY. TO appears attached to the cursor. 
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^ Click the slot in the requester into which you want to copy 
the new color. 

Use the EX button to exchange the positions of two colors in the 
palette. 

^ Select the first color from the row of colors. 

^ Click EX. TO appears attached to the cursor. 

► Click the second color. 

EXj If you use EX fo rearrange the colors in your palette, the result¬ 
ing screen image will likely be in the wrong colors. You can cor¬ 
rect this by choosing Remap from the Color menu. 

❖ You should remap immediately after you change the color ar¬ 
rangement in the palette. If you modify the palette a second 
iittte without fust remapping, you will not be able to remap 
to the original palette.) 

SPREAD 1 SPREAD helps you quickly create a spread of shades between 
two colors. 

Select the first color from the palette. 

^ Click SPREAD. TO appears attached to the cursor- 

p> Click the second color. 

DeluxePaint creates a uniform spread of colors, taking mto ac¬ 
count the beginning and ending shades and the number of colors 
in between in your palette. 

PICK | Use PICK to select a new foreground or background color for 
your palette. 

Click PICK. The pointer changes to an eye dropper cursor. 
(You can also display the eye dropper cursor by pressing the 
comma key.) 

Position the point of the eye dropper on the color you want to 
become the new foreground or background color 

► Click to make tf 
color. Right-clicl 

Use iittH to ren 

► C|g«4s|>lor yoi 

new foreground 
tfbnnd color. 

ftSfjLOPY. 

ursor 
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If you want to delete only one color, click on that color in the 
color set. The color will be deleted and the slot it occupied in 
the color set will be empty. 

If you want to delete more than one color, a range for ex¬ 
ample, click the first color in the range; click DELETE; move 
the TO cursor to the last color in the range; and click the 
color. DeluxePaint will delete all colors between the selected 
color in the sample-color box and the color you clicked on. 

UNDO I You can reverse the last change you made in the Color Mixer by 
clicking UNDO. 

MHKKM You can clear the changes you made in the Color Mixer by click¬ 
ing REVERT. With the exception of the mixing area, this returns 
the requester to the condition it was in before you displayed the 
Mixer. 

Color Mixing Area 

Use the mixing area to interactively mix colors to create new 
ones, and, if you wish, add colors to your palette. You can use 
colors in the picture, colors from the palette, and colors you mix 
to create new shades. Using your current built-in or custom 
brush you can select colors from the palette (one at a time), paint 
with them in the mixing area, and mix them with other colors. 

Creating a Neiv Color 

You can create a new color in the Mixing Area in two basic ways: 

1. Mix a selected color in the mixing area with one or more 
other selected colors. The resulting color can be a new color. 

2. Edit a color by adjusting its values with the RGB/HSV 
sliders. 

Here's a step-by-step example of how to select a color from 
the current picture, edit it, mix it with another color, and add 
it to the palette. 

Selecting a Color 

With a picture on your screen and the Color Mixer exposed, 
click the PICK action button. 

Move the PICK cursor to the picture and click on a color. 

The color you clicked on automatically becomes the current 
foreground color. It appears in the sample-color box, so you 
can paint with it immediately. The color slot of the new color 
appears indented in the color set. 
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This color can be edited. To edit the color in the mixing area: 

Arrange 

Use Brush Palette 

Drag one or more of the RGB/HSV sliders to change the color 
values, which changes the color itself. 

Mixing a Color 

Click a medium sized built-in brush and paint in the mixing 
area. 

Choose another color, and paint over the first color in the 
mixing area. As you combine the two colors, new shades are 
created. You can repeat this step as often as you like. 

^ When you have created a color you want to use, click the slot 
in the color set where you want to place the new color. 

Click the PICK button; click the color in the mixing area to 
make that shade the new color. 

Clearing the Mixing Area 

You can clear the Mixing Area to any color by copying the color 
to it. Here's how: 

^ Select the color you want to clear the Mixing Area to. 

^ Click COPY. TO appears attached to the cursor 

Click the in the Mixing Area. It is cleared to the color you 
selected. 

Keyboard Equivalent: P 
Shows the Arrange requester It displays all 256 colors of a Color 
Set (4 rows [128 colors] at a time). Clicking on the up and down 
arrows scrolls through the color set one row at a time (32 colors 
in a row). Shift-clicking on an arrow scrolls 4 rows at a time. 
Arrange is helpful if you want to copy, exchange or spread colors 
over more than one row at a time. The Arrange requester will 
replace the Color Mixer if it is open. 

Use the Arrange requester to organize colors in your palette or 
delete colors. It lets you delete colors easily, so that new colors 
can be added to the current 256-color set. 

The action buttons in the Arrange requester work exactly as they 
do in the Color Mixer. See above. 

When you load a brush from disk, DeluxePaint continues to use 
the current picture palette, even though it may be different from 
the one the brush was created with. Use Brush Palette switches 
to the brush palette, and includes any information about color 
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Restore Palette 

Default Palette 

Load... 

Save... 

Color Set ^ 

Load... 

cycling that was saved with the brush. If the newly loaded brush 
uses more colors than the current picture, Use Brush Palette 
switches to the brush palette and reduces the number of colors to 
that of the picture palette. It does so by recomputing the palette 
to match the original as closely as possible with few'er colors. Af¬ 
ter choosing Use Brush Palette, you can still revert to the original 
picture palette by choosing Restore Palette (see below). 

Compare Use Brush Palette with Remap in the Color menu; this 
command lets you keep the current picture palette, but maps the 
brush to the picture palette to match the original brush as closely 
as possible. 

Returns you to the palette you were using before the current pal¬ 
ette. Thus, if you load a picture with a different palette. Restore 
Palette reverts to the palette in effect before the load. See also Use 
Brush Palette, above, and Default Palette, below. 

The default palette is the palette DeluxePaint uses when you first 
start the program. The Default Palette command replaces the cur¬ 
rent palette with the default palette and resets any ranges you 
may have created to its (their) default state. 

Load a palette that you have previously saved, without loading 
an image. The Load Palette requester works just like the Load 
Picture requester (see Load under the Picture menu). When you 
load a palette, the palette colors overwrite your current palette 
directly. Compare this to loading a Color Set, explained below. 

Save a palette without saving the image. The Save Palette re¬ 
quester works just like the Save Picture requester (see Save un¬ 
der the Picture menu). Only the Base Register colors (those colors 
that appear below the Toolbox) are saved, NOT the entire color 
set. 

Displays the Load Color Set requester. This requester works just 
like the Load Picture requester (see Load under the Picture 
menu). 

Once you've selected the Color Set file you want to load and 
clicked Load in the first requester, a second Load Color Set 
requester appears. 
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Save ... 

Bg->Fg 

Load Colon Set 

<DEV> 
<DEV> 
<DEV> 
<DEV> 
<VOL> 
<VOL> 
<VOL> 
<VOL> 

DF0: 
DH0: 
DH1: 
RAH: 
ani: 
DPaintIV: 
RAH DISK: 
work:_ 

Drawer 
Pattern ■■■ 
File 

Disks Assigns ! Parent 

Load Cancel 

Figure S36 Load Color Set Requester 

This requester lets you choose which colors from the Color Set 
are to be loaded into your current color set. To select colors, click 
on them. Click on a color a second time to deselect it. The All 
button selects all colors in the Color Set. The None button de¬ 
selects all colors. The Base button selects only the colors in the 
palette (base registers). 

Once you have selected the colors you want to load, you can ei¬ 
ther Add them to your Color Set or Overwrite the current Color 
Set. If you choose Add, the colors are added beginning in the 
first empty slot of your current Color Set. Colors will be added 
only until the Color Set is full. If you choose Overwrite, the 
colors you have selected are entered into your current Color Set 
beginning at color 0 and the new colors overwrite the previously 
existing colors. 

If you change your mind and decide not to load any colors, click 
Cancel in the requester. 

Saveaa S&t as a separate file. The Save Color Set 
requ^f^T^s^irJtot like the Save Picture requester (see Save 
under &^&!urewenu). 

Changes aft pixels that use the current background color to use 
the current foreground color. This provides an easy method of 
changing colors globally — all pixels in the current background 
color in the picture are changed to the current foreground color. 
The change occurs on-screen only and does not affect the order 
of colors in the color palette 
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❖ Undo does not reverse this change. 

Bg<->Fg 

Remap 

Recompute 

Brush ^ 

Bg ->Fg 

Bg<->Fg 

Swaps all pixels in the current background color with the current 

foreground color. This is similar to the Bg->Fg option above, ex¬ 

cept that the change occurs in both directions. The change occurs 

on-screen only and does not affect the order of colors in the color 

palette. 

❖ Undo does not reverse this change. 

When you create a picture, DeluxePaint "remembers" each color 

on the screen by remembering its location in the palette. If a 

picture on the screen was created with a palette other than the 

current palette (for example, if you have modified the palette 

since loading the picture). Remap finds the locations in the cur¬ 

rent palette of the colors it used in the original palette and tells 

the picture to look there for its colors. Bg->Fg and Bg<-> Fg, 

above, are special cases of Remap. See also Remap under the 

Brush option of the Color menu, below. 

❖ Undo does not reverse this change. 

This option is available in HAM mode only. Choosing this option 

recomputes the picture data by doing a remap with the current 

palette. If you have loaded a HAM image from a different pro¬ 

gram, Recompute may reduce the fringing effects you see when 

moving a brush across the screen. 

Use the options in the submenu to modify the current brush 

colors. 

Changes all pixels in the brush that are in the current back¬ 

ground color into the current foreground color. This provides an 

easy method of making a global color change — all instances of 

the background color in the brush are changed to the current 

foreground color. Because you can select any color in the brush 

as either the foreground or the background color at any time, you 

can make intricate color changes easily This operation affects the 

brush colors only and does not affect the picture or the order of 

colors in the palette. 

Swaps the current background color in the brush with the cur¬ 

rent foreground color. This is similar to the Bg->Fg option, except 
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that the change occurs in both directions. The change affects the 
brush colors only and does not affect the picture or the order of 
colors in the palette. 

Remap Use Remap when you load a brush that uses a palette different 
from the current palette. Remap looks at the colors used in the 
brush and tries to find the closest fit within the current palette. 
This option is different from Use Brush Palette in that it does not 
change the p|i^^;|>alette. Instead it changes the palette loca¬ 
tions the bru^H-'fe^s at for its colors. You can perform this oper¬ 
ation on Ani^p^^es and all frames of the animated brush will 
be remapped. 

Change Transparency Lets you change the transparency of the currently selected brush 
to the current background color. 

The Effect menu contains several special features. Its options let 
you create stencils, "freeze" the background, and define planes 
for drawing in perspective. 

Effect 
Menu 

Stencil ► 

Bd&roand ► 
AntiAlias ► 
Process ► 
Translucency ► 
Perspective ► 

Creating a stencil allows you to paint around an image without 
painting on it, as though it were protected by a frisket. Create a 
stencil of an image in either of two ways (painting and locking), 
or by using both ways together. You can "paint" an area to mask, 
see Paint, below, or "lock" the colors that comprise that image. 

A stencil will also apply to the brush when it is captured. What¬ 
ever colors in the brush were locked when the stencil was made 
become transparent in the brush. 

When you have a stencil active, an "S" appears in the Title Bar. 

Show Show dims the colors in your picture and displays the stenciled 
areas of your picture (if any) in a contrasting lighter color. The 
"S" in the Title Bar changes to "s."You can't paint on your picture 
while Show is active. Click to return to your picture. 

Make ... Keyboard Equivalent: - (tilde, below Esc) 
This displays the Make Stencil requester. You can reposition the 
requester anywhere on the screen by dragging the Title bar. 
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To make a stencil: 

»> Click the colors you want to use to create the stencil. You can 
select colors by clicking them in the requester's palette, by 
clicking colors in your picture, or by clicking colors in the 
main palette. 

When you have clicked all the colors you want to protect, click 
MAKE. 

The colors you select define a mask that protects an area from 
being painted over. The shape of the stencil is what is created 
and saved, not the color information, which means you can 
change the colors of a "stenciled" shape, and still retain the 
stencil. 

If you have several animation frames, DeluxePaini^u^matically 
remakes the stencil as you move from one frame feffifehext, 
either manually or while using the Move requester 

I Clears the current color selections in the requester. 

Inverts the current color selections. This is useful if you want to 
mask more colors than you want to leave unmasked. 

When you are using HAM mode, your Make Stencil requester 
also contains a Show button, a Fine Tune button and a Tolerance 
edit field. These options are explained in detail, with examples, 
in Tutorial Four of Chapter 4, The World of Stencils. 

Show toggles the show stencil function on and off. This works 
like the Stencil>Show option in the Effect menu. 

Fine Tune lets you add or subtract individual colors from the 
stencil. 

The Tolerance edit field lets you click on a single color in your 
picture and simultaneously lock (or unlock) all "similar" colors 
in the image. The Tolerance number determines how different a 
color can be and still be considered "similar" to the one you 
clicked on. A low Tolerance number requires that the colors be 
very similar, while a high Tolerance number locks colors that 
may be very different from the color you clicked. The range of 
Tolerance values runs from 0 to 48. At 0 tolerance, only colors 
that are identical to the color you click on will be affected. At 48 
tolerance, all colors will be affected. 
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Remake 

Paint 

Reverse 

On/Off 

Free 

Load ... 

When you have a stencil active and you apply colors to your 

picture, the colors you apply are not protected, even though they 

may be locked in the Make Stencil requester. You can lock newly 

applied colors by bringing up the Make Stencil requester and 

clicking Make, or by selecting Remake from the Stencil 

submenu. 

❖ If you have several animation frames and you make a stencil, 

DeluxePaint automatically remakes the stencil as you move 

from one screen to the next. 

Keyboard Equivalent: Ctrl-s 

Uses your current built-in or custom brush to paint the area you 

want stenciled. The image under the stencil will be displayed in 

a "half-tone" mode. When you've finished painting the stencil, 

choose Paint again to exit this mode and activate the stencil. 

Stencils you create using Stencil Paint are "area-based" and 

apply only to the current picture or frame. Also, if you choose 

Make or Remake to create a "color-based" stencil, your painted 

stencil is discarded. 

Has the same effect as clicking Invert in the Make Stencil 

requester (see Make, above). 

Keyboard Equivalent: ' (below Esc) 

Toggles the stencil on and off. This maintains the stencil but 

turns it off temporarily so you can paint on the protected colors. 

Creating a stencil uses memory, even though you may have it 

turned off (see On/Off, above). Free deletes the stencil and 

deallocates the memory it was using. 

Stencils can be loaded as separate items. They are full screen 

only, and can be loaded only to the position they occupied when 

they were created. In other words, you cannot create a page 

larger than screen size and load the stencil into the middle of the 

page. The Load requester works like all other Load requesters in 

the program (see Load in the Picture menu). 

❖ When you load (or save) a stencil, you are loading (or saving) 

only a layer of data that indicates which pixels in your pic¬ 

ture you can or cannot paint on . You are not loading settings 

for the Make Stencil requester. In other words, stencils you 

load are area-based, like the stencils you create in the Stencil> 

Paint mode. Area-based stencils do not apply across ani¬ 

mation frames and are replaced by color based stencils you 

subsequently create using the Make Stencil requester. 
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Save... 

LightTable ► 

On/Off 

Merge 

Dim 

Two Back 

Previous 

Next 

You can save stencils just as you can any other file, such as pic¬ 
tures or brushes. The Save requester for stencils works like all 
other Save requesters in the program (see Save in the Picture 
menu). See the note above regarding the nature of the data you 
are saving when you save a stencil. 

Keyboard Equivalent: 1 
Turns the LightTable on or off. The LightTable lets you see the 
animation frames that immediately precede and/or immediately 
follow the current frame (or the spare page), which gives you 
greater control while creating your animation. This effect simu¬ 
lates the '"onion skin" techniques used by traditional animation 
artists. By using a combination of LightTable options, you can see 
a maximum of four frames simultaneously (Next, current frame. 
Two Back). 

The lighttabled frames appear behind the current image (in the 
BG color area) and can be dimmed to a darker color in all screen 
format modes except HAM. 

Merges all of the currently viewed images into the current frame, 
and turns off the LightTable so you can see the result as it actu¬ 
ally appears. 

Warning! •> You cannot UNDO this Merge command. 

Keyboard Equivalent: Alt-1 
When Dim is on, all frames displayed on the LightTable, except 
the current frame, appear dimmed. You can easily see at a glance, 
which frame you are working on. Dim is on by default. This op¬ 
tion applies to all screen format modes except HAM. 

❖ If you dim a frame that contains very dark colors, those colors 
may be difficult to see. 

Shows/hides the frame that is two back from the current frame 
in the LightTable. For example, if your current frame is number 
3, then Two Back shows frame 1 on the LightTable. 

Shows/hides the frame immediately preceeding the current 
frame in the LightTable. 

Show's/hides the frame immediately following the current frame 
in the LightTable. 
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Spare 

Background ^ 

Fix 

Free 

Lock FG 

Anti-alias ^ 

None, Low, High 

Shows/hides the scratch page in the LightTable. 

Fixes the background by "locking" the current picture. This 

allows you to draw on it without losing any of the background. 

You can erase any paint you apply after fixing the background 

by clicking CLR or by painting with the right mouse button. 

❖ Fixing the background uses additional memory. When the 

background is fixed, no colors may be picked up from that 

background. 

This "unlocks" the background, and merges it with anything that 

was painted over it, so that clicking CLR will clear the entire pic¬ 

ture. It also frees up the memory that was allocated to fixing the 

background. 

The Make Stencil requester lets you create stencils based on col¬ 

ors in the palette. By locking a color, you make it impossible to 

paint on that color, wherever it may be on the page. By using a 

combination of Fix Background (see above) and Lock FG, how¬ 

ever, you can define a stencil by area rather than color. When you 

select Lock FG, you define as a stencil those areas on the page 

that you have painted since fixing the background, regardless of 

the color of those areas. 

Anti-aliasing is a smoothing process which eliminates or reduces 

the jagged edges apparent in lines that aren't precisely vertical or 

horizontal. The effectiveness of anti-aliasing is dependent on the 

range of colors in the palette. For example, to draw a smooth, ob¬ 

lique black line on a white background, you'll need to have two 

intermediate shades of gray in the palette. 

Anti-aliasing works with straight and curved lines, and with 

filled and unfilled shapes. It is especially good at smoothing the 

jagged lines in a brush that result from rotating or shrinking it in 

Perspective mode. 

Keyboard Equivalent: Alt-/ 

Set the level of anti-aliasing used on your brush when you paint. 

None is the default setting and applies no anti-aliasing. Low lets 

you eliminate some of the jagged outline in your images and 

brushes. The cost of removing jagged lines is painting speed, 

but it is still faster than smoothing out an image by hand. To use 
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Process } 

On/Off 

Tint (default setting) 

Title Bar shows that 
Spare Page, Matte 

Brush mode. Process 
(Tint setting by 

default), and 
Translucency are 

active. 

anti-aliasing, select either Low or High before you lay down the 
brush image. Anti-aliasing is most effective when you have re¬ 
duced the size of your original brush (for example, by moving it 
back along the Z axis). Anti-aliasing in the High setting can be 
very slow if your brush or fill area is large. 

❖ The effectiveness of the Process options is dependent on the 
colors available in the palette. DeluxePaint combines your 
foreground color with the color in your image and then looks 
for the color in your palette that most closely matches the 
color it needs. For best results, your palette should contain a 
range of colors between the colors in the palette and the color 
you are using to tint. The Process options obviously give the 
best results in HAM mode because all 4096 Amiga colors are 
available for painting. 

You can combine Translucency with any of the Process options 
to increase your control over the effect of these options. For ex¬ 
ample, Hue would normally directly substitute the hue of your 
brush for the hues in your picture. If you turn on Translucency 
with a setting of 50%, instead of substituting the hue directly, the 
resulting hue will be a 50/50 combination of the brush hue and 
the picture hue. 

Keyboard Equivalent: Alt-p 
When you choose Process On, a P appears in the middle of the 
Title Bar. 

The color you are painting with tints the color(s) underneath it in 
the direction of the color you are applying. Use this option if you 
want to create a shading or tinting effect over a number of colors 
on the screen or to colorize a black and white or grayscale image. 

Figure 8.37 Shape painted over others using Tinted setting 
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Hue 

Value 

Translucency ► 

Oit/Off 

Settings ... 

Use this opti^f$||b any painting tool to adjust the hue of a col¬ 
ored area of This option is useful for converting a 
multi-colore^i^^ into a monochromatic image. Note that this 
option will have no effect on grayscale images because a color 
with no Saturation is gray regardless of its hue. 

Use this option to paint the Value of the current brush into the 
colors in the image. This is an effective way to create shading 
effects. If you choose a light color to paintValue mode, 
darker colors you paint on will become hgjhi££,,-.Sf you choose a 
dark color to paint with, lighter colors darker. 

Keyboard Equivalent: Alt-t 
When you choose Translucency, a T appears in the middle of the 
Title Bar. Painting with Translucency on has the effect of laying a 
transparency or colored filter over a portion of your picture. The 
transparency is tinted toward the current foreground color. The 
degree of tinting is determined by the level (percentage) set in 
the Transluceggjygquester (below). 

Keyboard Ec^Ml^^tt: Ctrl-1 
Displays the Translucency requester. The default setting is 50%. 

Translucency 

V. 50 

Cancel Ok 
Figure 8.38 
Translucenaf requester 

To change the setting, click on either side of the slider, or drag 
the slider to a particular position. Click Ok to confirm your new 
setting. 

Here's an example of how Translucency works. Let's say you 
have a red object in your painting with the RGB values R: 15 
(100%) G:0 B:0, and that blue (R:0 G:0 B:15 (100%) is your fore¬ 
ground color. If you set the translucency level to 50% and 
painted over the red object, the resulting color would be equal 
to 50% of the object's color, red, and 50% of the foreground color, 
blue. The RGB value of the resulting color is R:7 (50%) G:0 B:7. 
If this color (purple) is not in the current palette, the closest color 
to this value will be used instead. Like the Process functions, 
Translucency give the best results in 11 AM mode. 

The percentage value for translucency refers to the amount of the 
original object that will show through the newly applied fore- 
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Perspective } 

Do 

Fill Screen 

Reset 

Center 

ground color. For instance, in the above example if the translu- 
cency level was set to 75%, the resulting color would be 75% of 
the existing color in the painting, red, and 25% of the foreground 
color, blue. The RGB value of the resulting color would be R:ll 
G:0 B:3. 

Transiucency works with all the painting tools (except text, single 
pixel Airbrush, or the 3- and 5-pixel built-in brushes), and in 
combination with the Process options. By combining Transiu¬ 
cency with Tint, for example, you can control the degree of 
tinting. 

The Perspective submenu contains options for manipulating a 
brush in three dimensions. 

Keyboard Equivalent: Enter (on keypad) 
Puts you into Perspective mode. Your brush is represented by a 
four-cell matrix, which you can manipulate with keypad com¬ 
mands (listed later in this section). The amount of rotation for 
axes x, y, and z is given in degrees on the right side of the Title 
bar. The center of perspective (see Center, below) is indicated by 
a cross-hair. You can paint an image of the rotated brush at any 
time by clicking. 

•> To exit Perspective mode, click a tool in the toolbox. 

Keyboard Equivalent: - (minus on keypad) 
Fills the screen with the current brush, in its current state of rota¬ 
tion in 3D. The entire brush size (not just the opaque part) is the 
default size for the Perspective Fill pattern. 

Keyboard Equivalent: (Mon keypad) 
Resets the brush to its original state before rotation, and returns 
all of the settings in the Perspective Settings requester to their 
defaults (see Settings, below). 

❖ Note: The keyboard equivalent does not reset the perspective 
center. It is useful if you need to reset your brush to its origi¬ 
nal orientation without changing your perspective plane. 

Keyboard Equivalent:. (period on keypad) 
Allows you to set the Perspective center or horizon in your 
perspective "landscape." 

❖ When you select Center, your cursor changes into a large 
cross-hair. The smaller, stationary cross-hair on the screen 
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Settings 

Grid 

From Brush 

Angle Step 

Screen 

indicates the existing center Move the large cross-hair to the 

new center you want and click either mouse button. 

Once you have set the Perspective center, the position of the 

unrotated brush relative to that center determines the position of 

the perspective plane when you rotate the brush. The greater the 

distance above or below Perspective center, the less pronounced 

the perspective effect. 

Displays the Perspective requester. When you are in Perspective 

mode, you can also display this requester by right-clicking the 

Grid tool. 

Figure 839 
Perspective requester 

The following options are available: 

You can use these edit boxes to set the dimensions for a grid in 

three-dimensional space. When you first open the requester, the 

numbers in these boxes correspond to the dimensions of your 

brush, the Z dimension automatically takes the same value as the 

Y dimension. It is important to remember that the entire brush 

size (not just the opaque part) is the default size for Perspective 

Grid and Perspective Fill. 

Clicking From Brush sets the X and Y grid values to correspond 

to the width and height of the brush. This is the quickest way to 

restore the perspective grid settings to the same dimensions as 

your brush without affecting any other settings. 

j Specifies the rotation increment used in conjunction with the 

Shift key and the appropriate keyboard rotation key (see 

Perspective Rotations, below). This value defaults to 90°. 

The default setting, uses the screen coordinate system when ro¬ 

tating the brush on the X, Y, and Z axes. (If you are familiar with 

coordinate systems, you will knowr this coordinate system as the 

Euler method, which measures all three angles of rotation from 

absolute zero.) 
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Brush 

Display 

Rotates the brush relative to the current 

The Angle and Pos buttons let you choos^’^^^r^WSSgfe-bf 
rotation or the position of the brush in three dimensional space 
are displayed in the Title Bar. 

❖ If Coords from the Prefs menu is turned on, the Title Bar 
shows two dimensional coordinates; be sure to turn Coords 
off if you want to see three dimensional coordinates. 

Perspective Rotations 

All perspective rotations are controlled through the keypad on 
your keyboard. 

X rotations 

Y rotations 

Z rotations 

reset all rotations 
place center 
FillScreen 

-r +r reset 

7 8 9 

4 5 6 

1 2 3 

0 

Figure 8AO Perspective rotation and settings using the keypad 

-Angle +Angle Fix 
Step* Step' Axis 

X rotations 7 8 9 

Y rotations 4 5 6 

Z rotations 1 2 3 

reset all settings 
place center 

0 

FillScreen - 

Figure 8A1 Perspectiife rotation and settings using Shift 
with the keypad 

261 Reference DeluxePaint IV 



Other Perspective 

Keyboard Commands 

Pressing Keypad 0 resets all three axes to zero and fixes the Z 

axis (see below), but retains the apparent distance settings. Press¬ 

ing Keypad 0 in conjunction with the Shift key resets all perspec¬ 

tive values to the default state. 

A Ctrl temporarily fixes the Y axis so that you can move the brush 

J forward or backward in 3D space by moving the mouse forward 

or backward. 

The ; and ' keys move the brush plane forward or back along its 

fixed axis (see below) without changing its orientation, moving it 

in a direction perpendicular to the brush plane. This is the same 

effect described in the above discussion on brush position prior 

to rotation. Thus, with the Z axis fixed, brush position relative to 

the Perspective center at the moment of rotation determines the 

brush's distance above or below eye level. You can achieve the 

same effect after the brush is rotated by using the ; and ' keys to 

move it forward or back along its Z axis. 

% J Pressing these keys with the Shift key held down results in larger 

increments of movement. In addition, you can modify the appar¬ 

ent distance from the observer by pressing the < and > keys (i.e., 

the Shifted and keys). Thus, when the apparent distance is 

great, the perspective foreshortening is at a minimum, becoming 

greater as apparent distance decreases. 

Fixing Axes: Whenever you start in Perspective mode, the Z 

axis (the one perpendicular to the screen) is "fixed," that is, 

the mouse does not move the brush through that axis. You can 

selectively fix any axis, as follows: 

To fix the X axis, press Shift-9 

To fix the Y axis, press Shift-6 

To fix the Z axis, press Shift-3 

As noted above, you can move along the axis that is currently 

fixed by using the Shifted or un-Shifted ; and ' keys (use the 

Shifted keys for larger increments). You can also temporarily fix 

the Y axis by holding down the Ctrl key 
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Prefs 
Menu 

_lifirm_ 
Coords 
Fast FB 
MultiCycle 
Be Square 
Workbench 
txcIBrush 
AutoTransp 
No Icons 

yf AutoGrid 
Ori^inUL 

/ Fa stAd 

The Prefs menu contains a list of options that you can toggle on 
or off to suit your work habits. When you choose an option, a 
check mark (V) appears to the left of the option to indicate that 
it's turned on. Choosing the option again turns the option off 
and removes the V. 

You can toggle multiple options by clicking on the option while 
the Prefs menu is exposed. 

The AutoGrid is turned on by default for all DeluxePaint users. 
For artists using HAM screen format. Fast Adjust is also turned 
on by default. 

You can customize your working copy of DeluxePaint so that the 
preferences are automatically set to the way you like them each 
time you start the program. For example, you might like to have 
Coords always turned on when you boot DeluxePaint. To cus¬ 
tomize the preferences, use the Tool Types feature of Info in the 
Amiga Workbench. Here's how to do it under Workbench 1.3. 

^ Boot your Amiga. Insert your working copy of the program 
disk. Click the DeluxePaint program icon to select. Choose 
Info from the Workbench menu. 

The Info requester appears. In the bottom half of this requester 
you'll see a box for Tool Types with ADD and DEL buttons. To 
turn a Prefs option on: 

► Click the ADD button. Type the name of the Prefs option you 
want to turn on automatically each time you boot the pro¬ 
gram. (Type it exactly as it appears in the Prefs menu.) Press 
Return. 

To turn a Prefs option off, scroll to display that preference name 
in the edit box and click DEL. 

Click Save to exit the Info requester and save your changes. 

Coords Keyboard Equivalent: ShiftA 
This option turns on the coordinate display in the upper right- 
hand portion of the Title Bar. Simply moving the mouse displays 
the current position of the cursor, with the origin (0,0) set to the 
lower left corner of the screen. Holding down either mouse but¬ 
ton temporarily resets the origin to the current cursor position 
and displays the displacement value from that temporary origin 

Customizing 
the Prefs Menu 
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as you move around the screen. The readout is scaled in pixels. 

See also OriginUL, below. 

Fast FB 

MultiCycle 

Be Square 

Workbench 

ExclBrush 

Fast feedback. Turn on Fast FB when working with large or com¬ 

plicated brushes while using the line or unfilled shape tools. Fast 

FB lets you draw your lines or shapes using the smallest (one- 

pixel) brush for feedback, and then completes the design using 

the currently selected brush. This increases response speed while 

you are drawing, but does not affect the final image. 

Works in conjunction with the Cycle paint mode from the Mode 

menu. With MultiCycle turned on, painting with a multicolored 

brush in Cycle mode cycles each color in the brush, provided the 

color is in a cycle range. When MultiCycle is turned off (the de¬ 

fault), using Cycle with a multicolored brush treats the brush as 

though it were a single color (the current foreground color). 

Because the Amiga's pixels are not perfectly square, circles and 

squares drawn with the shape tools are not perfectly round or 

square. If you wish to draw "true" circles or squares, select Be 

Square. This will square all the built-in brushes, the appropriate 

shape tools, and symmetry. Be Square does not square gridding 

or perspective, and should be turned off when you are using 

those features. 

Toggles the Amiga Workbench on and off. Default setting is off. 

If you pick up a brush with ExclBrush (and the Grid) selected, 

you will exclude a one-pixel border on the right and bottom 

edges of your brush (see Figure 30). This is useful if your brush 

has a colored border around it and you want to use the brush to 

create a pattern fill or perspective fill (using the Fill Type re¬ 

quester). When DeluxePaint creates your pattern, the border will 

be uniform throughout instead of being twice as wide where one 

copy of the brush is placed next to another. 

❖ ExclBrush has no effect on brush pickup when the Grid is off. 
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AutoTransp 

No Icons 

AutoGrid 

The image 
picked up 
with Exd 
Brush off 

The image 
picked up 
with Excl 
Brush on 

Figure 842 An example of using ExcIBrush 

Modifies the way brush pickup works. With AutoTransp turned 
on, DeluxePaint determines the transparent color by looking at 
the corners of the captured rectangle or the points of the polygon 
to see if they are the same color If the four corners are the same 
color, that color becomes the transparent color, otherwise the 
current background color remains the transparent color. 

When No Icons is on, your files are saved without the icon "info" 
files. This option is useful if you don't ever expect to launch an 
application by double-clicking on a picture file. Saving without 
the icons saves space on your disks. 

With AutoGrid turned on, the perspective grid is resized auto¬ 
matically to match any custom brush you choose to load or pick 
up. It's as if you had clicked the From Brush action button in the 
Perspective requester. When AutoGrid is off, the perspective grid 
is not automatically resized. 

❖ This option affects only the grid in Perspective, not the stan 
dard grid. 
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OriginUL 

FastAdjust 

User Feedback 

in the Title Bar 

Painting Mode 

Color Fill Box 

When Coords from the Prefs menu is on, DeluxePaint displays 
the current position of the cursor on the right side of the Title 
Bar. By default the program calculates the origin, or zero point of 
coordinates (0, 0) of the cursor position from the lower left corner 
of the screen. Jf you would rather have the origin calculated from 
the upper left, choose OriginUL. To return to the default origin, 
choose OriginUL again. 

This option is available only in HAM mode, where it is tamed 
on by default. FastAdjust tells DeluxePaint NOT to attempt to 
correct the fringing effects that appear along the right side of 
your brush while the brush is moving. This improves the speed 
of brush movement and is especially helpful if you are using 
large custom brushes. If you find the fringing to be annoying or 
difficult to work with, turn FastAdjust off, and the fringing will 
be reduced. 

DeluxePaint Colon_ _wo 

Figure 8 A3 Title Bar 

Displays the the current painting mode (Matte, Color, Replc, 
Smear, Blend, Cycle, Smooth) beside the program title [Deluxe- 
Paintl on the Title Bar. See Mode menu, above, for information 
on painting modes. 

Displays the currently selected fill pattern, or perspective fill or 
gradient fill in a small box in the middle of the Title Bar. This box 
previews the pattern or gradient you'll get when you fill a shape. 
The Color Fill Box is absent if your Fill Type is set to Solid. See 
discussion under Fill tool, below, for more information on the 
Fill Type requester. 

A Appears in the middle of the Title Bar when Antialias>High 
is selected from the Effect menu. 

a Appears in the middle of the Title Bar when Antialias>Low 
is selected from the Effect menu. 

B Appears in the middle of the Title Bar when the background is 
fixed. 
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Axis Rotation 

Coordinates 

Memory Availability 

P Appears in the middle of the Title Bar when you have se¬ 
lected one of the Process options (Tint, I lue, Value) from the 
Effect menu. Process>None does not display the P. 

S Appears in the middle of the Title Bar to show a Stencil is 
active. 

s Appears in the middle of the Title Bar when a Stencil is active, 
and Stencil>Show or Stencil>Paint is selected. 

T Appears in the middle of the Title Bar when Translucency 
from the Effect menu is turned on. 

When you are in Perspective mode, the rotation of the selected 
shape about each axis (x, y, and z, respectively) appears in the 
right corner of the Title Bar. The axis rotation information is 
superseded by the cursor coordinates if you turn on Coordinates 
in the Prefs menu. 

When Coords is active, the coordinates oi the cursor position are 
displayed in the right corner of the Title Bar. 

Press the Ctrl key and the letter a at the same time to display 
available Fast memory/Chip memory in the left corner of the 
Title Bar. See Appendix A for information on DeluxePaint's 
memory usage. 
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Appendix A: Memory Management 

If you're running DeluxePaint IV on a machine with 1 megabyte 
of RAM, 282K is allocated to the program and 100K to Intuition, 
leaving about 600K free. But this doesn't take account of the 
memory required to create the display, so you'll generally have 
a little less memory available as you work. For example, the de¬ 
fault screen format (320 x 200 by 32 color display) uses 40K of 
memory, which leaves you with about 560K to work with. In 
addition, each external disk drive uses an extra 20K. You can 
measure available memory by selecting About from the Picture 
menu (or by pressing Ctrl-a) any time you need a memory check. 
DeluxePaint will warn you when you have insufficient memory 
to accomplish a task, or when you run the risk of losing data. 

Memory shortage is manifested in various ways. For example, if 
you are at the limits of available memory and you select a large 
brush, DeluxePaint conserves memory by displaying just the 
outline of the brush. When you paint with the brush the image 
will appear on the screen in the normal fashion, even though it 
may not be visible as you move the brush around the screen. 
When this happens, consider it a sign that available memory is 
low. In that case, you should take some action to reallocate 
memory (for example, by deleting the spare page or by removing 
any stencils, see below), or at least to save your current image or 
animation to disk. 

Here are some of the ways DeluxePaint IV consumes memory: 

Increasing the amount of change in an animation after you've 
allocated frames for animation (see below for further discus¬ 
sion). 

Creating and holding a large brush. When you see just the 
outline of the brush this is a sign that you are near the edge 
of your memory limits. 

Creating and holding a large AnimBrush. 

When your spare page is active, it uses up as much memory 
as the first page even if you cleared the image from it. You 
can regain the memory used by the spare page (40K or more) 
by selecting Delete This Page, while viewing the spare page, 
from the Picture menu. 

□ You use memory by leaving the Workbench open while you 
work DeluxePaint. The WorkBench can be opened and closed 
through the Prefs menu. 
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Animation and 
Memory Management 

WhatIfYou Run 
Out of Memory 

Creatinj|i|^^^^:il uses up one bit plane. The exact amount of 
memory1;^ on the screen format and page size 
you've Fixing the background has a much larger 
overhead, similar to that required by a spare page. 

Other things that require memory are loading the disk directory, 
loading the system fonts, and creating a fill pattern from a brush. 

You've probably discovered that animati^^-^^iires a lot of 
memory. And the two animation method^fAgkwded and 
Compressed, have different memory reql^l^^nts. 

The Expanded method of animation requires that there be 
enough memory to duplicate the entire screen for every frame. 
So if you are in 320x200 32 colors, which takes 40K per screen, 
you'll need 800K to get 20 frames. 

Memory requirements for animation in the Compressed mode^ -r 
based on the difference between each animation frame The n\Q0, 
a frame is different from tl^j^^^efore it, the more memory will 
be needed to store it in m^lf^lf^nd on the disk. The frame that 
requires the minimum amlUfeSlmemory is simply a copy of 
the frame before it. The maximum amount of memory is re¬ 
quired when every pixel in a frame is a different color than in 
the frame before it. 

It's possible to set the number of frames to a large number and 
then, in the course of painting on the different frames, run out 
of memory. What is happening is that you are increasing the 
amount that the frames differ from each other. When this hap¬ 
pens you'll see a message that explains that you don't have 
enough memory to save the changes you're making. 

Eventually everyone gets in a situation when they run out of 
memory. The first thing you should do when you get messages 
saying "Not enough memory" is to save your work. The follow¬ 
ing is a list of thingsCan do to get a little more memory to 
finish your work. 

Close the Workbench from the Prefs Menu. 

□ Delete your Spare page. 

Delete your custom brush by selecting a verv^^^tustom 
brush. 
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□ If you have an AnimBrush, choose AnimBrush>Free option 
from the Anim menu to free it. 

□ If you have a stencil, choose Stencil>Free from the Effect 
menu to free it. 

□ If you have an animation, delete some frames. 

□ Reduce your page size if it is larger than the screen. 

Work with the minimum number of colors that you can to 
achieve the effect that you want. Choose the screen format 
you are working with and reduce the number of colors. 

❖ If you receive the System Message "Not enough memory for 
requested page size" when you try to change the DeluxePaint 
IV screen format from Hi-Res, 16 colors to I ii-Res, 16 colors. 
Overscan, you may be experiencing memory fragmentation. 
To solve this problem, either reset the screen format from the 
Screen FpjrnjaCoption in the Picture menu, or quit the pro¬ 
gram DeluxePaint IV in Hi-Res, 16 colors. 
Oversea 
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Appendix B: Keyboard Command Summary 

Brush Commands Fl 

F2 Color ^ 
F3 Replc 

F4 Smear 

F5 Shade 

F6 Blend 

F7 Cycle 

F8 Smooth 

Brush smaller 

_ Custom brush smaller by 2 steps 

= Brush larger 

+ Custom brush larger by 2 steps 

Alt-n Copies custom brush to spare brush 

Alt-b Swaps current and spare custom brush 

Ait-m Metamorphosis from spare to current custom brush 

Z Stretch 

h Halve 

H Double 

X Double horizontal 

Y Double vertical 

x Flip horizontal 

y Flip vertical 

z 90 Degree rotate 

o Edge>Outline 

O Edge>Trim 

Alt-s Center brush handle 

Alt-x Flip brush handle horizontal 

Alt-y Flip brush handle vertical 

Alt-z Place brush handle 
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Resiorelast custom brush/AnimBrush 

Unfilled Circle 

Filled Circle 

Filled and Outlined Circle 

Contutvuous Freehand 
fl 1 IT 

Filled Freehand 

Filled and Outlined Freehand Shape 

Unfilled Ellipse 

Filled Ellipse 

Filled and Outlined Ellipse 

Fill 

Fill requester 

GrM mJ off 

Grid using current brush handle position 
as a grid point 

CLR (clear screen) 

Magnify on/off 

Palette Mixer requester 

Arrange Palette requester 

Curve 

Unfilled Rectangle 

Filled Rectangle 

Filled and Outlined Rectangle 

Dotted Freehand 

Text 

Choose Font requester 

Undo 

Straight Line 

Line Spacing requester 

> Increase magnification 

< Decrease magnification 

, PICK color cursor 

One-pixel brush 

[, 1 Change foreground color 

L ) Change background color 

/ Toggle Symmetry on /off 
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Special Keys 
Delete 

F9 

F10 

Shift-FlO 

Cursor keys 

Ctrl-Cursor Keys 

n 

Shift 

Ctrl 

Ctrl-a 
bar 

Tab 

S 

Ctrl-S 

- (Tilde) 

' (Grave) 

a 

I (ShiftA) 

Spacebar 

Esc 

j 
Ctrl-j 

Alt-/ 

Help 

Right Amiga-1 

Right Amiga-s 

Right Amiga-d 

Display About /memory info box 

Cursor arrow on/off 

Menu Bar on/off 

Toolbox & Menu Bar on /off 

Hide all panels (Toolbox, menu, etc) 

Scroll Page (except in text mode) 

Adjust Screen positioning 

(Adjusts the position of Mixer, Arrange 
Palette, and Range panels when the cursor 
is over the panel) 

Centers area under the cursor 

Constrain cursor 

Leave traces with line or shape tools 

Displays available Memory in the menu 

Color Cycle on/off 

Show page 

Toggle Paint Stencil mode 

Make Stencil 

Stencil on/off 

Again key - repeats last menu command 

Coords on/#T-;t.- 

Cancel ope^iS^iih progress 

Stop operation in progress 

Spare page 

Copy to Spare 

Step through Antialias settings 

Selects Freehand tool and single 

pixel brush 

Load requester 

Save requester 

Delete requester 
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Color Controls 

Perspective 
Commands 

Ctrl-r Range requester 

Alt-r Reverse direction of range 

All-1 and 

Alt-| Step forward/backward through available ranges 

Alt-1 Translucency On/Off 

Ctrl-t Translucency Setting requester 

Alt-p Process On/Off (Tint is default) 

P Color Mixer requester 

P Arrange Palette requester 

Enter 

Keypad 7 and 8 

Shift Keypad 7 and 8 

Keypad 9: Reset X axis to 0’ 

Keypad 4 and 5 

Shift Keypad 4 and 5 

Keypad 6: Reset Y axis to CT 

Keypad 1 and 2 

Shift Keypad 1 and 2 

Keypad 3: Reset Z axis to 0* 

Keypad 0 Reset all axes to 0° 

Shift Keypad 0 

Shift Keypad 9 

Shift Keypad 6 

Shift Keypad 3 

Keypad (Minus) 

Keypad (Period) 

; and ' keys: 

Shift; and ' keys (: and ") 

< (Shift.) and > (Shift,) 

Ctrl 

\ 

Enter/Exit perspective mode 

Rotate about the X axis 

Rotate X axis by Angle Step 

Rotate about the Y axis 

Rotate Y axis by Angle Step 

Rotate about the Z axis 

Rotate Z axis by Angle Step 

Reset all axes, positions, and 
settings 

Fix X axis 

Fix Y axis 

Fix Z axis 

Fill the screen with the current 
brush at the current perspective 

Reset Center 

Moves the brush along its fixed 
axis in a direction perpendicular 
to its plane 

Same as ; and ' keys but with 
greater increment 

Modify observer distance from 
screen 

Temporarily fixes the Y axis so 
you can move your brush on the 
x and z coordinates 

Toggle Angle/Position display 
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Animation Keys 1 Step to Previous Frame 

2 Step to Next Frame 

3 Display the Go To Frame requester to jump 
directly to a specific frame 

4 Play Animation continuously until Spacebar or 
mouse button is pressed 

5 Play animation once 

6 Play animation in ping-pong mode 

7 Step to previous AnimBrush cel 

8 Step to next AnimBrush cel 

Shift-1 Go to first frame 

Shift-2 Go to last frame 

Shift-3 Go to last frame you did a "go to" to 

Shift-4 Play animation continuously in reverse direction 

Shift-5 Play animation sequence once in reverse 
direction 

Shift-7 Go to first AnimBrush cel 

Shift-8 Go to last AnimBrush cel 

Space bar Stop the currently playing animation sequence 

r Reverses animation sequence while playing 

Left Arrow Slows down animation while playing 

Right Arrow Speeds up animation while playing 

Alt Held down while painting, turns on 
Animpainting mode 

M Move Requester 

Animation Alt-a Anim Control Panel on/off 

Control Panel 1 LightTable on/off 

All-I LightTable Dim on/off 

Ctrl-1 (main keyboard) LightTable 2 back on/off 

Ctrl-2 LightTable Previous on/off 

Ctrl-3 Lighttable Next on/off 

Ctrl-4 LightTable Spare Page on/off 

Alt-= Adds one frame 
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Appendix C: The Player Utility 

The Player utility on the Art2 disk lets you play the animations 
you have created with DeluxePaint IV. You can boot the utility 
from the Workbench or use CL1 arguments to start the Player. 

From the Workbench, open the Art2 disk and double-click on the 
Player icon. This loads the program in the default screen format 
(lo-res, 320 x 200, with 32 colors). The screen is black and the 
Menu Bar is not displayed. To see the utility's single menu, move 
the pointer to the upper left part of the screen and press the right 
mouse button. Animate appears in the Menu Bar, and the menu 
options. Load, Play, About, and Quit descend below it. 

Choose Load and when the Load Anim requester appears, 
specify which drive you want to make active and then load a 
picture or anim from the directory of the drive you chose. The 
utility automatically plays the highlighted file when you click 
Load in the requester. If you want to replay the animation after 
you have stopped it, choose Play. About displays the version 
and date of the utility. To exit the Player and return to the 
Workbench, choose Quit. 

You can use the same keyboard commands you've used in 
DeluxePaint IV while you view your animation. 

KEY EFFECT 

Tab Turns color cycling on/off 
Left Arrow Slows down play rate 
Right Arrow Speeds up play rate 
r Reverses play direction 
Esc or Space bar Stops plays 
1 Go to previous frame 
2 Go to next frame 
4 Play the animation 
5 Play once 
6 Play ping-pong 

To use Player from the CLI or Shell, open the CL1 or Shell from 
the Workbench. On the command line type cd Art2 : and press 
return. 

❖ If Art2 is not loaded you will be prompted to insert it. 

This will change the current directory to the Art2 disk where the 
Player utility is located. At the next prompt, type player (add a 
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space) and the complete path and filename of the picture or anim 
you want to load. For example, if you wanted to load the anima¬ 
tion called "TheTour" from the anim drawer of the Art2 disk, 
you would type the following 

player Art2:anim/TheTour.anim <enter> 

If you want to show the anim for a certain number of seconds, 
press the space bar and type that number after the filename. For 
example, to play "The Tour" for five second type: 

player Art:2 :anim/TheTour .anim 5 <enter> 

If you would like to indicate that the number is a loop count in¬ 
stead of time in seconds, press the space bar and type the number 
of loops you want to run. Press the space bar again and type 
loops. For example, to play five loops of "The Tour" type: 

player Art:2 :anim/TheTour .anim 5 loops <enter> 

You're now ready to issue player commands for your animation 
(or you can press Return right now and your animation will play 
and take you back to theCLI when it's finished). 

If you type an @ before the filename in this first Sine, the filename 
must be the name of a script file. Script files are ASCII text files 
from which commands are read. They are created with a text 
editor such as ED or EM ACS, both of which are included with 
Workbench 1.3. 

To instruct the Player utility to read commands from the script 
file (we'll call the filename TEST) type: 

player scripts/@test 

Play Commands 

from CL1 or Shell 
Command Meaning 

player Load the Player 
player (path & filename) Load and/or play file 
player (path & filename) 10 Load and/or play file for 

10 seconds and exit back to CLI or 
Shell 

player (path & filename) 20 Load and play file for 20 loops and 

loops exit back to CLI or Shell 
player ©test Read commands from script file 

"test" 
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Script File Commands The script commands, one per line, are similar to the CL1 com 
mands except that the word "player" is omitted. 

Command 

filename 
filename 
filename 
filename 

Meaning 

Display filename for 5 seconds 
Display filename for 10 loops 
Play filename until user hits key 
Display filename until user hits key 

❖ If the animations or pictures you are displaying are not in the 
same drawer as the Player, you must specify a complete path 
before the filename. 

If you hit the space bar or click while a picture or anim is running, 
the program will move to the next command, even if the speci¬ 
fied play-time has not elapsed. 

File names with blanks must be enclosed in quotation (" ") 
marks. 

A command line starting with a ; (semi-colon) is skipped. 

^--***? 

Creating an Auto¬ 
booting Slide Show 

1. Boot up your system with a Workbench disk. 

2. Format a blank disk using the noicons parameter. 

3. Use the Install command to make the empty disk a boot d*§fe 
For example, if the empty disk is in dfl type: 

INSTALL dfl: 

4. Make the following directories on the empty disk using the 
Makedir command: c; libs ; s; 1 
Example: Makedir dfl:c 

5. Copy the following commands from your workbench to the c 
directory of your empty disk: c.endcli; cloadwb ; csetpatch 
Example: Copy cendcli to dfl:c 

This following information is included For Advanced Users who 
are familiar with Amiga Dos and w&rct tq fCterte a n Autobooting 
Demo that displays your pictures:a»ima£i6ns from a script 
file. The whole process takes between 15 to 30 minutes. 
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6. Copy the file Icon.Library from the Workbench libs directory 
to the empty disk's libs directory. 

7. Copy the file Disk:Validator from the Workbench 1 directory 
to the empty disk's 1 directory. 

8. Copy the Player and Player.info from the Art2 disk to your 
empty disk. Since in fact your disk is no longer empty we'll 
call it your Player Disk from here on out. 

9. You should now have more than 700K free on your Haj'fr 
Disk for your pictures and animations. 

10. To execute the script file you will be writing to show your 
pictures and or animations you will need to first create a 
Startup-Sequence file in the S directory of your Player Disk. 
To do so, you must create a text file called Startup-Sequence 
with the following commands. Type the commands word for 
word and line for line. 

cisetpatch > nil: 

player @demo 

loadwb 

endcli > nil: 

You can create this Startup-Sequence file using Ed, 
MicroEmacs, or any text file editor. 

11. Copy the pictures and or animations you want in your demo 
to your player disk. Note that all of this copying can be ex¬ 
pedited if you you use a workbench directory utility. There 
are several in the public domain directory utilities and 
commercial ones as well. 

12. Create a script file called demo using the parameters given 
to you earlier in this section. 

13. After you've completed all these steps, you should be able 
to insert your Player Disk into the internal drive of most 
Amigas at the Workbench prompt (after rebooting) and 
watch your demo go. 
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Appendix D: Amiga Display Modes 

What Is a Bit Plane? 

Bit Planes and 
Available Colors 

DeluxePaint IV supports all of the built-in Amiga graphic display 
modes — low resolution, high resolution, extra-halfbrite, and 
hold and modify. You don't need to know much about the dif¬ 
ferent display modes to create great art with DeluxePaint IV. 
But some understanding of how the display modes work, and in 
particular, how they affect the number of colors available in the 
palette, can help you work more effectively. 

This appendix explains how a pixel derives its color, and how the 
display mode and the number of bit planes determine the num¬ 
ber of colors available in the palette. We've tried to avoid overly 
technical explanations, but the material is still very technical. If 
you don't understand everything you read here, don't be dis¬ 
couraged, just remember that you don't really need to know this. 

A bit plane can be thought of as a flat grid of dots — a plane of 
dots, where each dot represents a bit. So when we say "bit," 
think dot. 

If you look ahead to Figure D-l, you'll see that we drew the bit 
planes as flat surfaces. The best way to think of this surface is as 
a flat grid behind your computer screen. (This isn't actually how 
it works, but it may help you visualize how the colors are as¬ 
signed to pixels.) The grid is the same dimensions as your screen 
resolution. For example, if your screen is 320 pixels wide and 200 
pixels high, each bit plane is also 320 x 200 bits. 

Now imagine that each dot is either filled in or it's not. If the dot 
is filled in, it has a value of 1 and is said to be "on." If it is not 
filled in, the dot has a value of 0 and is said to be "off." In the 
simplest case of a display mode with only one bit plane, the 
picture can have only two colors. A pixel is one color if its cor¬ 
responding bit is on or a different color if the bit is off. 

The bit planes themselves don't determine the color of the pixel, 
they simply determine which color register the pixel looks to for 
its color. With a single bit plane, the pixel points to either Color 0 
or Color 1. If you add another bit plane behind the first, the num¬ 
ber of possible color registers doubles to four. Each additional bit 
plane doubles the number of colors again. The color register con¬ 
tains the numbers for the amount of red, green, and blue in the 
color 
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Lozv Resolution and 
High Resolution 

Display Modes 

Figure D-l illustrates how the bit planes determine which color 
register a pixel points to in Low Resolution display with five bit 
planes. Take a look at this figure for a moment. Notice that we've 
numbered the bit planes 0 through 4. Notice also that the num¬ 
ber of each bit plane corresponds to the power of two by which 
each bit plane value is multiplied. For example, the dot in bit 
plane 3 has a value of 1, and because it is in bit plane 3, the 1 is 
multiplied by 2\ which equals 8 (2 x 2 x 2). The numbers from 
the five bits are then added together to obtain the number of the 
color register the pixel points to. 

Figure D-l Low Resolution Pixel Color Selection 

Low and High Resolutions work exactly alike, except that High 
resolution does not support as many bit planes, and therefore 
provides fewer colors. Figure D-2 lists the graphics modes and 
the number of bit planes and colors each supports. Notice that 
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Extra-Halfbrite 
Display Mode 

Hold And Modify mode is a departure from the notion that each 
additional bit plane doubles the number of colors available. Hold 
and Modify is a special case that well explain in a moment. 

CD 

o 
<p 
n 
E 
3 

Graphics Mode 

320x200 320x400 640x200 640x400 

1 2 2 2 2 

2 4 4 4 4 

3 8 8 8 8 

4 16 16 16 16 

5 32 32 n/a n/a 

6 64 / 4096 64 /4096 n/a n/a 

Figure D-2 Number of Colors in Each Display Mode 

Extra-1 lalfbrite uses a trick to increase the number of colors 
available on the screen. The Amiga supports only 32 color reg¬ 
isters directly, but Extra-Halfbrite uses a sixth bit plane to indi¬ 
cate an additional 32 registers that don't really exist, 't he first 32 
registers are standard color registers; the second 32 are halfbrite 
equivalents. Pixels that use halfbrite colors point to one of the 
standard color registers and indicate that the color should be dis¬ 
played at half its normal intensity. This means that the second 32 
pixels are not independant of the first 32; you can change the 
color values only in the first 32 registers, and the change is auto¬ 
matically reflected in the halfbrite equivalent. Figure B.3 shows 
how Extra-Halfbrite uses the bit planes and color registers. 

❖ Not all Amiga 1000 computers support Extra-Halfbrite. The 
easiest way to find out whether or not your computer sup¬ 
ports this display mode is to try it. Open an Extra-Halfbrite 
screen and look at the Palette (make sure the pointer is not in 
the Menu Bar or Toolbox). If the last 32 colors are the same as 
the first 32, your computer doesn't support Extra-Halfbrite. 
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Bit-Plane 5 

U1 
Bit-Plane 4 

= 1 
Bit-Plane 3 

Bit Plane 2 

* ? ? 

<S^=o 
Bit-Plane 1 

\ 
Bit-Plane 0 

Color Palette Registers 

. 1 

. 0 

4 

. a 
16 

32 

Color Register 0 Color Register 32 

Color Register 1 Color Register 33 

Color Register 2 Color Register 34 

Color Register 3 Color Register 35 

Color Register 4 Color Register 36 

Color Register 5 Color Register 37 

Color Register 6 Color Register 38 

Color Register 7 Color Register 39 

61 

Color Register 29 Color Register 61 

Color Register 30 Color Register 62 

Color Register 31 Color Register 63 

Figure D-3 Amiga Extra-Halfbrite Pixel Color Selection 

Hold and Modify Hold and Modify display mode uses only 16 color registers, but 
Display Mode manages to display all 4,096 colors on the screen at the same 

time. To accomplish this, HAM display mode uses the first four 
bit planes to address the 16 color registers, and uses the fifth and 
sixth bit plane to determine whether the register color or a HAM 
color should be used. 

A HAM color is formed by taking the RGB value of the preced¬ 
ing pixel on the screen, and substituting a new value for one of 
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the RGB components. The new value is the number derived from 
the first four bit planes. Here's a quick example: 

Assume the color values of one pixel (a register color) are R3, 
G15, BIT. The following pixel (a HAM color) would have the 
color values R13, G15, Bll, if bit planes 0 through 3 pointed to 
register 13 and bit planes 4 and 5 indicated that the register value 
should be used to modify the red component of the preceding 
color. (Figure D 4 shows how the six bit planes are used to select 
a color in Hold and Modify mode.) 

Bit-Plane 5 

K 
Bit-Plane 4 

Bit-Plane 3 

Bit-Plane 2 

Bit-Plane 1 

T\ 
Bi-Plane 0 

t ♦ 
000000 

13 

Bit pair = 10 N 0 3 
_ Normal color selection using value of bit-planns 

Color Palette Registers 

Color Register 0 

Color Register 1 

Color Register 2 

Color Register 3 

Color Register 4 

Color Register 5 

Color Register 6 

Color Register 7 

"3-0 to choose 1 of 16 color registers. 

or Bit pair ■ [~q | rri _ Take color ot previous pixel and substitute value 
l_n_U of bit-planes 3-0 for Blue component ol RGB color 

or Bit pair • [TUm =TaKe cok)f 01 PfCV,ous P*®1 and substitute value 
LLTLjiJ of bil-planes 3-0 lor Red component of RGB color 

or Bit pair « f"T~| rj~| =Take color of previous pixel and substitute value 
L J 1 1 of bit-planes 3-0 lor Green component ol RGB color. 

Cokx Register 13 

Color Register 14 

Color Register 15 

Figure D-4 Hold and Modify Pixel Color Selection 

286 Appendix D DeluxePaitit IV 



Because HAM colors are based on color values of the preceding 
pixel, and only one color value can be changed at one time, it 
may take three pixels to reach the color you really wanted. In 
Figure D-5 it takes three pixels to change black (RO, GO, BO) to 
white (R15, G15, B15). Note that this example assumes there are 
no intermediate colors in the normal color registers. This gradual 
change from one color to the next is sometimes referred to as 
"ramping" the color, and appears on the screen to the left of 
HAM pixels. If you need fine details in your picture, you will 
want to use a color from the color registers, because those colors 
do not require ramping. 

Black (0, 0, 0) Green (0,15, 0) Yellow (15,15,0) White (15,15, 15) 

Figure D-5 hi AM Color Ramping 

In DcluxePaint IV, if you hold a brush over an area made up of 
HAM pixels, you may see an effect called "fringing." The fring¬ 
ing appears as streaks running to the right from the edge of the 
brush. This effect is only temporary. When you paint the brush 
onto the picture, DeluxePaint corrects the fringing, but you may 
see the "ramping" effect where DeluxePaint recreates the HAM 
color to the right of your brush. 
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Notes 



Index 

Note: Menu options appear under 
their menu titles in boldface ti/pe. 

About... DeluxePaint IV 222, 270 
Action buttons 6# 209, 210 
Activation point 31 
Active line 30 
Add Frame 237 
Again rule 98, 208 
Airbrush tool 31-32, 36,55, 56, 

196 
Amiga Display modes 282-287 
Angle step 111 
Anim Menu 230-240 

AnimBrush 230-231 
Load 232 
Save 233 
Move 233-236 
Frames 236-237 
Control 237 239 
Method 239-240; see also 
Compressed and Expanded 

Animation 8 
basic model 127 
commands 277 
cyclic 137-139 
effects 161-180; receding or 

approaching shapes 161- 
162, dissolve 162-163, 
expanding circles 163-164, 
trails 164-165, curving 
titles 166-167, tumbling 3D 
objects 167-169, spinning 
174-180 

trames 65 
keyboard equivalents in 63 
painting with 131-132 
recording 154 

Animation Control Panel 129- 
130 

commands 277 
AnimBrush 65 

creating an 144 
flip an 225 
metamorphose (transtorm) 

147-148 
picking up an 145 
painting with an 145 
settings 145-147 

Animfill 191 
Animpainting 64-66, 131-132 
AntiAlias 9, 256-257 
Assigns button 210 
AutoGrid 265 

AutoTransp 45, 265 
Axes 154-155 

rotation on brush 156-157, 267 

Background 171 
fixing the 63-64, 99 
scrolling the 171-172 

Background color 18, 206 
default 25 
erasing to the 26 
painting with the 25-26 
transparent 46 

Background>Fix 64, 180, 256 
Background>Free 64, 256 
Background>Lock FG 256 
Be Square 32,196, 264 
Bg->Fg250 
Bg<->Fg 251 
Bit plane 271,282-283 
Blend 229 
Brush 28 

affected by a stencil 98 
anything can be a 34-35 
axes 154-155 
built-in 28, 55,186 
commands 273 
coordinates 112-115 
creating a rectangular 44 
creating an irregularly shaped 

44-45 
custom 44-49 
display dependent on 

memory 110 
duplicating a 45 
enlarge or reduce 28 
handle 48,111-112,169-171 
in Perspective mode 48 
is a little picture 47-48 
moving a 45 
moving in 3 dimensions 133 
painting modes 60-62 
polygonal 200 
rotating in 3D space 107-108 

Brush Menu 223-227 
Load 223 
Save 223 
Restore 223 
Spare 223-224 
Size 224 
Flip 225 
Edge 225-226 
Rotate 226 
Bend 226 
Handle 227 

Brush mode, painting 266 
Brush Selector tool 34-35, 57, 

199-200 
Brush<->Spare 223 
Brush>Spare 223 
Built-in brushes 28, 55, 186 

Cels 65, 230 
Chip RAM 102 
Circle tool 33,197 
CLR 206 
Color 

background 18, 206 
changing 36,93-94 (HAM) 
controls 276 
copy 71-72, 245 
creating a new 247 
delete 246 
exchange 71-72, 246 
foreground 18, 206 
lock 96-98 
mask 96 
mixing 78, 248 
modifying 245 
pick 27, 246 
processing options 94-95 
screen format and 219 
selecting a 247 
spread 72,246 
transparent 35, 45, 265 
working with 69-77 

Color (Mode) 60,61,228 
Color Cycling 10, 53 

with ranges 85-88 
Color Indicator 18, 25, 206, HAM 

207 
Color Menu 240-252 

Ranges 242-243 
Cycle 243 
Palette 243-249 
Color Set 249-250 
BG->FG 250 
BG<->FG 251 
Remap 251 
Recompute 251 
Brush 251-252 

Color Mixer 8-9, 52-53,70-77, 
207, 244-247 

Color register 86, 220,282, 285 
Color Set 70,72-73, 89, 249 

loading and saving 74, 79, 250 
ColorText 15, 57 
Color Wheel 76 
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Compressed memory method 
132,171,240,271 

Constrain the cursor 139 
a tool 186 

Continuous Freehand tool 29,36, 
187-188 

Control 237-238 
Coords 121, 263-264,267 
Copy to spare 216 
Curve 55 
Curve tool 30-31,190 
Custom brushes 44-49 
Cycle 61, 229, 243 

Default palette 249 
Default settings 17 
Delete 213 
Delete Frame 237 
Delete this Page 216 
DeluxePaint 111 1,69 
DeluxePaint IV, screen 49-50 
DeluxePaint IV 

About... 222, 270 
default settings 17 
hardware requirements 14 
hints and reminders while 

using 4 
installing to hard disk 15-16 
manual 2 
quitting 19 
software 13 
starting 17-18 
using with floppy drive 16 17 
what's new in 7-10 

Directional gradients 83 
Disks 

button 209 
organizing 14 
copying 14 

Dither 195, 242 
pattern and random 81-82 

Dotted Freehand tool 29, 36, 186 
Double 225 

Ease In/Ease Out 140-141, 180- 
181,235 

Edge 225 
Edit box 7,39 
Effect Menu 252-262 

Stencil 252-255 
LightTable 255-256 
Background 256 
AntiAlias 256 
Process 257-258 
Translucency 258-259 
Perspective 259-262 

Ellipse tool 33,198 

Euler angles 112 
Excl Brush 264 
Expanded memory method 132, 

240, 271 
Extra-Halfbrite 62, 218, 284 
Eyedropper 73 

FastAdjust 92, 266 
FastFB 49,264 
Fill tool 31,190-191 
Fill Type requester 82-85,191-195 
Filled Freehand Shape tool 187- 

188 
Fine Tuning 104 
Fixing the background 63-64, 99 
Flip 215, 225 
FONTS 201-203 
Foregrou nd color 18, 206 
Frame slider 129 
Frames 236-237 
Frames 230 

creating 128 
painting on 128-129 
merging with LightTable 

152-153 
Freehand Shape tool 29-30 
Fringing 92-93, 221,287 

Go Back 135-136 
Gradient fills 53, 82-85,193-195 

linear 83-84 
radial 84-85 

Grid tool 36, 58-59, 203 

Halve 225 
HAM (Hold and Modify) 7-8, 

219-221,284, 285-287 
animation with 149 
changing colors in 93-94 
fringing 92-93, 221, 287 
outlining in 225 
painting in 89-95 
palette 89-90 
ramping 90-91, 287 

Handle 227 
HBRITE 229-230 
Hi-Res 54,218-219 
High resolution 283 
HSV 

color system 52, 74-78,245 
sliders 71 

Hue 75-76,245 
Hue 258 
Hybrid cycles 88 

Installing DPaint IV 15-16 
Interlace 54, 218 

Jaggies 9, 180 

Key positions 149 
Keyboard equivalents 27,63, 

273-277 

LightTable 8,149-151, 255-256 
Linear fills 83 

gradients 83-84,193-194 
Load. See individual menus 
Load requester 38-39 
Loading a file 18-19, 211 
Lo-Res 54, 218 
Low resolution 282 

Magnify tool 37,205 
Matte 60,61,228 
Med-Res 54,218 
Memory 

affects painting 110 
availability 267, 270 
fragmentation 272 
management 270-272 

Menu 24, 208 
submenu 208 

Menu Bar 18, 24-25 
Merge in Back 216 
Merge in Front 216 
Meta morph 224 
Metamorphosis 8,147-148 
Method 239-240 
Mixing area 73, 247 
Mode Menu 228-230 

Matte 228 
Color 228 
Replace 228 
Smear 228 
Shade 228-229 
Blend 229 
Cycle 229 
Smooth 229 
Mix 229 
HBrite 229-230 

Modifying tools 55-59 
Mouse 5 

painting with 5 
Move 233-236 
Move requester 132-133,141-144, 

233-236 
MultiCycle 61, 229, 264 

No Icons 265 
NTSC monitor 221 
Numeric keypad 109 

OriginUL 266 
Outline 225 
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Overscan 217, 221, 272 

Page 17,49 
scrolling the 51 
switching 50 

Page Size 50-51,216 217 
Painting modes 60-62, 266 
Painting screen 23-24 
PAL monitor 221 
Palette 243-249 
Palette 18, 25, 52-54, 207 

arrange 53, 74, 248 
common 211 
default 249 
HAM 89-90 
load and save 74,249 
manipulating 69-77 
restore 249 
screen formats and 54 
spare page 50 
use brush 248-249 

Palette Mixer. See Color Mixer 
Pattern edit field 209 
Perspective 107-124, 259-262 

commands 276 
Picture Menu 208-223 

Load 209-211 
Save 211-212 
Delete 213 
Print 213-215 
Flip 215 
Spare 215-216 
Page Size 216-217 
Show Page 217 
Screen Format 217-222 
About 222 
Quit 223 

Pixel 28, 32,56 
Player utility 278-281 
Polygon tool 34,198-199 
Prefs Menu 263-266; customizing 

the Prefs menu 263 
Coords 263-264 
FastFB 264 
MuItiCycle 264 
Be Square 32,196, 264 
Workbench 264 
ExclBrush 264-265 
AutoTransp 265 
No Icons 265 
AutoGrid 265 
OriginUL 266 
Fast Adjust 266 

Print 213-215 
Process 95,257-258 

Quitting DeluxePaint 19, 223 

Radial gradients 84-85,194-195 
RAM (Random Access Memory) 

15,17 
Ramping 90-91, 220-221, 225, 287 
Random 242 
Range 61, 242-243 

building the 80-81 
color cycling 85-88 
copy a 242 
defining 53-54 
working with 78-88 

ReadMe file 13 
Recompute 92,93 
Recompute 251 
Rectangle tool 32,196 
Remap 251 
Replace 228 
Requester 5-6, 209 
Restore Palette 249 
RGB 

color system 52, 74-78, 245, 
282-283, 286-287 

sliders 71 
Rotate 226 
Rotation 134 

displayed in Title Bar 114 

Saturation 75, 245 
Save. See individual menus 
Saving a file 38-39,51 
Scratch page 49-50 
Screen axes 154-155 
Screen coordinates 112-115 
Screen Format 52,217-219, 272 

palettes and 54 
Screen resolution 51-52, 282-283 
Scroll bar 6 
Scroll box 19 
Scrolling background 171-172 
Shade 228-229 
Shear 226 
Shift key 186 
Show Page 51,217 
Size 224 
Smear 60, 228 
Smooth 60, 229 
Spacing requester 56,182, 188- 

189 
Spare page 44,49-50,215-216 
Spare>Metainorph 148 
Special commands 275 
Spreads, creating 53 
Squares 32 
Starting DeluxePaint fV 17-18 

Startup-sequence 15-16 
Stencil 96-104,252-255 

fine tuning 104 
in HAM 102-104 
memory and 271 
painting a 100-101 

Stencil>Paint 10 
Straight Line tool 30, 55, 188 
Stretch 224 
Submenu 208 
Swap 215 
Symmetry tool 36, 58-59,204-205 

Technical support 20 
Text tool 35-36, 57, 200-202 
Tint 257 
Title Bar 18, 24 

displays rotation angles 114 
hiding 49 
user feedback in 266-267 

Tolerance 10,103 
Tools 

constraining 186 
modifying 55-59 

Toolbox 17-18,28-38, 50,185-208 
commands for the 274 
hiding the 49 

Traces 188 
Translucency 92,94, 258-259 
Transparent color 35,45, 265 

changing the 46-47 
Trim 226 
Tweening 149-151 

UNDO 26, 206 
Unfilled shape tools 55-56 
Unit 217 
Use Brush Palette 249 

Value 75-76,245,258 

Wire frame 134 
Workbench 264 
Wrap 

Zoom tool 37,205 
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Artist Bios 

Lee Tar an 

Dan Silva 

When Lee entered Stanford University, she was an aspiring 
young artist. Oil painting had been her first love at Manhattan's 
famed School of Music and Art, and college might have been a 
pleasant diversion before entering the New York "Art Scene." 
At the prodding of some friends, she took a computer science 
course "for the fun of it." 

Like many of the creative talents who have worked with Elec¬ 
tronic Arts, Lee's entry into big-time programming began inno¬ 
cently enough with the Amiga. It's a familiar story: The Amiga 
was released, it was neat, it was fun, it had color, and suddenly 
— note the slightly crazed look of excitement typical in these 
cases — "I've got to program this thing!" Lee was hooked. 

The art world became a sweet memory. Because Stanford had no 
undergraduate major in computer science, Lee designed a major 
for herself in AI, and took all the systems and computer science 
courses the university had to offer. She then took time away from 
school to get some graphics expereince, and wound up working 
at EA on some of Dan Silva's old code. Following six months 
of intensive hacking on the EGA/VGA support for the Prism 
graphics primitives, she returned to Stanford for her degree, and 
stayed on for an M.S. in Computer Systems. 

Through all her training and diverse experience, computer 
graphics has remained an enduring passion. Her belief that high- 
quality artwork can be created with a computer led her back to 
Electronic Arts, and has resulted in DeluxePaint IV. And she 
won't stop there. 

When she's away from the keyboard, Lee's a discriminating sci-fi 
fan, a connoisseur of trashy TV, and a dedicated aerobics/work¬ 
out freak. She and her husband Ali share their home in Palo Alto, 
California with two big cats named Dido and Zack. 

Dan Silva is a legend. By the time Dan joined Electronic Arts in 
1983, he had already worked with computers and computer 
graphics for twenty years. In productive stints at Informatics, 
Xerox, and Lucasfilm, he had designed a video editor, and new 
generation bitmap editor, and written an interactive language for 
displaying equations as graphic images. As important as his 
achievments was the fact that his work helped him form a clear 
idea of how the ideal paint program should behave. 



At EA he started work on Prism, a paint program that was to be 
an in-house tool for software development. Prism eventually 
became DeluxePaint (1985), and it was an instant success. Dan 
started improving DeluxePaint almost immediately, and the 
result was DeluxePaint II (1986), the best paint program available 
for the Amiga at that time. And as fine a program as it was, Dan 
still wasn't satisfied. He could paint, but the paintings didn't 
move. Dan's lifelong fascination with animation became the 
driving force of the best-selling DeluxePaint III. 

Dan has moved on to other projects but his code lives on. His 
mission to create the best graphic tools for the Amiga is embod¬ 
ied in DeluxePaint IV. We couldn't have done it without him. 
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NOTICE 

ELECTRONIC ARTS RESERVES THE RIGHT TO MAKE IMPROVEMENTS IN THE PRODUCT DESCRIBED IN THIS MANUAL AT ANY 

TIME WITHOUT NOTICE 

THIS MANUAL IS COPYRIGHTED. ALL RIGHTS RESERVED NO PART OF THIS MANUAL MAY BE COPIED. REPRODUCED. 

TRANSLATED OR REDUCED TO ANY ELECTRONIC MEDIUM OR MACHINE READABLE FORM WITHOUT THE PRIOR WRITTEN 

CONSENT OF ELECTRONIC ARTS. 1820 GATEWAY DRIVE. SAN MATEO CALIFORNIA 94404 

ELECTRONIC ARTS MAKES CERTAIN LIMITED WARRANTIES WITH REGARD TO DEFECTIVE RECORDING MEDIA PLEASE SEE 

THE ELECTRONIC ARTS LIMITED WARRANTY ENCLOSED WITH THIS PRODUCT 

SOFTWARE <£> 1991 ELECTRONIC ARTS 

MANUAL BY R J BERG 

€> 1991 ELECTRONIC ARTS 

LIMITED WARRANTY 
Limited Warranty. Electronic Arts (“EA”) provides to the original purchaser of the computer software 

product, for a period of ninety (90) days from the date of original purchase (the “Warranty Period”), the 
following limited warranties: 

Media: EA warrants that, under normal use. the, magnetic media and the packaging provided with it are 
free from defects in materials and workmanship. 

Software: EA warrants that the software, as originally purchased, will perform substantially in conform¬ 
ance with the specifications set forth in the packaging and in the user manual. 

Warranty Information If you are having any problems with the product, we are happy to help. Please 
address all correspondence to Electronic Arts, 1820 Gateway Drive, San Mateo, California 94404. Or call us 
at (415) 572-ARTS. 

Warranty Claims. To make a warranty claim under this limited warranty, please return the product to the 
point of ^dtase, accompanied by proof of purchase, a statement of the defect, and your name and return 
addro^:. Tc>:replace defective media after expiration of the Warranty Period, send the product, in protective 
pack^fijf, postage prepaid, to Electronic Arts, at the above address, enclosing proof of purchase, a 
statement of the defect, your name and return address, and a check for $7.50. EA or its authorized dealer 
will, at its option, repair or replace the product, and return it to you, postage prepaid, or issue you with a credit 
equal to the purchase price, the foregoing states the purchaser’s sole and exclusive remedy for any 

BREACH OF WARRANTY WITH RESPECT TO THE SOFTWARE PRODUCT 

Warranty Exclusions ea expressly disclaims any implied warranties with respect to the mediaandthe 

SOFTWARE, INCLUDING WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE ANY WARRANTIES 

IMPLIED BY LAW ARE LIMITS DURATION TO THE WARRANTY PERIOD SOME STATES DO NOT ALLOW LIMITATIONS ON THE 

DURATION OF AN IMPLIED-^fJ^NTY, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU. THIS WARRANTY GIVES YOU 

SPECIFIC LEGAL RIGHTS, r^AY ALSO HAVE OTHER RIGHTS WHICH VARY FROM STATE TO STATE 

LIMITATION ON DAMAGES 
EA SHALL NOT IN ANY CASE BE LIABLE FOR INCIDENTAL, CONSEQUENT! ALOR OTHER INDIRECT DAMAGESARISING FROM 

ANY CLA M UNDER THIS AGREEMENT, EVEN IF EA OR ITS AGENTS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH 

DAMAGES SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES. 

SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU. 

COMMODORE MAKES NO WARRANTIES. EITHER EXPRESS OR IMPLIED. REGARDING THE ENCLOSED COMPUTER 

SOFTWARE PACKAGE ITS MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR PURPOSE THE EXCLUSION OF IMPLIED 

WARRANTIES IS NOT PERMITTED BY SOME STATES THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU THIS 

WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS THERE MAY BE OTHER RIGHTS THAT YOU MAY HAVE WHICH VARY 

FROM STATE TO STATE. 

Unless indicated otherwise, all software and documentation is (D1991 Electronic Arts All Rights Reserved 



PROGRAM LICENSE AGREEMENT AND LIMITED WARRANTY 

Carefully read all Ihe terms and conditions of this agreement prior to using the enclosed diskette. Your use of the 
diskette indicates your acceptance of these terms and conditions. 

If you do not agree to these terms and conditions, you may obtain a full refund by returning the unopened diskette 
package and the other components of this product along with your receipt to the Commodore dealer where the 
purchase was made within three (3) days following such purchase 

1. Copyright: These programs and the related documentation are copyrighted. You may not use, copy, modify, 
or transfer the programs or documentation, or any copy except as expressly provided in this Agreement. 

2. License: You have the non-exclusive right to use any enclosed program only on a single computer. You may 
load the program into your computer’s temporary memory (RAM). You may physically transfer the program from 
one computer to another provided that the program is used on only one computer at a time. You may not 
electronically transfer the program from one computer to another over a network. You may not distribute copies 
of the program or accompanying documentation to others. You may not decompile, disassemble, reverse 
engineer, modify or translate the program or documentation You may not attempt to unlock or bypass any copy 
protection utilized with the program. All other rights and uses not specifically granted in this license are reserved 
by Commodore. 

3. Back-up and Transfer: You may make one (1) copy of the program solely for back-up purposes. You must 
reproduce and include the copyright notice on the back-up copy. You may transfer and license the product to 
another party only if the other party agrees to the terms and conditions of this Agreement and completes and returns 
a registration card to Commodore. If you transfer the program you must at the same time transfer the 
documentation and back-up copy or transfer the documentation and destroy the back-up copy. 

4. Terms: This license is effective until terminated You may terminate it by destroying the program and 
documentation and all copies thereof This license will also terminate if you fail to comply with any term or condition 
of this Agreement. You agree upon such termination to destroy all copies of the program and documentation. 

5. Program Disclaimer: The programs are provided “as is” without Warranty of any kind, either expressed or 
implied, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose. 
The entire risk as to the results and performance of any program is assumed by you. Should the program prove 
defective, you (and not Commodore or its dealers) assume the entire cost of all necessary servicing, repair or 
correction Further, Commodore does not warrant, guarantee or make any representations regarding the use of, 
or the results of the use of, the program in terms of corrections, accuracy, reliability, currentness, or otherwise: and 
you rely on the program and results solely at your own risk. 

6. Diskette Limited Warranty: Commodore warrants to the original licensee that the diskette(s) on which the 
program is recorded shall be free from defects in material and workmanship only for a period of ninety (90) days 
from the date of original purchase. If a defect covered by this warranty occurs during this 90-day warranty period, 
and it is returned to the dealer from whom it was purchased not later than five (5) days of the end of such 90-day 
period, the dealer shall, at the dealer’s option, either repair or replace the diskette. 

The above warranty is exclusive and in lieu of all other warranties, express or implied (other than those warranties 
implied by state law). All state statutory implied warranties, including, but not limited to implied warranties of 
merchantability or fitness for a particular purpose shall be limited to a period of 90 days from the date of your original 
purchase. No warranties, either express or implied, will apply after this period. 

7. Limitation of Liability: Commodore’s liability is limited solely to the repair or replacement of the defective 
product, in its sole discretion, and shall not in any event include damages for loss of use or loss of anticipated profits 
or benefits or other incidental or consequential costs, expenses or damages, including without limitation any data 
or information which may be lost or rendered inaccurate, even if Commodore has been advised of the possibility 
of such damages. 

Some states do not allow a limitation on how long an implied warranty lasts, or limitation of incidental or 
consequential damages, so the above limitations or exclusions may not apply to you This warranty gives you 
specific legal rights, and you may also have other rights which vary from state to state. 

8. Miscellaneous: This Agreement represents the entire understanding regarding the programs and related 
documentation, and supersedes any prior purchase order, communications, or representations. This Agreement 
may only be modified by a written amendment signed by an officer of Commodore. If any provision of the 
Agreement shall be deemed unlawful, void, or for any reason, unenforceable it shall be deemed severable from, 
and shall in no way effect the validity and enforceability of the remaining provisions of the Agreement. 

This license Agreement shall be governed by the laws of the United States of America, Commonwealth of 
Pennsylvania. 

9. The program License Agreement shall inure to the benefit of Commodore-Amiga, I nc., its parent, and all affiliated 
companies thereof 






